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Course Details

Instructor Contact Information

Douglas F. Robertson

Professor, Developmental Mathematics and Computing
Department of Curriculum and Instruction

College of Education and Human Development
University of Minnesota

Office: 270D Peik Hall, 612-625-1075
Postal Mail: 125 Peik Hall, 159 Pillsbury Drive SE, Minneapolis, MN 55455-0208

Email: droberts@umn.edu
Web Site: https://z.umn.edu/robertson

Prerequisites

You should have some familiarity with Microsoft Windows, which is the operating
system! most PCs run on. The textbook and this Study Guide are written for
Microsoft Windows 10. Globally, there are about 74% Windows users compared to
about 16% Macintosh users.

Mac: Even though the course is written for the Windows versions of the apps, it is
possible to do the course on a Macintosh computer, but it will be more
difficult. For the most part, Macs and PCs can do the same things, but the
interfaces, menus, and keyboard shortcuts often are different. For example,
the 38 (Command) key on the Mac usually does the same thing as the
Ctrl (Control) key in Windows. So, for example, Ctrl + s will save a file 2 in
Windows; this corresponds to Command + s on the Mac. If the directions say
to use the Ctrl key, try that on the Mac. If it does not work, try the Command
key. The textbook and this Study Guide have tips for Mac users to help you
get through some of the rough spots, but some places will be a challenge. If it
becomes too frustrating, you can do the work in one of the public computer
labs on campus. For locations, see
https://it.umn.edu/services-technologies/computer-labs

If you have never used Windows, you will find it useful to read the first hundred or so
pages in the textbook. These pages contain basic information on Windows that will
make the rest of the course go more smoothly for you. You do not have to do the
activities on those pages.

Computer Access

You may use any Windows or Macintosh computer that has the 2019 version of
Microsoft Excel, Word, and PowerPoint. Or, you may use the apps contained in
Office 365, which you may get free through the U. See the syllabus for detalils.
Browser versions of the apps generally do not have all the features you will need to
complete the assignments so do NOT use those.

1 An operating system, like Windows 10 or Mac OS, is a program that manages other programs, like
Microsoft Word. A program (AKA application or simply app) is a set of instructions that accomplishes
specific tasks.

2 A computer file is electronic information, such as a Word document, an Excel workbook, or a
photo, that is stored and organized in a container known as a folder.
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Honesty

You may get help and work with others on the projects, but you must submit your
own work. That is, someone can help you figure out what to do but you must, in the
end, do it yourself. Copying the work of someone else is academic misconduct and
may result in your receiving a grade of 0 on a project or failing the entire course.

Credits and Workload Expectations

For undergraduate courses, one credit is defined as equivalent to an average of three
hours of learning effort per week necessary for an average student to achieve an
average grade in the course. Because this is a four-credit course, you should expect
to spend 3 x 4 = 12 hours per week working on projects and studying for exams.

Course Grade

The course grade will be determined by your scores on 12 required homework
projects and three exams. You may earn extra credit on your homework score by
submitting Project 6 Excel practice exam questions OR Projects 14 and 15, which
cover Access, a database app (not available on the Mac). These are extra credit
and so submission is NOT required. If you do them, your scores will be added to
your homework total when final grades are calculated. Thus, it is possible to earn up
to 110% on homework projects.

The letter grades will be determined according to the following chart.

Letter Grade Points Needed Definition
A =4.00 100 - 96 Represents achievement that is outstanding
B relative to the level necessary to meet course

A- =3.67 95-90 requirements

B+ =3.33 89 - 86 Represents achievement that is significantly

B =3.00 85 -—82 above the level necessary to meet course

B- =267 81 —80 requirements

C+ =233 79-76 _

c ~ 200 75 _ 73 Represents _achlevement that meets the
course requirements in every respect

C- =1.67 72-70

D+ =1.33 69 — 68 Represents achievement that is worthy of

B credit even though it fails to meet fully the

D =1.00 6765 course requirements

S none 100 — 73 _Repl_resent_s achievement that is satisfactory,
i.e., is equivalent to a 2.00

= ~00 under 65 Repr_esents a failure to meet course
requirements

N ~00 under 73 Repr_esents a failure to meet course
requirements
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| will email you a four-character HWID (HomeWork IDentification number) that I will
use to keep track of your homework and exam scores. It will have three digits and a
letter, such as 100A. Be sure to include that on all submissions and any emails you
send me.

Student Learning Outcomes (SLOs)

Cl 1871 addresses the following SLOs:

1. Identify, define, and solve problems You will gain experience identifying,
defining, and solving problems by creating mathematical models that will help
you make predictions to see how a situation will evolve over time. For example,
in Project 5 you will use Excel to find out how much a person would need to sell
in order to make a certain level of income. The assessment will be based on the
computer output you produce.

3. Master a body of knowledge and a mode of inquiry You will increase your
technological knowledge base, especially in the area of data analysis, and you will
gain insights into how computers can be used to collect, analyze, display, and
present data and information. For example, in Project 5 you will use Excel to
calculate and summarize sales commissions for employees. The assessment will be
based on the computer output you produce and also your performance on exams.

5. Communicate effectively You will use word processing, spreadsheet, and
presentation software to communicate ideas, data, and charts from a wide variety
of disciplines including business, economics, and social science. For example, in
Project 13 you will create a presentation that includes text, tables, charts, audio,
animation, and video to inform people about the benefits of computer-mediated
instruction. In Project 10 you will modify a thirty-five page book chapter by
including a Table of Contents, charts, cross references, mathematical equations,
styles, and an index.

7. Effective citizenship and life-long learning The skills, concepts, and
knowledge you acquire in this course will help you to be an effective citizen in
that you will be better able to understand how yourself and others can use
computers to help store and retrieve data, make decisions, predict future events,
and communicate with others.






Introduction

In this course, you will learn concepts and develop competencies in the computer
technologies that are most often used in the social sciences and in business to help

solve problems.

Textbook

L \a‘ .
Gaskin, Vargas, Geoghan & Graviett. GO! with Microsoft Office w'};

)
*5

365, 2019 Edition Introductory. New York: Prentice Hall, 2020.
The course is set up to use Inclusive Access, which is a ©

textbook model that uses an eText rather than a print text. On the bookstore
website, the textbook title will appear as (Inclusive Access) Go! With Microsoft
Office 365 2019 Edition, Author: Gaskin, ISBN: 9780135417881 You will receive
access to this digital course material through Canvas 2 on the first day of class by
clicking Modules in its menu. Then, click the textbook link. The Inclusive Access
charge will be automatically billed to your account. Coffman Union Bookstore (612-
625-6000, http://www.bookstore.umn.edu/) will notify you about the fees, and how

and when they will be billed to your student account.

If you want to use a print copy of the textbook, you may opt out of Inclusive Access
via the link provided to you, or by emailing inclusiveaccess@umn.edu with your
course information and requesting to opt out. At your request, the bookstore will issue
a refund to your student account. Opt-outs are only accepted within the first seven
days of the semester. If you opt out, you may rent or buy the printed version of the
textbook from the bookstore or Amazon.com (search for ISBN 9780135417812).

The print text and eText have the same basic content. So, which should you get?

eText

Print Text

Can use online or offline.

A traditional softcover textbook.

Can electronically search for specific
pages, words, or phrases.

Have to page through the text or use
the Index to find things.

Pointing to highlighted words opens a
box that contains the definition.

Can use the Glossary to find the
definitions of words.

Cheaper than renting or buying a print
text.

More expensive.

Have to continually switch between the
eText screen and the app screen you
are working on (e.g., Excel). This will be
very annoying and time-consuming if
you have only one monitor.

No need to switch between screens.
This will be useful if you have only one
screen (e.g., a laptop without an
external monitor). Easy to make hand-
written notes in the margins.

3 Canvas is a cloud-based system that manages digital learning tools and resources. For more
information see https://it.umn.edu/services-technologies/canvas
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The front material of the text contains all sorts of information about the book and the
specific features it contains to help you learn. Feel free to page through this material
but reading it in detail will not be all that useful.

In the textbook, the authors use the word press when they want you to tap one of
the keys. So, when you see “press Enter” don’t hold down the key but quickly tap it.
If you hold down the key, it will be like hitting the key multiple times.

In the textbook and in this Study Guide, when you are to hold down one key and
then tap another, the two keys will be shown connected with the + sign. For
example, “Press Ctrl + s to save the document.” Ctrl + s tells you to hold down the
Ctrl key and, while holding down that key, tap the s key. The first key, Ctrl, is called
a modifier key because it modifies the action of the second key. The +in Ctrl + s is
there to tell you to hold down the first key while you tap the second key; you do NOT
touch the + key on the keyboard.

To save time, when the textbook instructs you to print something DO NOT PRINT IT.
When you complete all the work for a chapter, return to this Study Guide to find out
exactly what output to create and submit for grading.

At the very back of the textbook, page G-1, you will find a Glossary that you can use
to look up the definitions of many words that have particular meanings when used in
relation to computing.

G-1

Glossary

3-D
The shortened term for three-dimensional, which refers to an image that appears to have all three spatial

dimensions—length, width, and depth.

In the print text, the Index is located right after the Glossary. You can use the Index
to find places in the textbook that contain instruction on specific topics. If you forget
how to do something, look it up in the Index. The eText does not contain an index
because you can use the search feature to find key words.

Companion Web Site for Cl 1871

In addition to a Canvas site, where you will submit homework projects and exams,
this course has a website where you will find links that will allow you to download
the files you will need, the syllabus, this Study Guide, and exam instructions. The
URL (Uniform Resource Locator) is https://z.umn.edu/robertson
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Study Guide

This Study Guide has four components.
Introductory material: You are reading that part right now.

Projects: There are 12 required projects for you to complete, each of which contains
several parts. The projects tell you what to read in the textbook and which hands-
on activities to complete. The projects also contain additional instruction on how to
do some things that are not covered in the textbook but which | think are important.
The projects contain the details of what to submit for grading.

Project keys: Starting on page SG383 of this Study Guide “ is a section that contains
the keys for the projects. As you complete each assignment, look at the key to see
if your computer output matches the one in the key. If so, great. If not, figure out
what you did wrong and fix it. Note that since all computers and printers are set up
differently, some of your output may not look exactly like the output shown. This is
especially true for line breaks, which are the points where the text on one line stops
and continues on the next line, and page breaks, which are the points where the
text on one page stops and continues on the next page. Don’t worry about this.
When we grade the assignments, we look to see if you have correctly followed the
directions. In most cases, your output and the key will match.

Sample Exam Questions and Solutions: At the end of the sections on Excel,
Word, and PowerPoint, you will find practice questions that are similar to the ones
that will appear on the exams. The worked-out solutions are included after the
guestions and the keys are in the Keys section at the back of this Study Guide.

The Five Steps of Each Project
To learn the material in the most efficient way, follow the steps given below:
Step 1 Read

Before trying any activities, read the introductory material that is located at the
beginning of each textbook chapter. This will help you get the overall picture of
what you are going to do when you work on the computer. This will only take a
minute or two, but it is time well spent.

Step 2 Activities

The hands-on step-by-step exercises in the textbook are called Activities.
Carefully read and follow the directions for each activity, and read and understand
the explanations. Don't just punch the keys! Note that if the resolution of your
display is not 1280 x 768 things may look a bit different from the screenshots in
the textbook or this Study Guide. Don’t worry if you need to make minor
adjustments, especially to spacing, when working on your own computer.

4 Page numbers with SG in front of them refer to pages in this Study Guide.
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It is important that you do every step, except for printing, of every activity
assigned. You will need some of the workbooks, documents, and presentations
you create for later homework projects. If you skip something you will eventually
have to go back and do it later, and this will be confusing.

Step 3 Homework Projects

When you finish all the assigned textbook activities for a chapter, return to this
Study Guide and begin work on the homework. The problems are designed to get
you to think about what you have learned in the chapter and to show that you
have mastered the concepts and skills described in the textbook and this Study
Guide. If you get stuck, refer back to those pages in the textbook that cover
relevant material. In the eText, you can search for specific words or phrases. In
the print text the Index at the end of the textbook will be a big help.

You may have to go back through a chapter to see how to do something if you did
not learn it well enough through your reading and doing the activities.

When you complete an assigned problem, compare your output with the key at
the end of this Study Guide and make changes as needed.

Rather than produce printed copy, you will save your output as pdf files and
submit those to Canvas. PDF (Portable Document Format) was developed in
1991 by Adobe Systems. It is designed to represent documents in a manner
independent of application software, hardware, and operating systems.

Step 4 Submit

When you complete all the assigned problems for a project, place the pdf files in a
folder, compress it (see page SG12) and submit it to Canvas for grading.

Step 5 Backup

It is good practice to backup your files every so often,
especially if they are stored on a USB drive (also known as
Thumb drive, Memory stick, and Flash drive) °. These can be
lost or broken. To backup, drag your Cl 1871 folder from one
device to the other, e.g., from your USB drive to your computer’s hard drive or to
Google Drive (a cloud storage facility described on page SG24).

The more important the file the more often you should back it up. For example, if
you are writing a paper saving drafts with different names every hour is a good
idea. Use names like SocPaper-1, SocPaper-2, SocPaper-3, etc. as you
progress. That way you can always go back to a previous draft if you need to.
When you have completed the paper, you can delete all drafts but the final one,
and then copy that one to another device as a backup.

5 USB stands for Universal Serial Bus. It is a specification to establish communication between
devices, such as a USB flash drive, mouse, keyboard, or printer and a host controller, usually a
personal computer. USB connectors also supply electric power, so many devices connected by
USB do not need a power source of their own.
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What If Something Doesn’t Work?

The textbook gives step-by-step instructions on how to do many spreadsheet, word
processing, and presentation operations. If you follow the directions as described
your results will be as shown. Sounds simple, doesn’t it? However, sometimes what
you think you are doing may not be what you are really doing. You can get into
trouble if you try to rush through the material or because you simply miss a step.

So, pay attention to what you are doing. If it doesn’t work, carefully read the
directions and try it again.

For computer operations problems, restarting the computer usually helps. For
Windows, restarting usually is better than shutting down. This is because when
Windows shuts down it may be set to save some temporary files so it starts up faster
from a cold boot. ® Those files may cause problems so restarting usually is better
than shutting down and then starting up again. But, both may help.

Schedule Your Time

For the textbook chapters, you should set aside a two- to four-hour block of time to
go through the activities and complete the reading (there are two guided textbook
projects for each chapter). Then, when you begin the homework projects, set aside
several more hours. The projects vary quite a bit in the time needed to complete
them so be prepared to be flexible. Don’t hesitate to go back to the textbook to redo
some of the activities—there is a lot to learn and sometimes you need to do it more
than once before it sinks in.

Now, let's get started with the coursework.

6 Booting a computer means turning it on (an old term from the expression “picking up oneself by
one’s bootstraps”). A cold boot means the computer starts from a power off state. A warm boot
(restart) means the startup process begins without turning off the power.






Project 1
Getting Started

Step 1 Read For this project, there are no pages to read in your textbook.
However, if you have never used Windows or any Microsoft Office apps (e.g.,
Excel, Word, PowerPoint) you will find it useful to work through the activities at
the beginning of the textbook. These activities contain basic information that
will make the rest of the course go more smoothly for you.

Step 2 Activities For this project, there are no textbook activities. To complete
this project, do the following:

Set Up Your Computer Filing System

To reduce the typing that you will need to do, the textbook authors and | have
created a set of files for you to get started on for most of the assignments. The files
are located on Google Drive. This is a cloud storage service that allows you to store
files online. Since the U of M is a Google campus, we all have access to unlimited
free storage. Google Drive has lots of features that you might find useful. You can
get more information at https://it.umn.edu/technology/google-drive?km

a. To download the files, follow the steps given below. Most of the screenshots
are from my computer running Windows 10. If you are using a different version,
or a Mac, things may look a bit different, but you should be able to follow the
instructions without too much difficulty.

1. On the desktop, right-click and select New and then Folder.

2. Right-click the folder and select Rename. Type CI 1871 as the new name
and then tap Enter.

3. Open a web browser such as FireFox % or Safari

4. Type the following in the address bar near the top of the screen

http://z.umn.edu/1871f23 7 This is a “shortened” URL that actually points to

https://drive.qoogle.com/file/d/1QP198s1092gKOvrfXIKulrsd3ZuOQOMxe-/view?usp=sharing

At the U, shortened URL's all have the same first part, z.umn.edu/, which is
easy to remember, and a unique second part, in this case 1871F23, which is
easy to remember within the context of this course. There is a short
introduction to this service, which anyone can use, at https://z.umn.edu/

7 HTTP stands for HyperText Transfer Protocol. It is an application-layer protocol for transmitting
hypermedia documents, such as HTML. It was developed in 1989 by Tim Berners-Lee at CERN to
facilitate communication between web browsers and web servers. HTTPS is an extension of
HTTP. It is used for Secure (encrypted) communication over a computer network.
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5. Tap Enter. Depending on your setup, you may have to sign into your U of M
account. Google Drive will open and show the file. If you get this message

Whoops!
There was a problem with the preview.

Retrying...

¥  Download

click Download. Otherwise, move the cursor to the icon in the upper right
and click the download arrow.

File Edit View History Bookmarks Tools Help

s ] Inbox - droberts@umn.edu - Univers X A CI11871F230riginalFiles.zip - Goo X

< C @ O & O848 = google.com
DBuy O Financial [JFind [ Misc [ Weather mMyU Canvas @Doug aAmz Z Zoom EZ

Cl11871F230riginalFiles.zip Open with ~

CI1871F230riginalFiles.... -

Name Last modified File size

M C1871F230riginalFiles - 20 MB

6. Google Drive may give you a warning that the file is too large to scan for
viruses. In that case, click Download anyway. Depending on how your
browser is set up, the CI1871F230riginalFiles file may automatically go to
your computer’s Downloads folder or you might get a message asking
what to do with the file. In that case, click Save File.

7. Close your browser. On your Desktop or in your Downloads
folder, you should see the folder you just downloaded. Notice
the zipper on the icon. To save time and space, the folder is
compressed in ZIP 8 format. If you do not see the zipper, your
system may be set up to automatically UNZIP folders.

If you do not see the folder on your desktop, check
your downloads folder by taping the Windows
key, typing downloads and clicking s T le s

Mac: Click the Spotlight icon, (the magnifying glass on the menu bar),
= Tue 9:41 AM m Type downloads folder. Under Folders, click Downloads

b. If the folder has the zipper, UNZIP the folder by doing the following.
1. Point to the folder, right-click, and click Extract All.

Mac: Double-click the zipped folder to extract the files. Go to step 3.

8 ZIP is an archive file format that may contain one or more files or folders that have been
compressed. ZIP was created in 1989 by Phil Katz, who named it ZIP as in "move at high speed".
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The Extract dialog will appear. The box Select a Destination and Extract Files
shows the location where the folder will be

. . . . Fil ill be extracted to this folder:
saved. Here is the location as it looks like |, " ¢ @fraceq o e oeer

on my Computer: ‘ C:\Users\droberts\Desktop\Cl1871F23QriginalFiles

C:\Users\droberts\Desktop\CI1871F230riginalFiles

C: represents the hard drive of my computer.
\ is a subdirectory delimiter (folder separator).
Users means my computer is set up for multiple users.
droberts is the part of the computer’s hard drive | am using.
Desktop means the folder will be put on my desktop.
CI1871F230riginalFiles is the name of the folder.

If the shown location is not what you want, click Browse and then navigate
to your preferred location.

2. Once you have the proper location displayed, click Extract. In a few
seconds you will see a new folder called CI1871F230riginalFiles. The new
folder contains folders for each section of the course (Excel, Word,
PowerPoint, and Access, which is extra credit). Each folder contains the
UNZIPPED files you will need. Notice that this folder has no zipper.

3. Open the folder and drag the four folders (Access Files — EXTRA CREDIT,
Excel Files, PowerPoint Files, and Word Files) to your Cl 1871 folder.

4. You will not need the ZIPPED folder or the CI1871F230riginalFiles folder
any more so drag them to the Recycle bin.

5. Close any open windows. If you will be using your own computer, you can
drag the CI 1871 folder to any location you wish.

c. Skip this part c and go to part d if you will not be storing your work on a
USB drive. If you are not working on your own computer, you should store your
files on a USB drive. To do so, insert it into one of the computer’'s USB ports. It
should go in easily. There is a right side up so if it does not fit one way turn it
over and try again, but gently.

To see the contents of your drive, click File Explorer ‘H File Explorer [SRYNgop
taskbar (or, hold down the Windows keyE and tap the letter e, which stands
for Explorer). Click your USB drive. It probably has a drive designator D: or E:

Mac: The USB drive will automatically appear on your desktop.

My screen looks like this:
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Manage ROBERTSON (D)

File Home Share View Drive Tools

Cut X L?_] New item ~ \i—| Open ~ BE‘ Select all
—J W Copy path a Easy access ¥ Edit Select none
Pinto Quick Copy  Paste Move  Copy Delete Rename New Properties i
— |#] Paste shortcut G - . - - & History EF Invert selection
Clipboard Organize New Open Select
<« v w- » ROBERTSON (D) v D £ Search ROBERTSON (D)
~
Name Date modified Type Size
s Quick access
Cl 1806 8/12/2023 2:14 PM File folder
@ Onelrive - Personal EDHD 1525W 8/12/2023 2:14 PM File folder
W This PC FSOS 1211 8/12/2023 2:14 PM File folder
Non School Stuff 8/12/2023 2:14 PM File folder

> . ROBERTSON (D)

The name of my USB drive is ROBERTSON. Several drive designators may be shown:

. is for a floppy diskette drive (no longer used).

. is for a second floppy diskette drive (no longer used).

. is for the hard drive.

. is for the DVD/CD drive. My computer has none, so D: is for my USB drive.
is for a USB drive.

moow>

Click the Manage View tab and, in the Layout group, click Details.

Manage ROBERTSON (D:)

File Home Share View Drive Tools
IE ] & Extra large icons [&=| Large icons == M#um icons
([N Preview pane
55 Small icons S0EC List == Details

Navigation Details pane == Tiles

nane ¥

1

E Content

Drag the CI 1871 folder to the USB drive window. This will copy the folder.

d. When the textbook or this Study Guide asks you to save a file, save it to one of
the folders in the Cl 1871 folder. To see how this works, do the following (this is
part of your first homework project that you will submit for grading). Note that:

Word files are called documents

Excel files are called workbooks, parts inside are called worksheets

PowerPoint files are called presentations, parts inside are called slides

Access files are called databases, parts inside are called Tables, Queries, and Forms.

1. Start Word by doing one of the following:

rwa Option 1 If your computer has a tiny Word icon on the taskbar, click it once.
T Option 2 If your computer has a Word icon on the desktop, click it twice.
oo | Option 3 Tap the Windows key [ type word and select Word.

Mac: Click the Spotlight icon (the magnifying glass), type word, and tap Enter.

2. After Word starts, click Blank document.

3. Type the following: This file belongs to FirstName
LastName HWID, where HWID is the four-character
homework ID | emailed you. Use your own names.

Blank document
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4. Tap the Enter key. The usual default line spacing in Word is 1.08 inch. The
spacing on your computer may be different. It does not matter.

5. Type your U of M email address.

6. Tap the Enter key. Word may automatically underline the text, change its
color to blue, and attach a hyperlink to it. Word does this because it
recognizes the text as an email address and so applies its hyperlink style. If
this happens, leave it as is. You will learn about inserting hyperlinks on
page SG140 and more on page SG217.

------ e e e S

This file belongs to FirstName LastName HWID spaCing may be different
abcd1234@umn.edu on your computer-

7. Tap Ctrl + s (that is, hold down the Ctrl key and, while keeping that key
held down, tap the s key).

Mac: The Command key usually is equivalent to the Windows Ctrl key.

This will open the Save As dialog box. This allows you to specify where
you want your file saved and what name you would like to give it. You can
also get here by tapping the F12 function key.

If you are using a laptop, you may notice a key labeled fn on the bottom
row of the keyboard. Because laptops have extra features, their keyboards

typically do not have room for all the keys that are needed. The fn key
allows the function keys to do double duty. For example, on my laptop,
tapping the F12 key increases the volume of the speaker. Holding down
the fn key while tapping the F12 key opens the Save As dialog box.

Mac: Shift + Command + s opens the Save As dialog box.

8. On the left, click Browse and navigate to the desktop.

File name; | This file belongs to FirstName LastName HWID

Save as type: Word Document

Notice that Word is suggesting the first line of text in the file for the File name.
9. Click Save. The title bar shows the file name and that it was saved.

This file belongs to FirstName LastName HWID - Saved to this PC

Your computer may show the file name as This file belongs to HWID
FirstName LastName.docx The .docx is called a file name extension. It
tells the computer what app to use when opening the file. Depending on
how your computer is set up, it may or may not display the file name
extension (mine does not). Here are some common extensions:
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.docx Word Xlsx Excel .pptx PowerPoint .accdb Access
.html Web page source text .mov QuickTime Audio/Video

.pdf Portable Document Format .rtf Rich Text Format

.wav Windows sound .zip Compressed Archive

.gif Graphic Interchange Format — for computer generated images with limited colors
Jpg Joint Photographic Experts Group — good for photographs

.png Portable Network Graphics — better than .gif for most purposes

tif Tagged Image File format — good for output from a digital camera

.mp4 — good for storing video and audio

Now, you are going to save the document using a different name.

10.

11.

12.

13.

14.

Tap the F12 key (Shift + Command + s on the Mac) or, click the File tab
and select Save As. This will open the Save As dialog box. This allows you
to save a copy of the file using a different name and/or in a different location.

Navigate to your Cl 1871 folder, double-click it, and double-click the Word
Files folder to open it. You will see a list of all the Word files in that folder.
If you do not see any files listed, check to see if the Save as type: box is

set to [5ave as type: |Word Document

In the File name: box, delete the suggested file name and type
HWO01-1 HWID Practice Save Done where HWID is the four-character
homework ID | emailed to you. If your HWID were 100A, you would type this:

File name: | HW01-1 1004 Practice Save Done h Type this.
Save as type: | Word Document ( Be sure the file type is this.

Click Save. The file will be saved in the Word Files folder with the name
HWO01-1 HWID Practice Save Done

Quit Word by clicking the X in the upper right corner of the window.

Mac: Click the Word menu and select Quit Word, or tap Command + q.

Dictating Documents

If you have to type a large document and you are not a good typist, you
might try Word’s Dictate feature. You will need a microphone and Word .
365 installed on your computer. The dictate icon is in the upper right
corner of the Word window.

0

Dictate

Voice

Click the icon and a red dot will appear in the icon showing you are being recorded.
As you speak, the words will be typed on your screen. The transcription is good but
not perfect so you will have to go back and do some editing. The process is a bit
slow and in fact a good typist can go faster than the word recognition, but you might
want to give this a try just to see how it works. Here's a web reference if you'd like
more information https://support.office.com/en-us/article/dictate-your-documents-
d4fd296e-8f15-4168-afec-1f95b13a6408



https://support.office.com/en-us/article/dictate-your-documents-d4fd296e-8f15-4168-afec-1f95b13a6408
https://support.office.com/en-us/article/dictate-your-documents-d4fd296e-8f15-4168-afec-1f95b13a6408
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Finding Files

Windows has a powerful search engine that will help you find files without having to
sift through layers of folders. You can search for files with particular names,
contents, modification dates, and many other characteristics.

Mac: To search on a Mac, click the Spotlight icon, the little magnifying glass in the
right corner of the menu bar. A nice video on Mac searching is at
https://www.youtube.com/watch?v=pXIFPtBNt5g

a. To see how the search engine works, read the following (you don’t have to
actually do it). If you try this yourself, your results will be different from mine
because we are using different computers that contain different files and folders.
In the illustration that follows, | searched my USB drive rather than my hard drive.

1. To open the USB drive, | clicked File Explorer on the taskbar [ EilIz sy
Tapping the Windows key + e also works (e for Explorer).

Mac: The USB drive will automatically show up on the desktop.

Then, | clicked my USB drive ROBERTSON (D) -] Advanced options ~

e 1

Change indexed locations

2. Inthe Options group, click Advanced options and
be sure there no checkmarks next to the options. In
the upper right corner of the window, | clicked
inside the box that says Search ROBERTSON System files
(D:), typed excel, and tapped Enter. This searched Zipped (compressed) folders
the USB drive for files and folders whose name contains the letters excel.
Capitalization of words does not matter so Excel or EXCEL will give the
same result as excel.

In non-indexed locations

File contents

sl excel - Search Results in ROBERTSON (D)
File Home Share View Search

Current folder n_] Kind ~ 42 Recent searches ~ x

- All subfolders Ll size |:=] Advanced options ~
This Date Dpen file Close
pc  ,w Searchagainin~ | odified~ LI Other properties ~ Save search i Seareh
Location Refine Options
« ~ 4 1l » Search Results in ROBERTSON (D:) v [&] O excel
# Quick access p. Bxcel Bxam DACI 1871\Excel Files

Date modified: 8/12/2023 2:07 PM
@ OneDrive - Personal
Excel Files DACI 1871

= This PC Date modified: 8/12/2023 2:07 PM

~ ROBERTSON (D) HWO06-1b HWID Excel Practice Questions ... D:ACI 1871\Excel Files\Excel Exam  Size: 43.4 KB

v & Network Date modified: 8/12/2023 2:07 PM Authors: Douglas Robertson

= CEHD-W1755954 HWO06-1c Excel Practice Questions PivotTa...  D\CI 1871\Excel Files\Excel Exam  Size: 13.7 KB

Date modified: 8/12/2023 2:07 PM Authors: R1

D& &

HWNA-1A HWIN Fvral Prartica Niiactinne MAT 107N Evvmal Cilar\ Cvenl Cunma  Cizar 501 WD

8 items h

This found 8 items that have the word excel in their names (two folders
and six files). The screenshot does not show them all.


https://www.youtube.com/watch?v=pXIFPtBNt5g
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To open a file or folder, double-click its name.

To open the location of the file, right-click its name and select Open file
location.

3. Inthe Search Tools Search tab, in the Options group, click Advanced
options and check File contents.

P SWNER  excel - Search Results in ROBE/.TSON (D)

File Home Share View Search
. Current folder By Kind ~ € Recent searche! x
= ‘ All subfolders ‘ g‘ Size ¥ | |j Advanced options ~ f
This Date . oo “'ose
pc /= Searchagainin™ |odified~ | Other properties ~ Change indexed locations hrch
Location Refine Npon-indexed locations
< v /4 W > Search Results in ROBERTSON (D) : ¥ | File contents el

Now the search will include files that contain the word excel (or Excel or
EXCEL) in their names OR in their contents.

[T Rl excel - Search Result . in ROBERTSON (D)

File Home Share View Search
‘ Current folder r-l__'] Kind 42 Recent gParches ~ x
= All subfolders g Size ¥ |j Advangkd options ¥ f
This Date B Open file  Close
pc /= Searchagainin™  nodified~ L Other properties ~ | Save garch location  search
Location Refine Options
&~ v 1 » Search Results in ROBERTSON (D:) v D S excel

Date modified: 8ggR42023 2:07 PM

s+ Quick access . .
ﬁ HWO08-6b Infections Data Original DACI 187 1\Word Files

@ OneDrive - Personal Date modified: 8/12/2023 2:07 PM

W This PC ﬁ HW09-4 Name Tag Labels DATA Original DACI 187 1\Word Files

Date modified: 8/12/2023 2:07 PM
. ROBERTSON (D)

™ Sample-d Education and Earnings Original : i
¥ Network a P g g DACI 187 1\Word Files\Word Ex

7 Date modified: 8/12/2023 2:07 PM
W CEHD-W1755954

35 items $ ftem selected 58.1 KB

This returns 35 items. It lists folders and files that have excel in their names
and also files that contain excel somewhere inside them (e.g., a Word file).

ﬁ HWO06-1b HWID Excel tice Questions ...  DACI 1871\Excel Files\Excel Exam
Date modified: 8/12/2023 2:

b. In searches, you can use Boolean operators ° such as AND, OR, and NOT. For
example, typing excel OR original shows all files that contain either word.
Typing exc OR ori lists the same files plus others that start with the letters exc
(e.g., exciting) or ori (e.g., origami). You must use UPPERCASE LETTERS for
the operators. | got 74 hits.

9 Named after the 19" century English mathematician, philosopher, and logician George Boole, who
is considered one of the founders of the field of computer science.
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c. You can search for items that were modified on specific dates. To show how
this works, | deleted the text that was in the search box and then, on the
Search Tools Search tab, in the Refine group, | clicked the Date modified
arrow and selected Yesterday. Notice the search box says
datemodified:yesterday.

el datemodified:yesterday - Search Results in ROBERTSON (D:)

File Home Share View Search

! Current folder ~ E_] Kind ~ £ Recent searches ¥ x
= All subfolders Ll size~ [=| Advanced options ~

This

Date Open file Close
pc & Searchagainin™  odified~ LI Other properties ~ H Save search [eation eareh
Location Refine Options
<« v~ 1l » Search Results in ROBERTSON (D:) v D /2 datemodified:yesterday
~
7 Quick access Cl 1806 DA

Date modified: 8/12/2023 2:14 PM
@ OneDrive - Personal
EDHD 1525W D\

@ This PC N Date modified: 8/12/2023 2:14 PM
118 items

Today is August 13, 2023. Yesterday, | modified 118 files and folders.
To find files or folders modified on a specific date, type it (e.g., 7/28/23).

To find files or folders modified within a range of dates, type the dates with
two dots between them. For example, to find the names of files that were
modified between April and August 2023, inclusive, in the search box type
datemodified:4/1/23..8/31/23

Close all open windows. A nice YouTube video on advanced searching in
Windows is at https://www.youtube.com/watch?v=E37h8iyip|8

Keyboard Shortcuts in Windows 10

An extensive list of Windows 10 keyboard shortcuts can be found at:
https://support.microsoft.com/en-us/help/12445/windows-keyboard-shortcuts

Mac: See https://support.apple.com/en-us/HT201236 for a list of keyboard
shortcuts. You can also see shortcuts by going to the Apple menu, clicking
System Preferences, then Keyboard, then Shortcuts. Here, you can
change a keyboard shortcut to a different key combination if you wish.



https://www.youtube.com/watch?v=E37h8iyipl8
https://support.microsoft.com/en-us/help/12445/windows-keyboard-shortcuts
https://support.apple.com/en-us/HT201236
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Below are some keyboard shortcuts that may save you time. The @ symbol refers
to the Windows Key, which is in the bottom row of the keyboard, second from the
left and also to the right of the Spacebar and Alt keys.

@ Open the Start Menu.

@ +d Minimize all windows and show the desktop. Tapping this again restores
all the minimized windows.

@) + e Open the File Explorer (to show drives C:, D:, E:, etc.).
Ctrl +y Redo the last action.
Esc Cancel the current task.

Ctrl + F1 Show or hide the Ribbon. When you open a Word, Excel, or PowerPoint
file, the top four lines of the window are called the Ribbon. If your
computer has a small screen you may want to hide this so you can see
more of your work. You can also do this by clicking the Ribbon Display
Options button in the upper right corner of the window.

Douglas F Robertson  DF

5 S Ribbon Display Options '

Mac: To show or hide the Ribbon, tap Option + Command +r.

Using symbols, this writenas "\ 38 r

Shutting Down the Computer

Before you shut down the computer or remove a USB drive, be sure to close all
open windows (don’t minimize them with this button [.=, but click the close box
close them). Otherwise, you may lose some of your work. -

If you are using a USB drive, to be doubly sure, right-click the name Format..
of the USB drive and click Eject. The message Safe To Remove Eject
Hardware will show in the lower right corner of the screen. Cut

Mac: To eject a USB drive, drag it to the Trash. This will NOT erase it but simply
unmount it from the operating system.

Pull out your USB drive. Don’t wiggle it, just pull it straight out.
You now can safely shut down the computer.

To sign out of a computer in a campus computer lab or classroom, tap the Windows
key, click your account icon and select Sign out.

If you are using a campus computer anything you save to the hard drive will be
deleted when the computer restarts so be sure to save all your work to a USB drive.
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Step 3 Homework Projects

Do the following four homework projects and submit them for grading. Each begins
with the statement of a Problem and then the activity guides you through the solution.

HW means || O
HomeWork || Pro

1 means 1 means
Ject 1/ Problem #1

HWO01-1 Practlce Save

Problem: How can you open and save Word documents.?

a. Do the following:

1.
2.
3.

—3h

—The insertion point is the vertical line in the lower left corner. The | 11

Navigate to the CI 1871 folder and double-click it.
Double-click the folder Word Files.

Double-click the file name HWO01-1 HWID Practice Save Done, which you
created while following the directions on page SG16 of this Study Guide.
This will open the file.

Move the insertion point to the end of the text in the document by pressing
Ctrl + End. On a laptop, you may have to hold down the Fn key as well as
the Ctrl key as you tap the End key. If neither work, use the Down Arrow
key on the keyboard. The insertion point should be just below your email
address.

Tap Enter to insert a blank line.

So you can see where the Enter key was tapped, on the Home
tab, in the Paragraph group, click the show/hide button. [ q

Thisfile-belongs-to:FirstName:LastName:HWIDY

abcd1234@umn.edu-v]

1

are where the Enter key was tapped.

Type | am using a XXX computer. Here, XXX is either Windows or
Macintosh.

Tap Enter and then type | am using the YYY textbook. Here YYY is
either Print or Electronic.

Tap Enter twice to insert a blank line.
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10. Type the following on separate lines but replace DATE and TIME with the
proper date and time each exam is to be submitted to Canvas:

1871 Excel exam is due on DATE at or before TIME.
1871 Word exam is due on DATE at or before TIME.
1871 PowerPoint exam is due on DATE at or before TIME.

Mark on your calendar the dates and times for each exam.

b. Count the words in your document and take a screenshot by doing the following:

1. Atthe end of the document, tap the Enter key twice to insert a blank line.
Then, type the following: Screenshot of Word Count: and then tap Enter.

2. Onthe Review tab, in the Proofing group, click Word Count.

Word Count ? X

Statistics:
Pages 1
Waords 57
Characters (no spaces) 252
Characters (with spaces) 301
Paragraphs 8
Lines 11

Include textboxes, footnotes and endnotes

Mac: Tap Shift + Ctrl + Command + 4. A black cross will appear. Drag the black
cross over the Word Count window. This will put the image on the clipboard.
Skip to step 10.

3. Tap the Windows key E and type snip. Windows will list files on your computer
that contain the word snip. Windows puts the names of apps at the top of the list.

Snipping Tool
App

4. Click Snipping Tool to open the app.

£® Snipping Tool

S¢New [ Mode v (2 Dely ~ K §3 Options

5. Click Options and be sure Always copy snips to the Clipboard is checked.
6. Click OK.

7. Click Mode and select Rectangular Snip. The screen will look washed out
and a white cross will appear. If that does not happen, click SR New

8. Drag the white cross over the Word Count dialog box. When you let up the
mouse button a picture will be placed on the clipboard and a sample of
what you have captured will be shown.

9. Close the Snipping Tool by clicking the X in the upper right corner of its
window. If asked to save changes, click No.
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10.
11.

12.

13.
14.

Close the Word Count window.

Move the cursor to the bottom of your HW01-1 HWID Practice Save Done
window and then tap Ctrl + v to paste the screenshot.

Double-click the image. On the Picture Format tab, in the Picture Styles
group, click Picture Border and click red for the color. | [Z picture Border v

Click Picture Border again, click Weight, and select 3 pt.

On the Picture Format tab, in the Size group, type 2.5 in the
width box |=3 55 and tap Enter.

w

c. For this course, you will submit to Canvas electronic copies of your files.
However, for other purposes you may want to print your documents on
paper. To be sure you know how to do this, make a hard copy of HW01-1
HWID Practice Save Done by doing the following:

1

. Tap Ctrl + p to display the Print dialog box.

HWO01-1 HWID Practice Save Done Douglas F Robertson @ R'_V' ?

Print
E] Copies: | 1 -

Print

This file belongs to FirstName LastName HWID

o ® — abce1234@umn.edu
Printer
Hewlett-Packard HP Laser... 1 am using a Windows computer.
-
{’o Offline 1 am using the Electronic textbook.

Printer Properties

1871 Excel exam is due on DATE at or before TIME.

Sett| ng S 1871 Word exam is due on DATE at or before TIME.

Print All Pages
The whole thing

1871 PowerPoint exam is due on DATE at or before TIME.

Compare the preview with the key on page SG383 of this Study Guide.
If you need to make corrections, tap the Esc key (upper left corner of
the keyboard) to get back to edit mode and then make your changes.
Don’t print at this time. Tap the Esc key to cancel printing.

d. Do the following to locate the folder where HWO01-1 HWID Practice Save Done
is saved. This is useful when you are working with several files and drives.

Mac:

On the menu bar, click File, click Properties, and then click the General tab.
To the right of the word Location you will see the path of the file location. If
you want to open that folder, copy the path, click the Finder icon (smiley face
at the bottom of the screen), click Go from the menu bar, and select Go to
Folder. Paste the location in the box and click Go. Skip to step 2 below.
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1. Click the File tab to open Backstage view. On the left, click Info. This
provides information about the file.
) ) ] _ Related Documents
In the lower right corner, click Open File Location.
This opens the folder that contains the file. |=__| Open File Location
Check to be sure your file is in the correct place it (should be in the Word
Files folder of the CI 1871 folder).
> C11871 » Word Files » v D L Search Word Files
Name B Date modified
Word Exam 8/12/2023 2:07 PM
personal @ HWO1-1 HWID Practice Save Done 8/13/2023 10:12 AM
2. Close the folder you just opened.
3. Tap the Esc key to close Backstage view and return to normal view.

d. Save HWO01-1 HWID Practice Save Done, quit Word, and close all windows.
Rather than paper copy, you are going to submit your output to Canvas for
grading. Instructions showing how to do this are on page SG30. Don’t do it now.

HWO01-2 Saving Files to Google Drive

Problem: How can you save files so they can be accessed from any computer that

has an internet connection?

When you set up your computer filing system on page SG11 you accessed files that
| had put on Google Drive. In this project, you will experience uploading your own
file to Google Drive.

a. Create a new Word document by doing the following:

1.

Start Word and open a new blank document.

2. Type HWO01-2 HWID, where HWID is your four-character homework ID.
3.
4

. Tap Ctrl + s, navigate to your Word Files folder, and save the document

Tap Enter.

using the name HWO01-2 HWID Google Drive Done. Do NOT close Word.

b. You can access Google Drive by selecting Google Drive from the Google
apps button if your U of M email is open. Do the following:

1.

Start a web browser, type mail.umn.edu in the address bar, and tap Enter.
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2.

3.

4.

6.

Type your Internet ID (the characters in your U of M email address to the
left of the @ symbol), type your email password, and click Sign In.

—>i 0 M @

Click the Google apps button,

(the nine tiny squares in the upper right

corner of the window), and click Drive.

At the left of the window, click F o onew @ I I L
Account Gmail Drive

and then click File upload.

Navigate to your file HW01-1 HWID Practice Save Done and double-click.
In a few seconds, you will see the confirmation 1 upload complete message.

1 upload complete

m HWO01-1 HWID Practice Save Done.docx o

Under My Drive, you will see the file name.

File Edit View History Bookmarks Tools Help

DTS LI VUl £ My Drive - Google Drive

G © & https://drive.google.com/drive/my-drive
B Buy B3 Financial E3Find B3 Lib B3 Math £ Misc £ More [ Weather E5 U of M

L Drive Q

My Drive -
I_ New y Drive

Name
Priority
M@ Hwo1-1 HWID Practice Save Done.docx
» @ My Drive

In the upper right corner of the confirmation window, click the X to close the
1 upload complete window.



SG26 PROJECT 1: GETTING STARTED

Now, you need to specify who can access your uploaded file.

7. Right-click the file name and select Share and Copy link.

2+ Share »

2+ Share

You will see this:

Share "HWO01-2 HWID Google Drive @ @&
Done.docx"

‘ Add people and groups

People with access

Douglas Robertson (you)
droberts@umn.edu

General access

Anyone with the link ~ Viewer

Anyone on the internet with the link can view

. e Copy link ' m

It will show one of the following under General access:

e Restricted: If this is selected, you may choose who can access the file
by entering the email addresses of those with whom you would like to
share the file. Nobody else will be able to access the file.

¢ University of Minnesota Twin Cities: If this is selected, only those at
the U of M Twin Cities campus with this link will be able to view the file.

e Anyone with the link: If this is selected, anyone on the internet who has
the link can view the file.
8. Click the down-arrow and choose Anyone with the link, if necessary.
9. On the right, you will see one of the following:
e Viewer: People can see the contents and download it.
e Commenter: People can post comments on your document.

e Editor: People can edit your document.
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To not allow others to change the file, be sure Viewer is selected.

General access

Anyone with the link ~
@ y

' @ Copy link '

Anyone on the internet with the link can view

Viewer w

c. Do the following to paste an image of the Google Drive Share window into
your HWO01-2 HWID Google Drive Done file.

1. Take a screenshot of the Share window:

Share "HWO01-2 HWID Google
Drive Done.docx"

@ @

‘ Add people and groups

People with access

Douglas Robertson (you)
droberts@umn.edu
General access

Anyone with the link ~

Anyone on the internet with the link can view

[ @ Copy link ‘

Viewer ~

2. Click Done in the Share window to close it and then close your web

browser.

3. Switch to HW01-2 HWID Google Drive Done file and tap Ctrl + v to paste

the screenshot.

4. Put a 3 pt red border around the image. Make the image width 3 pt.

d. Tap Ctrl + p and compare the preview with the key. Make needed corrections,

save HW01-2 HWID Google Drive Done, and close it.
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HWO01-3 PDF and Compressed Files

Problem: How can you send files to others so that they will be able to view them as
they would appear on your computer?

If you want someone to have access to one of your files you could put it up on
Google Drive or email it as an attachment. Emailing files to yourself or others may
require special handling. Email clients, like Gmail, usually have a size limitation. The
file size limit for Gmail is 25 megabytes which means that you can send up to 25 MB
in attachments. If you have more than one attachment, they can't add up to more
than 25 MB. If your file is greater than 25 MB, Gmail automatically adds a Google
Drive link in the email instead of including the file as an attachment.

Also, because different printers require different setup parameters, if you email a file
to someone the formatting on that person's computer may not look exactly like it did
on your computer. Or, that person may not have Word or Excel or PowerPoint and
so could not open the file. You can get around some of these limitations by saving
files in Portable Document Format (pdf). It is designed to represent documents in a
manner independent of application software, hardware, and operating systems. Let's
see how this works.

a. Convert a Word file to a pdf file by doing the following:

1. Navigate to your Word Files folder and open the document HW10-1
Character Styles and Declaration Original, which is one of the files you
downloaded at the start of the term. You will use this file again in Project 10.

2. Tap the F12 key (Shift + Command + s on the Mac) to open the Save As
dialog box. Remember, on a laptop, you may have to use the fn key also.

In the File name box type HW01-3 HWID-a Pdf Done

Just below this, on the right, click the Save as type arrow (File Format on
the Mac) and select PDF.

File name: | HWO1-3 HWID-a Pdf Done

Save as type: PDF

3. Click Save (Export on the Mac). An accurate copy of this file now can be
opened by any computer with the aid of Adobe Acrobat Reader, an app
that is available free from http://get.adobe.com/reader/?promoid=JZEFU

4. If necessary, close the newly created pdf file. Also, close HW10-1
Character Styles and Declaration Original without saving changes to it.

b. Do the following to email to yourself (NOT me!) a compressed folder that
contains some files:

1. Navigate to the Word Files folder.

2. Click ONCE the icon just to the left of file name H =
HWO01-1 HWID Practice Save Done.


http://get.adobe.com/reader/?promoid=JZEFU
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3.

Hold down the Ctrl key (Command key on the Mac) and click the icon for
HWO01-3 HWID-a Pdf Done.

—>
—>

Name

Word Exam
@ HWO01-1 HWID Practice Save Done
@ HWO01-2 HWID Google Drive Done
HWO01-3 HWID-a Pdf Done

At the bottom of the window, the status bar will show 2 items selected.

With the arrow pointing at the icon next to file HW01-3 HWID-a Pdf Done,

right-click, select Send to, and then select Compressed (zipped) folder.
Y i 1

Word Exam
@ HWO01-1 HWID Practicg/Save Done
@ HW01-2 HWID Googe Drive Done

8/12/2023 2:04 PM

8/13/2023 12:32 PM
8/13/2023 2:0
8/13/2023 2:2
8/12/2023 2:0
8/12/2023 2:0
8/12/2023 2:0

D 9 Bluetooth
¢ Compressed (zipped) folder

PM
PM
PM JH
PM \Y
PM JH

ice

Mac: Right-click and select Compress.

9.

A new zipped file is created. Its icon is a folder

with a zipper.

HWO01-3 HWID-a Pdf Done

HlHW01-3 HWID-a Pdf Done

Right-click the name on the zipped folder, select Rename, type
HWO01-3 HWID-b ZIPPED Done, and tap Enter.

Open your email app and compose an email with the
message: Attached is the compressed file.

Type your own email address in the To box and

HWO1-3 in the Subject box.

If you are using Gmail, click the paperclip icon

To YOUR EMAIL ADDRESS|

HWO1-3

Attached is the compressed file.

0

near the bottom of the

window to attach the file to the email. If you are using a different email app
it will look a bit different. Navigate to your Word Files folder and double-
click HW01-3 HWID-b ZIPPED Done. The file will be attached to the email.

Send the email to yourself (NOT to me).

c. Do the following to create your homework file:

1. Start Word and open a new blank document.

2. Type HWO01-3 HWID (use your own HWID), and then tap Enter.
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3. Open your email app and then open the email you just sent to yourself.

4. Take a screenshot of the email. It should look something like this:

HWO1-3 nbox x

Douglas Robertson <droberts@umn.edu> & 1:12 PM (1 minute ago)
tome -

Attached is the compressed file.

B Hwo1-3 HWID-b ZI..

5. Click at the end of the new Word document and then tap Ctrl + v to paste
the screenshot into the document.

6. Place a black border around the screenshot (Picture Format, Picture
Styles, Picture Border).

d. Tap Ctrl + p and compare the preview with the key. Obviously, your screenshot
will be different from mine but that is fine. Make needed corrections and then
save the document using the name HW01-3 HWID-c Compressed Files Done,
close it, and exit Word.

Step 4 Submit Now you are ready to submit your first homework project for
grading. Rather than submitting paper copy, you will upload to Canvas a ZIPPED
folder that contains pdf versions of the following files:

HWO01-1 HWID Practice Save Done — Saved on page SG24
HWO01-2 HWID Google Drive Done — Saved on page SG27
HWO01-3 HWID-c Compressed Files Done — Saved on page SG30

Follow the steps below to submit your homework to Canvas:
a. Create a pdf version of HW01-1 HWID Practice Save Done by doing the following:

1. Open HWO01-1 HWID Practice Save Done.

2. Tap Ctrl + p to open the Print dialog box. Check the print preview to be
sure the output is what you want. If necessary, close the Print dialog box
and fix things.

3. If necessary, tap Ctrl + p to open the Print Printer o
dialog box again. Click the arrow under pE——
Printer and select Adobe PDF. SZ peady -
4. Click Print.

Mac: In the lower left corner, click the PDF arrow and select Save as PDF.




PROJECT 1: GETTING STARTED SG31

5. In the File name box, enter HWO01-1 HWID Practice Save Done (use your
own HWID).

File name: | HW01-1 HWID Practice Save Done

Save as type: PDF files (*.PDF)

6. Navigate to the Desktop and click Save.

7. Close HWO01-1 HWID Practice Save Done.

HWO01-1 HWO01-2
HWID Prac... HWID Goo...

b. Repeat the process for the other two homework problems
for project HWOL1 so that all three pdf files are on your
Desktop. The pdf file names should be:

HWO01-1 HWID Practice Save Done
HWO01-2 HWID Google Drive Done HWO01-3
HWO01-3 HWID-c Compressed Files Done AWID=E €.

c. Do the following to create a ZIPPED folder that contains your pdf files:

1. On your desktop, right-click and select New, Folder. Name the folder
HWO01 HWID LastName, FirstName. For this example, | will use
HWO1 100A Smith, Joe.

Drag the three pdf files for HWO1 into this folder.
Right-click the folder, select Send to, and then Compressed (zipped) folder.

Mac: Click Compress “HW01 100A Smith, Joe”

é
A new zipped file will be created. Its icon is a folder with a zipper. |mwo1 1004
Smith, Joe

d. By the due date, upload this folder to Canvas by doing the following:

1. Open your Web Browser, type https://canvas.umn.edu/ in the address bar,
and tap Enter. You will be asked to log in using your U of M internet ID.

2. On the menu on the left, click Courses and click CI 1871 (00n) Computer
Literacy and Problem Solving (Fall 2023). In 00n, the n is your section
number (1, 2, 3, or 4).

3. On the menu on the left, click Assignments.

@& i v Assignments
Assignments

No assignme

Courses Discussions
Grades
it v Assignments
Calendar People i g
=¥
= Pages @ : [ HWO1Getting Started

Not available until Aug 27 at 12:00am | Due Sep 12 at 11:59pm | 30 pts

Cilac
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4. Click HWO01 Getting Started.

HWO1 Getting Started Submit Assignment

Submitting a file upload

5. On the right, click Submit Assignment.

6. Click Browse, navigate to your ZIPPED HWO01 100A Smith, Joe folder,
and double-click it.

File Upload Google Drive

Upload afile, or choose a file you've already uploaded.

File: Browse... HWO1 100A Smith, Joe.zip

-+ Add Another File

Comments...

Cancel SubmitAssignment

7. Click Submit Assignment.

Submission

~ Submitted!

8. On the right, you will see a confirmation.
Submission Details

Download HWO1 100A Smith,
Joe.zip

9. Close your browser.

Step 5 Backup Now would be a good time to backup your files. It will take only a
minute or two to copy your files from their current location to your computer’s hard
drive, or to another USB drive, or to upload them to Google Drive.



Project 2
Excel Chapter 1: Creating Worksheets and Charts
This is the first project from the textbook. Some students will be using the printed

textbook while others will be using the eText. Both versions have the same content
but look a bit different.
@ Quizzes

To access the eText, go to your Canvas page and click Modules.

. . Help Modules
Then, click the textbook link.
£ Announcements
Dashboard @&
Assignments » VitalSource Bookshelf
Courses  Discussions ii £ Gol With Microsoft Office 365, 2019Access-UMN Twin Cities

Then, click Load Go! With Microsoft Office...

Load Go! With Microsoft Office 365, 2019Access-UMN Twin Cities in a new window

To see or hide the Table of Contents, click the Menu icon = in the upper left corner.

Table of Contents

= @Ol1:==  GO! with Microsoft Office
& 365, 2019 Edition
W;;-,

-5 Introductory (Subscription)
K Shelley Gaskin; Alicia Vargas...

S

To adjust font, size, and margins, click the Reader Preferences button As
in the upper right corner.

To search for something, click the Search icon Q. in the upper right corner.

This allows you to search for text. For example, Search

if you type formula bar and tap Enter, you will

get 263 hits. formula bar Q

If you are using the print text, lookup formula bar |, . (263) Figures (0) Workbook (0]

in the Index at the back of the book.

Clicking one of the entries will take you to that spot in the text. For example, clicking

Formula Bar 318

will take you to page 318 where you will see:

Formula Bar (® Displays the value or [SIgME contained in the active cell;

— SG33 —
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When this Study Guide tells you to go to a specific page, type the
number in the box in the lower right corner of the window. For
example, to go to page 315, type it in the box and tap Enter.

< [#5 oo >

+z

1 Creating a Worksheet and Charting Data

Search * @

formula bar Q

Content (263) Figures (0) Workbook (0

Expand | Collapse
Formula Bar ~

Expand Formula Bar button
Expand Formula Bar button

Increases the height of the Formula Bar
to display lengthy cell content.

Increases the height of the Formula Bar
to display lengthy cell content

~ Objective 2 Enter Dataina
Worksheet

notice that when you begin to type in
a cell, on the Formula Bar, the Cancel

and Enter buttons become active,.

when you begin to type in a cell, on
the Formula Bar. the Cancel and Enter o

o 315 /976 >

by one page.
m— Click the menu icon E| to open or close the Table of Contents.

Click the left or right arrows next to the page numbers to move forward or backward

Click the X to the right of Search to close its window.
Now, let’s get started.

Step 1 Read Read the introductory material on page 315.

Step 2 Activities Click the arrow on the right to go to the next page, 316.

‘ 316 :‘;’976 >

Figure 1.1 is a picture of how your output will look after you finish the textbook
activities for Project 1A. This is not the final result for Project 1A that you will
submit because you will add to it by following the instructions in this Study Guide

starting on page SG36.

We will not use MyLab IT so SKIP Project Files for MyLab IT Grader.

=) Prolect Files for MyLab IT Grader

1. In your storage location, create a folder named Excel Chapter 1.

In the 2. In your MyLab IT course, locate and click Excel 1A Quarterly Sales, Download Materials, and then
Print Text Download All Files.
do NOT 3. Extract the zipped folder to your Excel Chapter 1 folder. Close the Grader download screens.

o~

do this.

| updates to the book.

. Take a moment to open the downloaded Excel_1A_Quarterly_Sales_Instructions; note any recent

‘Yi Project Files for MylLab IT Grader

In the
eText 1. Inyour storage location, create a folder named Excel Chapter 1.
do NOT 2. Inyour MyLab IT course, locate and click Excel 1A Quarterly Sales, Download Materials, and then Download All Files.
do this. 3. Extract the zipped folder to your Excel Chapter 1 folder. Close the Grader download screens.
4. Take a moment to open the downloaded Excel_1A_Quarterly_Sales_Instructions; note any recent updates to the book.
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Below this, you will see Project Results which has directions for those NOT
using MyLab IT. That is us.

s===: [ For Non-MyLab Submissions in your storage location, create a folder named Excel Chapter 1
‘ For Project 1A, you will need: P ri nt in your Excel Chapter 1 folder, save your workbook as:
=== { New blank Excel workbook Lastname_Firstname_1A_Quarterly_Sales
T ext If your instructor requires a workbook with formulas, saye as:
Lastname_Firstname_1A_Quarterly_Sales_formulas
After you have named gnd saved your warkbaok, on the next page begin with Step 2. 4

This lists the files you will need for Project 1A. For this first project,
you will need a New blank Excel workbook and nothing else.

Do NOT follow these directions.
Below, I will give you alternate directions.

You are not going to use sub folders (e.g., Excel Chapter 1).
Instead, so you can see them all at once, save all your Excel files
in the Excel Files folder you downloaded on page SG11.

If the resolution of your display is not 1280 x 768 things may look a bit different
from the screenshots in the textbook. Don’t worry, especially if you need to
increase or decrease the widths of cells to make things look right on your computer.

Keep this in mind:

Do NOT print when the textbook instructs you to print.

Do NOT do GO! With Google Sheets (pages 345-346).

When you have completed Project 1A, do Project 1B (pages 348-362).
Do NOT do GO! With Google Sheets (pages 363-364).

Do NOT do GO! To Work (page 365).

Project 1A: Start reading on page 317. Instead of step 1 of Activity 1.01

Activity 1.01: Starting Excel, Navigating Excel, and
Naming and Saving a Workbook

avigate to your Excel Chapter 1 folder, and then double-click the Excel file you downloaded from
MyLab IT that displays your name—Student_Excel 1A_Quarterly_Sales. In your blank workbook, if

necessary, at the top click Enable Editing.

do the following. —
: ]
1. Start Excel and click Blank workbook to opena | :
new blank workbook. 4

2. Tap the F12 key to open the Save As dialog box.

Blank workbook

Mac: Shift + Command + s. Or, you can click the File tab, and then Save As.

3. Navigate to your Excel Files folder.
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4. In the File name box, replace Book1 with
LastName_FirstName_ 1A Quarterly_Sales where LastName is YOUR
last name and FirstName is YOUR first name.

5. Click Save.
6. Complete the rest of the Activities for this Project through step 10 on page 344.

10.  In the upper right corner of your screen, click Close H to close Excel.

Do NOT do steps 11 and 12 in Activity 1.17 on page 344.

7. Return here when you have completed Project 1A on page 344.

Do NOT do GO! With Google Sheets.

Project 1B: When you have completed Project 1A, start at the top of page 348.

Instead of Activity 1.18 step 1 do the following:

1. Open a blank Excel workbook and save it to your Excel Files folder using
the name Lastname_Firstname_1B_Plyo Products

2. Complete the rest of the Activities for this Project EXCEPT do NOT do
steps 12 and 13 on page 362.

3. Return here when you have completed step 11 of Project 1B on page 361.

Do NOT do GO! With Google Sheets or GO! To Work.

Step 3 Homework After you have completed Projects A and B return here and
complete the following additional activities, which you will submit for grading. A list
of what to submit is on page SG49. The output keys begin on page SG384.

Mac: The menus at the top of your screen will be a big help in locating features and
will allow you to do many of the same things as the tabs on the Ribbon. m——

@ Excel File Edit View Insert Format Tools Data Window Help W = = Sat114PM Q=
Q ©
Home Insert Draw Page Layout Formulas Data Review View < Tellme ¥ Share [J Comments
& calibri (Body) e KK =, 9. [E Conduomalfomuing v L O &
EB - o @ Format as Table v
it £ w v v I
g B I U~ 28] Iy A Alignment Number ﬁ T O Cells Editing Ideas

Clipboard Font Styles Ideas Sensitivity

If you are in full screen mode, the top menus will not show unless you use
your mouse to point to the very top of the window.

If you want to display the group titles in the Ribbon, as in i Ribbon, Shous

the Windows version, click Excel, Preferences, View and, Developer tab
at the bottom, check Group Titles. Group Titles
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HWO02-1 Quarterly Sales (Based on Project 1A)

Problem: How can you organize, summarize, and change the way data and
formulas are displayed?

a. Open the workbook LastName_ FirstName 1A Quarterly Sales, which you
created while following the directions in the textbook and saved in step 3 on
page 342.

If necessary, switch to normal view: View tab, Workbook Views group, Normal.

If you see a bunch of hash symbols (also known as pound signs or number
signs), #####, it means the column is too narrow. To fix this, move the mouse
pointer so that it is between two column heading letters. It will change to a
double-headed arrow.

A B\§+D E

1 Pro Fit Marietta
2 Second Quarter Cardio Sales
3 April May | June Total

4 |Exercise Bi H#H#H  HHHHE  HEE S

Click and drag to the right to show the cell values.

b. Save the workbook in your Excel Files folder using the name
HWO02-1 HWID 1A Quarterly Sales Done, where HWID is the
four-character homework ID | emailed you.

c. Create a bar chart of the total sales by doing the following:

1. Select E4:E7.

3-D Bar
2. Onthe Insert tab, in the Charts group, click the Insert
Column or Bar Chart arrow and select 3-D Clustered %
Bar. Notice that a column chart is vertical, like the
columns on a building, while a bar chart is horizontal. LIz i

If you have a small screen, you may have to click the Chart Design 3 O Tellm

double chevron to the right of the Chart Design tab to

see the Format tab.

3. Onthe Chart Design tab, in the Location group, click Move Chart.

4. Click New sheet and type the new chart name Sales Bar Chart.

| 1 (@ New sheet: Sales Bar Chart

Click OK. This puts the chart on a separate chartsheet where only the chart
is shown (versus a worksheet where both a chart and data cells may be
shown). This will make it easier to work on.
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5. To put names on the bars, on the Chart Design tab, in the Data group,
click Select Data to open its dialog box.

Horizontal (Category) Axis Labels

6. Under Horizontal (Category) Axis Labels click Edit.

[ s

7. You could type the range for the labels but there is an easier way. Click the
collapse dialog button | ® |then click the Sheet1 tab and select A4:A7.

Click the collapse dialog button again.

A B C D E

This puts in the reference for you. It says to go to Sheetl and select the

names in cells A4:A7. Excel puts a green dotted line around that range so
you can clearly see what you have selected. The $ indicate that these are
absolute references. Here, they are optional. Later, you will use absolute
references in some formulas.

1 Pro Fit Mar\etta
2 Second Quarter Cadio Sales
3 April May ‘ June Toi
Evercioe Bikas r
4 |Exercise Bikes : Axis Labels ? %
5 |Elliptical Machines:
6 |Treadmills 1| axis label range:
. . ]
7 |Rowing Machines || | =sheet115a54:5A57 El = Exercise Bikes...
8 |Total
9

Horizontal (Category) Axis Labels
EX

Exercise Bikes

8. Click OK. Now, the machine names show up under
the Horizontal (Category) Axis Labels.

9. Click OK.

Elliptical Machines

Treadmills

AR EE

Rowing Machines

10. Click anywhere in the chart and a green cross ‘l— appears in the chart’s
upper right corner. This is one of the Chart Elements buttons.

Mac: There is no green cross. On the Chart Design tab, in the Chart |:|;h
Layouts group (on the left), click the Add Chart Element arrow, i
select Data Labels, and select Data Callout. If the Add Chart
Format Data Labels pane does not automatically open, on the ~ LEement
Format tab, in the Format group, click Format Pane.

L
Chart Title w Chart Elements

Axes
[] Axis Titles
Chart Title

Rowing Machi —60,804.65
owing Machines D D
ﬁ ata Table

Gridlines

<IN

7
This puts the values (labels) at the ends of the bars.
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11. On the Chart Format tab, in the Current Selection

group (on the left), click the Chart Elements arrow
and select Series 1 Data Labels. Just under that,
click Format Selection.

Series 1 Data Labels ~

% Format Selection
@ Reset to Match Style

Current Selection

Mac: There is no Format Selection choice.

This selects the data labels and opens the Format Data Labels pane.

Mac: Over on the right, click Format Pane to open the Format Data Labels pane.

12.
13.

14.
15.

You can also select the data labels by clicking one of them. In that case, all of

them would be selected.

On the Home tab, in the Font group, select Arial Black and make the size 9.

On the Chart Format tab, in the Current Selection group, |Vertical (Category) Axis -
click the arrow and select Vertical (Category) Axis.

Just under that, click Format Selection (not on the Mac).

Change the font to 9 pt Arial Black.

<y Format Selection
<|'2_—C| Reset to Match Style

Current Selection

On the Chart Format tab, in the Current Selection group, click the Chart
Elements arrow and select Horizontal (Value) Axis. Just under that, click
Format Selection. Tap the Del key to remove this axis.

Mac: On the Chart Design tab, in the Chart Layouts group, click the Add Chart
Element arrow click Axes and deselect Primary Horizontal to delete it.

16. Onthe Chart Format tab, in the Current Selection group, click the
Chart Elements arrow and select Chart Title. Just under that, click
Format Selection. Click inside the formula bar and type Total Sales for

17.

18.

Each Type of Machine.

X « fx | Total Sales for Each Type of Machine

Chart Title

Tap Enter. Make the font 12 pt Arial Black.

Click the bar for Rowing Machines once, wait a second, and click it again.

This will select that single bar. This is not a
“double-click” but a click, a pause, and then
another click. Double-clicking will select all the
bars and open the Format Data Series pane
(not what you want).

Click the paint bucket and select blue.

Follow the same procedure to change the color of
the Treadmills bar to pink and the color of the
Elliptical Machines bar to green.

3 L7 -

Series 1 Point " =
BN Cutline ’F

Automatic

Theme Colors
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19.

20.

21.

22.
23.
24.
25.

On the Chart Design tab, in the Location group, click Move Chart. Click the

button next to Object in, select Sheetl (if necessary), and click OK.

Position the new bar chart under the column chart.

$40,000.00

$20,000.00

5

April June

M Exercise Bikes W Elliptical Machines M Treadmills  ® Rowing Machines

Total Sales for Each Type of Machine

Rowing Machines [N o, 04.65

Click one of the labels to select them all. Format Data Labels

The Format Data Labels pane will open. Label Options -~ |Text Options

Click the Label Options button. H CRCR NI

i . |:| |:| I Label Options

Click the Number triangle. Label Options| PR

Click the Category arrow and select Currency.
urrency

Change the number of decimal places to 0. Deciml pleces: ENI

Symbol:

The $ should show under Symbol.

d. Change the bar shape and spacing between bars by doing the following:

1.

5.

With the bar chart selected, on the Chart Format tab, in the Current
Selection group, click the Chart Elements arrow and select Series 1.

Series 1

Click Format Selection . 1 to open the Format Data
Series pane. < Format Selection

Click the Series Options icon m

Under Column shape, click Cylinder to change the shape of the bars from

rectangular pyramids to cylinders.

Change the Gap Width to 30% [t T

-

e. Depending on your screen resolution, the bar labels may be difficult to read

and/or the digits may wrap. Do the following to make the labels more readable:
1.
2.

Click the Rowing Machines label value once. This will select all four labels.

On the Chart Format tab, in the Shape Styles group, click the Shape Fill

arrow and select Yellow. Now the numbers are easier to read.
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3. Click in the Chart Area to deselect the data labels. Then, click the

Rowing Machines data label once, wait a second, and click it again.
This will select only that label. Grab the edge of the data label box and
position it as shown below. Repeat this process for the Treadmills,
Elliptical Machines, and Exercise Bikes data labels.

Total Sales for Each Type of Machine

Rowing Machines
$241,682 '
Treadmills
o ) $74,299 '
Elliptical Machines
Exercise Bikes

f. Add a callout by doing the following:

1.

On the Insert tab, in the lllustrations group, click Shapes, and way down
at the bottom, click Cloud Callout. If you do not have that callout, use any
other. A small cross will appear.

Move the cross to about the middle of cell F30, hold down the left mouse
button, and drag down and to the left to insert the callout.

Right-click the cloud and select Edit Text.
Type Too low! Change the font to black Arial Black.

Point to the little orange tip and a white arrow will appear
Drag so the cloud points to the Elliptical Machines bar.

Adjust the cloud size and position to it look like the following:

_ i s74,299' °® ‘
Elliptical Machines

As you can see, when working with graphs, you sometimes have to fiddle
around with the parts to get it to look the way you want it.

g. Double-click the Sheetl tab name to select the word Sheetl, type Data as the
new name, and then tap Enter.
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h. Set up the Quarterly Sales Data worksheet for printing by doing the following:

1.

Click cell A1. On the Page Layout tab, in the Page Setup group, in the

lower right corner, click the dialog box launcher m and click Page Setup.

Mac: There are no dialog box launchers on the Mac. For features not expressly
included on the Ribbon you can use the main menu bar. In that case, click
the File menu, and then Page Setup. Or, on the Page Layout tab, in the
Page Setup group, click the Page Setup button.

o g kA WD

Click the Page tab and confirm that the orientation is Portrait.
Click the Margins tab and put a check in the box next to Horizontally.

Click the Header/Footer tab and click Custom Footer.

Click inside the Left section box and click the Insert File Name icon ﬁ:

Click inside the Right section box and click the Insert Sheet Name icon @

Mac: Skip steps 7, 8, and 9. While Mac allows you to insert a picture there is no
Format Picture icon so you cannot change its size to fit in the footer.

7.
8.

Click inside the Center section box and click Insert Picture icon E

Navigate to your Word Files folder. Double-click HW07-2 Goldy Original.

Notice the codes inserted by Excel. Other icons allow you to modify the
font, display the page number, date and time.

Left section:

A e O| |&|| 8| 2] |k

Center section: Right section:

&[File] | &[Picture] | &[Tab]|
9. Select the code &[Picture], click the Format Picture icon
Change the Height to 0.3 inch.
10. Click OK three times. Tap Ctrl + p to open the Print dialog box and compare

the preview with the key on page SG384. Make corrections and save the
workbook but DO NOT close it. Later, you will make a pdf file of this to
submit to Canvas.

i. Copy the DATA worksheet and display the formulas by doing the following:

1.

Near the bottom left of the screen, right-click the Data tab R
and select Move or Copy from the menu. EX Delete

R
Click the Create a copy check box. -

Move or Copy...
Click OK. This makes a duplicate of the worksheet and QF View Code
names it Data (2). B3 Protect Sheet..
Double-click the tab name, Data (2), to select it. s
Type the new name, Formulas, and tap Enter. Hide

Data Select All Sheets
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5. If necessary, delete the two charts by clicking an edge to select them, and
then tapping the Del key.

6. Tap Ctrl + " to display the formulas. The " key is located at the upper left
corner of the keyboard. You can also display the formulas by going to the

Formulas tab and, in the Formula Auditing group, clicking Show Formulas.

7. Click the Select All box in the upper left corner of the worksheet. \

This selects all the cells of the worksheet.

8. Move the pointer to the column heading boundary between any

N

Cl

two columns so the pointer becomes a double-headed arrow. 1
A1 v F | PrgdMMarietta 2
A A + B

Double-click. This process, called AutoFit, will adjust the column widths to
fit the formulas displayed. Don’t worry if the formatting looks different
because displaying the formulas sometimes messes it up.

Second Quarter Cardio Sales

Pro Fit Marietta

p

3

A Exercise Bikes

L3l Elliptical Machines
(3 Treadmills

VAl Rowing Machines
3 Total

April May June Total Trend
68991.12 86894.82 99650.58 =SUM(B4:D4) /
28836 22634.23 22828.78 =SUM(B5:D5) \_‘
59519.78 82337.98 99823.87 =SUM(B6:D6) /
81267.17 87867.5 91669.98 =SUM(B7:D7) //

=B4+B5+B6+B7 =C4+C5+C6+C7 =SUM(D4:D7) =SUM(BS:D8)

9. Click cell Al to deselect all the cells.

j. Set up the Quarterly Sales Formulas worksheet for printing. The initial
setup should be the same as for the Data worksheet but check to be sure.
In addition, do the following:

1. Click cell A1. On the Page Layout tab, in the Page Setup group, in the

lower right corner, click the dialog box launcher E and click Page Setup.

button.

Mac: On the Page Layout tab, in the Page Setup group, click the Page Setup

2. Onthe Page tab, look at the Scaling section. Here, you can adjust the
scale to any percent of normal size, larger or smaller, or have Excel fit the
output to a specific number of pages wide and tall.

Click the button to the left of Fit to: and confirm that 1 is in the box.

Scaling
C' Adjust to:

@' Fit to:

-

% normal size

= | page(s) wide by

Y

< tall
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3. Click the Sheet tab. In the Print section, Print
check the boxes next to Gridlines and Row .
X L Gridlines
and column headings. Printing these makes e .
it easier to see if the formulas are correct. Black and white
. D Draft quality
4. Click OK. Row and column headings
5. Tap Ctrl + p. Be sure it shows Print Active
Sheets:
PC | Settings Mac ("Excel (]
ﬁ Print Active Sheets . o
Only print the active sheets Al
Print: | Active Sheets 2]
6. Compare the preview with the key. Tap the Esc key to close the Print

dialog. Make needed corrections, save the workbook, and then close it.
Later, you will make a pdf file of this to submit to Canvas.

HWO02-2 Plyometric Products Inventory (Based on Project 1B)

Problem: How can you summarize data and construct and format graphs so that

they are informative, visually appealing, and clearly display relationships
between data?

a. Open the workbook Lastname_Firstname_1B_Plyo_Products, which you
created while following the directions in the textbook and saved in step 10 on
page 361.

b. Save the workbook in the Excel Files folder using the name HWO02-2 HWID 1B
Plyo Products Done, where HWID is your four-character homework ID.

c. Insert some extra text, an arrow, and a photo by doing the following:

d. Double-click the Sheetl tab name to select it. Type the new sheet name Data.

1.

In cell A14, type University Recreation and Wellness Center is a great
place to work out.

In cell A15 type For more information see https://recwell.umn.edu/
Make the text red and bold.

Click cell A16. On the Insert tab, in the Illustrations group, click Pictures
and then Insert Picture From This Device. Navigate to your Excel Files
folder and double-click HW02-2 U of M Rec Center Photo Original.

Double-click the photo. On the Picture format tab, in | a5 7|
the Size group, change the height to 4.5 inches and the )

width to 7 inches. =

Click cell C15. On the Insert tab, in the Illustrations Lines
group, click Shapes and click Line Arrow. NN LT
This will display a cross. Drag the cross to make a Line Arrow

horizontal arrow that is about 1 inch long. O+
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7.

10.

With the arrow selected, on the Shape Format tab, in the Shape Styles
group, click Shape Outline, and select red.

With the arrow selected, on the Shape Format tab, in the Shape Styles
group, click Shape Outline, and select Weight and 3 pt.

With the arrow selected, on the Shape Format tab, in the Shape Styles
group, click Shape Outline, select Arrows and change the arrowhead to

this: <=

Adjust the text, arrow, and photo to look like this:

University Recreation and Wellness Center is a great place to work out

For more information see https://recwell.umn.edu/ h

e. Set up the Plyometric Products worksheet to print in Landscape orientation,
all on one page, centered horizontally but not vertically, and include a footer
that contains the file name on the left and the sheet name on the right.
Compare the preview with the key. Make needed corrections, save the
workbook, and close it.

HWO02-3 Vehicle Sales Charts

Problem: How can you create detailed three-D column charts to visually display

relationships between data?

a. Open the workbook HW02-3 Vehicle Sales Original, which is one of the files
you downloaded at the start of the term.

b. Save the workbook to the Excel Files folder using the name
HWO02-3 HWID Vehicle Sales Done

c. Set up the worksheet as follows:

1.
2.

Merge and center A1:E1. Merge and center A2:E2.

In row 7, enter formulas that will calculate the sum for Cars for each year.
Do the same for row 12 for Vans, for row 16 for SUVs, and for row 17 for
Grand Total.

Click F17 and type ="Average is "& AVERAGE(B17:E17) The ampersand,
&, allows you to display more than one item in a cell. It has the effect of
concatenating (sticking together) the items so the text inside the quotation
marks will be displayed followed by the calculated average.

Click the Enter checkboxand the cell will display Average is 84.25.

Sometimes, it is useful to display the entire location (path) of your file right
on the printout. To do that, click cell A19, type =cell("filename") and tap
enter. Here is what mine shows: C:\Users\droberts\Desktop\Excel
Files\[HW02-3 HWID Vehicle Sales Done.xlsx]Data



SG46

PROJECT 2 EXCEL CHAPTER 1: CREATING WORKSHEETS AND CHARTS

d. Insert Sparklines as follows:

1.

In cell F5, insert a Line Sparkline for the Sedans data.

/\

Use the options in the Sparkline Design tab to make the color red and
mark the High Point and Low Point in dark blue.

Do the same for the Coupes in F6.

In F9, insert a column Sparkline for the Full Sized Vans data. Do the same
for the Mini Vans and the Four Wheel Drive Vans. Make the Sparkline for
Full Sized red, for Mini green, and for Four Wheel Drive blue.

e. Set up the Data worksheet to print in Portrait orientation, all on one page,
centered horizontally but not vertically, and include a footer that contains the

file name on the left and the sheet name on the right. Note that you can have
the full file location displayed in the footer by clicking the Insert File Path button
instead of the Insert File Name button.

£

\F,

Compare the preview with the key.

Make needed corrections, save the workbook but do NOT close it.

f. Create a line chart of the Total Cars and Total Vans and Total SUVs for the
years 2005 through 2020 by doing the following:

1.

Click A3 and drag across to E3. This will set the scale at the bottom of the
line chart. Note that even though A3 is empty you still need to select it so
that there is consistency in the selection of the rest of the data.

Hold down the Ctrl key (Command key on Mac) and select A7:E7. Now
both A3:E3 and A7:E7 ranges are selected.

Vehicle Sales

(in thousands of vehicles)

2005 2010 2015 2020
Cars
Sedans 23 31 35 29
Coupes 14 12 16 15
 Total Cars | 37 43 51 44

Hold down the Ctrl key and select A12:E12.
Hold down the Ctrl key and select A16:E16.

On the Insert tab, in the Charts group, click Line,

and select Line with Markers.

i

On the graph, click Chart Title, click the formula bar, type Vehicle Sales,

and tap Enter.

Click the Chart Elements button, the green cross in the upper
right corner of the chart, and put a check next to Axis Titles.

Chart Elements

Axes
Axis Titles

Mac: Chart Design, Add Chart Element, Axis Titles, Primary Horizontal,
Primary Vertical. If the Format Axis Title pane does not automatically open,
click the Format tab, and click the Format Pane button.
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8.

10.

11.

12.

13.

Click the horizontal Axis Title and, in the formula bar type, Year, and tap
Enter.

Enter Thousands of Vehicles for the vertical Axis Title.

Change the font of the Title, the Axis Titles, and the Axis Numbers to
Arial Black.

On the Chart Design tab, in the Location group, click Move Chart to open
the Move Chart dialog box.

Next to New sheet, replace the word Chartl L]J @) New sheet:  Line Chart

with Line Chart.
Click OK. The chart now is in its own chartsheet. Do NOT print this chart.

Vehicle Sales

60

50

Thousands of Vehicles
2

g. Do the following to create a 3-D Column chart for 2005, 2015, and 2020 using
the data for Sedans, Coupes, Full Sized, Mini, and Regular.

1.

Click the Data worksheet tab. Since you are skipping the 2010 column you
cannot select the data like you did for the line chart. That is, you cannot
drag across the rows of data; you must click each cell individually, left to
right, top to bottom.

Start by clicking A3 even though it is blank. Then, hold down the Ctrl key
and click (do NOT drag) B3, then click D3, then click E3.

Move to row 5 and, with the Ctrl key still held down, click the cells you
want, working left to right.

Continue in this left to right and top to bottom manner, as if you were
reading a book. See the next page.
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Vehicle Sales

(in thousands of vehicles)
2005 2010 2015 2020

Cars
Sedans 23 31 35 29
Coupes 14 12 16 15
Total Cars 37 43 o1 4
Vans
Full Sized 12 10 8 12
Mini 8 12 14 23
AN Four Wheel Drive 0 2 3 16
hP4 Total Vans 20 24 25 51
NER SUVs
7l Regular 0 4 12 | 18
il Towing Package 0 0 2 6

4. Once the data are selected for rows 3, 5, 6, 9, 10, and 14,
on the Insert tab, in the Charts group, click 3-D Column.

Set up the chart so it has these characteristics: Format Chart Area

. Type: 3-D Column Chart Options |Tex't Option
O O 1H

> Shadow

» Location: New chartsheet called 3-D Column Chart
* Chart title (above chart):

Selected Vehicle Sales for 2005, 2015, 2020
» Horizontal axis title: Type of Vehicle
» Vertical axis title: Thousands of Vehicles
* Depth axis title: Year
« Make the Title and Axis Titles 14 pt Arial Black © 30 Format
+ Make the Axes Labels 9 pt Arial Black 4 3-D Rotation
* Legend: None

- Set the X Rotation to 50° and the Y Rotation to 30° :
« Vertical Axis Gridlines: 3 pt red I LD
* Floor: Gray ) Y Rotation

h. Set up the 3-D Column chartsheet to print in Landscape orientation. Include a
footer that contains the file name on the left and the sheet name on the right.
Compare the preview with the key. Make needed corrections, save the
workbook and close it.

» Glow

I Soft Edges

Presets




PROJECT 2 EXCEL CHAPTER 1: CREATING WORKSHEETS AND CHARTS SG49

Step 4 Submit Now, do the following to create your pdf files. Each file should
contain only one worksheet or chartsheet on a single page. Do
NOT submit multiple worksheets or pages in a single pdf. Check
the key on page SG384.

Use these names for the pdf files:

HWO02-1 HWID 1A Quarterly Sales Done (Data) — This is the Data worksheet

HWO02-1 HWID 1A Quarterly Sales Done (Formulas) — This is the Formulas
worksheet

HWO02-2 HWID 1B Plyo Products Done
HWO02-3 HWID Vehicle Sales Done (Data) — This is the Data worksheet

HWO02-3 HWID Vehicle Sales Done (3-D Column Chart) — This is the 3-D
Column chartsheet

See below for the steps for creating your pdf files.

1. Open one of the files, click the appropriate worksheet tab, and tap Ctrl + p
to open Print Preview.

Mac: Tap Command + p to open the Print dialog box

Print
10f1 Printer: @ Peik 125 Toshiba 2]
Presets: [ Default Settings
Copies: D@ Two-Sided
- R v Pages: © All
O From: [1 | to: [1 |
'III IIII IIII
e — = Paper Size: [ US Letter 8.50 by 11.00 inches @
e — e ] |
1_- - :—»-—J Y —————————— Excel B|—
Collate pages
~ - Print: [ Active Sheets @
Margins: [ Normal Margins @
QOrientation: [ Portrait @
[ Scale to fit:
1 0
) (Fide ez ] T (P @

2. Check the key on page SG384 to be sure your output is correct.
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3. Click the Printer arrow and select Adobe PDF.

olla

Mac: Click the PDF button [ PoF @@ at the bottom and select

|

Open in Preview

> T

Save as PDF.

Click Print.

Save as PostScript

Send in Mail
Save to iCloud Drive
Save to Web Receipts

7| Edit Menu...

Save as Adobe PDF |

Te=TT=T—"

PDF

Navigate to the desktop, enter the file name, such as HW02-1 HWID 1A
Quarterly Sales Done (Data) and then click Save.

6. When you have created all five pdfs, create a new folder
called HW02 HWID LastName, FirstName using your own

HWID and names.

7. Drag your pdf files into the new folder.

> HWO02 HWID LastName, FirstName v (9]
Name
HW02-1 HWID 1A Quarterly Sales Done (Data)
HWO02-1 HWID 1A Quarterly Sales Done (Formulas)
HWO02-2 HWID 1B Plyo Products Done
HWO02-3 HWID Vehicle Sales Done (3-D Column Chart)
HWO02-3 HWID Vehicle Sales Done (Data)

£ Search HW02 HWID LastName, FirstName

Date modified

6/19/2022 2:12 PM
6/19/2022 2:13 PM
6/19/2022 2:14 PM
6/19/2022 2:15 PM
6/19/2022 2:14 PM

Type

Adobe Acrobat Document
Adobe Acrobat Document
Adobe Acrobat Document
Adobe Acrobat Document
Adobe Acrobat Document

8. Compress the folder to form a new zipped file as you did on page SG29.

HWO02 HWID

LastName,
FirstName

9. By the due date, upload the zipped file to the HW02 Excel Cpt 1 Creating
Worksheets and Charts folder in Canvas.

Step 5 Backup Now would be a good time to backup your files.



Project 3
Excel Chapter 2: Functions, Tables, and Large
Workbooks

Step 1 Read Read the introductory material on page 385 in the textbook.

Step 2 Activities Turn on the computer and do the following:

Project 2A: Start at the top of page 387.

Instead of Activity 2.01 step 1 do the following:

1.

Navigate to your Excel Files folder and open e02A_Tree Inventory,
which is one of the files you downloaded at the start of the term.

Save the file in your Excel Files folder using the name
Lastname_Firstname_2A_Tree_Inventory

Complete the rest of the Activities through step 11 on page 408. Do NOT
do steps 12 and 13 in Activity 2.20 on page 409.

Return here when you have completed Project 2A on page 408.

Do NOT do GO! With Google Sheets

Project 2B: When you have completed Project 2A, start at the top of page 413.

Instead of Activity 2.21 step 1 do the following:

1.

Navigate to your Excel Files folder and open e02B_Weekly Sales, which
is one of the files you downloaded at the start of the term.

Save the file in your Excel Files folder using the name
Lastname_Firstname_2B_Weekly Sales.

Complete the rest of the Activities through step 4 on page 432. Do NOT do
steps 5 and 6 in Activity 2.36 on page 432.

Return here when you have completed Project 2B on page 432.

Do NOT do GO! With Google Sheets or GO! To Work

Step 3 Homework After you have completed Projects A and B return here, do
the following additional activities, and turn them in for grading.

— SG51 —
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HWO03-1 Tree Inventory (Based on Project 2A)
Problem: How can you use statistics to analyze data?

a. Open the workbook Lastname_Firstname_2A_Tree_Inventory, which you
created while following the directions in the textbook and saved on page 408.

b. Save the workbook to the Excel Files folder using the name
HWO03-1 HWID 2A Tree Inventory Done

c. When a worksheet has many rows or columns it is often useful to be able to
see non-adjacent parts of the worksheet at the same time. The textbook
showed you how to do this in a couple of ways:

e freeze parts of the screen so specific rows or columns are always in view
(textbook page 401).

e split the screen horizontally so you can scroll the upper and lower parts
independently, or split the screen vertically so you can scroll the left and right
parts independently (textbook page 406).

A third way is to hide rows or columns. To see how this works, do the following:

1. Select rows 17:41 by clicking on row number 17 and dragging to row 41.

2. While pointing to any selected row number,

: : . I Oak T 13
right-click and select Hide from the menu. 1 M%pléeﬁzes 6 (571 totd
Now it appears that row 16 is followed by row ¥ -
42. The other rows are still there but they are }i Quantity in Stock — ”e’]‘;fg;
hidden from view. Notice that the count in B10 & 35| 13358
has not changed. Even though you cannot 16 60 15688
see the hidden rows the values are taken into [ 201 16955
. ) 18 75 21683
account in the formulas. When you print, those g o 22189
hidden rows will not print. 20 68| 23677
42 350 43153
Do NOT go to the View tab, hid 43 7/5/2020 9:53
Window group and click Hide. e

This will hide the entire workbook! If you do that, click Unhide | [_]Unhide
to get the window back.

3. Select rows 16 to 42, right-click, and select Unhide.
d. Hide rows 21 to 41.

e. Set up the Tree Inventory worksheet to print in Landscape orientation, all on
one page, centered horizontally but not vertically, and include a footer that
contains the file name on the left and the sheet name on the right. Click the
Sheet tab and click Row and column headings. Click OK. Compare the
preview with the key. Make needed corrections, save the workbook, and close it.
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HWO03-2 Weekly Sales Summary (Based on Project 2B)

Problem: How can you organize and summarize data from different sources?

a. Open the workbook Lastname_Firstname_2B_Weekly Sales, which you
created while following the directions in the textbook and saved on page 432.

b. Save the workbook to the Excel Files folder using the name
HWO03-2 HWID 2B Weekly Sales Done

c. Set up the Summary worksheet to print in Portrait orientation, all on one
page, centered horizontally but not vertically, and include a footer that
contains the file name on the left and the sheet name on the right. Compare
the preview with the key. Make needed corrections, save the workbook but do
NOT close it.

d. The IF function introduced on textbook page 396 allows you to choose
between two alternatives based on the truthfulness of a condition called a
logical test. The IF function evaluates the logical test and, if the logical test
result is true, the first alternative is displayed; otherwise the second alternative
is displayed.

The IFS function, described on pages 427-429, allows the user to display
different things based on more than one condition (hence the S in IFS).
However, the conditions must be placed in the correct order for the function to
work properly. Here is the formula the authors provided:

=IFS(B4>4999,500,B4>3999,350,B4>2999,250,B4>0,0)

Notice that this starts with the highest cutoff, 4999.
IF that is exceeded, THEN 500 is displayed.
IF it is not, THEN the next highest cutoff, 3999, is checked.

And so on.
THEN Else THEN Else THEN Else THEN
=IFS| B4>4999 , 500 » B4>3999 , 350 , B4>2999 ’ 250 ’ B4>0 ’ 0
[ —— —_—— [ ————— —
Condition 1 Display Condition 2 Display Condition 3 Display Condition 4 Display
if true if true if true if true

Some people find using “nested” IF statements easier to understand. “Nested”
means putting one IF statement inside another. Here, you are choosing between
four different bonus values, so you need three IF statements.

For this problem, it would look like this:

THEN Else THEN Else THEN Else
=IF| B4>4999 , 500 , IF| B4>3999 ’ 350 s IF| B4>2999 ’ 250 ’ 0
M R S —
Condition 1 Display Condition 2 Display Condition 3 Display Display

if true if true if true if false
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What happens if you reverse the order in the IFS formula, like this?
=IFS(B4>0,0,B4>2999,250,B4>3999,350,B4>4999,500)

In this case, the first condition, B4>0, is true for everyone and so the
result is a bonus of 0 for everyone! Be sure to always check your
formula results by hand because it is really easy to get things backwards.

To see how this works, do the following:
1. Click the Bonus worksheet tab. In cell C3 replace Bonus with Bonus using IFS.
2. In cell D3 type Bonus using nested IF.
3. Select B4:D7, right-click and select Format Cells.
4

. On the Number tab, click Accounting and set the Decimal places to 0
and display the $.

5. Select A1:D1 and, on the Home tab, in the Alignment group, click
Merge & Center to deselect it and click it a second time to select it again.

1 Weekly Online Sales Bonus

=8 Salesperson Weekly Sales Bonus using IFS Bonus using nested IF

6. AutoFit columns A:D.
7. In cell D4 type =if(b4>4999,500,if(b4>3999,350,if(b4>2999,250,0)))

8. Fill D4 down to D7. Notice the values in columns C and D are the same.

There is nothing to print here. You will learn more about nested IF functions on
page SG136.

e. Set up the Bonus worksheet to print in Portrait orientation, all on one page,
centered horizontally but not vertically, and include a footer that contains the
file name on the left and the sheet name on the right. Compare the preview
with the key. Make needed corrections, save and close the workbook.

HWO03-3 Inventory (Based on Project 2G)

Problem: How can you summarize data based on certain conditions?

a. Start at the top of textbook page 453. Instead of step 1 do the following:

1. Open the file e02G_Inventory, which is one of the files you downloaded at
the start of the term.

2. Save the file in your Excel Files folder using the name
Lastname_Firstname_2G_Inventory

b. Follow the directions for steps 2 through 23 for Project 2G Inventory on pages 453-454.
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c. After completing step 23, save your file to the Excel Files folder using the
name HWO03-3 HWID 2G Inventory Done

d. The Tables may still be defined for the Bulbs and Trees worksheets.
If necessary, do the following to remove the Table designation:

1.
2.

Click the Trees worksheet tab.

Click A15. If the Table Design tab appears then this range is still designated
as a table. To remove the table designation, on the Table Design tab, in the
Tools group, click Convert to Range. Click Yes to confirm the conversion.
The Table Design tab will no longer be present and there will be no arrows in
the header row (row 14).

Click the Bulbs worksheet and, if necessary, convert the table into a range.

Click cell B5 and make the number bold red and the fill yellow so it stands out.

If the Gridlines are showing, remove them (View tab, Show group, Gridlines).

e. Change the worksheet tab colors by doing the following:

1.
2.

Right-click the Bulbs worksheet tab, point to Tab Color, and click orange.

Repeat the process to make the Trees worksheet tab color green.

f. The Sparklines in D5:D9 on the Summary worksheet are not informative
because all the tree prices are so much larger than all of the bulb prices. Do the
following to remove them:

1.
2.
3.

Click the Summary worksheet tab to make that worksheet active.
Select D5:D9.

Tapping the Del key does not delete the Sparklines. Instead, on the
Sparkline tab, in the Group group, click the Clear arrow, and select Clear
Selected Sparklines.

g. On page 405, step 8, the book showed you one way of determining the quantity
in stock of Tulips on the Bulbs worksheet by using filtering. Below is an easier
way of doing that, and one that will automatically update as the data change.

1.
2.
3.

Click the Bulbs worksheet tab to make it active.
In C10, type Tulip Total using SUMIFS.

In C11, type =sumifs(al5:a42,f15:f42," Tulips") and then click the Enter
checkbox to keep C11 active. Notice the number, 433, is the same as the
one you typed in B11. If the Quantity in Stock in column A changes, this
value in C11 will automatically be updated but the value in B11 will not.

The SUMIFS function works like the COUNTIF function you learned about
in Project 2A, except SUMIFS finds the sum of selected values rather than
counts how many there are. Here is the form of the function:
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where to look where to look
what to sum ——n—  what to look for ———n—  what to look for
——— criteria1 — criteria 2 —

=SUMIFS( sum range , , criteria1 ’ , criteria2 |,...
Quan in Stock —_— Tulips — not needed
range that not needed
has Category

sum range: Which cells do you want to sum? Quantity in Stock (A15:A42).

criteria 1 range: Whose Quantity in Stock do you want to include?

Those of Tulips, so use the Category in F15:F42

criteria 1: What should the Category be? Tulips, so use "Tulips"

criteria 2 range: You can include many more conditions but it is not needed here.

criteria 2: Not needed here.

what to sum where to look what to look for

——
=SUMIFS( A15:A42 ,| F15:F42 , "Tulips™ )
%,—J %,—J
Quan in Stock range that Tulips

has Category

Click the Trees worksheet tab to make it active.
In C10, type Evergreen Total using SUMIFS

Click C11 and enter a formula that will sum the quantity in stock for Evergreens
in the range F15:F42. You should get the same number, 583, as isin B11.

h. The AVERAGEIFS function is like SUMIFS but it finds averages rather than
sums. For example, do the following to find the average price for the tulips:

1.
2.
3.

Click the Bulbs sheet tab to make that sheet active.
In A12 type Tulip Average Price.

In B12, type =averageifs( After you type the left parenthesis, (, Excel
provides a screen tip that shows the structure of the AVERAGEIFS formula.

=averageifs(

AVERAGEIFS(average_range, criteria_rangel, criterial, ...)

The average_range is the location of the numbers you wish to average. This is
the Retail Price in D15:D42. Type that range followed by a comma.

=averageifs(d15:d42,

AVERAGEIFS(average_range, criteria_range]l, criterial, [criteria_range2, ...)

The criteria_rangel is the range where the criteria are located. That is,
Category in F15:F42. Type that range followed by a comma.

=averageifs(d15:d42,f15:f42,

AVERAGEIFS(average_range, criteria_range, criterial, [criteria_range?, criteria?], ...)
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The criterial is what you are looking for. That is Tulips. Type “Tulips”)
(note the right parenthesis). The quotation marks around Tulips are
needed. The square brackets around [criteria_range2, criteria2] mean
the items inside are optional. In this case, we have only one criterion so
there is no criteria_range2.

Click the Enter checkbox to keep B12 active. The value 11.426 should show.

10 Tulip Types 5 Tulip Total using SUMIFS
AN Tulip Total Quantity 433 433

Tulip Average Price | § 11.426 |

4. Format the average price in B12 to match the average price in B5. A quick

way to do that is to use the Format Painter. Its icon is the paintbrush on X

the Home tab, in the Clipboard group. To use it, click cell B5, which has
the format you want, click the paintbrush, and click B12. All the formatting
in B5 is “painted” onto B12.

5. If you need to remind yourself of something about the contents of a cell you
can use an Excel Note. These are like Post-It notes that you can tack on to
any cell. For example, click C11, right-click, and select New Note, or tap
Shift + F2. In the box, type Used SUMIFS.

. H i IES
10 . Tulip Typ_es 3 Tulip Total using SU Douglas Robertson:
BN Tulip Total Quantity 433 433 | Used SUMIFS.

WA Tulip Average Price §  11.43

Notice that Excel inserts the name of the user automatically so if more than
one person makes a Note you can see who did it. Notes do not
automatically appear when the worksheet is printed. If you want to print
them, go to Page Layout, Page Setup, Sheet, click the Comments and
notes down-arrow, and select As displayed on sheet. For more options
on Notes, click the Review tab and click the Notes down-arrow.

Click C11. Depending on how your version of Excel is set up, the Note may
disappear, leaving only a small red triangle in the upper right corner of the

cell. If you click the cell the Note textbox will appear. To have the Note stay
on the screen, right-click the cell and select Show/Hide Note. To hide a
Note, right-click and select Show/Hide Note again. To delete a Note, click
the cell, right-click, and select Delete Note (do not do that).

6. To add a cute image to the Bulbs worksheet, on the Insert tab, in the
[llustrations group, click Icons. In the search box, type tulip. Click a tulip
icon, and click Insert.

Drag the tulip icon so it is in column C, just under As of December 31.

On the Graphics Format tab, in the Graphics Styles group, click the
Graphics Fill arrow and select orange.

Mac: Right-click the icon. Select Format Graphic. Click the paint bucket and Fill.




SG58 PROJECT 3 EXCEL CHAPTER 2: FUNCTIONS, TABLES AND LARGE WORKBOOKS

9. Onthe Graphics Format tab, in the Graphics Styles group, click the
Graphics Outline arrow and select black.

Mac: Click the paint bucket and Line.

Pasadena Facility: Iny

As of Dec

[N Average Price
[ Median Price
WA Lowest Price
sl Highest Price

[ Total Items in Stock 2,847

S 899
$ 8.42
$ 475
$ 16.58

i. Set up the Bulbs worksheet to print in Portrait orientation, all on one page,
centered horizontally but not vertically, and include a footer that contains the
file name on the left and the sheet name on the right. Make the Note in cell
C11 appear on the output. Compare the preview with the key. Make needed
corrections, save the workbook, but do not close it.

J. Use the COUNTIF, SUMIFS, and AVERAGEIFS functions to collect Bulbs and

Trees detailed summary data by doing the following:

1. Click the Details worksheet tab.

2. Click cell B5, type =, then click the Bulbs worksheet and click B4 there, then
tap Enter. This will switch you back to the Details worksheet and 2,847 will
be displayed. Click B5 on the Details worksheet and you will see the formula

that is there:

B5

You are in B5
on the Details
worksheet. /

- x v Kk =Bu|bs!B4K

Bulbs

You are display@ B4
on the Bulbs worksheet

>

Total ltems in Stock/ 2,847

=Bulbs!B4 says the item displayed is the item in cell B4 on the Bulbs
worksheet. Notice the exclamation point ! It signifies that Bulbs is a

worksheet name.

3. Repeat the process for cells B6:B9. A quick way of doing that is to copy the
formula in B5 and paste it into B6:B9. Here are three ways of doing that:
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Bulbs

2,847

Method 1: Select B5:B9 and tap Ctrl + D (D for Down). This copies the
formula from B5 to B6:B9. But, it also copies the formatting of B5 so the
Average Price, etc., appear without the $ sign and the numbers are
rounded to O decimal places, and the bottom dark border is lost.

Bulbs

Total ltems in Stock 2,847
6 | Average Price 9
Median Price 8
E’ Lowest Price 5
ER Highest Price 17

This is not what you want. Tap Ctrl + z to undo this.

Method 2: Use the Fill Handle (see textbook page 322). To do that, click
B5 and notice the small square in the lower right corner of the cell. =%
Move the pointer to the lower right corner of the cell and a black cross
(the Fill Handle) will appear.

Drag the cross down to B9 and the cell contents (formula and formatting)
will be pasted in B6:B9. Again, not what you want. However, your

—— =« computer may be set to display Auto Fill Options when you copy this

way. If so, a tiny menu will appear.

If that menu appears, click the down arrow | -

=L

and select Fill Without Formatting. @ Copy Cell

Bulbs l 2 Fill Eermatting Only
Total ltems in Stock 2,847

2 Fill Without Fermatting

Average Price| $ 8.99
Median Price| $  8.42 O HashFill
Lowest Price| $ 475
Highest Price| $ 16.58

The formulas are copied but the formatting of the cells in B6:B9 is retained.

If the menu does not appear, you can turn on this option by clicking the
File tab, scrolling down and clicking Options, clicking Advanced,
scrolling down to Cut, copy, and paste, and putting a check mark next
to Show Paste Options button...

Cut, copy, and paste

Show Paste Options button when content is pasted

Then, click OK. If your computer does not have the Paste Options
button, use Method 3 below.
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Method 3: If your computer does not have the Paste Options |P2ste Options:

button, copy cell B5, select B6:B9, right-click and, under [%
Paste Options, select Formulas (F). That will paste the fﬁ_ﬁL @ @L—i
formulas only and preserve the original formatting. Formulas (F)

Y]

In cell C5, display the contents of B4 on the Trees worksheet. Then, fill the
formula down to C9, preserving the format.

In B12, display the sum of the quantities of the different types of Begonias
in stock on the Bulbs worksheet. To do that, click B12 and type =sumifs(

SUMIFS(sum_range, criteria_range1, criterial, ...)

The screen tip appears showing the structure of the SUMIFS formula:

e sum_range, which means “Which numbers are you going to sum?” (on
the Bulbs sheet, Quantity in Stock range A15:A42).

e criteria_rangel, which means “Where are you going to look?” (on the
Bulbs sheet, in the Category range F15:F42).

e criterial, which means “What are you looking for?” (the word Begonias).
Now, click the Bulbs worksheet and select A15:A42

then type a comma
then click the Bulbs worksheet and select F15:F42
then type a comma
then click the Details worksheet and click A12 (or type Al12),
then type a right parenthesis )
finally, click the Enter checkbox to keep B12 active.

B12 should display the number 314 and the formula bar will show
=SUMIFS(Bulbs!A15:A42,Bulbs!F15:F42,Details!A12)

This is similar to page SG55 where you entered this formula in C11 on the
Bulbs worksheet: =sumifs(al5:a42,f15:f42," Tulips")

The difference is that (1) the first two cell ranges are on the Bulbs
worksheet and (2) the criteria is not a word in quotes (like "Tulips") but a
cell reference that has the criteria word in it (A12, which contains the word
Begonias)

what to sum where to look what to look for
=SUMIFS(Bulbs!A15:A42 ,Bulbs!F15:F42 , Details!A12 )
%/—/
range that has range that :
Quan in Stock has criterion gg?:illislishggt

Before copying the formula to B13:B17, you need to convert the ranges for
the Bulbs worksheet to absolute references so when you fill the formula
down the ranges on the Bulbs worksheet will not change (similar to what
you did on page 355 of the textbook). To do that quickly, in the formula bar
click the cell reference A15 and then tap the F4 key. Remember, on a
laptop, you may have to hold down the fn key when you tap F4.
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The cell reference changes to $A$15. If you forget about this keyboard
shortcut, you can always type the $ manually.

Do the same for cell references A42, F15, and F42 and then click the
Enter check box on the formula bar.

Do NOT put the $ in A12 because you want that to change to A13, then
A14, etc. when you fill down.

Now the formula looks like this:
=SUMIFS(Bulbs!$A$15:$3A%$42,Bulbs!$F$15:$F$42,Details!A12)

6. Point to the lower right corner of B12 and the fill handle (little black cross)
will appear. Drag down to B17 and let up the mouse button. This copies
(fills) the formulas. Note that if you double-click the fill handle the formula
will be filled down automatically, without having to drag. Remember to use
the Auto Fill Options menu to preserve the formatting.

Number :Number of Average
11 | Bulbs Category in Stock Categories: Price
12 | Begonias 314
13 Callas 101
14 Daffodils 795
15 Dahlias 473
16 Gladiolus 771
17 Tulips 433

Note that when you point to a cell you will see one of three icons:
E White Cross shows where the mouse is pointing.

|:| Black Cross in lower right corner is the fill handle. To copy
+ a formula down, drag this cross or double-click it.

| .1, Four-headed Arrow allows you to drag the contents of the
cell in any direction. When you drag a cell onto another cell
the contents of that other cell will be replaced.

7. Enter similar formulas in cells B20:B24. A quick way to do that is to copy
the formula in B12 and paste it into B20. Then, in B20 change Bulbs! to
Trees! and change A12 to A20. So, the formula in B20 would be

=SUMIFS(Trees!$A$15:$A$42, Trees!$F$15: $F$42,Details! A20)

8. Fill the formula in B20 down to B24 and preserve the format.

k. In C12:C17, enter formulas that display the Number of Categories (that is, the
number of different types of Begonias, Callas, etc.). Here, you are counting
the different types of bulbs so you will use the COUNTIF function.°

10 =COUNTIF(Bulbs!$F$15:$F$42,Details!A12)
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There are 3 types of Begonias,

23 | 136 1379/ Fringed Mix 12.99]  15"Begonias_|
30 [ | 126 1456 Pendula Cascade 9.89]  15[Begonias |
36 | 52 1469 Multiflora 9.89] _ 15"Begonias ]

[. In C20:C24 do the same for Trees.

m. In D12:D17, enter formulas that display the Average Price for the bulbs. Here,
you are finding an average so you will use the AVERAGEIFS function.!?

n. In D20:D24 do the same for Trees.

0. Set up the Details worksheet to print in Portrait orientation, all on one page,
centered horizontally but not vertically, and include a footer that contains the
file name on the left and the sheet name on the right. Compare the preview
with the key. Make needed corrections, save the workbook, and close it.

HWO03-4 Payroll IF

Problem: How can you set up a payroll worksheet that automatically calculates
regular pay, overtime pay, total pay, and summary statistics?

a. Open the workbook HWO03-4 Payroll IF Original, which is one of the files you
downloaded at the start of the term.

b. Save the workbook to your Excel Files folder using the name
HWO03-4 HWID Payroll IF Done

c. Sort the data alphabetically by name by doing the following:

1. Select rows 8 through 28. Be sure to select entire rows and not just the
Name column or the data will be scrambled. To select an entire row, point
to the row 8 number. The cursor will change to a right-pointing arrow. (. g
Click to select the entire row 8. Then, drag down to row 28.

2. Onthe Home tab, in the Editing group, click the Sort & Filter arrow, and
select Custom Sort from the menu.

I
()

Mac: The Editing group might look like a magnifying glass: |~

Editing

3. Be sure there is a check next to My data has headers so the titles in row 8
will not be sorted with the rest of the data.

4. Select Name from the Column Sort by drop-down menu.

+ Add Level X Delete Level []agopy Level ‘ Options... My data has headers
Column Sort On Order
Sort by |Name Cell values v AtoZ v
|D ..........
Name

11 =AVERAGEIFS(Bulbs!$D$15:$D$42,Bulbs!$F$15:$F$42,Details!A12)
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5.

You want the names in alphabetical order so leave the Order as A to Z.

Click OK.

d. Break-up the names in column B so that the last names and first names are
shown in separate cells by doing the following:

1. Select columns C and D, right-click, and choose Insert. This will move
column C (Sex) right to become a new column E and leave two blank
columns, now called C and D, that will hold the last and first names.

8.

Date Modified:

Time Modified:

Current Date:

Current Time:

ID Name

Sex

4470881 Anderson, Amanda R

Type Last Name in C8 and First Name in D8.

In C9, type Anderson. This is the last name of the first person on the list.
Click the Enter checkbox to accept the typing and remain in cell C9.

With C9 still selected, on the Home tab, in the Editing group,
click Fill, and select Flash Fill. The last names are filled in
column C. If a small icon appears, click its arrow and click
Accept suggestions.

= E—

© Undo Flash Fill

Accept suggestions

In D9, type Amanda. This is the first name of the first person on the list.
Click the Enter checkbox to accept the typing and remain in cell D9.

With D9 still selected, on the Home tab, in the Editing group, click Fill, and
select Flash Fill. The first names are filled in column D. Click Accept

suggestions, if necessary.

You no longer need the Name column so select the entire column (click the
column letter B), right-click, and select Delete. The columns to the right are
shifted left so now Sex is in column D, Pay Rate is in column E and so on. *?

AutoFit columns A:E.

e. In G9, enter a formula to calculate the regular pay for Anderson. You can use
the IF function to do that. The IF function chooses between two alternatives. In
this case, the alternatives are two different ways of calculating regular pay,
depending on the hours worked.

12 Flash Fill can also work in reverse. For example, if you were to click cell L9, type Amanda
Anderson, tap Enter, and then select Flash Fill, the rest of the names would be filled in
(Christopher Bastian-Smith Ill, EImer Gary Bell, and so on. Don’t do this!
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Here is the logic you need to use:

¢ If she worked 40 hours or less (F9<=40) then the regular pay is computed by
multiplying rate and hours (E9*F9).

¢ |If she worked over 40 hours, then she worked 40 regular hours. In that case,
the regular pay is the product of rate and 40 (E9*40).

1. Type your formula in G9.

display if display if
logical test condition condition
(condition) TRUE FALSE

=IF( F9<=40 , E9*F9 , E9*40 )
are hours pay rate pay rate

40 or less? times times
hours 40

So, the formula is =IF(F9<=40,E9*F9,E9*40)

2. Tap Enter and check the result. Since Anderson worked 21 hours her
regular pay will be her Pay Rate times her Total Hours, 6*21 = 126.

3. Fill the formula in G9 down to row 28 and preserve the format.

4. Check the result for Bell, in G11. He worked 50 hours, which is 40
regular hours and 10 overtime hours. So, his regular pay will be his
Pay Rate times 40, 3*40 = 120.

f. In H9, enter a formula to calculate the overtime pay for Anderson.

» If Anderson worked 40 hours or less (F9<=40) then her overtime pay is 0
(she has not worked overtime so her overtime pay is 0).

» If Anderson worked over 40 hours, then her overtime pay is computed by
multiplying the rate times 1.5 (for time and a half) times the number of
overtime hours worked. Here, the overtime hours will be the total hours minus
40. Remember to use parentheses where appropriate because you want the
computer to do the subtraction of the hours before it multiplies by the rate.

1. Type your formula in H9.

display if display if
logical test condition condition
(condition) TRUE FALSE
=IF( F9<=40 , 0 , E9*1.5*(F9 - 40))
are hours no pay rate times 1.5

40 or less? overtime times hours over 40

So, the formula is =IF(F9<=40,0,E9*1.5*(F9-40))

2. Tap Enter and check the result. Anderson worked 21 hours so her
overtime pay will be 0.

3. Fill the formula in H9 down to row 28 and preserve the format.
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4.

Check the result for Bell, in H11. He worked 50 hours, which is 40 regular
hours and 10 overtime hours. So, his overtime pay will be his Pay Rate
times 1.5 times 10, 3*1.5*10 = 45.

g. In 19 (that is eye nine not 19) enter a formula that will add the regular and
overtime pay for Anderson. Enter the same formula in J9. You will see why
later. Fill the formulas in 19:J9 down to row 28 and preserve the format.

h. Improve the “look” of the numbers in G9:J28 by doing the following:

1.

3.

Select G9:J28 and, on the Home tab, in the Number group. click the
Increase Decimal button | §§ | twice to show cents.

Select G9:J28, right-click any cell, and Text alignment
choose Format cells. On the Alignment Horizontal:
tab, under Text alignment, Horizontal, —
change Indent from 0 to 2. Right (Indent) ¥ | Indent:
Click OK. This looks nicer. Vertical: 2
G H | J
Regular Pay @ Overtime Pay Total Pay Total Pay

$126.00 $0.00 $126.00 $126.00

$140.00 $0.00 $140.00 $140.00

$120.00 $45.00 $165.00 $165.00

I. Insert a rank indicator to show the rankings for Total Pay.

1.

In K9 type =rank($i9,$i$9:$i$28) and tap Enter. This calculates
Anderson’s rank in terms of total pay. The RANK function compares the
value in 19 (Anderson’s Total Pay) with the values in 19:128 and displays
her rank (1, 2, 3, etc.).

Note the use of dollar signs, which indicate absolute references:

e The $ to the left of i says to NOT change the column indicator, i, when
the formula is copied left or right. This is an absolute reference.

e There is no $ to the left of the first 9 because when you fill the formula
down you want this 9 to change to 10, and then to 11, and then to 12, so
on. This is a relative reference.

e The $ to the left of the second 9 and the 28 (in the range $i$9:$i$28)
says to keep those row numbers the same when the formula is filled
down. That will keep the range the same for all rows.

Fill the formula in K9 down to K28 and preserve the format. The ranks
range from 1, highest pay (in 124), to 20, lowest pay (in 126).

Use a conditional format to highlight duplicate Pay Ranks. Since you want
to format the ranks, select the range K9:K28. On the Home tab, in the
Styles group, click Conditional Formatting, select Highlight Cells Rules,
and select Duplicate Values. Click OK. Notice that Bostrom and Francis
both made $80 so they are tied for 17t" place. Hence, there is no rank 18.
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4.

Use a conditional format to make a bar graph of the Total Pay. Since you
want the format to be on the Total Pay cells, select the range J9:J28. Then,
on the Home tab, in the Styles group, click Conditional Formatting, select
Data Bars, and select the green Gradient Fill icon.

[ Gradient Fill Total Pay
[ 1l Data Bars > $126.00

$140.00

$165.00
This provides a visual representation of the relation between the
Total Pay values of the employees.

Having the numbers and the data bars in the same cell sometimes makes the
numbers difficult to read. To have only the data bars show in column J do the
following:

5.

Select the range J9:J28 again. On the Home tab, in the Styles group, click
Conditional Formatting, Manage Rules.

Double-click the Data Bar rule to open its dialog box.

Under Edit the Rule Description, click the box next to Show Bar Only.

Edit the Rule Description:

Format all cells based on their values:

Format Style:  Data Bar v iShow Bar Only
Under Bar Appearance, choose Solid
Border and black for the Color. Total Pay Total Pay
$126.00 |
Click OK. Then, click OK again. Now, the $140.00 |
Total Pay numbers are in column | and $165.00 |
the Data Bars are in column J. 30200 [ ]

j. In order to make some formulas easier to read and understand, Excel allows
users to create what are called named ranges. To see how helpful this can be,
do the following:

1.

Select cells D9:D28. In the name box, type Sex. mex X vk |

Tap Enter. Now, anytime you want to use that range in a formula, you can
use its name rather than the cell references.

Names must begin with a letter. They cannot contain spaces but can
contain the underscore.

In the same way, create the following named ranges:

E9:E28 PayRate
F9:F28 TotalHours
H9:H28 OvertimePay
19:128  TotalPay
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3. To see alist of your named ranges, on the Formulas tab, in the Defined
Names group, click Name Manager.

Mac: Formulas, Defined Names, Define Name arrow, Define Name...

Mame Manager

Mew... Edit... Delete
Mame Value Refers To Scope
278 OvertimePay {"$0.00""$75.00":"$0.0... ='Payroll Data'l$H$2:%...
@PayRa‘ce {"g""g" 4" 34 .. ='Payroll Data''$E§3:%... Workbook
@Sex PRSI L, ='Payroll Data'l $D$9:5..  Workbook
@TotalHours 21"rs0n35" 50" 2., ='Payroll Data"! $F$9:5... Workbook
@Totalpay {"$126.00""$275.00""... ='Payroll Data" $139:51.. Workbook

If you want to change a name, select it and click Edit.
If you want to delete a name, select it and click Delete.

Mac: To delete a name, select it and click the minus sign inside a box.| -

4. Click Close. You can also see your named ranges by clicking the arrow in
the name box.

Al
OvertimePay
PayRate

Sex
TotalHours
TotalPay

Selecting a name will select the cells in that range.

k. In J3, insert a function that will display the number of people who earned
overtime pay. Since you are looking for a number of things, use COUNTIF.
The form for COUNTIF is =COUNTIF(range, criteria) The range is “where to
look” and the criteria is “what to look for”. Be sure to put the criteria inside
quotation marks: You can write the formula in two different ways:

=COUNTIF(H9:H28,">0") Uses cell references
=COUNTIF(OvertimePay,">0") Uses the named range for Overtime Pay.

As you can see, using a named range makes the formula easier to read and
understand.

l. In J4, insert a function that will display the number of women who earned
overtime pay. To count cells based on multiple criteria (here, sex and overtime
pay), use the COUNTIFS function. It has the form:
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where to look where to look
—_— what to look for —_— what to look for
criteria1 — criteria 2 —"
=COUNTIFS( y criteria1 y criteria2 |,...)
range N range —
R e — Women R e — over 40
range that range that
has sex has hours

It is basically the COUNTIF function with two or more ranges and corresponding
criteria (hence the S in COUNTIFS). Again, remember to put the criteria inside
quotation marks, as in "=F".%3

In J5, insert a SUMIFS function that will display the sum of the Total Pay for

people who worked overtime. Remember, the form for SUMIFS is
SUMIFS(sum_range, criteria_range1, criteria1, ...) Here, there is only 1
criterion. Be sure to put the criteria inside quotation marks. 14

n. In J6, insert a function that will display the total hours for men whose pay rate is
under 5 dollars. To sum cells based on multiple criteria (here, sex and pay rate),
use the SUMIFS function again. It has the form:

where to look where to look
what to sum —_— what to look for ———~—  what to look for
—— criteria1 — criteria 2 —
=SUMIFS(sum range , y criteria1 |, y criteria2
—_— range —_— range —_—
total hours —_— Men —_— under 5
range that range that
has sex has pay rate

sum range: Which cells do you want to sum? Total Hours (F9:F28).

Whose Total Hours do you want to include?
Those of Men, so use the Sex in D9:D28

What should the Sex be? M, so use "=M"

What kind of men do you want to include?
Those who have a certain Pay Rate, which is in E9:E28

What should the Pay Rate be? Under 5, so use "<5" 15

criteria 1 range:

criteria 1:
criteria 2 range:

criteria 2:

0. Create a conditional format so that the data of the people who worked overtime
has Bold Red text and a Yellow cell fill by doing the following:

1. You want to apply the formatting to the data, so select A9:K28.

2. Onthe Home tab, in the Styles group, click Conditional Formatting and
select Manage Rules.

3. Click | & newRuk... |

in lower left corner. From Style select Classic.

Mac: Click the plus sign inside a box| +

4. Click the last bullet, Use a formula...

13 =COUNTIFS(D9:D28,"=F",F9:F28,">40") or =COUNTIFS(Sex,"=F",TotalHours,">40")
14 =SUMIFS(19:128,H9:H28,">0") or =SUMIFS(TotalPay,OvertimePay,">0")
15 =SUMIFS(F9:F28,D09:D28,"M" ,E9:E28,"<5") or =SUMIFS(TotalHours,Sex,"=M" ,PayRate,"<5")
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5. Type this into the formula box: =$f9>40 This says to see if the value in F9
(Total Hours for Anderson) is greater than 40. If it is, apply a special
format to the selected cells (A9:K28); otherwise, leave the cells alone.

6. Click Format. Set the font to Bold Red and the fill to Yellow.
7. Click OK twice.

Rule (applied in order shown) Format Applies to

Formula: =§F9>40 AaBchYyZz =$A$9:5K$28

Notice that the formula =F9>40 looks like it will only evaluate Anderson's
pay. However, under Applies to the range for this conditional format is
$AS$9:$K$28 so Excel will use =F10>40 for Bastian-Smith, and =F11>40
for Bell, and so on. That is because you selected $A$9:$K$28 before you
created the conditional format.

8. Click OK to return to edit mode. The format is applied to the data of the
seven people who have worked overtime (this matches the value in J3).

p. Excel stores dates and times as whole numbers representing the number of
days since 1900-Jan-0, plus a fractional portion of a 24-hour day. This is called
a serial date, or serial date-time. For example, 18 June 2021 at 8:35 am is
stored as 44365.3576388889.

Be careful if you switch between Windows and Mac because, for historical
reasons, older Macs use 1904 for its starting year rather than 1900. If you
change the date system for a workbook that already contains dates, the dates
will shift by four years and one day (1462 days taking Leap Years into account).
So, if you switch from one computer to another be sure to check that the dates
are correct.

In Windows, if you want to change your dates to the 1904 version use File,
Options, Advanced, When calculating this workbook and check the box
next to Use 1904 date system. This is NOT recommended. 6

Mac: Excel menu, Preferences, Formulas and Lists, Calculation.

Enter the date and time and apply custom formatting by doing the following:

1. Click B3 and enter the current date. You can either type the date or tap
Ctrl +; (that is, hold down the Ctrl key and tap the semicolon key) and
then tap Enter. This is a static date, which means that it will stay at that
value until you enter in a new one.

2. Click B4 and enter the current time. You can either type the time or tap
Shift + Ctrl + : (that is, hold down both the Shift key and the Ctrl key and
tap the colon key) and then tap Enter. This is a static time, which means
that it will stay at that value until you type in a new one.

16 For more information see https://support.microsoft.com/en-us/help/214330/differences-between-
the-1900-and-the-1904-date-system-in-excel
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3. Click B5, type =now/() and tap Enter. Note the parentheses () with nothing
inside them! This enters the current date and time and it will automatically
change each time Excel recalculates any formula. Excel also has a DATE
function, but that does not display the date! DATE displays a number that
Excel uses to internally keep track of time. It is not very useful unless you
are a programmer.

4. Click B6, type =now() and tap Enter again. You get the same result as in B5.

5. Select cells B3 and B5. To select non-adjacent cells, click the first cell,
then hold down the Ctrl key and click the second cell. With the two cells
selected, right-click, and select Format Cells.

6. Click the Number tab and click Custom. 1/

7. Replace the text in the Type: box with ddd d mmm yyyy. This tells
Excel to display the date using the day of the week (ddd), the date (d),
the month (mmm), and the four-digit year (yyyy).

8. Click OK. If you see ####### in the cell it means the column is too narrow.
Make the column wider if necessary.

9. Select cells B4 and B6 and follow the same procedure except replace the
text in the Type: box with h:mm am/pm and tap Enter. The h tells Excel to
display the hour, mm tells Excel to display the minutes, and am/pm tells
Excel to display either AM or PM, depending on whether the current time is
before noon or after noon. Notice that the times in
the two cells are different. Cell B4 displays the time
when you tapped Shift + Ctrl + : while B6 displays
the current time (it was just updated when you
tapped Enter).

10. Select A3:B6. Place a heavy border -
around the outside and a light border

3

between the rows. 4

5

Date Modified: Fri 18 Jun 2021
Time Modified: 2:01 PM

Current Date: Fri 18 Jun 2021
S8 Current Time: 6:08 PM

11. Now, create some other custom formats.
Click J3, right-click, and select Format
Cells. On the Number tab, click Custom. Replace the text in the Type:
box with #* people" )

# tells Excel to display the number without decimal places,
" people" says to display the word people,

_) says to leave one blank space on the right (so this will line up nicely
with the accounting format that will be in J5).

Click OK.

12. Click J4 and follow the same procedure except replace the text in the
Type: box with #* women"_)

17 For more information on custom formatting, see https://www.youtube.com/watch?v=tGY70sdpalc
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13. Click J5, right-click, and select Format Cells. On the Number tab, click
Accounting. Be sure two decimal places and the $ show. Click OK.

For historical reasons, the Accounting style places the $ on the left edge
of the cell whereas the Currency style places it against the number. Also,
the Accounting style places a blank space to the right of the number.

Accounting: | $ 1,697.50 |  Currency:| $1,5697.50|

14. Click J6 and follow the same procedure except replace the text in the
Type: box with #" hours"_)

£l Date Modified: Fri 18 Jun 2021 Number of people who earned overtime pay = 7 people
L3 Time Modified: 2:01 PM Number of women who earned overtime pay = 6
f:l Current Date: Fri 18 Jun 2021 Sum of Total Pay for people who worked overtime = $ 1,597.50
Gl Current Time: 2:22 PM Total hours for men whose pay rate is under $5 = | 130 hours

g. Excel allows you to change the font characteristics of text within a cell. Try this:
1. Double-click Al to enter edit mode.

2. Select the four letters roll in the word Payroll.

3. On the Home tab, in the Font group, click the launch dialog button |«
(lower right corner of the Font group).

Mac: Tap Command + 1 to open Format Cells, Font.

4. Put a check in the box next to Subscript,
make the color red, and the font Arial Black.

5. Click OK and then tap Enter.

r. Follow a similar procedure make the following changes:
In 13, make the word people bold and purple.
In 14, make the word women bold and red.
In 16, make the word men bold and blue.

s. Note that the time in B4 is the same as it was when you tapped Shift + Ctrl +:
but the time in B6 is the current time because you just made a change to 16 and
so Excel did a recalculation of all cells. If you open this file tomorrow, the date
in B3 will be today’s but the date in B5 will be tomorrow’s.

t. Set it up the Payroll Data worksheet to print in Landscape orientation, all on one
page, centered horizontally but not vertically, and include a footer that contains
the file name on the left and the sheet name on the right. Compare the preview
with the key. Make needed corrections, save the workbook and close it.
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Step 4 Submit Now, do the following to create your pdf files. Each file should
contain only one worksheet on a single page. Do NOT submit
multiple worksheets or pages in a single pdf. Check the key on
page SG386.

Use these names for the pdf files:

HWO03-1 HWID 2A Tree Inventory Done

HWO03-2 HWID 2B Weekly Sales Done (Summary) — This is the Summary worksheet
HWO03-2 HWID 2B Weekly Sales Done (Bonus) — This is the Bonus worksheet
HWO03-3 HWID 2G Inventory Done (Bulbs) — This is the Bulbs worksheet

HWO03-3 HWID 2G Inventory Done (Summary) — This is the Summary worksheet
HWO03-4 HWID Payroll IF Done

Create a pdf file of the output for each of the above, place them in a folder
called HWO03 HWID LastName, FirstName, zip the folder and, by the due date,
submit it to the Canvas folder HWO03 Excel Chapter 2: Functions, Tables, and
Large Workbooks.

Step 5 Backup Now would be a good time to backup your files.



Project 4
Excel Chapter 3: Analyzing Data with Charts and

What-If Tools

Step 1 Read Read the introductory material on page 459 in the textbook.

Step 2 Activities Turn on the computer and do the following:

Project 3A: Start at the top of page 461.

Instead of Activity 3.01 step 1 do the following:

1.

Navigate to your Excel Files folder and open eO3A_Enterprise_Fund,
which is one of the files you downloaded at the start of the term.

Save the file in your Excel Files folder using the name
Lastname_Firstname_3A_Enterprise_Fund

Complete the rest of the Activities through step 8 on page 473. Do NOT do
steps 9 and 10 in Activity 3.11 on page 473.

Return here when you have completed Project 3A on page 473.

|‘ Do NOT do GO! With Google Sheets

Project 3B: When you have completed Project 3A, start at the top of page 476.

Instead of Activity 3.13 step 1 do the following:

1.

Navigate to your Excel Files folder and open e03B_Tourism, which is one
of the files you downloaded at the start of the term.

Save the file in your Excel Files folder using the name
Lastname_Firstname_3B_Tourism.

Complete the rest of the Activities through step 10 on page 494. Do NOT
do steps 11 and 12 in Activity 3.22 on page 494.

Return here when you have completed Project 3B on page 494.

|‘ Do NOT do GO! With Google Sheets or GO! To Work

Step 3 Homework After you have completed Projects A and B return here, do
the following additional activities, and turn them in for grading.

— SG73 —
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HWO04-1 Enterprise Fund (Based on Project 3A)

Problem: How can you visually display the relationship between expenditures for
an enterprise?

a. Open the workbook Lastname_Firstname_3A_ Enterprise_Fund, which you
created while following the directions in the textbook and saved on page 473.

b. Save the workbook to the Excel Files folder using the name
HWO04-1 HWID 3A Enterprise Fund Done

c. Set up the Expenditures Chart to print in Landscape orientation and include a
footer that contains the file name on the left and the sheet name on the right.
Compare the preview with the key. Make needed corrections, save the
workbook and close it.

HWO04-2 Tourism Spending Projection (Based on Project 3B)

Problem: How can you make data-based predictions concerning tourism at a
resort?

a. Open the workbook Lastname_Firstname_3B_Tourism, which you created
while following the directions in the text and saved on page 494.

b. Save the workbook to the Excel Files folder using the name
HWO04-2 HWID 3B Tourism Done

c. Click the Expenditures tab. The background picture makes the chart more
interesting and visually pleasing, but it may detract from clearly seeing the data.
That is a problem with being cute; it sometimes makes it more difficult to see
that which is important. Adjust the transparency of the chart by doing the
following:

1. Click anywhere in the chart.

2. On the Chart Format tab, in the Current Selection group, click the arrow
and select Chart Area.

3. Click Format Selection to open the Format Chart Area pane.

Mac: On the Format tab, in the Format group, click Format Pane. If you have a

small screen, you may have to click the double chevron |chart Design > O Tell m

to the right of the Chart Design tab to see the

Format tab. Click Format Pane.

4. Click the paint bucket to show the Fill & Line choices.
5. Click the Fill arrow to show its options.

6. Make the Transparency 30%. Now you can better see the information
on the chart. You still can see the picture, but it is not so overpowering.
Depending your printer, the transparency may not work correctly. If it
does not, don’t worry about it.
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d. On the Expenditures worksheet, click cell Al to be sure the chart is not
selected. Set up the worksheet to print in Portrait, all on one page, centered
horizontally but not vertically and include a footer that contains the file name
on the left and the sheet name on the right. Compare the preview with the key.
Make needed corrections, save the workbook, but do NOT close it.

e. On the Advertising worksheet, click cell Al to be sure no chart is not selected.
Set up the worksheet to print in Portrait orientation, all on one page, centered
horizontally but not vertically, and include a footer that contains the file name
on the left and the sheet name on the right. Compare the preview with the key.
Make needed corrections, save the workbook, and close it.

HWO04-3 HLOOKUP Gradebook

Problem: Given the total points earned by students in a course, how can you
assign the corresponding letter grades?

a. Open the workbook HW04-3 HLOOKUP Gradebook Original, which is one of
the files you downloaded at the start of the term.

b. Save the workbook to your Excel Files folder using the name
HWO04-3 HWID HLOOKUP Gradebook Done.

At the end of each semester, | assign letter grades based on the total number
of points students earned on homework and exams. Here is the table | use:

5 Total Points. [} 65 68 70 73 7 | 80 82 8 20 95
| Comment  Ouch! | Studylots! | Study! Fair Ok Not bad Fine Good | Pretty good | Very good | Great!

7 Grade F D D+ C- c | o+ s | B | B+ A- A

To assign a specific letter grade, | have Excel “look up” the total points in the
above table and then display the corresponding letter grade. For this, | use one
of Excel'’s LOOKUP functions.

The above table is horizontal, so | use the HLOOKUP function. If the table were
vertical, | would use VLOOKUP (see page SG81). The HLOOKUP function has
the following form:

need exact or
what to look for where to look row to display approximate match?

=HLOOKUP( lookup value , table array , row index num , range lookup )

total points range with number of row approximate
total points with letter grades match
and grades

* lookup value is the value to be found in the first row of the table. It can be a
value, a reference, or a text string. In this example it is the Total Points
earned. For example, Aanon’s total points is located in J12.

» table array is the range where the lookup value is to be looked up.
In this case, it is C5:M7.
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* row index number is the number of the row in the table | want displayed. In
this example, it is row 3. Note that this is NOT the worksheet row number,
which is 7. It is the row number within the range C5:M7.

* range lookup is an optional parameter that is either TRUE or FALSE.
It specifies whether you want Excel to find an exact (FALSE) match or an
approximate match (TRUE).

If you type TRUE or omit this parameter, then the values in the first row of the
table must be placed in ascending sort order. In that case, Excel will find an
approximate match. For example, if the lookup value (total points) is 79,
Excel will scan the first row of the table for 79. Since 79 is not listed, Excel will
use the next lowest number in the table (76) and display the corresponding
letter grade (C+). If the lookup value were 80, Excel would display B-.

If you type FALSE, then the values in the first row of the table may be in any
order. In that case, Excel will look for an exact match. If no exact match exists
Excel will display #N/A. In this example, Aaron’s total of 79 is not in the table so
Excel would display the error message.

1. Click K12 and type =hlookup(

A ScreenTip will appear to remind you of the form of the function.

Total Grade Comment
79 _\_| =hlookup(

HLOOKUP(lookup_value, table_array, row_index_num, [range_lookup])

2. Finish by typing j12,$c$5:$m$7,3)

Your complete formula should be =hlookup(j12,$c$5:$m$7,3) Note the
absolute references (the dollar signs) in $c$5:$m$7. You need the dollar
signs so that when you copy the formula for the other students the location
of the table will remain constant.

3. Click the Enter checkbox. The grade C+ appears in K12 and the formula
appears in the Formula Bar.

K12 - < v £ | =HLOOKUP(J12,3C$5:$MS$7,3)

1

2 Course: Math1051 | Cutoff on Diagnostic Test -> 65 |

3 Instructor: Robertson Cutoff on Total Points Earned -> 65

4 Num Stu with Diag Below Cutoff and Total At Least Cutoff ->

5 Total Points, 0 65 | 68 70 | 73 76 | 80 82 | 86 | 90 95

6 Comment  Ouch! | Study lots! Study! | Fair Ok _Not bad Fine . Good Pretty good | Very goggl |  Great!
7 Grade| F D i D+ C- | C C+ | B- B | B+ | A- A

8 Num Stu | |

]

10 Using HLOOKUP XLOOKUP
11 [Name Attend HW Diagnostic Ex1 Ex2 Ex3 Final Ex Total Grade | Commenft | Comment
12 |,Aan,°n»Na,ta|,ie, .80 80 99 | 56 94 14 T4 79 C+ I

c. To make the worksheet easier to work with, split the screen by doing the
following:

1. Select row 17 (click the 17 row number).

2. Onthe View tab, in the Window group, click Split. This splits the screen
into two parts. The top shows rows 1 through 16. The bottom shows the
rest of the rows.
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3. Click B17. Tap Ctrl + Down Arrow. This will move the active cell to the last
non-blank cell in column B (Williams in B121). This same technique works
moving to the last non-blank cell on the right (Ctrl + Right Arrow) or on the
left (Ctrl + Left Arrow).

d. Finish displaying the grades by doing the following:
1. Fill the formula in K12 down to K121, preserving the format.

2. Select K12:K121, right-click and select Format Cells. Click the Alignment
tab. Under Horizontal, select Left (Indent) and in the Indent box enter 3.

Number Allgn ment Font Bords

Text alignment

Horizontal:
Left (Indent) ~ | Indent;
Vertical: 3 =

Click OK. The effect is to line up the letters on the left and center the grade
in each cell.

e. For cell L12, create an HLOOKUP formula that will display the appropriate
comment from the table in cells C5:M7. The comment should be based on the
Total in column J. It will look very similar to the formulas in column K. In fact,
the only difference will be that the row index number will be 2 rather than 3.
Then, fill the formula down to cell L121, preserving the format.

f. Microsoft has introduced a new function called XLOOKUP that is designed to
replace HLOOKUP, VLOOKUP, and LOOKUP. Unfortunately, older versions of
Excel do not have this function. That is why | used the HLOOKUP function
above.

If your version of Excel has XLOOKUP, then do the following;
otherwise skip this part, f, and leave M12:M121 blank.

The XLOOKUP function has the following form:
=XLOOKUP(lookup_value, lookup_array, return_array, [if _not_found],
[match _mode], [search_mode])

* lookup value is the value to search for. In this example it is the Total Points
earned. For example, Aanon’s total points is located in J12.

» lookup array is the range where the lookup value is to be found. In this
case, it is the total points in C5:M7.

« return array is the range that contains the values you want to return. In this
case it is the comment in C6:M6.

The following three parameters are enclosed in square brackets, which means
they are optional:
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» [if not found] is what to display if the lookup value is not found. If it is not
included and the lookup value is not found the #N/A error is displayed.

+ [match mode] specifies how to do the match. It can have one of four values:

0 means Excel will look for an exact match. This is the default.

-1 means if there is no exact match; Excel will return the next smaller item.

1 means if there is no exact match; Excel will return the next larger item.

2 means the lookup value contains the *, ?, or ~ wildcard. See page SG134
for an example that uses wildcards.

+ [search mode] specifies how to do the match.
1 means to start the search at the first item. This is the default.
-1 means to do a reverse search starting at the last item.

So, the formula should look like this:

what where what text to display exact or
to look for to look to display if not found approximate
match? order
looku looku return range
=XLOOKUP( P P, ’ 9 » 001,1,2 , 1,1 )
value array array lookup S —_
—_— —_— return next start at
total points range with range with Not found smaller item firstitem
J12 total points letter grades -1 1

$CH5:5M$5 $C$6:5MS$6
Two of the last three parameters are optional. If you leave them off the default
values will be used. So, both of these formulas work:
=XLOOKUP(J12,$C$5:$M$5,$C$6:$M$6,"Not found",-1,1)
=XLOOKUP(J12,$C$5:3M$5,$C$6:$M$6,,-1)

Enter either formula and then fill down, preserving the format. The text in
column M should match the text in column L.

g. In C8, enter a formula that will display the number of students that earned the
grade in C7. Give it a try. You want to count the number of students who
earned the grade so you will use COUNTIF, which has the form:

where to look what to look for

—_——
=COUNTIF(criteriarange, criteria )
—
range that grade in C7

has grades

The criteria (letter grades) are located in row 7 so use a cell reference rather
than typing the criteria inside quotation marks. Be sure to use absolute
referencing where appropriate so you can duplicate the formula in D8:M8.18

Fill the C8 formula to M8.

18 =COUNTIF($K$12:$K$121,C7)
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h. At the start of my precalculus course, students take a diagnostic pretest to see
if they have the necessary high school algebra background. | want to know how
many students who scored below a certain cutoff on the diagnostic test also
scored above a certain cutoff in their final total points. In other words, | want to
know how badly a student can do on the pretest and still pass the course.

To do this, create a formula for J4 that will display the number of students with
diagnostic test scores below the diagnostic test cutoff score in J2 AND above
the total points cutoff score in J3.

You want to count the number of students who meet two criteria at the same
time so use the COUNTIFS function, which has the form:

where to look where to look

what to look for ———— what to look for

criteria1 criteria 2 —
=COUNTIFS( , criteria1 y y criteria2 )
range —_— range —_—
under diag test —_— over total pts
range that has cutoff score range that cutoff score
diag test scores inJ2 has total pts inJ3

criteria 1 range is the location of the diagnostic test scores, E12:E121
criteria 1 is under the value in J2

criteria 2 range is the location of the total points, J12:J121
criteria 2 is at least the value in J3

To use > or < with cell references for criteria you must put > or < inside quotation
marks and you must put an ampersand & to the left of the cell reference. Here is
the formula:

where to look what to look for| |(where tolook what to look for

=COUNTIFS( E12:E121 , "<"&J2 |,| J12:9121 , ">="8J3 |

range that has under diag test range that over total pts
diag test scores cutoff score has total pts cutoff score
inJ2 inJ3

=COUNTIFS(E12:E121,"<"&J2,J12:J121,">="&J3)

Cutoff on Diagnostic Test -> 65
Cutoff on Total Points Earned -> 65
Num Stu with Diag Below Cutoff and Total At Least Cutoff ->| 1

You can see that out of 110 students only 1 who scored under 65 on the
diagnostic test was able to earn at least 65 for a total and pass the course. | have
to make a decision: Should | force students who score under 65 on the test to
drop to a lower course or should | only suggest that they do it, knowing that not
dropping would almost certainly be a time-wasting and money-wasting mistake.
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On the Excel exam, | will not ask you to do something this complicated. | show it
here so you can see what Excel is capable of doing and maybe use it on the job.

I. Use Conditional Formatting to identify which students failed the diagnostic
test and still passed the course:

1. Select B12:B121 because that is where you want the formatting to display.

2. On the Home tab, in the Styles group, click Conditional Formatting, and
select New Rule.

Mac: From Style: select Classic.

3. Select Use a formula to determine which cells to format.

4. Because two criteria must be met, use the Boolean operator AND.
This returns true if BOTH criteria are met. In the Formula box, type
=and($e12<$j$2,$j12>=$j$3)

5. Click Format, Fill, and select purple. Click OK two times.

6. Select E12:E121 and repeat the process. You can save typing by copying
the formula you just entered and pasting it into the new Formula box.

7. Select J12:J121 and repeat the process.

8. Scroll down and you can see that Beth Earlywine just missed the
diagnostic cutoff by one point.

71 |Earlywine, Beth 73 100 | 64 | 63 73 62 62 68 | D+

Looking at this result, should | change the cutoff or is it working OK?

j. Remove the split screen (View, Split). Set the print area to A1:M21 (select
A1:M21, Page Layout, Print Area, Set Print Area).

Set up the Gradebook worksheet to print in Landscape orientation, all on one
page, centered horizontally but not vertically, and include a footer that
contains the file name on the left and the sheet name on the right. Compare
the preview with the key. Make needed corrections, save the workbook, and
close it.

HWO04-4 VLOOKUP Shipping

Problem: Given the item number or the weight of a product, how can you look up
the corresponding shipping cost?

The VLOOKUP function works the same way as the HLOOKUP function except the
table array is a vertical table rather than a horizontal table.

a. Open the workbook HW04-4 VLOOKUP Shipping Original, which is one of the
files you downloaded at the start of the term.

b. Save the workbook to your Excel Files folder using the name
HWO04-4 HWID VLOOKUP Shipping Done
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c. For cells D11:D70, you want Excel to display the Shipping Cost for each Item
Number. The cost depends on the weight of the item. To do the calculation, you
can use the VLOOKUP function. It has the same form as HLOOKUP except H
is replaced by V and row is replaced by column.

need exact or

what to look for where to look column to display approximate match?
=VLOOKUP( lookup value , table array , columnindex num , range lookup
weight range with number of column approximate
weights and that has shipping costs match

shipping costs

1. Click D11 and type =vlookup( and a screen tip will appear:

|:vlookup{ |

WLOOKU |:'I:|IDD|(I.J p_value, table_array, col_index_num, [range_lookup])

* lookup_value is what you want to find, which is the weight.
Type cl1, (be sure to type the comma).

» table_array is the vertical range where you want to look. It is the range
that contains the Weights and Shipping costs.

Type h11:i20, (be sure to type the comma).

* col_index_num is the number of the column in the table whose value
you want displayed.

Column H, which is Column 1 in the table, contains the Weights.

Column I, which is Column 2 in the table, contains the corresponding
Shipping costs. This is what you want to display.

Type 2, (be sure to type the comma). When you type the comma after 2
a screen tip provides the definition of TRUE and FALSE for the
[range_lookup].

=vlookup(c11,h11:120,2,

VLOOKUP{lookup_value, table_arcg ol indey nyo [rang
1 TRUE - Approximate match
(...)FALSE - Exact match

» [range_lookup] tells Excel if you want an exact match or an
approximate match.

FALSE says to look for an exact match. If there is no exact match the
error message #N/A will be displayed. This is not what you want
because the weights in column C are in tenths of a pound and the
weights in column H are in whole pounds.

TRUE says that data in the first column of table_array (column H) are in
ascending order, which they are, and you want either an exact
match or an approximate match. If an exact match is found, great; if
not then Excel settles for the next lowest value. The weightin C11 is
7.5 so Excel would choose the Shipping Cost for 7.0 (the next value
below 7.5). This is what you want.

)
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Type true) The formula is =vlookup(c11,h11:i20,2) Because TRUE is the
default value, it may not appear in the formula.

Click the Enter checkbox. The cost is $30.60.

2. You are going to fill this formula down to row 70 so you must figure out if
you need absolute referencing (the $) and, if so, where to put them.

Put the $ in the proper places, click the Enter checkbox, and then fill the
D11 formula down to D70, preserving the formatting. If you get an #N/A
error then go back and check your $. The range H11:120 must be the same
for all rows so that needs the $.

D11 ¥ > v f | =VLOOKUP(C11,5H$11:$1$20,2, TRUE)
. B D
9 VLOOKUP XLOOKUP : Round up
0 Item Number Weight (Ibs) Cost Cost Cost
44537 7.5 $30.60 If you do If you do

For this example, if a weight is between two whole numbers, then the
Shipping Cost for the lower weight is used. Thus, a weight of 7.9 would
use the Shipping Cost for 7.0. However, the shipper might want to charge
the higher weight in order to fully cover the cost of shipping. To do that, you
need to use XLOOKUP, which you will do in the next section.

d. Use XLOOKUP instead of VLOOKUP to find the Shipping Costs.

If your version of Excel does not have XLOOKUP then skip to part
f on the next page and leave E11:F70 blank. Otherwise, construct
an XLOOKUP function to calculate the shipping cost in E11.

1. Construct your formula:

what where what text to display exact or
to look for to look to display if not found approximate
match? order
looku looku return range
=XLOOKUP( P P , %€ 01,12 , 1,1 )
value array array lookup — —_
— — — — approx match start at
Weight range with range with Not found return next firstitem
c11 weights shipping costs smaller item 1
$SH$11:5H$20 $I1$11:51520 -1

2. Enter the formula in E11. Remember, as you type Excel will show a screen
tip to remind you of the values of the match_mode and the search_mode.
For example,

=XLOOKUP(C11,$H$11:$H$20,51$11:$1$20,"Not found",)

XLOOKUP({lookup_value, lookup_array, return_array, [if not_found], [match mad
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3. Fill down to E70, preserving the format. The costs in columns D and E
should match.

e. In F11:F70, use XLOOKUP to find the shipping costs but this time return the next
larger cost. The only difference between this formula and the previous one is
that the match_mode should be 1 rather than -1.

Enter your formula and then fill down, preserving the format. Notice F12 shows
Not found. That is because the weight, 9.9 Ibs, is higher than the highest entry in
the Weight/Cost Table and so Excel cannot return the next larger cost because
there is none. The shipper will have to make some adjustments to fix this
problem.

f. Enter a function in E5 that will display the Item Number of the item with the
highest weight and also some explanatory text so it looks like this:

' 4 E | F 6 H [ 1 |J
Weight and ltem Number
- Highest weight is for item number 80680

<- Use VLOOKUP |

The MAX function can be used to find the highest weight in C11:C70. To find
the Item Number you can use the VLOOKUP function. Unfortunately, Item
Number is to the left of Weight in the table in columns B:D, so VLOOKUP
cannot be used directly. To get around this, create a “scratch area” that has
Shipping Cost but where Weight is to the left of tem Number. Do the
following:

1. In K11, type =c11,in L11, type =b11 and in M11 type =d11

2. Fill the formulas in K11:M11 down to K70:M70 and preserve the format.
This creates a new table that has Shipping Costs but where the Weight is
to the left of the Item Number. Compare this with columns B:D

A__B . ¢ | D ¢} K L | M |

VLOOKUP Scratch Area
Item Number Weight (Ibs) Cost Weight Item Number  Shipping Cost
44537 7.5 $30.60 7.5 44537 $30.60
80680 9.9 $33.00 9.9 80680 $33.00
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3. In E5, enter a VLOOKUP function that will display the Item Number of the

item with the highest Weight. Here is the structure:

what to look for where to look column to display

need exact or
approximate match?

=VLOOKUP( lookup value , table array , column index num ,

highest weight range with number of column
weights and that has item numbers
item numbers

range lookup

exact match

* lookup value is the highest Weight in K11:K70. Use MAX(k11:k70)

+ table array is the range that contains Weights and Item Numbers in

the scratch area.

* column index num is the number of the column in the table whose

value you want displayed.

Column K, which is column 1 in the table, contains Weights

Column L, which is column 2 in the table, contains Item Numbers

* range lookup is TRUE or FALSE. Make your choice by noting that the
Weights are not in ascending sort order and you want an exact match.

TRUE for approximate match
FALSE for exact match

4. Enter your formula:

E5 - X « fo | =vlookup(max(k11:k70),

Weight and Item Number

K11:L70,2,false)

=vlookup(max(k11:k70),K11:L70,2,false) <- Use VLOOKUP |

Click the Enter checkbox and 80680 will be displayed.

5. Now, use the Ampersand, &, to display the following text to the left of 80680:

Highest weight is for item number

When you tap Enter you may see ####H#H#H###, which indicates the value to
display will not fit entirely in E5. To fix that, select E5:H5 and, on the Home
tab, in the Alignment group, click Merge & Center, and then click the

Align Left button.

ES i »x « Jf | ="Highest weight is for item number "&VLOOKUP(MAX(K11:K70),K11:L70,2,FALSE)

“8 Weight and Item Number
Highest weight is for item number 80680 <- Use VLOOKUP |

g. If your version of Excel has XLOOKUP, enter in E6 the formula to display the
item number of the highest weight. With XLOOKUP, you do not need the
Scratch Area because XLOOKUP can look either left or right. *°

19 ="Highest weight is for item number "& XLOOKUP(MAX(C11:C70),C11:C70,B11:B70,"Not

found",0,1)

)
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h. Enter a formula in C7 that will display the Shipping Cost for an item whose
Item Number is entered in B7. You want to find (lookup) a number in a vertical
list, so VLOOKUP is a good choice. Excel does have a FIND function but that
does not “find” items in a list, so do not use that. Do the following:

1. Enter 43913 in B7. This is the ltem Number whose Shipping Cost you seek.

2. In C7, enter a formula that will display the Shipping Cost for the item
whose Item Number is in B7.

need exact or
what to look for where to look column to display approximate match?

=VLOOKUP( lookup value , table array , columnindex num, range lookup )

item number range with number of column exact match
item nums and with shipping costs
shipping costs

* lookup value is the Item Number in B7.

+ table array is the range that contains Item Numbers and Shipping
Costs. This is B11:D70.

e column index num is the number of the column in the table whose
value you want displayed.

Column B, which is Column 1 in the table, contains Item Numbers
Column C, which is Column 2 in the table, contains Weights
Column D, which is Column 3 in the table, contains Shipping Costs

* range lookup is TRUE or FALSE. The Item Numbers are not in
ascending sort order and you want an exact match.

TRUE for approximate match
FALSE for exact match

Since this formula will not be filled to other cells, you do not need the
absolute referencing $.

1 Shipping Cost Calculations

3 Calculate Shipping Cost
4 Given Iltem Number Weight and Item Number
5 Choose Shipping Highest weight is for item n|

6
7

ltem Number Cost Highest weight is for item n
43913 $31.80
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Here is the XLOOKUP formula; 20

what where what text to display exact or
to look for to look to display if not found approximate
match? order
looku looku return range
=XLOOKUP( P P , 9 0112 , 1,1 )
value array array lookup — —_
— — — S — exact match start at
Item Num range with range with Not found return next firstitem
B7 item nums ship costs smaller item 1
B11:B70 D11:D70 -1

j. Misspelled words can be embarrassing. ?* For example, a news headline read
“Floods from the Mississippi may be prevented by putting big dames in the
river.” Here is a road sign from South Bend Indiana:

- best
pubic schogls.

When you misspell a word in an email or letter the reader often can figure out
what you are trying to say from the context. Try reading this:

| cdnuolt blveiee taht | cluod aulaclty uesdnatnrd
waht | was rdanieg. The phaonmneal pweor of
the hmuan mnid. Aoccdrnig to rscheearch it
deosn't mttaer in waht oredr the Itteers in a wrod
are, the olny iprmoatnt tihng is taht the frist and
Isat Itteer be in the rghit pclae. The rset can be
a taotl mses and you can sitll raed it.

Just about every word is misspelled, but your amazing brain is able to fill in
what it needs to make sense of this from the context and your facility with
English.

However, if you enter a wrong number in Excel the user probably will not be
able to tell if it is wrong by looking at the context, and any analysis which uses
that number will be wrong. While you cannot completely prevent data entry
errors, Excel allows you to check some of the characteristics of data you enter
through its Data Validation feature. To see how this works, do the following:

20 =XLOOKUP(B7,B11:B70,D11:D70,"Not found",-1,1)
21 Adapted from http://www.dummies.com/how-to/content/limit-data-entry-with-data-validation-in-
excel-201.html



http://www.dummies.com/how-to/content/limit-data-entry-with-data-validation-in-excel-201.html
http://www.dummies.com/how-to/content/limit-data-entry-with-data-validation-in-excel-201.html
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1. Click B7, and then, on the Data tab, in the Data Tools group, click the
Data Validation arrow and select Data Validation. There are a lot of
choices that you can explore on your own.

2. Click the Settings tab and select List from the Allow menu.

3. For this project, ltem Number must be one of the Settings | Input
numbers in the range B11:B70. So, in the Source box, |
type the range where the Item Numbers are listed. Validation criteria
That is type =$b$11:$b$70 (or select that range with Allow:
your mouse). -
List
4. Click the Input Message tab and in the Input message Data:

box type Select or type item number. |
Detween

Data Validation
Source:

Settings Input Message  Error Alert =$B$11:5B570

Show input message when cell is selected

When cell is selected, show this input message:

Title:

Input message:

Select or type item number.

Now, when you click B7 the message will appear to remind you of what
type of data goes in B7.

5. Click the Error Alert tab and, in the Error message box, type Iltem
Number not found. Now, if you enter an Item Number that is not on the
list of numbers in B11:B70 you will get an error message.

The default under Style is Stop. That means Excel will not allow a number
outside the range. If you change the Style to Warning Excel will display
the error message as a warning, but it will allow the value to be entered if
you wish. Leave the Style as Stop.

6. Click OK. You will see the Input message for cell B7.

Shipping Cost Ca

Calculate Shippir
Given ltem Nu

Choose 4
Item Number
43913 -
Select or type

Im item number.
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7. To see how data validation works, click B7, type 1, and tap Enter.

1 Shipping Cost Calculations
2 |
3 | Calculate Shipping Cost
4 | Given ltem Number
5 Choose Shipping
6 Item Number Cost
7 1 - #N/A
8 |
9 jSeIect or type VLO
I item number.
10 i
11 Microsoft Excel
2]
13 8 Item Number not found.
14 _ _
E Cancel Help
Click Cancel.

8. When B7 is active, there will be an upside triangle just to the right of the
cell. This is a drop-down menu that can be used to select an ltem Number
rather than type it.

To see how the drop-down menu works, click the arrow, scroll up a bit, and

select 80680.
43913 -
44537 A
43913

The Shipping Cost in C7 will show $33.00.

k. Here is another type of validation rule. You are to set up things so that the
weights entered in C11:C70 must be between 0 and 10 pounds. Give it a try. If
you need help, do the following:

1. Select C11:C70 and then, on the Data tab, in the Data Tools group, click
the Data Validation arrow and select Data Validation.

Click the Settings tab. In Allow box and select Decimal.
In the Data box, select between.
In the Minimum box type 0.

In the Maximum box type 10.

o o kA w D

Click the Input Message tab. In the Input message box type
Enter decimal between 0 and 10.
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7. Click the Error Alert tab and, in the Error message box, type
Weight must be a decimal between 0 and 10.

8. In the Style box confirm that Stop is selected.
9. Click OK.

10. To see how data validation works, click C11, type 11, and tap Enter. You
should see the error message.

11. Click Cancel.

If you want to find cells to which Data Validation has been applied, tap the F5
key to open the Go To dialog box, click the Special button, click the Data
Validation button, and click OK. Every cell that has Data Validation will be
highlighted (B7 and C11:C70).

Go To Special ?
Select
O Comments O Row differences
D Constants O Column differences
O Formulas O Precedents
MNumbers O Dependents
Text Direct only
Logicals All levels
Errors O Last cell
D Blanks O Visible cells only
O Current region
O Current array
O Objects

If you want to get rid of Data Validation assigned to a particular cell range, first
select the range. Then, on the Data tab, in the Data Tools group, click the Data
Validation arrow and select Data Validation. Click the Clear All button and

then click OK. Do NOT do this now.

|. Setthe Print Areato A1:M35 (Page Layout, Page Setup, Print Area, Set
Print Area). Set up the Shipping Costs worksheet to print in Landscape
orientation, all on one page, centered horizontally but not vertically, and
include a footer that contains the file name on the left and the sheet name on
the right. Compare the preview with the key. Make needed corrections, save
the workbook, and close it.
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HWO04-5 PivotTables

Problem: How can raw data be organized into meaningful reports that can reveal
patterns or trends?

A PivotTable is a table of statistics that summarizes the data of an Excel worksheet
or Access database. This summary might include sums, averages, or other
statistics, which the PivotTable groups together in meaningful ways. The PivotTable
allows you to arrange and rearrange ("pivot") the data in order to draw attention to

useful information.

For example, you might have data on family expenses like this:

A B

1-Jan Mom
2-Jan Mom
3-Jan Dad
4-Jan Dad
4-Jan Kelly

C 1o A

4N O R W N

(& D
Fuel S50
Groceries $120
Cafes $10
Fuel S40
Groceries $129

~o L can

Here, the variables or fields are in columns and the individual data are in rows.

With a few mouse clicks, the data can be summarized by creating a PivotTable like
this, which summarizes the amount spent by each family member:

A B
3 Row Labels ~ Sum of Amount
4 Dad $15,444
5 Kelly $28,160
6 Mom $26,373
7 Grand Total $69,977

A couple more mouse clicks and the data can be summarized in a more detailed
report that shows how much each person spent on each type of item:

11 Restaurants
12 |Grand Total

A B C
3 |Sum of Amount Column Labels ~
4 Row Labels |~ Dad Kelly
5 |Books $108 51,574
6 |Cafes S58 5179
7 |Entertainment $609 51,923
8 |Fuel 5882 $822
9 Groceries 58,722 513,734
10 Music $202 547

54,863 59,881
$15,444 $28,160

D

Mom
$309
5219

$3,207
5488
510,213

$11,937
$26,373

E

Grand Total
$1,991

5456

$5,739
52,192
$32,669
$249
526,681
$69,977
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Two more mouse clicks and the data can be “pivoted” to show the details by person:

A B C D E F G H |
3 Sum of Amount Column Labels -
4 Row Labels -~ Books Cafes Entertainment Fuel Groceries Music Restaurants Grand Total
5 Dad 5108 S58 S609 5882 $8,722 S202 54,863 515,444
6 Kelly $1,574 5179 $1,923 5822 513,734 547 59,881 $28,160
7 Mom $309 S$219 $3,207 5488 510,213 $11,937 526,373
8 Grand Total $1,991 $456 $5,739 $2,192 532,669 5249 $26,681 $69,977

One more mouse click, and a PivotChart of the data may be created:

Family Expenses

$13,734

$14,000

$11,93
$12,000 =

$10,213
$10,000

$8,722

= Books
Cafes

$8,000

u Entertainment

u Fuel

u Groceries

$6,000
? u Music

Restaurants

$4,000

$2,000

$0
Dad Kelly Mom

To see how to create PivotTables and PivotCharts, do the following:

a. Open the workbook HWO04-5 PivotTables Original, which is one of the files
you downloaded at the start of the term.

b. Save the workbook to your Excel Files folder using the name
HWO04-5 HWID PivotTables Done

c. The worksheet shows the data to Fire and Police Departments for three months.??

A B © D E
1 Fire/Police Month Loc Class N
2 Fire Jan  Station1 Medical 924
3 Fire Jan  Station1 Fire 299
4
5 Fire Jan Station2 Medical 987

For example, row 2 shows that 924 Medical calls were received from Fire
Station 1 during the month of January.

22 Based on Project 7 in Gaskin & Vargas. GO! with Microsoft Excel 2016 Comprehensive. New
York: Prentice Hall, 2017.
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Your task is to organize the data in several different ways so that staffing and
resource decisions can be made. You will do this by “pivoting” or arranging the
information in different ways in order to see it from different perspectives. To
see how this works, do the following:

1. First, you need to make sure the data have clear column headings. In row 1,
change Loc to Location and N to Num.

2. The structure of the data must be consistent. So, for example, you must
remove blank columns (there are none for this worksheet) and blank rows.

+ Option 1 By Eye: One way to remove blank rows is to find them by eye
and, when you see a blank row such as row 4, select the entire row,
right-click, and select Delete. That will be time consuming for a large
data set so you will not do that. Instead, use Option 2 below.

« Option 2 By Sorting: A second way to remove blank rows is to sort the
data. To see how this works, do the following:

Select all the rows and, on the Home tab, in the Editing group, click Sort
& Filter and Custom Sort. Be sure the My data has headers box is
checked. Then, add four sort levels, one each for Fire/Police, Month,
Location, and Class.

Mac: Add Level, Delete Level, and Copy Level are in the lower left corner of the
Sort dialog box. They look like this:| + - Copy]|

Except for Month, set the sort Order to A to Z. For Month, you want the
data chronologically rather than alphabetically, so click its Order arrow,
select Custom List, and select Jan, Feb, Mar, Apr, ...

Sort ? X
—I— Add Level X Delete Level [Bgopy Level A Options... My data has headers
Column Sort On Order

Sort by | Fire/Police v || Cell Values v | |AtoZ v

Then by | Month ~ || Cell values ~ | |Jan, Feb, Mar, Apr, May, Jun, Jul, A ~

Then by || ocation v | cell values v | |Atoz v

Then by | Class v | Cell values v | |Atoz v

Click OK.

3. Convert the data into a Table by selecting A1:E79 and, on the Insert tab,
in the Tables group, clicking Table and then OK.

1 Mlﬂ_

2 |Fire Jan Station 1 Fire
3 |Fire Jan Station 1 Medical 924

Table Name:

4. Onthe TableTools Design tab, in the Properties group, in
the Table Name box, type RawData, and then tap Enter.
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The reason you convert the data into a table is if you were to add data to
the blank rows under the table, the data would be added to the PivotTable

when it is refreshed (updated).

5. Click anywhere in the data and, on the Insert tab, in the Tables group, click

PivotTable. A dialog box will appear that shows the RawData table will be
used as the basis for the PivotTable. Under Choose where you want the

PivotTable report to be placed, be sure New

6. Click OK. Excel adds a new Sheetl.

Worksheet is checked.

7. Double-click the Sheetl tab, type Pivot, and tap Enter. Raw Data |

PivotTable Tools

Two new PivotTable Contextual tabs appear on the Ribbon. _

Analyze  Design

Mac: If you have a small screen, you may have to click the double chevron to the

right of the PivotTable Analyze tab to see the Design | PpivotTable Analyze
tab, like you did working with charts on page SG37. [ Design |

F= | =

Also, if you are working on a small screen, you may want to show or hide the

Ribbon by tapping Ctrl + F1 (Option + Command

On the right, the top part of the PivotTable Fields
pane lists the Field (column) headings from the
RawData table. This is called the Field section.

Just below this is the Layout section. This is where
you will place the fields that will form the PivotTable.

You may change the relative sizes of the Field and
Layout sections by pointing to the border between

them. A double headed arrow will appear. Left-click

and drag to change the sizes.
More Tables...
K

Drag fields between areas be;c:w:

+ R on the Mac).

L] Fire/Police

[ Month

[1 Location Fleld_

[ Class Section
] Num

PivotTable Fields ~ X
Choose fields to add to report: @ S
Search ,C

Drag fields between areas below:

Filters Columns
Layout
Section

Rows Values

If you prefer, you can make the Field and Layout
sections side-by-side by clicking the Tools icon

and clicking Fields Section and Areas Section
Side-by-Side.
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d. Set up the PivotTable by doing the following:

1. Since you are interested in the number of calls, from the Values
Field section drag the Num field to the Values box in the
Layout section.

Sum of Num

It says Sum of Num because, by default, the sums of the numbers are
displayed. Later, you will see how other statistics, such as average, may be
displayed. Notice that a check appears next to Num in the Field area.

On the left, a small PivotTable appears. Right now, it only A
contains the total number of calls for all the Stations and
Precincts.

1
2
3 Sum of Num
4 101250

2. Drag the Fire/Police field down to the Rows box. The
PivotTable is modified to show the number of calls to Fire and the number
of calls to Police, as well as the total number of calls.

A B
1
2
3 |Row Labels| ~ Sum of Num
4 |Fire 10212
5 |Police 91038
6 |Grand Total 101250

3. Drag the Location field down so it is under the Fire/Police field in the

Rows box.
Rows Values
Fire/Police ¥ ||| Sum of Num
Location v

The PivotTable is modified to include the Locations of the calls.

A B C D E F [~ . .
1 PivotTable Fields
2
3 Row Labels | - Sum of Num Choose fields to add to report:
4 | =Fire 10212 Searct
5 Station 1 3524 e
? ga?on g ?g;g Fire/Police

ation

[N

8 Station 4 1911 o
9 | =Police - 91038 Drag fields between areas below:
10 Precinct 1 11909
11 Precinct 2 16222 Filters Columns
12 Precinct 3 15643
13 Precinct 4 16077
14 Precinct 5 15250
15 Precinct 6 15937 Rows Values
16 |Grand Total 101250
17 Fire/Police - | * | Sum of Num
18 Location ¥ |
19

Pivot | Raw Data :+: p , Defer Layout Update
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4. In the Layout section, in the Rows area, point to Fire/Police, hold down
the left mouse button, and then drag the field name upward into the Filters

box.
Filters Filters
Fire/Police Fire/Police
|
Rows Rows
Fire/Police - Location
Location hd

On the left, the Fire/Police label is inserted into cell
A1, and the Precinct rows are moved above the 13

Station rows (because P comes before S).

A B
1 Fire/Police (All) ~
- 2
3 Row Labels - Sum of Num
4 Precinct 1 11909
5 Precinct 2 16222
6 Precinct3 15643
- 7 Precinct 4 16077
8 Precinctb 15250
9 Precinct 6 15937
10 | Station 1 3524
11 | Station 2 3515
12 |Station 3 1262
Station 4 1911
14 | Grand Total 101250

5. On the right, drag Class down so it is under Location. On the left, a little =
appears next to each Precinct and Station. If these do not appear, on the

PivotTable Analyze tab, in the Show group, click

I§'E| +/- Buttons

Point to the = or '+ of any location, right-click, point to Expand/Collapse,
and select Expand Entire Field. Now, the sub-data (Class) appear for all
Precincts and Stations.

6. Click the */ to show Class again.

A B C D E F [«] _
1 |Fire/Police  (All) - PivotTable Fields
2
3 |Row Labels |~ | Sum of Num Choose fields to add to report:
iy = Precln_ct 1 11909 earch
5 Accidents 731
6 Crime 499 ¥ | LULALIUIl
7 Sent 10679 Class
8 | = Precinct 2 16222
9 Accidents 586 Drag fields between areas below:
10 Crime 699
11 Sent 14937 Filters Columns
12 | =@ Precinct 3 15643 Fire/Police A
13 Accidents 558
14 Crime 634
15 Sent 14451 Rows Values
16 | @ Precinct 4 16077 Location + <] sum of Num
17 Accidents 617
18 Crime 881 BE (A4
19 Sent 14579 v
Pivot Raw Data :+: . y Defer Layout Update
In cell A4, click the = next to Precinct 1. e IP'?‘ Al B
Class for that Location disappears, and ) ire/Police _ (All
the =/ changes to a &, indicating that there
is more infogrjmation under that Ingel 3 |Row Labels - [Sum of Num
' 4 |+ Precinct 1 11909
5 |=ZPrecinct 2 16222
5] Accidents 586
7 Crime 699
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7. You can change the order of the fields by dragging. This is called “Pivoting.”
For example, under Rows, drag Class up so it is above Location.

Rows Rows
— Class
Location A é Class A
Class ¢ L Location -

Now, the PivotTable shows Location subordinate to Class.

A B C D E F [~ i .
1 |Fire/Police  (All) s PivotTable Fields
§ Row Labels -~ Sum of Num Choose fields to add to report:
4 | ZAccidents 3917 <earch
5 Precinct 1 73
6 Precinct 2 586 Y| Lucauun
7 Precinct 3 558 Class
8 Precinct 4 617
9 Precinct 5 600 Drag fields between areas below:
10 Precinct 6 825
11 | @ Crime 4311 Filters Columns
12 Precinct 1 499 Fire/Police A
13 Precinct 2 699
14 Precinct 3 634
15 Precinct 4 881 Rows Values
16 Precinct 5 763 Class + =11l sum of Num
17 Precinct 6 835 -
18 | =Fire 2409 Location M 4
19 Station 1 989

Pivot Raw Data :+} . R Defer Layout Update

8. Drag Class back under Location to return to the previous arrangement.

9. On the right, from the Field section, drag the Month field down to the
Columns area. This allows you to see the month by month data.

Now you can see, for example, that Precinct 2 Crime (row 11) decreased
from January (310) to February (175), but Precinct 3 Crime (row 15)
increased from 196 to 224 during that same time period.

A B C D E F[~] _. ]
1 Fire/Police  (All) - PivotTable Fields
§ Sum of Num Column Labels [~ Choose fields to add to report:
4 Row Labels -~ |Jan Feb Mar Grand Total Search
5 | = Precinct 1 4275 3529 4105 11909
3] Accidents 327 208 196 73
7 Crime 285 03 121 499 Month
8 Sent 3663 3228 3788 10679 o
9 | =@ Precinct 2 5637 4563 6022 16222 Drag fields between areas below:
10 Accidents 252 163 171 586
11 Crime 214 690 Filters Columns
12 Sent 5075 4225 5637 14937 Fire/Police - Month
13 | @ Precinct 3 5540 4504 5599 15643
14 Accidents 221 215 122 558
15 Crime 214 634 Rows Values
16 Sent 5123 4065 5263 14451 Location ~ =1 Sum of Num
17 | =@ Precinct 4 5340 4959 5778 16077 e e
18 Accidents 235 197 185 617
19 Crime 308 327 246 881
Pivot Raw Data @D . y Defer Layout Update

It would be a good idea to investigate why this is so.
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10. To make the PivotTable easier to read, select columns B, C, and D, right
align them, and make the column width 9. Apply Wrap Text to cell B3.

11. On the Design tab, in the PivotTable Styles group, click More [Z] and
select Rose, Pivot Style Medium 10.

Medium

—
=

Now, the PivotTable looks like this:

Mac: The style may look a bit different on a Mac.

A B C D E T _
1 |Fire/Police - PivotTable Fields
2 Column Choose fields to add to report:
53 Sum of Num Labﬂ Search
L3 Row Labels i Jan Feb Mar Grand Total
5 | @ Precinct 1 4275 3529 4105 11909 Fire/Police
6 Accidents 327 208 196 731 .
7 Crime 285 93 121 499
8 Sent 3663 3228 3788 10679 Drag fields between areas below:
9 | ZPrecinct 2 5637 4563 6022 16222
10 Accidents 252 163 171 586 Filters Columns
11 Crime 310 175 214 699 Fire/Police - Month
12 Sent 5075 4225 5637 14937
13 | = Precinct 3 5540 4504 5599 15643
14 Accidents 221 215 122 558 Rows % Values
15|  Crime 196 224 214 634 T— ~ =1 sum of Num
16 Sent 5123 4065 5263 14451
17 | = Precinct 4 5340 4959 5778 16077 gl A4
18 Accidents 235 197 185 617 -

| Pivot | Raw Data | f+j < , Defer Layout Update

e. When you make a PivotTable, Excel takes a “snapshot” of the raw data by
making a copy. The result is that if you modify the data on the Raw Data tab,
the PivotTable is not automatically updated — you must do that manually. To
see how this works, do the following:

1. Click the Raw Data worksheet. Click cell E30 (Precinct 2 Crime for
January), change it from 310 to 5000, and tap Enter.

Click the Pivot worksheet and notice that cell B11 still shows 310.
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2. To update the PivotTable, right-click any cell in the PivotTable and select
Refresh. The value now is 5000 and all the values that depend on that cell
are updated.

A B [ D E

1 |Fire/Police (4~
2

Column
53 Sum of Num Labﬂ
4 Jan Mar Grand Total
5 | = Precinct 1 4275 3529 4105 11909
6 Accidents 327 208 196 731
7 Crime 285 93 121 499
8 Sent 3663 3228 3788 10679
9 | ZPrecinct 2 10327 4563 6022 20912
10 Accidents 252 163 171 586
11 Crime | 5000_| 175 214 5389
12 Sent 5075 4225 5837 14937

3. Now, change the data back by clicking the Raw Data worksheet,
clicking cell E30, typing 310, and tapping Enter.

Click the Pivot worksheet and notice that cell B11 is still 5000. To update
the table, right-click any cell in the table and select Refresh. B11 is 310
again and all the cells that depend on B11 are updated.

If you want to add new raw data, you would enter it in the row just below the
last row on the Raw Data worksheet. Then, you would refresh the PivotTable
as you just did.

4. You can focus on either Fire or Police data by
using the filter arrow in B1. Click the filter arrow
and then click Fire.

Fire/Police
Search

Mac: Click the check next to Police to deselect it.

Click OK

Mac: There is no OK button. Click the red dot to close the dialog box.
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The Police data disappear leaving only the Fire data displayed.

A B C D E F G [~ _
1 |Fire/Police Flx PivotTable Fields
2 Column Choose fields to add to report:
53 Sum of Num Labﬂ Search
L3 Row Labels Jid Jan Feb Mar Grand Total
5 | = Station 1 1223 1248 1053 3524 Fire/Police
6 Fire 299 369 321 989 o
7 Medical 924 879 732 2535
8 | = Station 2 1313 1035 1167 3515 Drag fields between areas below:
9 Fire 326 265 204 795
10 Medical 987 770 963 2720 Filters Columns
11 | = Station 3 439 424 399 1262 Fire/Police hd Month
12 Fire 68 92 78 238
13 Medical 371 332 321 1024
14 | - Station 4 658 601 652 1911 Rows % Values
15 Fire 17 123 147 387 o ~ =] M Sum of Num
16 Medical 541 478 505 1524
17 |Grand Total 3633 3308 3271 10212 Class pl A4
18 -

Pivot Raw Data f-i-) < , Defer Layout Update

5. Click the filter arrow in B1 and select All so all the data appear again.

f. If you want to send a PivotTable to someone else so they can do an analysis,
you would make a copy of the worksheet and save it in a new workbook. To
see how this works, do the following:

1. Right-click the Pivot worksheet tab and select Move or Copy to open its
dialog box.

Mac: Edit menu, Sheet, Move or Copy Sheet.

2. Click the Create a copy box.

3. Inthe box under To book, click the arrow and select (new book).
4. Click OK. A new workbook, titled Book1, is created.
5

Save the new workbook in the Excel Files folder using the name HWO04-5b
HWID Fire & Police PivotTable Done.

Now, you have a copy of the PivotTable. You can manipulate the data as you
see fit. However, since this is a “snapshot” of the data, the data cannot be
updated and refreshed.

6. Close the new workbook HW04-5bh HWID Fire & Police PivotTable Done.

g. Specific data may also be displayed using Slicers (filters).

1. With the workbook HWO04-5 HWID PivotTables Done open, make a copy
of the Pivot worksheet and rename it Slicer-1.

2. Onthe PivotTable Analyze tab, in the Filter group, click Insert Slicer.
This displays the field names in a dialog box.




SG100PROJECT 4 EXCEL CHAPTER 3: ANALYZING DATA WITH CHARTS & WHAT-IF TooLS

3. Click the Fire/Police check box Review Ve and then click OK.

E Insert Slicer
Insert Slicers

Fire/Police HWO04-5 HWID PivotTables Done ~
I:‘ Month

In the ribbon, a new tab called Slicer appears. |Peveloper  Help  Acrobat  Slicer

4. On the Slicer tab, in the Slicer Styles group, select Light Green.

5. Inthe Slicer box, click Fire to display only the Fire data. The filter ?
button now shows a red X. To remove the filter, click that button X
(DO NOT do that now).

6. Click any cell in the PivotTable and insert a second slicer. Click Class in
this new dialog box, and then click OK.

7. Apply the Lavender style.
8. Arrange the two slicers on the right so you can clearly see both.

9. On the Class slicer, click the Medical filtering button.

A B C D E F G H | J K
1 |Fire/Police F|-T
2

Column Fire/Police Y= ¢ | Class = N2

53 Sum of Num Labﬂ - .
'l Row Labels E§  Jan Feb Mar Grand Total [ Fire
5 | - Station 1 924 879 732 2535  Police Medical
6 Medical 024 879 732 2535
7 | - Station 2 987 770 963 2720 Accidents
8 Medical 987 770 963 2720 Crime
9 | - Station 3 371 332 321 1024 ot
10 Medical 371 332 321 1024
11 | - Station 4 541 478 505 1524
12 Medical 541 478 505 1524
13 | Grand Total 2823 2459 2521 7803

The Fire/Police slicer filters out the Police data, and the Class slicer filters
out Fire calls. The three police Class buttons are grayed because the
Police data have been already filtered out by the Fire/Police slicer.

h. Set up the Slicer-1 worksheet to print in Portrait orientation, all on one page,
centered horizontally but not vertically, and include a footer that contains the
file name on the left and the sheet name on the right. Click the Sheet tab, click
Gridlines and also Row and column headings. Compare the preview with the
key. Make needed corrections, save the workbook but do NOT close it.

i. In this Activity, you will “pivot” the order of the fields to view the data from a
different perspective.

1. Remove the filters from the Slicer-1 worksheet. To do this, click the ?x
icon on each slicer.

2. Click the Pivot worksheet tab. In the Layout section of the PivotTable
Fields pane, from the Columns area, drag Month upward into the white
Field section. This removes the Month data from the PivotTable.
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3. Inthe Layout section, from the Rows area, drag the Class field into the
Columns area.
A B C D E F G NI _
1 |Fire/Police ¢- PivotTable Fields
2
B8 Sum of Num Column Labels n Choose fields to add to report:
L Row Labels Bl Accidents Crime Fire Medical Sent Grand Total Search
5 |Precinct 1 731 499 10679 11909 S
6 |Precinct 2 586 699 14937 16222
7 Prec?nﬂ 3 998 634 14451 15643 Drag fields between areas below:
8 Precinct 4 617 881 14579 16077
9 Precinct5 600 763 13887 15250 Y Filters il Columns
10 |Precinct 6 825 835 14277 15937 Crespon -a
11 | Station 1 989 2535 3524 LCpebe 2
12 |Station 2 795 2720 3515 = Rows 3 Values
13 |Station 3 238 1024 1262 :
14 | Station 4 387 1524 1911 e V| e
15 |Grand Total 3917 4311 2409 7803 82810 101250 -
» | Slicer-1 | Pivot | Raw D ... @.} P N - S
Class now is in columns rather than rows. The column names are listed in
alphabetical order, which is not very useful since Fire data are intermixed
with Police data.

4. Right-click Medical, in cell E4, point to Move, and then click Move
“Medical” to Beginning. This moves those data to the beginning of the
columns in column B.

5. Repeat the process for Fire. The Fire data now are adjacent to each other,
as are the Police data. This makes things easier to read.

A B c D E | F G - . _
1 |Fire/Police - PivotTable Fields
2
% Sum of Num  Column Labels n Choose fields to add to report:
L3 Row Labels jd Fire Medical Accidents Crime Sent Grand Total Search
5 |Precinct 1 731 499 10679 11909 -
6 | Precinct 2 586 699 14937 16222
7 Prec?ncl 3 558 634 14451 15643 Drag fields between areas below:
8 |Precinct 4 617 881 14579 16077
9 |Precinct 5 . 600 763 13887 15250 Y Filters Il Columns
10 |Precinct 6 Fire 825 835 14277 15937 el Ia
11 | Station 1 989 2535 Police 3524 i =
12 | Station 2 795 2720 3515 = Rows S Values
13 |Station 3 238 1024 1262 -
14 | Station 4 387 1524 1911 Cocation | Sum of Nurn
15 |Grand Total 2409 7803 3917 4311 82810 101250~
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J. You can display select PivotTable report details in a new worksheet. For
example, do the following to make a report that shows Crimes reported each
month by Precinct:

1. On the Pivot worksheet, double-click cell E15 (Grand Total for Crimes).
This creates a new worksheet with the details of the Crimes for each
Precinct and Month.

A B % D E
1 M Month [ - M Num [
2 |Police Mar Precinct 1  Crime 121
3 |Police Feb Precinct 1 Crime 93
4 | Police Jan Precinct 1  Crime 285
5 |Police Mar Precinct 2 Crime 214
6 |Police Feb Precinct 2 Crime 175
7 |Police Jan Precinct 2 Crime 310
& Police Mar Precinct 3 Crime 214

2. Rename the worksheet Crime. At this point, you should have four
worksheets in this workbook. | Slicer-1 | Crime | Pivot | Raw Data |

k. Apply conditional formats to this Crime worksheet so that each month’s row will
have a different color. Do the following:

1. You are going to do some complex sorting and set conditional formats so
convert this table into a regular Range. To do that, on the Table Design
tab, in the Tools group, click Convert to Range and then click Yes. Notice
the filter arrows disappear.

2. With A1:E19 selected, on the Home tab, in the Styles group, click the
Conditional Formatting arrow, click New Rule and then click Use a
formula ...

Mac: Select New Rule, Style: Classic, Use a formula...

Style: | Classic (2]

[ Use a formula to determine which cells to format

3. Inthe box, type =$b1="Jan"
4. Click the Format button.

Mac: Click Format with and select Custom Format.

5. Click the Fill tab and click light red.
6. Click OK. Click OK again.
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7. Repeat the process for Feb and Mar, using different colors for those months.

1 IIEEEI
2 Pollce Precinct 1 C.nme
3 |Police Feb Precinct 1 Crime
4 Paolice Jan Precinct 1 Crime
5 Police Mar Precinct2 Crime
6 Police Feb Precinct2 Crime

|. Do the following to sort the data by Month, Jan to Mar, and then by Num, in
descending order:

1. With A1:E19 selected, on the Home tab, in the Editing group, click the
Sort & Filter arrow, and select Custom Sort. Be sure My data has
headers is checked.

2. Click the Sort by arrow and select Month. Click the arrow under Order
and select Custom List. Choose Jan, Feb, Mar, ... and click OK.

3. Click Add Level (* on Mac). Click the Then by arrow and select Num.
Click the arrow under Order, select Largest to Smallest, and click OK.

m. Insert Data Bars to graphically show the data. To do that:

1. Select column E, copy, click the column F column label, and paste. You are
going to put the data bars in column F so you can easily see both the
numbers and the data bars.

2. Select F2:F19 (you do not want F1 because that contains the field name).

3. Onthe Home tab, in the Styles group, click Conditional Formatting, point
to Data Bars, and select More Rules.
4. Check the box that says Show Bar Only (so the numbers do not show).
5. Click the arrow under Fill and select Gradient Fill.
6. Select dark gray for the color.
7. Click the arrow under Border and select Solid Border with the color black.
PC Mac
Format all cells based on their values: Direction: [ Context ] Show data bar only
Format Style: | pata Bar e Show Bar Only
Minimum Meximum Fills: O Solid © Gradient
Type: Automatic R Automatic R
Positive values: | 14
Value: (Automatic) L (Automatic) + osttive values [ .]
Negative values: | I
Bar Appearance:
il Color Border Color Borders: ) Solid ) None
Gradient Fill w W Solid Border |~ -v
Positive values: | IEEEE——
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Click OK. Here you can see that Precinct 2 had the highest Num of
Crimes in January, but was in the bottom half for February and March.
This would be something to investigate.

A B C D E F
1 Fire/Police |Month Location Class Num Num

2 Police [Jan Precinct 2  Crime 310|.

3 |Police Jan Precinct4 Crime 308.

4 |Police Jan Precinct5 Crime 286-:|
5 Police Jan Precinct 1 Crime saes R ]
6 Police Jan Precinct 6 Crime s1allE |
7 |Police Jan Precinct3 Crime 196.:|

8 Police Feb Precinct4 Crime 27 |
9 Police Feb Precinct5 Crime 2430 ]
10 Police Feb Precinct 3 Crime 224 ]
11 Police Feb Precinct6 Crime 206 |
12 Police [Feb Precinct2 Crime 1751

13 Police Feb Precinct 1 Crime 93|:|

14 Police Mar Precinct6 Crime <G
15 Police Mar Precinct4 Crime 246 [ ]
16 Police Mar Precinct5 Crime 234 ]
17 Police [ Mar Precinct 2 Crime 214

18 Police Mar Precinct 3 Crime 214 |
19 Police Mar Precinct 1 Crime 121 |:|

n. Set up the Crime worksheet to print in Portrait orientation, Adjust to 150 % of
normal size, centered horizontally but not vertically, and include a footer that
contains the file name on the left and the sheet name on the right. Compare
the preview with the key. Make needed corrections, save the workbook but do
NOT close it.

0. In order to make analysis easier, you can display data on separate worksheets.
For example, let’s do this for Fire and Police data. Doing so will make it easier
to answer questions about the calls handled by each department.

1. On the Pivot worksheet tab, click cell Al.

2. Onthe PivotTable Analyze tab, in the PivotTable group (on the left), click
the Options arrow, and then click Show Report Filter Pages.

File Home Insert

Active Field:

Fire/Police

[iZ Field Settings |

Active |

PivotTable Name:

PivotTable1
@Options @
E Options

In the dialog box, confirm that Fire/Police is selected and click OK.
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This adds two new worksheets, one for Fire and one for Police.

Fire Worksheet Police Worksheet
A B C D A B C | D E

1 |Fire/Police FT 1 |Fire/Police Poli T

2 2

&) Sum of Num  Column Labels [ :’ ;""" :;xm.im_':'"tubds -c e Sent Grand Total

Yl Row Labels Bl Fire Medical Grand Total I} Pim ; ShE 1 “ 179 il , 109

2 | Station 1 989 2535 35241 16 | precinct 2 586 699 14937 16222

6 |Station 2 795 2720 3515/ | 7" precinct 3 558 634 14451 15643

7| Station 3 238 1024 1262) 1 8 |Precinct 4 817 881 14579 16077

8 |Station 4 387 1524 1911 [9 |Precinct 5 600 763 13887 15250

9 |Grand Total 2409 7803 10212 (10 |Precinct 6 825 835 14277 15937
11 |Grand Total 3917 4311 82810 91038

The data are copied, not moved. That is, the data for each worksheet
remains on the original Pivot worksheet.

3. Hide the Fire worksheet by right-clicking its worksheet tab

and selecting Hide.

Hide

Select A
Fire | Fonce

4. In the same way, hide the Police worksheet. You can unhide a worksheet
by right-clicking any tab and selecting Unhide.

p. The default summary statistic is to find sums. It is also possible to calculate

other quantities. Do the following:

1. On the Pivot worksheet tab, point to cell G5 (Grand Total for Precinct 1),

right-click, and click Value Fiel

d Settings.

2. Under Summarize value field by, select Average, and click OK.
All the calculated values are changed from Sum to Average. Notice that
cell A3 changes from Sum of Num to Average of Num.

3. Right-click any numeric value and select Value Field Settings. In the lower
left corner of the dialog box, click Number Format to open its dialog box.

4. Under Category, click Number. Make the Decimal places 0 and check
the Use 1000 separator box. Click OK. Click OK again.

A B C D E F G - i .

1 |Fire/Police e PivotTable Fields ~ X
2
&W Average of Num Column Labels Choose fields to add to report: @} 7
L3 Row Labels -Fire Medical Accidents Crime Sent Grand Total cearch /O
5 |Precinct 1 166 3,560
6 |Precinct 2 195 233 4,979
7 Prec!nct 3 186 211 4,817 1,738 Drag fields between areas below:
8 |Precinct 4 206 294 4,860 1,786
9 |Precinct 5 200 254 4629 1,694 Filters Columns
10 |Precinct 6 275 278 4,759 1,771 Fire/Police - Class -
11 |Station 1 330 845 587
12 |Station 2 265 907 586 R %! Vhflees
13 |Station 3 79 341 210
14 | Station 4 129 508 319 Location 57 Average of Num ¥
15 |Grand Total 201 650 218 240 4,601 1,298

4 » ...| Crime | Fire | Police | Pivot ... 3.3 4 ¥ - -
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g. You can create charts of the PivotTable. Do the following on the Pivot worksheet:

1. Onthe PivotTable Analyze tab, in the Tools group, click PivotChart. In the
Insert Chart dialog box, on the left side, if necessary, click Column, and
then click OK to accept the default chart — Clustered Column.

Format Tools Data

Mac: There is no Insert Chart dialog box. To see chart
types, in the menu at the very top line, click Insert
to open its menu and click Chart. Then, select the

Cells...

Rows

Columns
type_ Sheet
Chart
Sparklines...
A B C D E F G -~ . .
1 |Fire/Police -~ PivotTable Fields ~ %
2
EW Average of Num Column Labels n Choose fields to add to report: @ 4
L3 Row Labels -Fire Medical Accidents Crime Sent Grand Total earch /o
5 Precinct 1 244 166 3,560 1,323
[i] Prec!nct2 195 233 4,979 1,802 Fire/Police
7 |Precinct 3 186 211 4,817 1,738 [ Month
8 Precinct 4 206 294 4860 1,786 _
9 Precinct 5 200 254 4,629 1,604 Al
10 |Precinct 6 275 278 4,759 1,771 Class
11 | Station 1 330 845 587 Num
12 | Station 2 265 907 586 M
| ore Tables...
13 | Station 3 79 341 210
14 | Station 4 129 508 319
15 |Grand Total 201 650 218 240 4,601 1,298
:? Fire/Police + Drag fields between areas below:
18 Average of Num Filters Columns
;3 6,000 Fire/Police A Class A
5,000
21 Class v
4,000
22| 49 m Fire
23 | 2,000 Miedical
n ical
24 | 500
25 Accidents
1,000 )
3? 0 " " . [l n [l || a .l m Crime Rows 21 Values
= -oé'\ -Q\é{“ & _,\é}“’ -g\“;o -é\'\’ -d';.' -é"g .di‘h meent Location > ||| Average of N.. ~
29 Q&o q@c Q@(} q@(} Q@(} q@c ‘-3"?;L o > o
30
31 Location +
32
33
34
3= Defer L Upd
» | Slicer-1 | Crime | Pivot ‘ Rav ... () 4 » efer Layout Update

This is a chart of all the Fire and Police data. It shows:

6 Police Precincts with their 3 Classes: Accidents, Crime, and Sent
4 Fire Stations with their 2 Classes: Fire, and Medical.

Notice the Filter Buttons for:

Fire/Police
Average of Num [Average of tum |
Location W

Class

Mac: There are no Filter Buttons on Mac PivotCharts.
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2. On the chart, click the Fire/Police Filter Button.

Select Fire and click OK. The Fire/Police Filter Button
now shows the filter icon with the arrow. The same is true for the filter
button in cell B1 on the PivotTable.

Mac: On the PivotTable, click the arrow in cell B1. A B

Uncheck Police so that only Fire is checked. | 1_|Fire/Police Fire

Click the red dot to close the dialog.

A B [# D E F G - ] |

1 |Fire/Police GES PivotTable Fields ~ X
2
EW Average of Num Column Labels - Choose fields to add to report: @ 57
L3 Row Labels - Fire Medical Grand Total coarch 0
5 |Station 1 330 845 587
G |Station 2 265 907 586 Fire/Police 7=
I |Station 3 79 KLy 210 [ Month
8 |Station 4 129 508 319 .
9 |Grand Total 201 650 426 e
10 Class -
11 Fire/Police + ¥ —
12 | Average of Num Drag fields between areas below:
13 1,000 §
14 300 Filters Columns
15 200 Fire/Police S Class 7
16 700
17 500 Class v
18 500 M Fire
19 | 400
bo| 300 = Medical Rows % Values
e1 ig I I Location 57 Average of N... =
P2
2l - N
ba Station 1 Station 2 Station 3 Station 4
b5 Location v
i - Defer Layout Upd

» | Slicer-1 | Crime | Pivot | Rav .. &) F » ST AR EIEE

3. Repeat this process to display All the data again.

4. In the lower left, click the Location Filter Button to open its dialog box.

Mac: In the PivotTable, click the arrow in cell A4, Row Labels.

Click the Value Filters arrow, select Top 10... and, in the dialog box,
change 10 to 4 and click OK.

Mac: Under Filter, next to By value, click the Choose one arrow and select Top
10. Under Top 10, change the 0 to 4 and close the dialog box.
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Now, the four Locations with the most calls are displayed. They are Police
Precincts 2, 3, 4, and 6.

| A . B € [ b [ETF] 6 T . )
1 Fire/Police - PivotTable Fields ~ X
2
£ Average of Num Column Labels - Choose fields to add to report: @ 7
L3 Row Labels Fire Medical Accidents Crime Sent Grand Total F— Jo
5 Precinct 2 195 233 4,979 1,802
6 Precinct 3 186 211 4,817 1,738 Fire/Police -
7 Precinct 4 206 294 4,860 1,786 [ Month
8 Precinct 6 975 278 4,759 1,771 o
9 Grand Total 216 254 4,854 1,774 ¥ Location g
10/ 3 Class
11: Fire/Police » Num
127 Average of Num h
13— 6,000 Drag fields between areas below:
15 5,000 T Filters Il Columns
16
17| Class - Fire/Police - Class -
— 4,000
18 | H Fire
;g_ 2000 u Medical
21— m Accidents
22: 2000 B Crime = Rows 3 Values
;3— 1,000 [ Sent Location * | Average of Num *
;g— 0 -. -. =l nm
a Precinct 2 Precinct 3 Precinct 4 Precinct 6
28: Location ¥
29 -
< » .| Crime | Fire | Police | Pivot .. 3 4 » Defer Layout Update

5. On the right middle of the chart, click the Class arrow.

Mac: In the PivotTable, click the arrow in cell B3, Column Labels.

Deselect everything but Accidents and Crime. | = Selectab

[TFire
. [ Medical
Click OK. [¥] Accidents
Crime
A , B T € | D [ E | F | G- _ ,
1 |Fire/Police B PivotTable Fields
2
kM Average of Num Column Labels Choose fields to add to report:
L3 Row Labels Accidents Crime Grand Total Search
5 |Precinct 2 195 233 214 A
6 | Prec!ncl 4 206 294 250 Fire/Police
7 |Precinct 5 200 254 227 [ Month
8 |Precinct 6 275 278 277 .
9 |Grand Total 219265 242 ]l || 4 Location
10/ s - h Class
”— Fire/Police + 7 Nuen

12 | Average of Num
- Drag fields between areas below:

13 | 350
14 200 Y Filters Il Legend (Series
15
16_ 250 Fire/Police - Class
1?:) 200 Class ¥ (
18, 150 M Accidents
19 | .
o0 | 100 rime = Auxis (Categories) % Values
21| so Location A Average of Num
22

— 0
33— Precinct 2 Precinct 4 Precinct 5 Precinct 6
o5 | Location +¥

R | Slicer-1 | Crime | Pivot .. (3@ P » Defer Layout Update

6. Move the chart to its own chartsheet (PivotChart Design, Location, Move
Chart) and label it 3-D Chart.
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7. Onthe PivotChart Design tab, in the Type group, click

Change Chart Type, select 3-D Stacked Column, and M
then click OK.

3-D Stacked Column

Click the green cross + and place checks next to Axes (Primary
Horizontal, Primary Vertical), Chart Title (Above Chart), Data Labels,
Gridlines (Primary Major Horizontal), and Legend (Right).

Mac: There is no green cross. On the Chart Design tab, in the Chart Layouts group

(on the far left), click the Add Chart Element arrow and set the Axes (Primary
Horizontal, Primary Vertical), Chart Title (Above Chart), Data Labels (Data
Callout), Gridlines (Primary Major Horizontal), and Legend (Right).

9.

10.
11.

12.

Enter 1st Quarter Crime and Accident Calls for Top Four Precincts as
the title. Change the font to 12 pt purple Arial Black.

Change the font of both axes and the legend 12 pt purple Arial Black.

Make the Major Gridlines purple and Width 2 pt. (PivotChart Format, Current
Selection group, Vertical (Value) Axis Major Gridlines, Format Selection
(Format Pane on Mac), Line, Solid line, Color Purple, Width 2 pt).

Change the font of the column data labels to 12 pt yellow Arial Black. Since
Mac folks did Labels (Data Callout) their labels will look a bit different:

Mac

500

400

300

13. Follow a similar procedure to make the floor gray.

Fre/Police

Average of Num

1st Quarter Crime and Accident Calls for Top Four Precincts

500

400

300 Class -

H Crime

200 m Accidents

100

Precinct 2

Precinct 5

Precinct 6

Location Y’

The columns show the Accidents (blue) and Crime (red) calls added together.
The different colors illustrate how much each contributes to the total.
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14. Click the Pivot worksheet tab. Since the charts were based on this
PivotTable, and you changed the items displayed in the chart the
PivotTable shows only Accidents and Crime for the top four Precincts.

A B C D

1 |Fire/Police (All) -

2

53 Average of Num Column Labels

3 Row Labels Accidents Crime Grand Total
5 |Precinct 2 195 233 214
6 |Precinct 4 206 294 250
7 |Precinct 5 200 254 227
8 |Precinct 6 275 278 277
9 |Grand Total 219 265 242

If you were to change the filters on this PivotTable, the graph that is based
on this PivotTable would change also.

r. Click the 3-D Chart tab and click in the chart. On the PivotChart Analyze tab, in
the Show/Hide group, click the Field Buttons arrow and select Hide All so
those do not show on the printout. (To show them again, click that button again).

Mac: Field Buttons do not exist on Mac PivotCharts so ignore references to them.

Set up the 3-D Chart chartsheet to print in Landscape orientation. Include a
footer that contains the file name on the left and the chartsheet name on the
right. Compare the preview with the key. Make needed corrections, save the
workbook but do NOT close it.

s. Unhide the Fire and Police tabs (right-click a visible tab to open the Unhide
dialog box, click the name of the tab you wish to unhide, and click OK).

There may be too many worksheet tabs in this workbook to see them all at one
time. If you see arrows to the left of the left-most tab, it means some tabs are
not visible. To see them, click the arrow as many times as is necessary. The
arrow will change as you display worksheet tabs or hide them.

* | means there are more tabs on the right.

means there are more tabs on both the left and right.

@ means there are more tabs on the left.

You may want to adjust the space for the tab labels. To do that, move the
mouse pointer to the three vertical dots next to the horizontal —
scroll bar. The pointer becomes a double headed arrow. Click & b !
and drag left or right to make less or more room for the tab
labels. This will expand or contract the horizontal scroll bar.

Mac: The horizontal scroll bar is just above the tab names so skip this.

t. Save and close the workbook.
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Step 4 Submit Now, submit the following. Use these names for the pdf files:

HWO04-1 HWID 3A Enterprise Fund Done (Expenditures Chart) — This is the
Expenditures Chart chartsheet

HWO04-2 HWID 3B Tourism Done (Expenditures)— This is the Expenditures
worksheet

HWO04-2 HWID 3B Tourism Done (Advertising) — This is the Advertising
worksheet

HWO04-3 HWID HLOOKUP Gradebook Done

HWO04-4 HWID VLOOKUP Shipping Done

HWO04-5 HWID PivotTables Done (Slicer-1) — This is the Slicer-1 worksheet
HWO04-5 HWID PivotTables Done (Crime) — This is the Crime worksheet
HWO04-5 HWID PivotTables Done (3-D Chart) — This is the 3-D Chart chartsheet

Create a pdf file of the output for each of the above, place them in a folder
called HW04 HWID LastName, FirstName, zip the folder and, by the due date,
upload it to the Canvas folder HWO04 Excel Chapter 3: Analyzing Data with
Charts and What-If Tools.

Step 5 Backup Now would be a good time to backup your files.






Project 5
Excel: Customize Charts, Make Decisions, and Sort

Step 1 Read For this project, there are no pages to read in your textbook.
Step 2 Activities For this project, there are no textbook activities.

Step 3 Homework Do the problems listed below, and turn them in for grading.

This Project will extend your knowledge of using Excel to make graphs and to help
make decisions using IF/THEN/ELSE logic.

HWO05-1 River Chart

Problem: How can you create a mathematical model (formula) based on empirical
data and put two graphs on one chart?

In this exercise you will be given measurements that show the relationship between
the depth of a river, the distance from one of its banks, and the water temperature.
Water depth measurements are routinely made to help keep rivers navigable and to
help with flood control and prevention. Your task is to graph these relationships and
to create a mathematical model that can be used to predict the expected water
depth at any distance from the shore. Where the actual depth does not match the
model might indicate that dredging is needed. On the same graph, you will also
graph bottom water temperature versus distance from the riverbank. Having these
two graphs on one grid will enable you to see the relation between water depth and
temperature.

a. Open the workbook HWO05-1 River Original, which is one of the files you
downloaded at the start of the term.

b. Save the workbook to your Excel Files folder using the name
HWO05-1 HWID River Done.

— SG113 —



SG114 PROJECT 5: EXCEL: CUSTOMIZING CHARTS, MAKING DECISIONS, AND SORTING

c. Graph the distance/depth data by doing the following: H:l? dil- 3~ M
K- - B
1. SEIECt Ce”S Bng Recommended a .
. Charts 'e)' |‘—'
2. Onthe Insert tab, in the Charts group, Scatter
click Scatter and then select Scatter.
® & O
A B T D E F] o®
. [ ] [ ]
Distance from | Depth of Water
the West Bank | the River | Temperature 11
1 (feet) (feet) (degrees F)
2 0 0.0 70.0
3 15 10.2 53.6
4 25 17.0 45.0
5 40 19.0 48.0
6 50 200 500 Note that a
7 70 18.0 65.0
8 90 72 69.0 Worksheet has
— 20 20 cells and may
. Chart Title contain a chart.
13 25.0
14
15 || 20.0 & .
16 . .
17 15.0
18
19
20 10.0 L]
21 [}
22 50
23
24| g0 .
25 o 1 2 3 4 5 i) 7 2 9
26

3. Be sure the chart is selected and then on the Chart Design tab in the
Location group (way over on the right), click Move Chart.

4. Click the button next to New sheet, type River Depth Chart, and click OK.
The chart appears in its own chartsheet.

Chart Title

. Note that a
Chartsheet
has no cells,
only a chart.

50

00 . .
o 1 2 3 4 5 6 7 8 9

B

Select
Data

5. Be sure the chart is selected and then on the Chart Design tab in
the Data group (way over on the right), click Select Data.
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_ _ ) ) Legend Entries [Series)
6. Under Legend Entries (Series), click Edit. 47 add 3 Edit

Mac: There is no Edit button. The boxes below automatically appear.

7. Fillin the Edit Series box as follows:

¢ In the Series name box type Depth. This gives the data a name.
In a bit, you will enter another series called Temperature.

¢ Next to the Series X values box, click the collapse dialog button:

Series name:

Depth El Sele nge

Series X values:

2| select Range

e Click the River Data worksheet and select A2: A9, which contains the
distance data. Notice how the location is inserted in the box:

='River Data'l$A52:5A%9 [«

¢ Click the collapse dialog button again.

8. The Series Y values should already show the range B2:B9 in the River
Data worksheet. Click OK.

Select Data Source ? X
Chart data range: | ='River Data'!$A$2:5B59 *
Switch Row/Column

Legend Entries (Series) Horizontal (Category) Axis Labels

E add E % Edit I P<Remove & | w E Edit

Depth 0 ~
15
25
40
50 W

Hidden and Empty Cells oK Cancel

9. Click OK again.
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_|_

1. Click anywhere in the chart so the chart elements buttons are 4
displayed in the upper right corner. ?

d. Format the chart as follows:

Mac: There are no chart elements buttons. The Add Chart Element menu is in the
upper left corner of the screen. Click its arrow to open it.

Open the Chart Elements menu by clicking the green cross.

Insert checks as shown below:

CHART ELEMENTS
y Aoces

& Axis Titles
Chart Title

Y |:| Data Labels
[ | ErrorBars
Gridlines » Prirary Major Horizontal
[ ] Legend Primary Major Vertical
[ ] Trendline Primary Minor Horizontal

Prirnary Minor Vertical
Mare Options...

2. Click the Chart Title textbox (it probably has the word Depth in it). Click
the formula bar, and type River Depth vs. Distance From West Bank

Tap Enter to update the title.

Mac: If you have trouble selecting a chart element, tap the Tab key to cycle through
the elements until the one you want is selected.

3. Using the same technique, change the Vertical Axis Title to Depth (feet).
Change the Horizontal Axis Title to Distance From West Bank (feet).

4. For each of the three titles, make the font 14 point Arial Black.
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e. Format the data points by doing the following:

1. Onthe Chart Format tab, in the Current Selection group (on the left), click
the arrow and select Series “Depth”. This selects the data points.

Series "Depth" s* S ™y

2

+ %% Format Selection Ood- [ Abe ] [ Abe ] [ Abe ] - [

3] Reset to Match Style AL LIs T o
Current Selection Insert Shapes Shape Styles

- % | =SERIES("Depth”,'Ri

River Depth vs. Dis

250

2000 3

£

2. Onthe Chart Format tab, in the Current Selection group click
= Format Selection to open the Format Data Series pane (on the right).

Mac: Click the Format Pane button on the right side of the ribbon.

Click the paint bucket|<’»| to see the Line and Format Data Series
Marker options. Series Options ¥

3. Click Marker, click the triangle next to Marker S ol
Options to open its menu, and then click the
Built-in button. ~ Line " Marker

1 .. . S H .D t' -
Click the Type arrow and be sure it is set to circle eries Uptions

(third choice from the bottom). & |||
Change the size to 10.

. . . . . -~ Line " Marker
4. Click the Fill triangle to open its menu, click

Solid fill, and then change the color to dark red. 4 Marker Options

Automatic
Mane
* Built-in

Type (# -

Size 10
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f. Change the background color of the chart by doing the following:

1. Onthe Chart Format tab, in the Current Selection group, click the arrow,
select Chart Area, and then click Format Selection to open the Format
Chart Area pane.

2. If necessary, click the Fill triangle to show its menu and then click Picture
or texture fill.

Insert picture from

3. Click the arrow to the right of Texture File.. | | Clipboard Online..

and click the Blue tissue paper texture. Texture -

g. Format the axes and gridlines as follows:

1. Onthe Chart Format tab, in the Current Selection group, click the arrow,
select Vertical (Value) Axis, and click Format Selection.

2. Click the paint bucket |<*3| change the Line color to purple and make the
width 3 pt.

3. Follow the same procedure to format the Horizontal (Value) Axis line
to 3 pt purple.

4. On the Chart Format tab, in the Current Selection group, click the arrow,
select Vertical (Value) Axis Major Gridlines, and click Format Selection.

Click the paint can and change the Color to dark gray and the Width to 2 pt.

Format Major Gridlines ~
Major Gridline Options ~

&

4 |line
Mo line
* Solid line

Gradient line

Automatic

Color &y -

Transparency | 0%

Width 2 pt
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5. Use the same procedure to make these changes:
* Make the Vertical (Value) Axis Minor Gridlines 0.5 pt dark gray.
* Make the Horizontal (Value) Axis Major Gridlines 2 pt dark gray.
+ Make the Horizontal (Value) Axis Minor Gridlines 0.5 pt dark gray.

River Depth vs. Distance From West Bank

25.0

20.0 ®

,_.
o
=}

Depth (feet)

-
o
=]
| J

5.0

00 @ @

0 20 40 60 80 100 120

Distance From West Bank (feet)

h. Have Excel calculate and insert a trend line by doing the following:

1. If necessary, click inside the chart to show the Chart Elements button
(green cross). Click the arrow next to Trendline and select More Options.

Mac: Click the Chart Design tab, click the Add Chart Element arrow, select
Trendline, and select More Options.

If it is not already selected, click ||| to open the Trendline Options
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2. Notice how most of the points of the graph look like they would fall on an
upside down parabola. So, you will try a mathematical model whose graph
Is a parabola. To do this, if necessary, click the Trendline Options triangle
to open its menu and select More options to open the Format Trendline
pane. Click the three vertical columns to open the Trendline Options.

S K" CHART ELEMENTS Format Trendline
y fxes Trendline Options
& Axis Titles _
¥ Chart Title @ 7 0
[ ] DataLabels
L] ErrorBars 4 Trendline Options
Gridlines
] Legend Exponential
[] Trendline b Linear .
| Linear

Linear Farecast

Two Period Maving Average | Logarithmic
More Options.. | ® Polynomial Order

Click the button next to Polynomial. Confirm that the Order is set to 2.

Excel uses a mathematical technique called polynomial regression to
create the second degree (quadratic) polynomial that best describes the
data. The graph of the equation is a parabola. You will study regression
when you take a statistics course.

3. Check the box next to Display Equation on chart.

4. Check the box next to Display R-squared value on chart. This value
gives an idea of how well the mathematical model describes the data. The
optimal value is R2 = 1, which indicates a perfect fit.

The actual data points are represented by the red dots and the
mathematical model calculated by Excel is represented by the trendline.
The displayed R2 value, 0.9919, indicates that the mathematical model fits
the data very well.

5. Click the Fill & Line paint bucket @ and change the trendline color to
dark red, the Width to 3 pt, and the Dash type to solid.

s -0.0082x} + 0.8209x + 0.144 b

2]
20 R*=0.9919 100

6. Save your file.
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i. Different mathematical models will fit the data more or less precisely. To see
this, do the following:

. Format Trendline
1. Make a copy of the River Depth Chart chartsheet. . .
To do this, right-click the chartsheet name, select Trendline Options ¥
Move or Copy, click Create a copy, and click OK. & |||
Double-click the new chart name, River Depth
Chart (2), type River Depth and Temp Chart, and
then tap Enter. 4 Trendline Options

2. Be sure Series “Depth” Trendlinel is selected
and click Format Selection.

#* |inear

Change the Trendline to Linear.

You may have to move the equation so you can see it more easily.

River Depth vs. Distance From West Bank
25.0 s
T
20.0 ®
L
L
L
c 15.0
o
]
e
's Oy =-0.0235x ¥ 12569o
% - R*=0.0101
Q w0 ® —
®
5.0
0.0 @ @
0 20 40 60 80 100 120
Distance From West Bank (feet)

The shape of the trendline changed to a straight line, the mathematical
model now has only two terms, and the R2 value of 0.0101 indicates that this
new model does not fit the data very well, which is obvious from the graph.
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3. Change the Trendline to Polynomial and change the Order to 6.

Notice how the shape of the trendline has changed to a more complex
curve that better follows the flow of the data, the displayed equation has
more terms, and the displayed R2 value of 0.9985 indicates that this new
model fits the data even better than the quadratic model. There is an
obvious trade-off here: when the model is more complex it generally fits the
data better, but it also may be more difficult to work with.

4. Click the equation textbox.
* Change the font to dark red 9 pt Arial Black.
» Make the fill of the textbox white.

+ Click inside the box and, just to the right of R2 = 0.9919, type a space,
and then type where y is Depth and x is Distance from West Bank.

Mac: Select the Series “Depth” Trendline 1 Equation. Point to the very edge of
the textbox, right-click, and select Edit Text. | found this tricky on my Mac so
if you cannot get it to work just leave it out.

X
|y = 2E-09x°® - 6E-07X5 + TE-05x% - 0.0037x® + 0.0778x2 + 0.1473x - 0.0165
R? = 0.9985 where y is Depth and x is Distance from West Bank

20 | 40 ! | 60 &0 (100

j. Do the following to add a second graph that shows how bottom temperature
varies from one side of the river to the other: 23

1. Click anywhere in the River Depth and Temp Chart.

2. Onthe Chart Design tab in the Data group click Select Data. EEU]
Legend Entries Select

3. Click the Add button. 7 Add Data

Mac: There is no Add button. Under the box labeled Legend entries (Series),
click the +

28 For Mac users, check out https://www.youtube.com/watch?v=99XaQFINf_Q
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4. Fill in the boxes as follows:
» For the Series name type Temperature.
* Next to the Series X values box, click the collapse dialog button. *

e Click the River Data worksheet and select A2:A9, which contains the
distance data. Notice how the location is inserted in the box.

Edit Series
='River Data'!$A$2:5A59 Edit Series ? X
Series name:
* Click the CO"apse dlalog button again. Temperature - Temperature
R i lues:
« For the Series Y values, follow Se:_“isat“f;mmg o0
='River Data'l H - =
the same procedure to select the _
Temperature data in C2:C9 on series Yvalues:
th F\P Dat ksh 't ='River Data"l$C$2:$C$0 2| -700 s
€ Rilver bata worksneet.
. . . -OK Cancel
+ Click OK and then click OK again.
River Depth vs. Distance From West Bank o
80.0 Vs
Y
70.0 ® 1
L]
60.0
L J
50.0 °
L 2
&
H
40.0
<
=
et
2 300
]
Q
20.0 -
10.0
y = 2E-09x® - 6E-07Xx* + 7E-05x4 - 0.0037x? + 0.0778x2 + 0.1473x - 0.0165
R? = 0.9985 where y is pth and x is Di from West Bank
T 0 20 40 60 80 ? 120
-10.0
Distance From West Bank (feet)
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k. Do the following to add a secondary vertical axis scale:

Mac: Instead of steps 1 through 5 below, do this:
* On the Chart Format tab, select Series Temperature.
» On the Chart Design tab click Change Chart Type.

* From the drop-down menu choose X Y (Scatter) and then Scatter with
Smooth Lines and Markers.

+ With Series Temperature still selected, click Format Pane.
» With the Series Options selected, click Secondary Axis.

1. Onthe Chart Design tab in the Type group click Change Chart Type.

2. Atthe bottom of the choices on the left, click | [fly Combao

3. Put a check in the Secondary Axis box next to the right of Temperature.

Choose the chart type and axis for your data series:
Series Name Chart Type Secondary Axis
| Cepth of the River [feet) Clustered Column e |:|
B Temperature Line w <—

Notice the graph types have automatically changed. Use the arrows to
select Scatter for the Depth and Scatter with smooth line and markers
for the Temperature.

Series Name Chart Type Secondary Axis
B Depth Scatter e ]
I Temperature Scatter with Smooth Lines... | ~

4. Click OK.

5. Onthe Chart Format tab, in the Current Selection group select Series
“Temperature” and click Format Selection.

Mac: Continue with Step 6 below.
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6.

Click the paint bucket, change the line color to blue and the Width to 3 pt.

25.0

20.0

i
3
o

Depth (feet)

5.0

0.0

5.0

River Depth vs. Distance From West Bank

80.0

b 70.0

50.0
40.0
30.0

y = 2E-09x® - 6E-07x5 + 7E-05x4 - 0.0037x® + 0.0778x2 + 0.1473x - 0.0165 20.0
J R? = 0.9985 where y is Depth and x is Distance from West Bank

0 20 40 60 80 100 120 100

0.0
Distance From West Bank (feet)

1.

Format the vertical and horizontal axes as follows:

On the Chart Format tab, in the Current Selection group, select Vertical
(Value) Axis, and click Format Selection.

In the Format Axis pane on the right, click the Axis Options icon |||

If necessary, click the triangle to the left of Axis Options to open its menu.
If necessary, under Bounds, change the Minimum to 0 and the Maximum
to 25.

If necessary, click the triangle to the left of Number to open its menu.

Under Category, select Number 4 Number
from the drop-down menu and set Category
the number of decimal places to O. -
MNumber =
Format the vertical axis numbers to _ -
dark red 10 pt Arial Black. Decimal places: | 0

Repeat this process to change the Horizontal (Value) Axis Minimum to O
and Maximum to 100. Also, under Number change the Category to
Number with 0 decimal places. Format the axis numbers to 10 pt Arial
Black. Leave the color as is.
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8. Repeat this process to change the Secondary Vertical (Value) Axis
Minimum to 0 and Maximum to 80. Also, under Number change the
Category to Number with O decimal places. Format the secondary vertical
axis numbers to blue 10 pt Arial Black.

Notice that the right scale numbers shown do not line up with the major
gridlines. It will make the graph look better if those numbers were to line up
with the major gridlines. Since the right vertical axis scale goes from 0 to 80
and there are 5 major gridlines, divide 80 by 5 to get 16.

So, change the Major Units to 16.

4 Aads Options
Bounds
Minimum 0.0 Auto
Maxirnurm 80.0 Auto
Units
Major 16.0 Reset

9. Click the Green Cross to open the Chart Elements menu, click the
triangle to the right of Axis Titles, and put a check next to Secondary

Vertical.
| L
4 CHART ELEMENTS _
t Options
Axes
o Auis Titles 3 Primary Horizontal
Chart Title Primary Vertical
Y [ ] Data Labels L] Secondary Horizontal
Secondary Vertical

10. Click the Secondary (Right) Vertical Axis title and type Bottom
Temperature (deg F). Make the font blue 14 pt Arial Black.

—
11. With the Right Vertical Axis title selected, click the Size and Properties icon [2
and, under Alignment Text direction, select Rotate all text 90°.

Format Axis Title v X
Title Options ¥  Text Options

4 Alignment

Vertical alignment Center Mid... ~

Text direction Rotate all t.. | =

ABC | Horizontal

=
g Rotate all text 90°
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12. Make the left vertical axis title Depth (feet) dark red.

River Depth vs. Distance From West Bank
25 80

20 54'.,'
[
=
=]
3

= =
T 15 a8 ©
0 3
A= °
= (1]
= 3
o -
® 10 32 €
- o
_—
e
(1]
Q@

5 16 oy

-

y = 2E-09x® - 6E-07x° + 7E-05x4 - 0.0037x3 + 0.0778x2 + 0.1473x - 0.0165
R2? = 0.9985 where y is Depth and x is Distance from West Bank

0 10 20 30 40 50 60 70 80 20 100
Distance From West Bank (feet)

The two graphs show that the depth and temperature are inversely related.
That is, as you go from the shore to the middle of the river the depth
increases while the temperature decreases.

m. Color code the graphs, equation, and labels to make it easier to distinguish
them by doing the following:

1. Click the title and change it to River Depth and Bottom Temperature
vs. Distance From West Bank.

2. In the title, select the word Depth and make its color dark red.

Mac: | don’t think you can change individual words on a Mac so skip it.

3. Inthe title, select the Bottom Temperature and make its color blue.

4. Center the equation textbox just above the horizontal axis.

n. Set up the River Depth and Temp Chart chartsheet to print in Landscape
orientation and include a footer that contains the file name on the left and the
sheet name on the right. Compare the preview with the key. Make needed
corrections, save the workbook, and close it.
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HWO05-2 Loans IF
Problem: How can you determine if a loan payment is overdue?

The worksheet you develop for this problem will determine if a loan payment is more
than 30 days past due and, if so, it will calculate the number of days it is overdue.
This project and the next two will give you more experience in working with the IF
function, which you used to calculate regular and overtime pay on page SG64.

a. Open the workbook HWO05-2 Loans IF Original, which is one of the files you
downloaded at the start of the term.

b. Save the workbook using the name HWO05-2 HWID Loans IF Done
c. As you did on page SG66, create a named range for cell B3. Call it Today.

d. For cells D7:D10, construct a formula that uses the IF function to display the
word OVERDUE if the payment is more than 30 days overdue. Here is the form:

=IF(logical test, value if true, value if false)
To help you write the IF function, consider the following three parts:

Logical test — how will Excel choose between the two possibilities (to display
the word OVERDUE or to display a blank)? The difference of Today's Date
and the Due Date must be greater than 30. Write this inequality as you
would in algebra using cell references instead of variables.

Value if true — if the Logical test is true, what should be displayed?
You want to display the word OVERDUE. You must put OVERDUE inside
quotation marks or Excel will think it is a special function or a named range
(see page SG66) and not know what to do with it.

Value if false — if the Logical test is false, what should be displayed?
You want to display a blank so you must type two sets of double quotation
marks next to each other, like this "". This is called a null string since it
contains nothing (it is null).

In the space below, write the IF statement for D7:

display if display if
logical test condition condition
(condition) TRUE FALSE
=IF( ’ ’ )
is difference the word " (null string)

in dates more "OVERDUE"
than 30?
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1. Once you have constructed the formula, type it in =
D7 and then fill down to D10. After you fill, be sure Copy Cells
to click the arrow on the Auto Fill Options button o
and select Fill Without Formatting to preserve
the original formatting of the cells. If you do not,
the bottom border of D10 will be incorrect.

Fill Fermatting Only
O Fill Without Formatting
©  FlashFill

1 Loan Payments

2

<3 Today's Date: 13 Jul 2023 |

4 More than

5 30 days Number of
6 Loan Due Date Amount overdue days overdue
a Boat 11 Jun 2023 $450.00 OVERDUE 32

8 Car 30 Jun 2023 $520.00

9 | Home 04 Jul 2023 $980.00

il Student 24 May 2023 $300.00 #VALUE! 50

11 =

Notice the #VALUE! error in D10. When you filled down the formula, Excel
changed the row numbers in the formula one at a time. That is, B7 became
B8, and then B8 became B9, and so on. That is what you want. However,
Excel also changed B3 to B4, and then B4 to B5 and so on. That is NOT
what you want because Today's Date is in B3 and so B3 should remain
B3 in all the formulas.

To tell Excel to keep B3 the same use an absolute reference. So, in D7
change B3 to B$3. The $ to the left of 3 means to keep that row number
constant (absolute) when you fill down. Note that you also could use $B$3
but since you are not copying left or right the B will not change anyway.

2. Correct the formula in D7 and fill down, again preserving the formatting.

3. Check D7. It should display OVERDUE since Today’s Date, 13 Jul 2023 is
more than 30 days after the Due Date, 11 Jun 2023.

4. Check D8. It should be blank since Today’s Date, 13 Jul 2023 is only 14
days after the Due Date, 30 Jun 2023.

e. For cells E7:E10, construct a formula that will display the number of days the
loan is overdue, if it is, or a blank, if it is not overdue. These formulas will be
almost the same as the formulas in cells D7:D10 but in place of "OVERDUE"
have Excel calculate the actual difference in dates by subtracting them.
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In your formula, use the named range Today rather than B$3. Using a named
range means you need not worry about absolute referencing and it makes the
formula a bit easier to understand: =IF(Today-B7>30,Today-B7,"") The value
in E7 should be 32.

Fill the formula in E7 down to E10 and preserve the format.

f. Set up the Loan Data worksheet to print in Landscape orientation, all on one
page, centered horizontally but not vertically, and include a footer that contains
the file name on the left and the sheet name on the right. Compare the preview
with the key. Make needed corrections, save the workbook, and close it.

HWO05-3 Rent IF
Problem: How can you determine which of two rates should be applied to rental properties?

The worksheet you develop for this problem will determine the payment that is
due for renting floor space in a mall. In this situation, there are two possible rates:
a low, introductory rate of $5.00 per square foot for clients that have been renting
for under a year, and a regular rate of $9.00 per square foot for older clients. To
make the formulas easier to understand, you will use several named ranges.

a. Open the workbook HW05-3 Rent IF Original, which is one of the files you
downloaded at the start of the term.

b. Save the workbook as HW05-3 HWID Rent IF Done

c. In order to make the formulas easier to read, create several named ranges by
doing the following:

1. Click B3 and create a named range called Today. A Today .
quick way to do this is to click B3 and then type Today @
in the name box (on the left side of the formula bar)

and tap Enter.

2. Click B6 and create a named range called NormRateB.
3. Click B7 and create a named range called IntroRateB.

4. Create a named range called Space for B10:B20. This is similar to
creating a single cell named range except that you first select several cells.

5. Create a named range called PayDue for D10:D20.

6. On the Formulas tab, in the Defined Names group, click Name Manager.
You will see listed the named ranges you just created.
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Name Manager

New... Edit... Delete
Name Value Refers To Scope
::EélntroRateB =Data!$B$7 Workbook
@NormRateB 9 =Data'$B%6 Workbook
@PayDue {remm e =Data!$D$10:3D%20 Workbook
@Space {"5000%"1500%"800%"... =Data!$B$10:38%$20 Workbook
@Today 11 Jul 2022 =Data'$B%3 Workbook

Click Close to close the Name Manager dialog box.

d. For cells D10:D20, construct a formula that displays the payment for renting
floor space. The condition in the IF function should test to see if the difference
of Today's Date and the Initial Date is greater than 365 (that is, one year). If it
is, the payment is calculated by multiplying the Floor Space by the Normal
Rate (in B6); otherwise, the payment is calculated by multiplying the Floor
Space by the Introductory Rate (in B7).

To help you write the IF function, consider the following three parts:

Logical test — how will Excel choose between the two possibilities (what
criteria will Excel use to choose between the formula that uses the Normal
Rate or the Introductory Rate)?

Value if true — if the Logical test is true, what should be displayed (which
formula should be used)?

Value if false — if the Logical test is false, what should be displayed (which
formula should be used)?

1. Once you have constructed the formula, type it into D10. Use the named
ranges in your formula. If you do not use the names ranges, then you must
use absolute references (the $) where appropriate. 4

2. Check D10. The Initial Date, 10 Oct 2015 is more than 365 days
from Today’s Date, 11 July 2023, so the payment should use the
Normal Rate: 9*5000 = 45000.

3. If your formula displays 45000, fill it down to D20, preserving the format.
Otherwise, fix it.

4. Check the value in D11. The difference between Today’s Date and the
Initial Date is less than 365 so the Introductory Rate should be used:
5*1500 = 7500. If that does not check, look at your formula. Did you put in
absolute referencing for the cells that should not change (B3, B6, and B7)?
If you used the name ranges for these cells, then the absolute referencing is
automatic. If you used the cell reference, such as B3, then you must add a $
between the B and the 3 to indicate that the 3 is to remain constant
(absolute) when you fill down. In that case, the cell reference would be B$3.

24 z|F(Today-C10>365,B10*NormRateB,B10*IntroRateB) or =IF(B$3-C10>365,B10*B$6,B10*B7)
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5. Format the dollar amounts in D10:D20 as currency with two decimal places and
the dollar sign (e.g., $45,000.00).

e. The rates in B6 and B7 are given using dollars per square foot rather than
dollars per square meter. The U.S., Liberia, and Myanmar are the only
countries in the world that still use the antiquated British Imperial measurement
system. All other countries use the Metric system 2,

Use the CONVERT function to see what the Metric values of the rates are. This
function has the form: CONVERT(number,from_unit,to_unit). The from_unit
and to_unit are codes that Excel requires. For example, the square foot code
is “ft2” and the square meter code is “m2”. 26 Do the following:

1. Incell C6, type
=NormRateB/convert(1,"ft2","m2"). Here, the
normal rate in B6 is divided by the conversion of
one square foot to square meters.

Metric System
96.87519375
53.81955208

2. Enter a similar formula in C7.

f. Apply some custom formats to several cells by doing the following:

1. Select cells B6:B7, right-click B6, select Format Cells, click the Number
tab, and click Custom. The shortcut for displaying Format Cells is Ctrl + 1.

2. Change the text in the Type box to $#.00" per sq. ft." (the quotation marks
are needed) and then click OK.

$ says to display the dollar sign.

#.00 is a place holder that says to display the number, rounded to two
decimal places.

" per sq. ft." says to display the text between the quotation marks exactly
as it is shown.

3. Select cells C6:C7 and follow the same procedure to apply this custom
format: $#.00" per sq. m." Cell C6 should display $96.88 per sq. m.

4. Select cells B10:B20 and follow the same procedure to apply this custom
format: ####" sq. ft." Cell B10 should display 5,000 sq. ft.

#,##H## says to display the number with a comma if the number is over one
thousand.

" sq. ft." says to display text between quotation marks exactly as it is shown.

25 The Metric System of measurement was developed in the 1790’s in France. The official name for
this system today is the International System of Units (SI). Although most U.S. citizens are ignorant
of this system, it is used by many institutions in the U.S. including science, medicine, electronics,
the military, automobile production and repair, and international affairs. Thomas Jefferson was the
one who decided to use the British system. The U.S. does not convert because it would cost a lot of
money in the short term, although it would save a lot more money in the long term.

26 To see a list of CONVERT codes, tap F1 and type convert in the search box.
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i. In D21, insert a formula that uses a named range and calculates the Total
Payment Due for all companies by doing the following:

1. In D21, use the SUM function to find the sum of all payments due. To do
that, type =sum(paydue) and tap Enter.

2. Format the dollar amount in D21 as currency with two decimal places and
the dollar sign.

J. Set up a conditional format so that the rows of the companies whose payments
are less than $8,000 have a light orange fill. To do that, Select A10:D20 since
that is where you want the formatting to appear. On the Home tab, in the
Styles group, click Conditional Formatting, New Rule, Use a formula, and
type =$d10<8000. Note the use of the dollar sign to indicate an absolute
reference. Finally, click Format, Fill and choose light orange.

Mac: Click the plus sign inside a box| + |in lower left corner. From Style select Classic.

k. In D23, enter a formula that displays the number of payments that are less
than $8,000. Here, you are counting something so use the COUNTIF
function. If you forget the form, type =countif( and a _
ScreenTip will remind you. If you have an internet [ =countif(_]
connection, you can click the underlined blue
COUNTIF for a more extensive explanation.

| COUNTIF(range, criteria) |

1. Type your formula. Remember to use quotation marks around the condition. 2’

2. Check your answer. The second and third payments are less than $8,000
so the number should be 2.

3. Format the value as a number with zero decimal places.

l. In D24, display the sum of the payments that are less than $8,000.
1. Type your formula. Here, you are finding a sum so use the SUMIFS function. 28

2. Check your answer. The second and third payments are less than $8,000
(these should be highlighted in light orange). So, the sum should be $7,500
+ $7,200 = $14,700.

3. Format the value as currency with two decimal places and the dollar sign.

m. In D25, display the sum of payments where the floor space is less than 2,200.

1. Type your formula. Here, you are finding a sum so use the SUMIFS
function. Note that the range where the criterion is checked (B10:B20) is
different from the sum_range that you will sum (D10:D20). ?°

27 =COUNTIF(PayDue,"<8000") For the condition, you could also use “<$8,000”

28 =SUMIFS(PayDue,PayDue,"<8000") For the condition, you could also use “<$8,000”

29 =SUMIFS(PayDue,Space,"<2200") Note how the use of named ranges makes this formula easier
to understand..
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2. Check the result. The second, third, and fourth floor spaces are less than
2,200 so the sum of the payments for those should be $7,500 + $7,200 +
$10,000 = $24,700.

3. Format the value as currency with two decimal places and the dollar sign.
4. Left align cells D23:D25.

n. Set up a conditional format to highlight with yellow fill the rows of the
companies whose payments are over the average of all the payments. 3°

A quick way to check that what you have is correct, is to select D10:D20 and
look at the status bar at the bottom of the window.

Average: $70,209.09 Count 11 Sum: $772,300.00

This shows the average of the selected cells is $70,209.09. A quick glance at
the Payments Due confirms that Cub, Gertins, and Menards have Payments
Due over this amount while all the other companies do not.

0. Remove the words inside parentheses in column A. To do this quickly, use
Excel’s Find and Replace feature and wildcards. Wildcards are symbols that
take the place of one or several characters. Do the following:

1. Select A10:A20.

2. Tap Ctrl + h (Shift + Command + h on Mac) to open the Find and
Replace dialog box.

The Find what box tells Excel what you are looking for. If you were to enter
(Outdoors) and click the Find Next button, Excel would highlight cell A10. You
could then delete (Outdoors). Don’t do this because you want to delete ALL
instances of words and their surrounding parentheses in A10:A20.

3. Inthe Find what box, type (*). The asterisk * is a wildcard that takes the
place of ANY string of characters. Leave the Replace with box empty
because you want to replace the parentheses and characters with nothing;
that is, you want to delete them.

i Company Find and Replace
Wil Lisa's Camping Supply (Qutdoors)

BN Badtke Burger Barn (Fast Food) Find Replace

W24 Brainiac Books (Books) ind what ” »
(&8 Know It All Notions (Miscellaneous) -
A Panera (Food) Replace with:
WEN Cub (Groceries)

Wl Gertins (Gardening)

l LE SR (Blg BOX) eplace All eplace ind all ind Ne lose

EE) Mary's Malts (Food) eplace 4 ep A ¢

Wkl Stamp House (Hobby)
Trainworld (Hobby)

Options >>

30 Select A10:F20 since that is where you want the formatting to appear. Click Conditional
Formatting, New Rule, Use a formula, and type =$d10>average($d$10:$d$20) Note the use of
the dollar signs to indicate absolute references. Finally, click Format, Fill.
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4. Click the Replace All button. Excel tells you it has made 11 replacements.
Click OK. All the parentheses and words inside them are deleted.

5. Close the Find and Replace dialog box.

The two most useful wildcards in Excel are the asterisk and the question mark. 3!

* asterisk represents any number of characters. For example
ch* matches any text string that begins with ch such as Charles, check, and chess.
*ch matches any text string that ends with ch such as March, inch, and fetch.

*ch* matches any text string that contains ch in any position such as Chad,
headache, and arch.

? question mark represents any single character. For example:
pri?e matches price, pride, and prize.

with a hyphen such as ABC-DEF, ABC-123, and 111-222.

p. Set up the Rent IF Data worksheet to print in Landscape orientation, all on one
page, centered horizontally but not vertically and include a footer that contains
the file name on the left and the sheet name on the right. Compare the preview
with the key. Make needed corrections, save the workbook and close it.

HWO05-4 Commission IF

Problem: How can you determine an employee's commission, total pay, and target
pay based on their sales record?

a. Open the workbook HW05-4 Commission IF Original, which is one of the files
you downloaded at the start of the term.

b. Save the workbook using the name HW05-4 HWID Commission IF Done

c. In D4, enter a formula that will calculate Sherri’s hardware commission. Use the
following rules to construct the formula:

+ If an employee sells up to and including $20,000 worth of hardware, she
earns a hardware commission of 10% of her hardware sales. For example,
Mary will earn 10% of $13,500, which is $1,350.

+ If an employee sells more than $20,000 worth of hardware, she earns a
hardware commission of 10% of $20,000 plus 12% of the amount that her
hardware sales were over $20,000. For example, Sherri will earn 10% of
$20,000 plus 12% of $3,000, which is $2,000 + $360 = $2,360.

31 This information is from https://www.ablebits.com/office-addins-blog/2020/10/14/excel-wildcard-
find-replace-filter-formulas/ It has lots more information on wildcards.
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https://www.ablebits.com/office-addins-blog/2020/10/14/excel-wildcard-find-replace-filter-formulas/
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Basically, you want to use the IF function to select between two formulas: one
that calculates the commission if the hardware sales are $20,000 or less and

the other if the sales are over $20,000. This commission problem is similar to

the overtime pay problem described in Project HW03-4 on page SG62.

Here is the basic formula setup.

display if display if
logical test condition condition
(condition) TRUE FALSE
=IF( ’ ’ )
is Hardeware Sales 10% times 10% times 20000
20000 or less? Hardware Sales +12% of excess

To find the sales over $20,000, subtract 20000 from the Hardware Sales (so
Sherri would be 3000). Be sure to put that in parentheses so Excel does the
subtraction before the multiplication by 12%.

1. Type your formula in D4 and tap Enter. Do you need to use absolute or
relative references? Absolute, which uses the $, says to NOT change any
row numbers when you fill down. Relative says to change row numbers. 32

2. Check the result. Sherri's Hardware Sales were 23,000. So, her
commission should be 10%*20,000 + 12%%*3,000 = 2,360.

3. Fill D4 down to row 80 and preserve the format. Check the result for Mary
in D5. Her Hardware Sales were 13,500 so her commission should be
10%*13,500 = 1,350.

d. Click E4 and enter an Excel formula to calculate the software commission. An
employee earns 8% on software sales. You do not need an IF function here
because there is no decision to be made—every software commission is
calculated in the same way.

e. Click F4 and enter an Excel formula to calculate the total commission (the sum
of the Hardware Commission and the Software Commission).

f. Click G4 and enter an Excel formula to calculate the Total Earnings for Sherri.
Employees earn a base salary plus their Total Commission. The base salary
is calculated as follows:
$10,000 if the Total Commission is $1,200 or less;
$11,000 if the Total Commission is between $1,200 and $1,400;
$12,000 if the Total Commission is $1,400 or over.

Follow the directions below to do this calculation using “nested” IF formulas.

You use nested IF logic in your daily life. For example, when you approach a
traffic signal while driving your car:

32 =|F(B4<=20000,10%%*B4,10%*20000+12%*(B4-20000))
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IF green light THEN keep going, ELSE
IF red light THEN stop ELSE
the light is yellow so speed up or slow down depending on how far you
are from the light.
For this problem the logic will go like this:
IF Total Commission <= 1200 THEN 10000 + Total Commission ELSE
IF Total Commission < 1400 THEN 11000 + Total Commission ELSE
12000 + Total Commission
When you write your Excel formula, you will use the cell reference for Total
Commission (F4 for Sherri) rather than the words, and commas instead of

THEN and ELSE. If your version of Excel has the IFS function you could use
that instead of nested IF, but the logic will be the same.

Do the following:

1. Type your formula in G4 and tap Enter. Do NOT put commas in the
numbers in the formula (that is, type 1200 as1200 and not 1,200). Excel
considers commas delimiters (separators) between parts of a formula and
the commas will cause an error message.

THEN ELSE THEN ELSE
=IF| F4<=1200 , 10000+F4 , IF| F4<1400 , 11000+F4 , 12000+F4
| —_———
Condition 1 Condition 2 ﬂ

4

Here is the formula using IFS: Default value is 12009 + F4

THEN ELSE THEN ELSE THEN\
=IFS| F4<=1200 , 10000+F4 , F4<1400 , 11000+F4 , F4>=1400 , 12000+F4
N—_— — —
Condition 1 Condition 2 Condition 3

2. Check the result. Sherri's Total Commission is 2,424. Since this is over
1,400 her base will be 12,000. So, her Total Earnings should be 12,000 +
2,424, which is 14,424.

3. Fill E4:G4 down to row 80 and preserve the formatting.

Check the result for Mary in G5. Her Total Commission is 1,390, which is
between 1,200 and 1,400, so her base is 11,000. Her Total Earnings
should be 11,000 + 1,390, which is 12,390.

Check the result for Monica in G8. Her Total Commission is 970.24,
which is less than 1,200, so her base is 10,000. Her Total Earnings
should be 10,000 + 970.24, which is 10,970.24.

g. In cells B81:G81, enter formulas for the Totals of columns B:G.
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h. In cells B82:G82, enter the formulas for the Averages of columns B:G.

i. Perform a Goal Seek for Lawrence to see what his Hardware Sales would
have to be to make his Total Earnings $15,000 (Data, Forecast, What-If,
Goal Seek). The answer is $28,200.00

Click B6 and insert a note that says Used Goal Seek here (right-click, New Note).

< Mary $ 13,500.00 +’]Douglas F. Roherm:;r?:n
B Lawrence $ 28,200.00 ' {ysed Goal Seek here.
[& Brady $ 75,192.00 960.

j. Set up a conditional format to highlight the high performers by making the cell fill
for Employee names and data yellow if their Total Earnings is over $20,000.33

k. Split the worksheet below row 10 (View, Split) and adjust things so you can
see the top and bottom rows.

1 MicroMania, Inc., Sales and Earnings Summary
2

Employee Hardware Sales | Software Sales Hard\:fvar.e Softv.var.e Toi.:al . Total Earnings
3 Commission Commission Commission
E8Sherri $ 23,000.00 | $ 800.00 | $ 2,360.00 | $ 64.00 % 2,424.00 $ 14,424.00
(20 Mary 3 13,500.00 QDougIas Ro;;‘%g_ $ 1,350.00 | § 40.00 §$ 1,390.00 $ 12,390.00
(S8 Lawrence $ 28,200.00 ' |\jced Goal Seek here. | 3 2,984.00 ' $ 16.00 $ 3,000.00 $ 15,000.00
{4 Brady $ 75,192.00 gouuu; $ 8,623.04 | $ 76.80 $ 8,699.84 $ 20,699.84
3 Monica 3 9,500.00 | § 253.00 | $ 950.00 | $ 2024 % 970.24 ' $ 10,970.24
B Jezebel $ 79,944.00 | $ 91900 | $ 9,193.28 ' § 7352 $ 9,266.80 $ 21,266.80
L'} Abigail $ 31,013.00 | $ 112001 % 3,32156 | § 8.96 $ 3,33052  § 15,330.52
g4 Sean $ 98,630.00  $ 810.00 . $ 11,435.60 . $ 6480 § 11,500.40 $ 23,500.40
78 [VEYS $ 62,357.00 | $ 958.00 ' $ 7,082.84 ' $ 7664 % 7,159.48 § 19,159.48
el Amy $ 33,883.00 | $ 974001 $ 3,665.96 | $ 7792 § 3,743.88 $ 15,743.88
)8 Jessica 3 58,418.00 | $ 388.00 i $ 6,610.16 | § 31.04 % 6,641.20 $ 18,641.20
il Totals $ 4,050,169.00 : $ 44,539.00 : § 456,120.06 ; $ 3,563.12 $ 459,683.18 $ 1,378,683.18
78 Averages $ 52,599.60  $ 578.43 | $ 5923.64 $ 46.27 $ 5,969.91 $ 17,904.98

|. Do the following to print the worksheet:
1. Remove the split screen.

2. Hide rows 11 through 75 as you did on page SG52.

Do NOT go to the View tab, Window group, and click Hide. | [IHide

That will hide the entire workbook! If you do that, click Unhide | /] ynhide
to get the window back.

3. Setthe Print Areato A1:G82.

33 Select A4:G80 since that is where you want the formatting to appear. Click Conditional
Formatting, New Rule, Use a formula to determine which cells to format, =$G4>20000,
Format, Fill.
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4. Set up the Commission IF Sales Data worksheet to print in Landscape
orientation, all on one page, centered horizontally but not vertically and
include a footer that contains the file name on the left and the sheet name
on the right. Set the note to print (Page Layout, Page Setup, Sheet,
Comments and notes, As displayed on sheet). Compare the preview
with the key. Make needed corrections, save the workbook, and close it.

HWO05-5 Sorting Values

Problem: How can you create summary information on home values and then
display particular values based on certain conditions?

a. Open the workbook HWO05-5 Sorting Values Original, which is one of the files
you downloaded at the start of the term.

b. Save the workbook using the name HW05-5 HWID Sorting Values Done.

c. Freeze the pane so that rows 1 and 2 are always on the screen (select row 3,
then View, Window, Freeze Panes, Freeze Panes).

d. Number the addresses by doing the following:

1. In B3, to display the row number of the cell, type =row() click the Enter
checkbox. The number 3 is displayed.

2. Change B3 to =row()-2 and tap Enter. The number 1 is displayed. This is
the first entry in the list. Later, when you sort the rows, the number 1 will
remain in B3 indicating that there is a new number 1 in the list.

3. Fill the formula down to B15 preserving the format. You can see that there
are 13 items in the list.

e. Often, it is useful to be able to distinguish between cells that contain formulas
and those that contain labels or raw data. To see how this works, do the
following:

4A B
1. Click the Select All triangle in the upper left corner of the worksheet. _

2. On the Home tab, in the Styles group, click Conditional Formatting, and
select New Rule.

Mac: From Style: select Classic.

3. Select Use aformula to determine which cells to format.

4. Type this into the formula box: =isformula(al). This is true if a cell contains
a formula (that is, it begins with an = sign). While the formula indicates only
cell A1, it will apply to all the cells of the worksheet because you selected
all the cells before Conditional Formatting.

5. Click Format and set the font color to dark red.

6. Click OK three times. The numbers in cells B3:B15 now are red.
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f. Create additional summary information by doing the following:

1.

In C17, enter a formula that will display the number of houses that have a
Cable TV Hookup. Check the result. 34

In C18, enter a formula that will display the number of properties that are
over 1 acre in size and whose Property Taxes is under $2,100. Check
the result. 3

In C19, enter a formula that will display the sum of the Property Taxes for
lots that are over one acre.®® Check the result. A quick way of checking is
to click the Property Tax of home 2, hold down the Ctrl key, and then click
the Property Taxes of homes 4, 9, and 10. Now, look in the bottom right
corner of the window, on the Status Bar, and you can see the SUM of the
selected cells is $8,724.00.

| Average: $2,181.00 Count:4 Sum: $8,724.00 |

In C20, enter a formula that will display the sum of the Estimated Value of
the properties whose Lot Size is over 1 acre in size and that do not have
Cable TV Hookup. Check the result. 37

In C21, type Click here to open Zillow.com to see more home values.
Click the Enter checkbox to keep C21 active.

With C21 still active, tap Ctrl + k. This is the shortcut for Insert Hyperlink.
You can also click Hyperlink on the Insert tab.

Near the bottom of the Insert Hyperlink dialog box, in the Address box,
type the URL for Zillow: http://www.zillow.com/

Address: http://www.zillow.com/

Click OK. The hyperlink is created and the style for the URL is
automatically set to Hyperlink (underlined blue text).

Point to (do NOT click) C21 to see the hyperlink.

Click here to open Zillbw.com to see more home values
22 http://www.zillow.com/ - Click once to

follow. Click and hold to select this

cell.

%4 You are counting the number of houses based on a condition so use =COUNTIF(G3:G15,"Yes")

35 You are counting the number of houses based on two conditions so use
=COUNTIFS(F3:F15,">1" E3:E15,"<2100")

36 You are looking for a sum with certain conditions so use =SUMIFS(E3:E15,F3:F15,">1")

37 =SUMIFS(D3:D15,F3:F15,">1",G3:G15,"No")
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10. Click cell C21 and your web browser will open and take you to the web site.
Just for fun, if you wish, type your home address and Zillow will show you
its estimated value. Here is what you will see if you type 1600
Pennsylvania Ave NW, Washington, DC 20006. This is the White House,
valued at about $459 million. Note the 35 bathrooms!

~

2 Zillow Z Edit Q

s
[EET
B

I I l l ' 16bd 35ba 55,000 sqft

i
?__1 1600 Pennsylvania Ave NW, Washington, DC 20500
X

Off market Zestimate®: $455,695,100 Rent Ze}

11. Close the web browser.

If you want to select the cell that contains the hyperlink, point to it and hold
down the left mouse button for 3 seconds. That selects the cell without
activating the link.

If you want to remove the link, select the cell, tap Ctrl + k, and the click the
Remove Link button.

g. In Project 1 you used Boolean Operators when searching for files that
contained specific words. Those operators, AND, OR, and NOT can be
used in IF functions. To see how this works, do the following:

1. Click H3. You want to create a formula that will determine which homes
have a small lot AND cable TV. To do that you can use the AND operator
inside an IF formula.

Type =if(and(f3<1,g3="Yes"),"Yes","No") and click the Enter checkbox.
Here, the AND function requires that both conditions be met. That is, F3,
the Lot Size, must be less than 1 and also G3, Cable TV Hookup, must
be Yes. If either is not true, then the condition is not true.

Check the result. The Lot Size for the first home is 0.80, which is
less than 1, AND the Cable TV Hookup is Yes so the result should
be Yes.

Note that you can also do this with nested IF functions:
=IF(F3<1,IF(G3="Yes","Yes","No"),"No")

2. Fill the formula down to row 15 and preserve the format. Check the
result for the second home. It's Lot Size is 1.20, which is greater than 1,
and the Cable TV Hookup is Yes. Since one of the two conditions is not
true, the entire condition is not true and so H4 displays No.

3. Click I3. Create a formula that determines which homes have a small lot OR
cable TV. To do that you can use the OR operator inside an IF formula.

Type =if(or(f3<1,9g3="Yes"),"Yes","No") and click the Enter checkbox.
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Here, the OR function requires that either condition be met. That is, F3,
the Lot Size, must be less than 1 OR G3, Cable TV Hookup, must be
Yes. If both are not true then the condition is not true.

Check the result. The Lot Size for the first home is 0.80, which is less than 1,
and the Cable TV Hookup is Yes so, the result should be Yes.

Note that you can also do this with nested IF functions:
=IF(F3<1,"Yes",IF(G3="Yes","Yes","No"))

4. Fill the formula down to H15 and preserve the format. Check the
result for the second home. It's Lot Size in 1.20, which is greater than
1 so that does not match. But, the Cable TV Hookup is Yes and that
does match. So, it meets at least one of the conditions and so 14
displays Yes.

For the fourth home, the lot size is over 1 and there is no cable. Since
neither condition is true the entire condition is false and a blank is displayed.

h. Do the following to filter the data in the table so that only rows with the
Property Tax between 1500 and 2100, inclusive, are displayed:

1. Select the range B2:12

2. Onthe Home tab, in the Editing group, click Sort & Filter, and select
Filter. This puts little upside down triangles in row 2.

4A B C D E F €] H I
Home Values
Estimated | Property | Lot Size @ Cable TV = Small Lot | Small Lot |
P Nu ~ Address ~ Value ~ Tax |~ (acre)| - Hookup - with Cab ~: or Cabl¢ - |
1 11457 Via Colinas $ 252 467 i $ 1,969.00 0.80 Yes Yes Yes

3. Click the triangle in E2, select Number Filters, and select Between.

2] Sort Smallest to Largest 0.80 Yes
El Sort Largest to Smallest 1.20 Yes
Sort by Color 3 0.94 Yes
1.12 No
Filter by Color 3 0.90 No
noFn
Mumber Filters » Equals...
Search Fa) Does Mot Equal.
] [Select All) - Greater Than,
-] $390.00 - _
[+ §1,891,00 Greater Thafl Or Equal To..

-+ 51,969,00
-] $2,035.00
[+ 52,040,00
[+ 52,051.00 Between...

ol e omem o

m

Or Equal To...
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4. Enter 1500 and 2100 in the Custom Autofilter dialog box.

Custom AutoFilter

Show rows where:
Property Tax

is greater than or equalto |~ 1500

@and Oor
is less than or equal to b 2100
5. Click OK.

1 Home Values

Estimated | Property Lot Size Cable TV | Small Lot = Small Lot
2 Nu ~ Address v Value - Tax |- (acre)| ~: Hookup ~: with Cab - or Cabl¢ -
&) 1 1457 Via Colinas $ 252467 ' $ 1,969.00 0.80 Yes Yes Yes
6 4 23 Fourth Street $ 242467  $2,051.00 112 No No No
7 5 3579 Lake Avenue $ 252 467 ' $ 2,056.00 0.90 No No Yes
8 6 1458 Via Colinas $ 260,890  $2,035.00 0.70 Yes Yes Yes
11 9 3580 Lake Avenue $ 262,890  $ 1,891.00 1.05 No No No
15 13 22 Fourth Street $ 263,578 $ 1,969.00 0.82 Yes Yes Yes

Notice the triangle in E2 has changed to a funnel@ indicating that a filter
has been applied to the data below this column.

i. Do the following to sort the data in ascending order by Cable TV Hookup
status and then, within that, in descending order by Estimated Value.

1. Copy the Values Original worksheet and rename the new worksheet
Values Sorted.

2. Remove the filter so all rows show (Home, Editing, Sort & Filter, Filter).
The triangles disappear.

3. Select rows 2:15 (be sure to select the entire rows by clicking the row
numbers on the left).

4. On the Home tab, in the Editing group, click Sort & Filter, and then select
Custom Sort. Be sure My data has headers is checked.

5. Inthe Sort by drop-down menu, select Cable TV Hookup and confirm that
the Order is A to Z.

6. With the Sort dialog box still open, click Add Level.

Mac: Add Level, Delete Level, and Copy Level are in the lower left corner of the
Sort dialog box.

7. Inthe Then by section select Estimated Value and choose Largest to
Smallest from the drop-down menu under Order.
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Sort ? X
+ Add Level > Delete Level E@Qopy Level N Options... My data has headers
Column Sort On Order
Sortby | cable TV Hookup ~ | | cell values ~| |AtoZ w
Then by  Estimated Value £ Cell Values £ Largest to Smallest s

8. Click OK. The data are sorted by Cable TV Hookup with the No’s first,
and then the Yes’s. Within the No’s, the data are sorted by Estimated
Value in reverse numerical order. Likewise, within the Yes’s, the data are
sorted by Estimated Value in reverse numerical order.

Home Values

Estimated | Property Lot Size Cable TV | Small Lot = Small Lot

Num Address Value Tax (acre) Hookup | with Cable or Cable
1 24 Fourth Street $ 262,990 | $ 2,430.00 1.10 No No No
2 3580 Lake Avenue $ 262,890  $ 1,891.00 1.05 No No No
3 3578 Lake Avenue $ 261,578 $ 2,149.00 0.80 No No Yes
4 13579 Lake Avenue $ 252 467 $ 2,056.00 0.90 No No Yes
5 23 Fourth Street $ 242 467 | $ 2,051.00 1.12 No No No
6 25 Fourth Street $ 50,000  $2,313.00 0.95 No No Yes
7 1459 Via Colinas $ 301,582 $ 2,352.00 1.20 Yes No Yes
8 1460 Via Colinas $ 297,566 @ $ 2,321.00 0.97 Yes Yes Yes
9 3582 Lake Avenue $ 296566 $ 390.00 0.77 Yes Yes Yes
10 1461 Via Colinas $ 285456  $ 2,227.00 0.94 Yes Yes Yes
11 22 Fourth Street $ 263,578  $ 1,969.00 0.82 Yes Yes Yes
12 1458 Via Colinas $ 260,890  $ 2,035.00 0.70 Yes Yes Yes
13 1457 Via Colinas $ 252 467 | $ 1,969.00 0.80 Yes Yes Yes

Notice that the Num column is still in order but the numbers are assigned to
different houses. That is because rather than typing the numbers individually
you used the ROW() function to have them keyed to the row number.

j. Set up the Values Sorted worksheet to print in Portrait orientation, all on one
page, centered horizontally but not vertically and include a footer that
contains the file name on the left and the sheet name on the right. Compare
the preview with the key. Make needed corrections, save the workbook and
close it.
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HWO05-6 Gradebook with Macros

Problem: How can you create summary information and use macros to sort data
and to move about a worksheet?

Before the start of each semester, | download from the University’s database Excel
files that contain my class lists. | transfer the information to my gradebook so | can

keep track of homework and exam scores, and so | can send out progress reports

and calculate interim and final grades using Excel formulas.

a. Open the workbook HW05-6 Gradebook with Macros Original, which is one
of the files you downloaded at the start of the term. This is a simplified version
of my gradebook for Cl 1871 for section 1. | have scrambled the names, ID’s
and emails to protect privacy.

b. Save the workbook using the name HW05-6 HWID Gradebook with Macros Begin

c. The worksheet has both raw data and formulas. It will be helpful to make their
fonts different colors so you can easily distinguish them. As you did in HWO05-5
(page SG139) use ISFORMULA to make the font color of formulas red.

d. This workbook is larger than can fit on a single screen. Do the following to
freeze the panes so that the column headings (row 10) and the student
names (column B) are always visible.

1. Click C11. When you apply Freeze Panes the rows above 11 and the
columns to the left of C will be frozen.

2. Onthe View tab, in the Window group, click Freeze Panes and select
Freeze Panes.

3. To see how freeze panes works, scroll horizontally and vertically until the
screen looks like the following. Freeze lines are indicated by the vertical
line just to the right of column B and the horizontal line just below row 10.

2
3 A Vertical Freeze Line

4

5

6 Pct of

; GFrI::L Horizontal
9 35% ) Freeze

([l HWID |Name HW | Tot Pts | Grade z Line

"3 135R iYang, Bryan
;8 136A Apple, Ben

ks 137U
'Y 138P
N 139T
Gy 140H
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e. In AD11, enter a formula that will calculate the score for homework, rounded to
the nearest whole number. A student's homework score is the sum of the
student’s scores divided by the sum of the points possible for each homework
project (except for HW6, HW14, and HW15, which are extra credit). This result
is then multiplied by 100. That is, for AD11

sum of 011 through AC11

= *100
sum of 09 through $9+sum of U9 through AA9

HW

Written in Excel code we have
=SUM(011:AC11)/(SUM($0%$9:$S$9)+SUM($U$9:$AA$9))*100

Notice the use of the absolute references (the $ signs) in the denominator.
Those are needed so that when the formula is filled down the data in row 9 are
always used in the denominator.

1. Type the formula in AD11. The result is 79.692.

2. To round off the homework score to a whole number, use the ROUND
function, which has the form:

=ROUND(number,num digits)

You want to round

=SUM(O11:AC11)/(SUM($0$9: $S$9)+SUM($U$9: $AA$9))*100 to 0 digits:
=ROUND(SUM(011:AC11)/(SUM($0$9: $5$9)+SUM($U$9: $AA$9))*100,0)

Modify the formula in AD11. The result is 80.

3. If a student name is blank, you want a blank displayed rather than a 0. Use
an IF function to do that. That is, if the name in B11 is blank, display a
blank, which is called a null string. It is two double quotes "" Otherwise,
display the results of the formula.

=IF(B11="""" ,ROUND(SUM(0O11:AC11)/(SUM($0%$9:$S$9)+SUM($U$9:$AA$9))*100,0))
Modify the formula in AD11.

4. Fill the formula down to row 50 and preserve the format. As a result of the
IF formula, cells AG47:AG50 are blank.

Note that 103M Biff, Timothy has a homework score of 112%. That is because
he earned all the points on the regular homework and he also earned 80 points
on HW6 for extra credit.

Think about how this formula was constructed. It was built up in three steps.
That is a good technique to use when constructing complicated formulas. If you
find a formula is incorrect, you can reverse the process — that is, remove parts
one at a time until you see where the error occurred.
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f. Calculate the total points and letter grade for each student by doing the following:

Total points is calculated using weightings of 35% for the Excel exam,
20% for the Word exam, , and 35% for
the homework score. That is:

Total points = 35% * Excel exam score + 20% * Word exam score +
+ 35% * Homework score

The weights for the exams are listed in L5:N5 and the weight for the homework
is in AD9. The Excel formula will use those cell references along with the cell

references of the individual scores. Type the following in AE9. Notice the use of
absolute references (the $) on the cells that contain the percentage weightings:

=(SLSS5*L11+SM$S5*M11+ +$SAD$9*AD11) / 100
Excel Word Homework Converts
to a
percent

1. Enter your formulain AE11. The answer should be 82.8.

2. Add ROUND and IF functions as you did for the homework score and
type your formula in cell AE11.38 |Be sure to read footnotes

3. In AF11, enter a formula that will display the letter grade based on the total
points in AE11 and the table of points and letter grades in R1:AB2. You
are looking up a letter grade in a horizontal table so use HLOOKUP or
XLOOKUP. Remember to use absolute references, $, where appropriate.

4. Modify your formula to use an IF function to display a blank if the student
name is blank.3°

5. Fill the formulas in AE11:AF11 down to row 50 and preserve the
formatting.

g. If a student registers for a class, and then drops, instructors are required to
keep their name in the gradebook and record a grade code of either NOL or W.

NOL stands for Not On List. This is for students who drop before week three of
the semester. In that case, the course will not appear on their transcript.

W stands for Withdraw. This is for students who drop after week two of the
semester. In that case, the course will appear on their transcript with a

grade of W.
3 =|F(B11="","" ,ROUND(($L$5*L 11+$M$5*M11+$N$5*N11+$AD$9*AD11)/100,0))
% =|F(B11="","" , HLOOKUP(AE11,R1:AB2,2, TRUE)) or

=IF(B11="","" ,XLOOKUP(AE11,$R$1:$AB$1,$R$2:$3AB$2,"Not Found",-1))
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It helps to keep track of such students by using a conditional format to gray fill
the cells that contain their data. Do the following:

i : . ipboar N|
1. Select A11:AF50. A quick way of doing that is to type e

all:af50 in the name box and tap Enter. a11:afb0

2. Onthe Home tab, in the Styles group, click Conditional Formatting,
select New Rule, and click Use a formula to determine which cells to
format.

3. Enter a formula that will be true if K11 is either NOL or W. Since there are
two conditions, use the OR function to make the cells have a gray fill if
either condition is true.

The formula is =or($k11="NOL",$k11="W")

Note that a $ is needed to the left of K11 to ensure that Excel only checks
column K, where the grade code is located. If you leave off the $ the
formula will still work but only the cells in column A will be shaded.

4. Set the format to gray fill and then click OK twice.

13 | 103M |Biff, Timothy 2106779 :Design Freshman Retail Mer biff1234@umn.€ Timothy Biff

14 | 104R :Bing, William 3263672 (CLA Sophomore Undeclaired bing3263@umn.William Bing NOL
15 | 105H :Cheng, Recca 2172092 CLA Freshman Undeclaired :chen2172@umnRecca Cheng w
16 | 106A :Coen, Tiffany 3667079 :CEHD Non-degree Business Ed coend667@umn Tiffany Coen

h. Enter formulas that summarize the exam data in L3:N4 by doing the following:

1. In L3, enter a formula that will calculate the Excel exam average score.
You do not want to include scores of 0 because that means a student did
not take the exam and so should not be included in the average.

Here, you want the average of the numbers in L11:L50 that are greater
than 0. So, use AVERAGEIFS. 4°

2. Copy the formula to M3:N3 and preserve the format.

3. In L4, enter a formula that will display the number of students who took the
Excel exam. You do not want to include scores of O because that means a
student did not take the exam and so should not be included in the count.

Here, you are counting the numbers in L11:L50 that are greater than 0. So,
use COUNTIF. 4!

4. Copy the formula to M4:N4 and preserve the format.

40 =AVERAGEIFS(L11:L50,L11:L50,">0")
41 =COUNTIF(L11:L50,">0")
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I. Enter formulas that summarize the total points for students in different colleges
by doing the following:

1. In D3, enter a formula that will display the number of CLA students in the
gradebook. Since you want the NUMBER of students who meet a certain
criterion, COUNTIF is a good choice. Because you are going to fill this
formula down, be sure to use $ where appropriate. 42

2. Fill down the formula in D3 to D8 and preserve the formatting.

3. In ES3, enter a formula that will display the average total points of CLA
students. Since you want the AVERAGE of students who meet a certain
criterion, AVERAGEIFS is a good choice.

=AVERAGEIFS(average range, criteria range 1,

what to average

where to look

what to look for

range that has
total points
AE11:AE50

range that has
stu colleges
D11:D50

criteria1

%/_/
cell that has
college of interest
which is C3

Remember to put in $ on cells that you do NOT want to change when the
formula is filled down.

=AVERAGEIFS($AE$11:$AE$50,$D$11:$D$50,C3)

4. Fill down the formula in E3 and preserve the formatting.

5. Since there are no CSE or UC students, AVERAGEIFS displays the
#DIV/0! error. To fix that, modify the formula in cell E3 so that if the number
of students in D3 is O, then n/a will be displayed.

To do this, put the AVERAGEIFS inside an IF function:

=IF(D3=0,"n/a" ,AVERAGEIFS($AE$11:$AE$50,$D$11: $D$50,C3))

6. Fill down the formula in E3 and preserve the formatting.

College

Number

Total Pts Ave

CLA

4

50

CEHD

20

84

CFANS

1

94

CsSE

0

n/a

Design

11

85

uc

0

n/a

Except for the CLA students, it looks like everyone did OK. Can the CLA
student average total points really be only 50? What happened?

42 =COUNTIF($D$11:$D$50,C3)

)
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The problem is that CLA student 104 Bing never attended (his code is NOL)
and so his total points is 0, and 105 Cheng withdrew early (her code is W) and
so her total points is 13. You do not want those numbers to be included in the
average. To not include NOL and W students, add two more criteria to the
AVERAGEIFS function as follows:

Have this = |+ range to average contains the numbers in AE11:AE50 (total points earned)

=IF(D3=0,"n/a" ,AVERAGEIFS(SAE$11:$AES50

Have this =» |+ criteriarange 1is D11:D50 and criteria 1 is C3 (name of college)

=IF(D3=0,"n/a" ,AVERAGEIFS($AE$11:$AE$50,$D$11:$D$50,C3

Need this = | criteriarange 2 is K11:K50 and criteria 2 is “not” NOL (student Not On List)

=IF(D3=0,"n/a" ,AVERAGEIFS($AE$11:3AE$50,$D$11:$D$50,C3,$K$11: K $50,
"<>NOL" Here, note that <> means “not”

Need this = |+ criteriarange 3 is K11:K50 and criteria 3 is “not” W (student Withdrew)

=IF(D3=0,"n/a" , AVERAGEIFS($AE$11: $AES50,$D$11:$D$50,C3,$K$11: $K$50,
"<>NOL" $K$11:$K$50," <>W"))

7. Enter the formula into cell E3, fill down, and preserve the format. Now the
average for CLA students is 88. That makes more sense.

| know, this one probably blew your socks off, and it took a while. Think about
how the formula was built up in parts, each one addressing a problem caused
by the data.

j. Enter a function that will display the current date and time by doing the following:
1. Merge A9:C9 and left align.
2. In A9, use the NOW function to display the current date and time.

3. Format the merged cells so they display something like
Printed Fri 15 Jun 2023 at 10:18 AM %3

k. At times, there are some operations that you have to do repeatedly within a
workbook. For example, in my gradebook | sometimes need student names in
alphabetical order, such as when | check registrations and submit my final
grades, while other times | need the names in HWID order, such as when |
insert scores from the paper grader. Since | do these two types of sorts many
times throughout the semester, | have constructed macros so | can do the
sorts with a single mouse click. A macro is a small app (set of commands) that
you can have Excel carry out with a single mouse click or keystroke. While very
useful, macros have the potential to completely mess up a workbook, so it is a
good idea to make a backup copy of the workbook before constructing macros.

43 Use NOW(). The custom Format Cells code is "Printed "ddd d mmm yyyy " at " h:mm AM/PM
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1. Tap Ctrl + s to save your workbook. It is a good idea to make a backup
copy when working with macros because they can really mess up things if
done improperly. If that happens, just close the workbook without saving
and try again.

So, save the file using the name HW05-6 Gradebook with Macros Done
To see how macros work, do the following:

2. If the Developer tab is not showing, click the File tab, click Options, click
Customize Ribbon.

Mac: Click Excel, Preferences, Ribbon & Toolbar.

Down on the right, put a check in the box next to Developer.

MView
Developer
[vIAdd-ins

Then, click OK. The new Developer tab appears on the ribbon.

Home Insert Page Layout Formulas Data Review View Developer

Excel macros use a programming language called Visual BASIC. If you know
the language you can directly write your own macros. If you do not know the
language, you can ask Excel to record your keyboard and mouse actions and it
will write the code for you. To see how this works, do the following:

3. Click the Developer tab.
4. In the Code group, click Record Macro.

5. Inthe Macro name: box, type SortByName. Macro hames can contain
only letters and numbers and must begin with a letter.

6. Click OK. Excel will record all of your keystrokes and mouse actions until
you tell it to stop.

7. Select rows 10:50.

8. On the Home tab, in the Editing group, click Sort & Filter, and select
Custom Sort.

9. Be sure that there is a check in My Data has headers. In the Sort by box,
select Name and be sure A to Z is selected.

10. Click OK.
11. Tap Ctrl + Home to make C11 active.
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12. Click the Developer tab and click Stop Recording. You should see
136 Apple, Ben at the top of the list.

:[il HWID |Name ID College |Year Major

'kl 136 Apple, Ben 1233212 CEHD Freshman Business Ed
‘N 101 Berg, Alex 7023072 CEHD :Senior Business Ed
kY 102 :Bets, Sam 7266721 Design  Senior Retail Mer

13. On the Developer tab, in the Code group, click Macros. |:=;
This will show a list of all the macros in the workbook. Macros

Mac: Click Visual Basic.

Macro name:

|=»

SortByMame

The new macro is listed. To see what the code looks like, click Edit.

Sub SortByName ()

' SortByName Macro
1

Rows ("10:50") .Select
ActiveWorkbook.Worksheets ("Sec 1").Sort.SortFields.Clear
ActiveWorkbook.Worksheets ("Sec 1").Sort.SortFields.AddZ Key:=Range ("B11:B50")
, SortOn:=xlSortOnValues, Order:=xlAscending, DataOption:=xlSortNormal
With ActiveWorkbook.Worksheets("Sec 1").Sort
.SetRange Range ("Al10:BC50")
.Header = xlYes
.MatchCase = False
.Orientation = xl1TopToBottom
.SortMethod = x1Pin¥in
-Rpply
End With
Range ("C11") .Select
End Sub

Sub at the top and End Sub at the bottom indicate that this is what
programmers call a subroutine, which is a mini-app within a larger one.
The apostrophes indicate comment lines where you can write any
comments you wish. The rest of the lines are the executable code.

14. Tap Alt + Q to close the Visual Basic window.

15. Tap Ctrl + s to save the file and its macro. You will get an error message
that says:

The following features cannot be saved in macro-free workbooks:

= VB project

To continue saving as a macro-free workbook, click Yes.

To save a file with these features, click No, and then choose a macro-enabled file type in the File Type list.
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16.
17.
18.
19.

20.

This says you cannot save a file that has macros (Visual Basic subroutines)
unless you save it as a macro-enabled file. If you click Yes the file will be
saved without the macros. DON’T DO THAT!

Click No and the Save As dialog box will open.

Navigate to your Excel Files folder.

Change the file name to HWO05-6 HWID Gradebook with Macros Done
Change the file type to Excel Macro-Enabled Workbook.

File name: ‘ HWO05-6 Gradebook with Macros Done

Save as type: Excel Macro-Enabled Workbook

Click Save. Now, each time you save the file the macros will be saved also.

|. Follow a similar procedure to create a macro called SortByHWID that sorts the
data by the HWID in column A. Now, 101 Berg, Alex will be at the top (row 11)

Don’t Forget to Click Stop Recording!

m.To create buttons that you can click to run the macros, do the following:

1.

o gk~ WD

N

10.

On the Insert tab, in the lllustrations group, click Shapes and click
Rectangle: Rounded Corners.

Rectangles

O DOAOAGO0O0O0

Rectangle: Rounded Corners

The curser will turn into a small cross.

Drag the cross down and to the right to form the rectangle. |

Let up the mouse button to reveal the rectangle. -

Make the height of the rectangle 0.4 and the width 1.5.

Drag the rectangle to the upper left corner of the window, about at cell A2.

Right-click the rectangle, select Edit text, and type

Sort By Name. Make the font 12 pt Arial Black. CL1871 sec 1, Profes

Sort By Name

Click SortByName and then OK. Now, you have a button that will run the
macro with a single mouse click.

Right-click the rectangle and click Assign Macro.

Select the button by holding down the Ctrl key and clicking the button.

Tap Ctrl + D to create a duplicate of the button.
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11. Change the name to Sort By HWID.
12. Assign the SortByHWID macro to this button.

13. Ctrl + Click the new button and drag it so that it is CI 1871 sec 1, Profess
just below the other one. Sort By Name

14. Click the Sort By Name button and notice how the data Sort By HWID
are sorted by Name with 136 Ben Apple at the top.

15. Click the Sort By HWID button and notice how the data are sorted by
HWID with 101 Berg, Alex at the top.

n. Macros can be used to move to specific places in a worksheet with the click of
a button. This is useful for large worksheets where scrolling would be time
consuming. To see how this works, do the following:

1. Onthe Developer tab, in the Code group, click Record Macro.
2. In the Macro name: box, type GoTo Grades and then click OK.

3. Inthe Name Box, type fx500 and tap Enter. This will move the active cell
to a place far away from the cell you want to go to. This is FX500 .
needed because if the active cell is close to the target cell A 4
Excel may not adjust the screen properly.

4. In the name box, type ad1 and tap Enter. This is where you want to be.

5. Click the Developer tab and click Stop Recording.

6. Create a button with the label Go To Grades and assign the new macro to
it. Drag the button so it is just below the Sort By HWID button.

7. Try your new macro by making C11 active (tap Ctrl + Home) and then
clicking the Go To Grades button to make AD1 active.

A B AD AE AF
1 |CI 1871 sec 1, Professor Robe _l
:
8l Sort By HWID
5
7 Final
8 Grade
9 |Printed Fri 16 Jun 2023 at 11 35%
10 | HWID |Name HW Tot Pts | Grade
11 | 101Q Berg, Alex 80 83 B
12 | 1022 Bets, Sam 73 85 B
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0. Set up the worksheet for printing by doing the following:

1. On the Sec 1 worksheet, hide columns O:AC (select the columns,
right-click, select Hide).

2. Set the print area of the Sec 1 worksheet so that A1:AF47 will be printed
(select A1:F47, click Page Layout, Print Area, Set Print Area).

3. Set up the Sec 1 worksheet to print in Landscape orientation, all on one
page, centered horizontally but not vertically, and set all margins to 0.5 inch.
Include a footer that contains the file name on the left and the sheet name on
the right. Print with row and column headings. Compare the preview with the
key. Make needed corrections, save the workbook and close it.

Step 4 Submit Now, submit the following. Use these names for the pdf files:

HWO05-1 HWID River Done (River Depth and Temp Chart) — This is the River
Depth and Temp Chart chartsheet

HWO05-2 HWID Loans IF Done

HWO05-3 HWID Rent IF Done

HWO05-4 HWID Commission IF Done (Sales Data) — This is the Sales Data worksheet
HWO05-5 HWID Sorting Values Done (Values Sorted) — Values Sorted worksheet
HWO05-6 HWID Gradebook with Macros Done (Sec 1) — Sec 1 worksheet

Create a pdf file of the output for each of the above, place them in a folder
called HWO05 HWID LastName, FirstName, zip the folder and, by the due date,
upload it to the Canvas folder HWO05 Excel: Customize Charts, Make
Decisions, and Sort.

Step 5 Backup Now would be a good time to backup your files.






Project 6
Sample Exam Questions for Excel

You should do this project in preparation for the Excel exam, but you do not
have to submit it for grading. If you do submit it, you may earn up to 80 extra
credit points which will be added to your homework score. If you do not
submit it, it will not count against you.

Step 1 Read For this project, there are no pages to read in your textbook.
Step 2 Activities For this project, there are no textbook activities.
Step 3 Homework Review for the Excel exam.

HWO06-1 Sample Exam Questions for Excel
Problem: How can you do well on the Excel exam?

Go back through projects 2 through 5 and be sure you know how to do the activities
in both the textbook and this Study Guide. You do not have to re-do them all, just
skim them and, if you think you have forgotten how to do something, read through
the material on that activity.

When | grade your exam, | will look at your formulas as well as the displayed results.
So, if you cannot get something to work don’t waste time trying to figure out the
answer by hand and typing in the result. You will get no points for that. Instead, write
as much of the formula as you can and type it WITHOUT the equal sign. That way, |
will be able to see your formula and you may earn partial credit.

Recall that as you start typing a function, Excel will display a screen tip that will show
its structure. So, for example, typing =viookup( will display the following:

A B C D E
1 |=vlookup( |
2 VLOOKUP(lookup_value, table_array, col_index_num, [range_lookup])

The screen tips should help jog your memory. Here, it shows that you must enter:
lookup_value - the cell reference of the thing you are looking for, e.g. A4
table_array - the range of cells where you are looking, e.g., C5:D12

col_index_num - the number of the column in the table_array that contains the
thing you want to display, e.g., 2

[range_lookup] — type TRUE if the table_array is sorted low to high and you want
an approximate match, or FALSE if you must have an exact match. The square
brackets [ ] mean this is optional. It is assumed to be TRUE if you leave it out.

— SG157 —
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Below are some tips on the functions students find most difficult:

=VLOOKUP(what to find, where to look, what column to display, TRUE or FALSE)

Used to locate an item in a vertical list and then to display something in the same
row. See SG8L1. If the list is horizontal, use HLOOKUP. See SG75.

Example: =VLOOKUP(C11,$H$11:$1$20,2) from HWO04-4
If your version of Excel has XLOOKUP, it is better to use that. See page SG77.

=IF(logical test, display if true, display if false)
Used to choose between two things based on a logical test. See SG64.
Example: =IF(F9<=40,0,E9*1.5*(F9-40)) from HWO03-4
If there is more than one condition, use IFS (SG53) or nested IF functions (SG136).

=COUNTIF(where to look, what to look for)

Used to find the number of things that match the what to look for criteria.
Criteria must be inside quotes or a cell reference. See textbook page 395.

Example: =COUNTIF(H9:H36,">0") from HW03-4
If there is more than one condition, use COUNTIFS. See SG67.

=SUMIFS(which cells to sum up,where to look, what to look for, ...)

Used to find a total of things that match the what to look for criteria.
Criteria must be inside quotes or a cell reference. See SG55.

Example: =SUMIFS(A15:A42,F15:F42," Tulips") See page SG55.
Can be used if there is more than one condition. See SG68.
Example: =SUMIFS(F9:F28,D09:D28,"M" ,E9:E28,"<5")

=AVERAGEIFS(which cells to average,where to look, what to look for,...)

This is just like SUMIFS but it calculates the average of things that match the what
to look for criteria. Criteria must be inside quotes or a cell reference. See SG56.

Example: =AVERAGEIFS(D15:D42,F15:F42,”Tulips”)

Can be used if there is more than one condition.
Conditional format: Used to highlight values that match specific criteria. Select the
range you want to format BEFORE you open the conditional formatting dialog box.

Then, choose Conditional Formatting, Manage Rules, New Rule, Type the
condition that describes what you want to find and then choose a format. See SG68.

Example from HWO03-4.

Conditional Formatting Rules Manager

Show formatting rules for: | cyrrent Selection W

E:Eﬂew Rule... E}‘Edi‘t Rule... > Delete Rule

Rule (applied in order shown)  Format Applies to

Formula: =F2=>40 AaBchYyZz =$B$%$BE36
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Do the following practice problems:

Solutions to these problems begin on page SG168

a. Open the workbook HWO06-1a Excel Practice Questions Original, which is
one of the files you downloaded at the start of the term.

b. Save the workbook to your Excel Exam folder using the name
HWO06-1b HWID Excel Practice Questions Done.

Sales Data Worksheet

c. Click the Sales Data worksheet tab and do the following.

1. Insert the following data in between the rows for Braasch and Good:

7 | Clover, May Sales 5584
8 Day, Dennis Marketing 6588

2. In C17, insert a formula that will find the total of the values in C4:C15.

This formula and all the others you construct must work if the
data change. In other words, you cannot simply figure out the
sum on your calculator and then type in the answer.

3. In C18, insert a formula that finds the average of the values in C4:C15.

4. In D4, enter a formula that will calculate the commission for Adams. If her
total sales are below $5,000, the commission is $9,000 plus 8% of her total
sales. Otherwise, the commission is $9,400 plus 12% of the total sales that
are above $5,000. Fill the formula down to D15.

5. In E4, enter a formula that will calculate the percent of Total Sales for
Adams. This is the value in C4 divided by the total in C17 and then
multiplied by 100. Fill the formula down to E15.

6. Format C4:D20 as currency with two decimal places and the dollar sign
showing. Use currency style, not accounting style.

7. Format E4:E15 as a number with one decimal place showing.

8. In F4, display the word Great if Adams’ Total Sales in C4 are over $8,000,
Good, if C4 is between $6,000 and $8,000, and Poor if C4 is $6,000 or
less. Fill the formula down to F15.

9. In D20, enter a formula that will display the sum of the Total Sales for
people whose Commissions are over $9,800.

10. Create a conditional format so that the names and department name of the
people in the Marketing Department whose commissions are over $9,600
have a yellow fill.
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11. In D22, enter a formula that will display the number of commissions that
are over $9,600 for people in the Marketing Department.

12. In D1, enter a formula that will automatically display the date and time the
worksheet is printed. The format should look like Printed on Tue 8 July
2020 at 11:50 AM.

13. Change the value in C4 so that Adam's % of Total Sales is exactly 25.00.

14. Change the widths of all the columns to 12.

15. Merge D1:F1 and left align it.

16. Center and wrap the text in D21.

17. Center D19:D22.

18. Set the Print Areato A1:F22.

19. Set up the Sales Data worksheet to print in Landscape orientation, all on

one page, centered horizontally but not vertically with 1 inch margins.
Include a footer that contains the file name on the left and the sheet name
on the right. Show gridlines and row and column headings. Compare
the preview with the key. Make needed corrections, save the workbook but
do NOT close it.

Column Chart - New Chartsheet Based on Sales Data

d. Create a chart of the data on the Sales Data worksheet. Ll -
1. Create a clustered column chart of the data in C4:C15. 2D Coly
2. Place the chart on a new chartsheet called Column Chart. hﬂm
3. Use the data in A4:A15 for the horizontal axis.
4. Type your four-character HWID as the Chart Title.
5. Type Total Sales for the Vertical Axis Title.
6. Type People for the Horizontal Axis Title.
7. Display the Data Labels and make their font red Arial Black rounded to the
nearest whole dollar.
8. Do not show the Legend.
9. Add a Thought Bubble: Cloud callout with $24,371
the text Wow! Position the callout as shown. ‘e
Make the font 12 pt Arial Black and the color ®
yellow. w
10. Change the background of the chart to
Newsprint texture.
11. Set up the Column Chart chartsheet to print in Landscape orientation and

include a footer that contains the file name on the left and the sheet name
on the right. Compare the preview with the key. Make needed corrections,
save the workbook but do NOT close it.
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Bonus Data Worksheet

e. Click the Bonus Data worksheet.

1.

Click A1 and make the text bold and red and center the text across
columns A:G.

Enter a formula in C4 that will display the bonus for the sales value in B4.
Use the data table in B10:G12. Fill the formula down to C8 and preserve
the formatting.

Sort the rows of data by Bonus in decreasing order.

Create a conditional format that will make the Names, Sales, and
Bonuses bold red and the background of the cell light green if the
bonus for a person is between $300 and $900.

In A2, display this: Highest Bonus Awarded was $x,xxx.00, where xxx is
the largest value in C4:C8. Merge across A2:D2.

1 Bonus Data

»2 Highest Bonus Awarded was $1,000.00

Create an orange Column Sparkline in C9 of the values in C4:C8.

In cell D3, enter a formula that shows the average of the Total Sales on
the Sales Data worksheet. Format D3 so that it displays Average of Total
Sales is $x,xxx.00. Merge and Center D3:F3.

Set up the Bonus Data worksheet to print in Landscape, all on one page,
centered horizontally but not vertically and include a footer that contains
the file name on the left and the sheet name on the right. Include
gridlines and row and column headings. Compare the preview with the
key. Make needed corrections, save the workbook, but do NOT close it.

Sort Data Worksheet

f. Make the Sort Data tab active and do the following:

1.
2.
3.

Delete Row 8 (it has red text).
Delete Column C (it has blue text).

Sort the data by Class in ascending order (A to Z) and, within Class by
Trend in descending order (Largest to Smallest).

Filter the data in A1:D33 so that only rows with Class to C or T are showing.
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Births Data Worksheet

g. Click the Births Data worksheet tab.

1.

Split the screen just below row 9 and then scroll the bottom half of the
screen down so you can see row 28.

9 22 802 36
28 49 30 1

Set up Data Validation for A2:A28. The ages should be whole numbers
between 14 and 50, inclusive. If an error occurs, have a Warning message
display the text Age must be between 14 and 50, inclusive. Here is what
should happen if you type 1 in A2 and tap Enter.

Age of Mother Births/Thousand
| 15

Index
850

Age must be between 14 and 50, inclusive.

continuer
10

No Cancel Help 00

Births Chart - New Chartsheet Based on Births Data

3.

10.

11.

12.

13.
14.

Create an XY Scatter plot of the data in columns A and B. Do not connect
the points by a smooth line.

Move the chart to its own chartsheet called Births Chart.

Make the Chart Title Live Births Per Thousand Women vs. Age
Make the font 14 pt Arial Black.

Make the Horizontal Axis title Age (years) Make the font 12 pt Arial Black.

Make the Vertical Axis Title Live Births Per Thousand Women
Make the font 12 pt Arial Black.

Show the Major and Minor gridlines for both axes.
Make the data points square, green, and 8 point width.

Add a Trendline that is a degree 5 polynomial. Display the equation and R
squared value. Make their font 10 pt Arial Black. Make the trendline solid,
red, and 3 pt width.

Make the color of the Chart and Plot areas pink.

Make the horizontal and vertical axes 4 point width and dark blue and the
numbers Arial Black.

Make the major gridlines 2 point width and dark gray.

Do not display the minor gridlines.
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15. Scale the horizontal axis so that it starts at 12 and ends at 52 and make
the interval between major grid lines 4.

16. Add a second set of data markers using Age for the Horizontal (X) axis and
Fertility Index for the Vertical axis (Y). Use Index for the Series name.

17. Move the equation and R squared value textbox so it is just above the
horizontal axis

18. Add a Thought Bubble: Cloud callout that points to the data gap between
ages 25 and 29. Insert the text Data unavailable

19. Arrange the sheet tabs alphabetically left to right.

Sales Data Column Chart Bonus Data | Sort Data Births Data Births Chart

20. Set up the Births Chart chartsheet to print in Landscape orientation and
include a footer that contains the file name on the left and the sheet name
on the right. Compare the preview with the key. Make needed corrections,
save the workbook, and close it.

PivotTable - Start

h. Open the workbook HWO06-1c Excel Practice Questions PivotTable Original,
which is one of the files you downloaded at the start of the term.

I. Save the workbook to your Excel Files Excel Exam folder using the name
HWO06-1d HWID Excel Practice Questions PivotTable Done

The workbook shows three months of data for an Aquatics Program sponsored
by a Parks and Recreation department.

Pl Month Pool  Item $ Num Staff
vB April  Haven Food $2,009 208 Albe

For example, row 2 shows that in April a total of $2,009 was taken in on Food
supervised by Albe at the Haven pool.

PivotTable - Clean Up Data

j. Remove blank rows, rename a field,
and convert to a table.

File Home Insert Page Layout Formulas Data

Table Name: Summarize with PivotTable F‘ @ D
IncomeTable 5( Remove Duplicates I:? =2 N
Insert Export Refre:

'@’ Resize Table r.,"% Convert to Range Slicer v v

1. On the Data worksheet, in cell D1,
change $ to Income.

Properties Tools Extg

2. Remove all blank rows. . | T
Do NOT sort. 4 B | ¢ | - B F
3. Convert the data into a _1_Month BiPool Hitem B _Inconfd _ Null Staff KI

April Haven Food $2,009 208 Albe
N May Haven Food $2,025 210 Albe
"8 June Haven Food $1,230 200 Albe

table called IncomeTable.
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PivotTable - Construct PivotTable

k. Construct a PivotTable by doing the following:

1. Using the data in IncomeTable, insert a PivotTable on a new worksheet
named Pivot. Place Income under Values, Pool under Rows, and Item
under Columns.

2. Pivot the table so Item forms the rows and Pool forms the columns.

3. Inthe Rows area, display Month above Item.

4. Display the averages rather than sums. Round the numbers to the nearest
dollar and display the dollar sign.

5. Collapse the data so the Items only show for April.

A B C D E F G H

1

2

3 |Average of Income Column Labels -

4 |Row Labels -~ Beach Cape Coral Haven Sands Tropics Grand Total
5 |oApril $1,555 $1,513 $1,797 $1,704 $1,581 $1,511 $1,610
6 Ball $810 $811 $667 $799 $945 $707 $790
7 Dive $882 $910 $1,111 $910 $899  $679 $899
8 Food $2,100 $2,204 $2,230 $2,009 $1,801 $1,799 $2,024
9 Polo $380 $383 $493 $450 $487 $356 $425
10 Spa $2,264 $1,907 $2,102 $2,250 $2,349 $2,196 $2,178
11 Swim $2,894 $2,864 $4,181 $3,805 $3,007 $3,326 $3,346
12 | ®May $1,696 $1,452 $1,613 $1,596 $1,501 $1,384 $1,540
13 @=June $1,567 $1,498 $1,509 $1,413 $1,447 $1,381 $1,469
14 Grand Total $1,606 $1,488 $1,640 $1,571 $1,510 $1,425 $1,540

Notice that A3 displays Average of Income but H4 and A14 display Grand
Total. The values in column H and row 14 are not Totals but Averages.

For example, cell H5 is the average of H6:H11. Also, cell H14 is the

average of H6:H11 and H13:H18 and H20:H25, even though the last two
ranges are not visible. It is also the average of B14:G14. While those totals

might be useful when sums are displayed, they are not useful when

averages are displayed.

PivotTable - Construct 3-D Pie Chart

[. Construct a 3-D Pie Chart of the PivotTable:

1.

S e

Rename the worksheet Pool.

Collapse the fields so that only the Pool field shows.
Create a 3-D Pie Chart of the data.

Place the chart on its own chartsheet called 3-D Pie.

Starting on the Data worksheet, create a new PivotTable with Income under
Values and, Pool, Month, Item, and Staff, in that order under Rows.

Show the Data Labels and format them to be percentages rather than sums.
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7. Make the data labels white 18 pt Arial Black.
8. Make the title Contribution of Each Pool. Make the font 18 pt Arial Black.

Mac: Your graph may not show the Field Buttons. The tilt (perspective) of your

graph may be different from that shown in the key. That is OK.

9. Set up the 3-D Pie chartsheet to print in Landscape orientation. Include a

footer that contains the file name on the left and the chartsheet name on
the right. Compare the preview with the key. Make needed corrections,
save the workbook but do NOT close it.

PivotTable - Slicers

m. Use slicers to filter data:

1. Click the Data tab and insert another PivotTable named Filtered. Place

S e

Income under Values, Month under Filters, Pool under Rows, and Iltem
under Columns.

Format the values as currency with 0 decimal places and the $ showing.
Insert a slicer for the Pool field. Apply a yellow slicer design.

Insert a slicer for the Item field. Apply a green slicer design.

Move the slicers so they are under the table.

Use the two slicers to filter the data to show the Income for Dive and
Swim for the Beach, Haven, and Tropics pools.

A B ¥ D

1 Month (Al -

2

3 | Sum of Income Column Labels -7

4 'Row Labels -T Dive Swim Grand Total
5 |Beach $2,655 $9,147 $11,702
6 Haven $2,799 $9,438 $12,237
7 |Tropics $2.213 $7,735 $9,948
8 |Grand Total $7,567 $26,320 $33,887

Drag the slicers so that they are just under the PivotTable.

Set up the Filtered worksheet to print in Portrait orientation, Adjust to 150
% of normal size, centered horizontally but not vertically. Include a footer
that contains the file name on the left and the worksheet name on the
right. Compare the preview with the key. Make needed corrections, save
the workbook and create the pdf file, but do NOT close it.
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PivotTable - Individual Reports

n. Place the Dive Lessons and Swim Team data for Beach on its own worksheet
named Beach. AutoFit the columns.

Dive 882 95 Melby
April Beach Dive 882 95 Melby
June Beach Swim 2876 295 King
i 345 King
296 King A

86 Melby

Beach BSElGS

Set up the Beach worksheet to print in Portrait orientation, Adjust to 150 % of
normal size, centered horizontally but not vertically. Include a footer that
contains the file name on the left and the worksheet name on the right.
Compare the preview with the key. Make needed corrections, save the
workbook and create the pdf file, but do NOT close it.

PivotTable - Stacked Column Chart

0. Create a Stacked Column Chart based on the PivotTable on the Filtered
worksheet.

1.
2.
3.

From the Filtered worksheet, insert a Stacked Column PivotChart.
Move the chart to its own chartsheet called Stacked.

Filter the chart to show the April and May Income for Dive and Swim for
the Coral, Haven, Sands, and Tropics pools.

Display the Averages rather than the Sums.

Make the chart title April and May Income for Dive and Swim for Coral,
Haven, Sands, and Tropics Pools.

Make the title, legend, and axes 12 pt Arial Black.
Hide the Filter Buttons if they are showing.

Set up the chartsheet to print in Landscape orientation. Include a footer
that contains the file name on the left and the chartsheet name on the
right. Compare the preview with the key. Make needed corrections, save
the workbook but do NOT close it.
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Click the Filtered worksheet and notice how the PivotTable has changed.
This is because you changed the filters on the chart.

A B © D
1 Month (Multiple Items) v
2
3 Average of Income Column Labels -7
4 |Row Labels <Y Dive Swim Grand Total
5 Coral $1,111 $3,522 $2,316
6 Haven $910 $3,350 $2,130
7 |Sands $906 $2,694 $1,800
8 Tropics $734 $2,660 $1,697
9 Grand Total $915 $3,056 $1,986
10 Pool 7= &  ltem = X
:I]; Beach Ball
13| Cape Dive
L Coral Food
15
16 Haven Polo
17 Sands Spa
18 - -
19 Tropics Swim

PivotTable - Change Data and Update PivotTable

p. You are going to update the raw data on the Data worksheet. This will change
all the PivotTables to reflect the new data. However, for this practice activity,
you want to keep those PivotTables as they were so you can go back and look
at them later if you wish. For that reason, you are going to make a copy of the
Data worksheet and base a new PivotTable on those data. Do the following:

1. Make a copy of the Data worksheet and name it Updated Data.

If there are too many tabs in this workbook, you can right-click a tab and
select Hide to make more room. Or, use the arrows on the left of the tab
list to scroll the tab names back and forth.

2. Starting from the Updated Data worksheet, insert a PivotTable that
has Income in the Values box, Pool in the Rows box, and Item in
the Columns box. Name the worksheet Updated Pivot.

A B C D E F G H

1

2

3 |Sum of Income Column Labels -

4 Row Labels - Ball Dive Food Polo Spa Swim Grand Total
5 |Beach 2341 2555 6684 1386 6792 9147 28905
6 |Cape 2043 2813 6612 11556 5721 8432 26776
7 |Coral 2216 2943 6470 1349 6928 9610 29516
8 |Haven 2804 2799 5264 1270 6699 9438 28274
9 |Sands 2872 2713 5502 1473 6985 7630 27175
10 |Tropics 2559 2213 5397 1311 6436 7735 25651

11 |Grand Total 14835 16036 35929 7944 39561 51992 166297
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3. Go back to the Updated Data worksheet and, in cell D2 (April Haven Food)
replace $2,009 with $40,000.

A B C D E F
il Month§d Pool fllitem | Inconfld Nulld Staff &
2 |April Haven Food $40,000] 208 Albe

4. Add the following to the bottom of the table on the Updated Data worksheet.

A B 8] D E F
110 April Cape Souvenirs $100 40 Jones
111 May Cape Souvenirs $200 60 Jones
112/ June Cape Souvenirs $300 80 Jones

5. Click the Updated Pivot worksheet and refresh the PivotTable. You should
see a new column for Souvenirs with data, 600 and the Haven Food
changed from $5,264 to $43,255.

6. Arrange the worksheet tabs as follows:

Data Plvot @ 3-DPie Filtered | Beach | Stacked @ Updated Data & Updated Pivot

Step 4 Submit Submitting this project is optional. However, you may earn extra
credit on your homework score if you submit the following. Use these names for
the pdf files:

HWO06-1b HWID Excel Practice Done (Sales Data)
HWO06-1b HWID Excel Practice Done (Column Chart)
HWO06-1b HWID Excel Practice Done (Bonus Data)
HWO06-1b HWID Excel Practice Done (Births Chart)
HWO06-1d HWID Excel Practice Pivot Done (3-D Pie)
HWO06-1d HWID Excel Practice Pivot Done (Filtered)
HWO06-1d HWID Excel Practice Pivot Done (Beach)
HWO06-1d HWID Excel Practice Pivot Done (Stacked)

Create a pdf file of the output for each of the above, place them in a folder called
HWO06 HWID LastName, FirstName, zip the folder and, by the due date, upload
it to the Canvas folder HW06 Sample Exam Questions for Excel.

How to Solve Sample Exam Questions for Excel

Sales Data Worksheet - Solutions

cl. Question cl is on page SG159. Here is how to solve it:

Click the number for row 7, drag down to row 8, right-click, and select
Insert. This inserts two blank rows. Then, type the new data.

c2. You are finding a total of numbers so use SUM. Type =sum(, drag down
from C4 through C15, type ), and the tap Enter.

c3. Do the same as for c2 but replace the word SUM with AVERAGE.
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c4.

Co5.

c6b.

You are entering a formula that displays one of two things. That is, the
formula will choose between

Choice 1: $9,000 plus 8% of total sales.
Choice 2: $9,400 plus 12% of the total sales that are above $5,000.

The formula makes the choice by seeing if total sales are below $5,000.
So, the condition is C4<5000. Type =IF(C4<5000,

If the condition is true, display Choice 1, which is $9,000 plus 8% of her
total sales. Since total sales are in C4, add this to the formula
9000+8%*C4, to get =IF(C4<5000,9000+8%*C4,

If the condition is false, display Choice 2, which is $9,400 plus 12% of the
total sales that are above $5,000. To find the total sales that are above
5000 subtract C4-5000 (for Adams this will be 5644-5000, which is 644).
Then, take 12% of that. Note that you must use parentheses, so the
computer does the subtraction first and then multiplies by 12%. That is,
12%%*(C4-5000). Finally, add 9400 to this to get 9400+12%*(C4-5000).
Thus, the final formula is

=IF(C4<5000,9000+8%*C4,9400+12%*(C4-5000))
Tap Enter.

To fill the formula, click D4, drag down to D15, and tap Ctrl + D. Or, use
the Fill Handle by pointing to the lower right corner of D4 (so the little black
cross appears), and drag down to D15.

To find the percentage that something is of a whole, divide that something
by the whole. That gives a decimal. Multiply by 100 to convert the decimal
into a percent. For Adams, her total sales are in C4 and the sum of the total
sales for all employees is in C17. So, type =C4/C17*100

You are going to fill this formula down to row 15. You want the C4 to
change to C5, and then to C6 and so on. But, you want C17 to always
remain C17 so you must use an absolute reference (the $ signs).
Thus the formula is =C4/$C$17*100. To fill the formula, click E4, drag
down to E15, and tap Ctrl + D.

Select C4:D20, right-click, Format Cells, Number tab, Currency.
Be sure the Symbol is $ and Decimal places is 2.

Format Cells
PN umber Alignment Font Border Fill
Category:
General Sample
Mumber $5.644.00
Curren T
Accounting Decimal places: |2 =
Date
Time Symbal: | §
Percentage
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=IF| Condition1 ,

c7. Select E4:E15, right-click, Format Cells, Number tab, Number, Decimal
places 1. Note that since you multiplied by 100 in the formula, you do not
use the percentage format. If you did, Adams would show 716.6%.

c8. You need to display one of three words depending on the value in C4.
Since there are three choices you need two IF statements, one nested

inside the other.

THEN

show this ,

Else

Develop the formula in steps:

IF| Condition 2

THEN Else
» show this , show this

What to do

Excel Code

Check to see if Total
Sales are over 8000.

=IF(C4>8000,

If that is TRUE, display
the word Great.

=|F(C4>8000,"Great",

If itis FALSE, check to
see if C4 is over 6000.

=IF(C4>8000,"Great",IF(C4>6000,

If that is TRUE, display
the word Good.

=IF(C4>8000,"Great",IF(C4>6000,"Good",

If it is FALSE display
the word Poor.

=IF(C4>8000,"Great",IF(C4>6000," Good" " Poor"))

Or, you could do it in the reverse order like this:
=|F(C4<=6000,"Poor",IF(C4<8000,"Good","Great"))

Or, you could do it this way:
=IF(C4>8000," Great",IF(C4<6000,"Poor","Good"))

If your version of Excel has the IFS function, you could use that instead of
the nested IF functions. In that case, the formula would be:

=IFS(C4>8000,"Great",C4>6000,"Good",C4<=6000,"Poor")

In the key, I put in all four of these formulas so you could see how they
work. Fill down in the usual way.

c9. You want to find a sum of Total Sales for people who meet a certain
condition (Commissions are over $9,800). So, use SUMIFS.

You want to sum the Total Sales, which are in C4:C15, type =SUMIFS(C4:C15,

The range to look in to see if the condition is met is D4:D15.
So, you have =SUMIFS(C4:C15,D4:D15,

The condition is >9800. So you have =SUMIFS(C4:C15,D4:D15,">9800")
Note the quotation marks on the condition. This is different than when using IF.
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¢10. For conditional formats, first select the cells that are to be formatted. Here,

c1l1.

cl2.

cl13.

cl4.

cl5.

you want the names formatted so select A4:B15.

Click Conditional Formatting, New Rule, Use a formula to determine
which cells to format.

The employee must meet two criteria: Department (column B) is Marketing,
and Commission (column D) is over 9600. So, use the AND function:
=AND($B4="Marketing",$D4>9600) The $ are needed because you want
two columns formatted. Also, notice that here you do not put in the range
B4:B15 but only B4. Same goes for column D. For Conditional Formatting,
you select the cells where you want the formatting first, then you put in the
rule for the first person and Excel does it for all the people that you have
selected in A4:B15.

Finally, click the Format button, click Fill, and click yellow. Click OK a
couple of times to close the conditional formatting dialog box.

You are to display the number of things based on two criteria so use
COUNTIFS.

The first condition is that the Commission (in column D) must be over
9600. So, you have =COUNTIFS(D4:D15,">9600"

The second condition is that the department is Marketing (in column B).
So you have =COUNTIFS(D4:D15,">9600",B4:B15,"Marketing")

Note that in each case the condition must be inside quotation marks.

To have the date and time update automatically, NOW(). Do NOT use
DATE since that is used when you need to take three separate values
and combine them to form a date (not very useful).

Once you have entered =NOW() click the green check. The date is stored
as the number of days it is after January 1900. The time is stored as a
fractional portion of a 24 hour day. So, if the date and time are 20 Jul 2020
at 3:23 PM, the number will be 44032.64127.

To format the date and time, right-click, Format Cells, Number tab, and
Custom. The phrase Printed on must be in quotes since it is text. Then,
enter the code for the day (ddd), the date (d), the month (mmm), the year
(Yyyyy), the word “ at “ and the hour (h) a colon, the minutes (mm) and
am/pm so Excel uses our normal 12 hour clock rather than military time.
This is "Printed on " ddd d mmm yyyy" at "h:mm am/pm

Use Data, Forecast, What-If, Goal Seek t0 [ goal seek B

get the exact value. _
Set cell: E4 |§|

The answer is 24370.6624489115. To value: 25

Select the entire worksheet, point to column | By changing cell: [5Cs4 E3

heading A, right-click, select Column width, l o ] | p— |

and enter 12.

Select D1:F1, click Merge and Center, then click Right align.
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c16. Select D21, click Center align, click Wrap text.
c17. Select D19:D22 and click Center align.

c18. Select A1:F23. On the Page Layout tab, in the Page Setup group, click
the Print Area arrow, and click Set Print Area.

c19. Tap Ctrl + p, click Page Setup, and make the settings look like these:

Margins Header/Footer Sheet
Orientation
[, Ty - F =
() Portrait - (® Landscape
Scaling
O Adjust to: 100 =/ % normal size
@ Fit to: 1 = page(s) wide by |1 = tall
Page Header/Footer Sheet
Top: Header:
1 = 0.5
Left: Right:
1 = 1 =
Bottom: Footer:
1 = 05 =
Center on page
Horizontally

Footer

To format text: select the text, then choose the Format Text button.

To insert a page number, date, time, file path, filename, or tab name: position the
insertion point in the edit box, then choose the appropriate button.

To insert picture: press the Insert Picture button. To format your picture, place the
cursor in the edit box and press the Format Picture button.

&

Left section: Center section: Right section:

&(File] E |- &[Tab] -
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Page Margins Header/Footer __________ Sheet
Print area: | A1:G23
Print titles

Rows to repeat at top:
Columns to repeat at left:

Print

Gridlines Comments: (None)
|:| Black and white i

Cell errors as: | displayed
[ ] Draft quality

Row and column headings

Column Chart - Solutions

di.

d2.

d3.

d4.

Select C4:C15. On the Insert tab, in the Charts group, select 2-D column,
and then Clustered Column.

Do NOT copy and paste the chart into a new worksheet. On the Chart
Design tab, in the Location group, click Move Chart, and type the name
Column Chart. This creates a new chartsheet that contains only the chart
and no cells.

On the Chart Design tab, in the Data group, click Select Data, Horizontal

(Category) Axis Labels, Edit. Click | # |to collapse the dialog, switch to

the Sales Data worksheet, select A4:A15, and click| % | again.

Auxis Labels ? >

Axis label range:
='Sales Data"'$A%54:54%15 * = adams, Kathy, ...

Click OK and click OK again.

The green cross allows you to put in many different chart elements.

Mac: There is no green cross. On the Chart Design tab, on the left, use the Add
Chart Element.

d>s.

d6.

Chart Elements
Axes

[ Axis Titles
Chart Title

Put a check next to Chart Title, if necessary. With Chart
Title selected, in the formula bar, type your HWID.

4

Click the green cross and put a check next to Axis Titles.
If necessary, click the vertical axis title so select it.
Type Total Sales and tap Enter.

Click the horizontal axis title and type People and tap Enter.
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d7.

ds.
do.

d10.

dil.

Click the green cross and put a check next to Data Labels. Then, on the
Chart Format tab, way over on the left, click the arrow and select Series 1
Data Labels to select them.

With the Data Labels selected, click the Home tab and change the font.

On the Chart Format tab, in the Current Selection group,
be sure Series 1 Data Labels is selected, and click Format
Selection. In the Format Data Labels pane, click Label
Options. Click the Number triangle and, under Category, select
Currency, and make the Decimal places 0.

il

Label Options

Click the green cross and be sure Legend is NOT checked.

On the Insert tab, in the lllustrations group, select Shapes, Callouts, and
click Thought Bubble: Cloud. Drag to open the callout. Type the text and
then format the font. To point to the Adams column, grab the little orange
circle at the end of the point and drag it to the desired position.

On the Chart Format tab, in the Current Selection group, click the arrow,
select Chart area, and click Format selection. Click the paint bucket and
under Fill click Picture or texture fill. Click the arrow to the right of
Texture and select Newsprint.

Set up to print as usual.

Bonus Data Worksheet - Solutions

el.

e2.

To center across cells, select A1:G1 and, on the Home tab, in the
Alignment group, click Merge and Center.

The sales and bonus data are in B10:G12. This is a horizontal table so use
HLOOKUP.

You want to look up the value in B4 so use =HLOOKUP(B4

You want to lookup that value in the horizontal table B10:G12 so use
=HLOOKUP(B4,$B$10:$3G$12 Note the use of absolute references (the $).
This is because when you fill down this formula you want the location of the
table to remain constant, which is what the $ do.

When the value of B4 is found in row 1 of the table, you want to display the
value in row 3, so use =HLOOKUP(B4,$B$10:$G%$12,3

Since you do not need an exact match and the table is in ascending order,
type TRUE as the last parameter, =HLOOKUP(B4,$B$10:$G$12,3, TRUE).
TRUE is the default so you can leave it off if you wish.

When you fill down, to preserve the formatting be |5 -
sure to select Fill Without formatting from the B copy Cels

Auto Fill Options. 2 Fill Fermatting Only

2 Fill Withgut Formatting
& Flash Fill
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e3.

e4.

e5.

€b.

Be sure you select all the data in each row and not just the data in column
C. That is, click the number for row 4 and drag down to row 8 to select
those five rows and then, on the Home tab, in the Editing group, select
Sort & Filter, Custom Sort. Under Sort by, select Column C and Largest
to smallest, and then click OK.

Select A4:C8 since those are the cells you want to format. Then, on the
Home tab, in the Styles group, click Conditional Formatting, New Rule,
Use a formula to determine which cells to format. There are two
conditions, less than 900 and also greater than 300. Use AND for the
condition, like this: =and($c4<900,$c4>300). Notice the use of the $
because you have selected more than one column and you want all three
to have the format.

20 Name Sales Bonus
8 Maren $38,200 $1,000
Sue $30,123 $800
- Melissa $25,821 $600
@ Elana $22,054 $400
"W Kathy $17,866 $200

Here are two ways of doing this:

Method I: Since you are looking for the highest number in C4:C8 use
=MAX(C4:C8). This gives you the number $1,000. To format the cell
right-click, select Format Cells, click the Number tab, click Custom and
type "Highest Bonus Awarded was "$#,###.00 The part inside quotes
is text that will be displayed exactly as written. To the right of the quote
shows the format for the number: The $ indicates currency, the #
indicates numbers (you cannot use x’s here), the comma indicates that
it should be put there if the value is over one thousand, the period
shows the decimal point, and the 00 shows that zeros should be
displayed. Select A2:D2 and click Merge & Center, and then Align Left.

Method II: This method uses the & to connect (concatenate) the text
Highest Bonus Awarded was with the number 1000. So, use
="Highest Bonus Awarded was "& TEXT(MAX(C4:C8)," $# ###.00")
The TEXT function must be used to show Excel how to format the
number. If you do it this way you will not have to use Merge & Center to
see the result.

Click C9. On the Insert tab, in the Sparklines group, click Column
Sparkline. For the Data Range enter C4:C8 and for the Location enter
C9. Then, on the Sparkline Design Style tab, in the Style group, click
Sparkline color, and select Orange.
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e’.

e8.

Click D3, type =, click the Sales Data worksheet, click C18, tap Enter.
The formula will look like this: ='Sales Data'!C18 This says go to the
Sales Data worksheet and display the contents of cell C18.

Right-click D3, Format Cells, Number tab, Custom, type
"Average of Total Sales is "$#,###.00

Select D3:F3 and, on the Home tab, in the Alignment group,
select Merge & Center.

Set up to print as usual.

Sort Data Worksheet - Solutions

f1.

f2.

f3.

f4.

Click the number for row 8, right-click, and select Delete. Row 9 becomes
row 8. This gets rid of the entire row and not just the data in a row.

Click the letter for column C (Height), right-click, and select Delete.
Column D becomes column C.

Click the number for row 1 and drag down to the number for row 33. This
selects all the data in those rows and not just the data in a particular
column. On the Home tab, in the Editing group, select Sort & Filter,
Custom Sort. Be sure My data has headers is checked. Under Sort by,
select Class and A to Z, click Add Level, select Trend and Largest to
Smallest. Click OK.

Select A1:D1. On the Home tab, in the Editing group, select Sort & Filter
and click Filter. Click the Class arrow and click Select All (to deselect
everything) and then click C and T. Click OK.

A B @ D
1 Level - Trend| -  Width - Class|-¥
5 1 9 7 o
6 5 5 85 C
7 2 3 111 o
8 2 3 111 C
22 5 5 7 T
23 5 5 7 T
24 1 4 114 T
25 2 3 111 T

Births Data Worksheet - Solutions

gl.

g2.

Click the number for row 10 and on the View tab, in the Window group,
click Split. Scroll to the bottom part of the screen so row 28 shows.

Select A2:A28. Since the screen is split, rather than scrolling it will be
faster to click A2, hold down Shift, and click A28.

On the Data tab, in the Data Tools group, click the Data Validation arrow
and select Data Validation. On the Settings tab, under Allow, select
Whole number. Under Data select between, under Minimum enter 14,
and under Maximum enter 50. Click the Error Alert tab and under Style
select Warning, and under Error message type Age must be between 14
and 50, inclusive. Click OK.

In cell A2, type 1 to check if the warning comes up. Click cancel and the 1
will return to its original value.
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Births Chart - Solutions

g3.
g4.

g5.

g6.

gv.

g8.

g9.

g10.

gl1.

gl2.

Select A2:B28. On the Insert tab, in the Charts group, select XY Scatter.

On the Chart Design tab, in the Location group, click Move Chart. Next
to New sheet, type Births Chart, and click OK.

Click the green cross and put a check next to Chart Title, if necessary.
On the Chart Format tab, in the upper left corner, click the arrow and
select Chart Title. In the formula bar, type Live Births Per Thousand
Women vs. Age. Change the font size and type.

Do the same for the Horizontal (Category) Axis Title and type
Age (years). Change the font size and type.

Do the same for the Vertical Axis Title and type Live Births Per
Thousand Women. Change the font size and type.

Click the green cross, click Gridlines » Primary Major Horizontal
the triangle to the right of [] Legend Primary Major Vertical
Gridlines and put a check  [[[] Trendline Primary Minor Horizontal
next to each box. Primary Minor Vertical

On the Chart Format tab, in the upper left corner, click the arrow and
select Series 1. This selects the data points. Just under that click Format
Selection to open the Format Data Series pane. Click the paint bucket
and click Marker and then Marker options.

To the right of Type, select square, to the right of Size, select 8 pt.
Click the triangle next to Fill, click Solid fill, and select green.

Click the green cross, click the arrow to the right of Trendline and select
More Options to open the Format Trendline pane. Click the little column
graph, click Polynomial and set the Order to 5. Put checks next to
Display Equation and Display R-squared. Select those on the chart and,
on the Home tab, make the font 12 pt Arial Black.

Click the Trendline to select it. Click the paint bucket, click the Dash Type
arrow, select the solid line, change the Width to 3, and the color to red.

In the upper left corner select Plot Area from the drop-down menu and
click Format Selection to open the Format Plot Area pane. Click the
paint bucket, click Fill, click Solid fill and select pink as the Color.

Repeat for the Chart Area.

In the upper left corner select Horizontal (Value) Axis from the drop-down
menu and click Format Selection to open the Format Axis pane. Click the
paint bucket and then Line if necessary. Set the width to 4 pt and the
color to dark blue.

On the Home tab, in the Font group, select Arial Black and Blue.

Repeat for the Vertical (Value) Axis.
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gl13.

gl4.

g15.

gl6.

gl7.
g18.

g19.
g20.

On the Chart Format tab, in the Current Selection group, select
Horizontal (Value) Axis Major Gridlines from the drop-down menu and
click Format Selection to open the Format Major Gridlines pane. Click
the paint bucket and then Line if necessary. Set the Width to 2 pt and the
Color to gray. Do the same for the Vertical (Value) Axis Major Gridlines.

On the Chart Format tab, in the Current Selection group, select
Horizontal (Value) Axis Minor Gridlines from the drop-down menu and click
Format Selection to open the Format Minor Gridlines pane. Click No line.
Do the same for the Vertical (Value) Axis Minor Gridlines.

On the Chart Format tab, in the Current Selection group, select
Horizontal (Value) Axis from the drop-down menu and click Format
Selection to open the Format Axis pane. Click the little column graph, |||
click Axis Options and set the Minimum to 12 and the Maximum to 52.
Set Units Major to 4 (no need to set the Minor units since the minor
gridlines are not showing).

On the Chart Design tab, in the Data group, click Select Data, and click
the Add button to open the Edit Series dialog box.

For Series name type Index.

For Series X values, click the collapse dialog button EI click the Births

Data worksheet tab, select A2:A28, and Fdit Series
click the collapse dialog button again. _
Series name:
For Series Y values, click the collapse Index 1
dialog button, click the Births Data Series X values:
worksheet, select C2:C28, and click the _Births Datal$AS2:5A528 *
collapse dialog button again. s T
Click OK. Click OK again. ='Births Data'l$C$2:5C528 L

Select the textbox and drag it under the title.

Click anywhere in the chart. On the Insert tab, in the Illustrations group,
click the Shapes arrow and, near the bottom, select the Thought Bubble:
Cloud callout. Drag the tiny cross to open the callout and enter the text.
Grab the tiny orange circle and drag it to the data gap.

Click each tab and drag it into position.

Set up to print as usual.

PivotTable - Clean Up Data - Solutions

1.
2.

Click cell D1 and type Income.

Click the row number of row 5 so a right pointing arrow appears.

4 June Haven Food $1,230 200 Albe

5[

Right-click and select Delete. Repeat for row 9 (old row 10) and row 85
(old row 87).




PROJECT 6: SAMPLE EXAM QUESTIONS FOR EXCEL — OPTIONAL SG179

j3. Select the range A1:F109. On the Insert tab, in the Tables group, click
Table and then click OK.

A B

‘Bl MonthEJ Pool Bl itemBl Inconfd Nulld Staff &

2 |April Haven Food
3 May Haven Food

C

D

$2,009
$2,025

208 Albe
210 Albe

On the Table Design tab, in the Properties group, type
IncomeTable in the Table Name box.

Table Name:

IncomeTable

PivotTable - Construct PivotTable - Solutions

k1. Click anywhere inside the table. On the Insert tab, in the Table group, click

PivotTable and click OK.

From the PivotTable Fields pane, drag the Income field so that it is under
Values in the Layout section. Repeat for Pool and Item.

Double-click the new worksheet name and type Pivot.

O~ N R =

A B

Sum of Income Column Labels -
Row Labels - Ball

Beach 2341
Cape 2043
Coral 2216
Haven 2804
Sands 2872
Tropics 2559
Grand Total 14835

Pivot | Data (.B

C

2555
2813
2943
2799
2713
2213
16036

D

6684
6612
6470
5264
5502
5397
35929

E

1386
1155
1349
1270
1473
1311
7944

F

Dive Food Polo Spa

6792
5721
6928
6699
6985
6436
39561

G

9147
8432
9610
9438
7630
7735
51992

H

Swim Grand Total

28905
26776
29516
28274
27175
25651
166297

-

PivotTable Fields ~ X

Choose fields to add to report: @} -
Search ,O
] Month -
] Pool

] Item

[¥] Income

1 num

[ staff hd

Drag fields between areas below:

Filters Columns
Item 5
Rows 2 Values
Pool 5 Sum of Income ¥
Defer Layout Update
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k2. Drag Pool so that it is under Columns and Item so that it is under Rows.

A B

1

2

3 | Sum of Income Column Labels -
4 |Row Labels -~ Beach

5 |Ball 2341
6 Dive 2555
7 |Food 6684
8 |Polo 1386
9 |Spa 6792
10 |Swim 9147
11 |Grand Total 28905
12

13

14

15

16

17

18

19

20

21

22

23

24

25

26

27

Pivot | Data @

c

Cape Coral Haven Sands Tropics Grand Total

2043
2813
6612
1155
5721
8432
26776

D

2216
2943
6470
1349
6928
9610
29516

E

2804
2799
5264
1270
6699
9438
28274

4

F

2872
2713
5502
1473
6985
7630
27175

G

2559
2213
5397
1311
6436
7735
25651

H a
PivotTable Fields ~ X
Choose fields to add to report: {é} b
14835 ~eareh O
;gggg [ Month -
7944 Pool
39561 0
51992 Income
166297 I Num
[] staff -
Drag fields between areas below:
Filters Columns
:‘OO -
Rows Values
Item 7 Sum of Income ~

, Defer Layout Update

k3. Drag Month down to the Rows area, just above Item.

k4. Right-click Sum of Income in cell A3 and select Value Field Settings. In

the dialog box, click Average and then click Number Format. Under
Category, click Currency, and change the Decimal places to 0. Be sure
the $ is showing next to Symbol. Click OK. Click OK again.

k5. In cell Al12, click H next to May to collapse that field. Repeat for June.

PivotTable - Construct 3-D Pie Chart - Solutions

[1. Click the Data worksheet tab to make it active. On the Insert tab, in the
Table group, click PivotTable and click OK. From the PivotTable Fields
pane, drag the fields to the proper locations in the Layout area.

Rows
Pool 7
Month 4
Item e
Staff 7

Values

Sum of Income

2. Double-click the new tab and type Pool.

13. In cell A4, right-click E next to Beach, point
to Expand/Collapse, and select Collapse

Entire Field.

+ Beach
i Cape

4 Coral
+Haven
+ Sands
# Tropics

O oo~ bk WwWNN-—=

Row Labels ~ Sum of Income

10 |Grand Total 166297

28905
26776
20516
28274
27175
25651
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4. Click anywhere in the PivotTable. On the PivotTable Analyze tab, in the
Tools group, click PivotChart, click Pie select 3-D Pie, and click OK.

Mac: Clicking PivotChart inserts a column chart. To change it, on the PivotChart

Design tab, in the Type, group, click Change Chart Type, select Pie, and
then 3-D Pie.

5.

16.

On the PivotChart Design tab, in the Location group, click Move Chart.
In the dialog box, replace Chartl with 3-D Pie, and click OK.

Click anywhere inside the chart. Click the Green Cross, point to Data
Labels, and click More Options.

Mac: On the PivotChart Design tab, in the Chart Layouts group, click Add Chart

Element, Data Labels, More Data Label Options.

This opens the Format Data Labels pane. Click Percentage Value
and deselect Value.

+/| Percentage

Click any data label to select them all and, on the Home tab, in the Font
group, make the changes.

On the chart, click the title box to select it. Or, on the PivotChart Format
tab, in the Current Selection group, click the arrow and select Chart Title.
Then, click Format selection. In the formula box, type the title. Select the
title and make the font changes.

9. Set up to print as usual.

PivotTable - Slicers - Solutions

m1. Click the Data tab to make it active. On the Insert tab, in the Table group,
click PivotTable and click OK. From the PivotTable Fields pane, drag the
fields to the proper locations in the Layout area.

Double-click the new worksheet tab and type Filtered.

A
Month

Beach
Cape
Coral
Haven
9 Sands
10 Tropics

CO~ N & W h =

B
(A -

Sum of Income Column Labels -
Row Labels ~ Ball

2341
2043
2216
2804
2872
2559

11 Grand Total 14835

12
13
14
15
16

C

D E

F

Dive Food Polo Spa

2555
2813
2943
2799
2713
2213
16036

3-D Pie | Pools | Filtered

6684 1386
6612 1155
6470 1349
5264 1270
5502 1473
5397 1311

6792
5721
6928
6699
6985
6436

35929 7944 39561

G

9147
8432
9610
9438
7630
7735
51992

H

Swim Grand Total

28905
26776
29516
28274
27175
25651
166297

-

PivotTable Fields ~ X

Choose fields to add to report: @ -

Search O

Drag fields between areas below:

Filters Columns

Month 4 Item 5
Rows Values

Poo 7 Sum of Income ~

-
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m2. Right-click Sum of Income in cell A3 and select Value Field Settings. In
the dialog box, click Number Format. Under Category, click Currency,
and change the Decimal places to 0. Be sure the $ is showing next to
Symbol. Click OK. Click OK again.

m3. On the PivotTable Analyze tab, in the Filter group, click Insert Slicer.
Click Pool and then OK.

On the Slicer Options tab, in the Slicer Styles group, click Yellow.

m4. On the PivotTable Analyze tab, in the Filter group, click Insert Slicer.
Click ltem and then OK.

On the Slicer Options tab, in the Slicer Styles group, click Green.

m5. Click each slicer heading and drag into position.

m6. In the Pool slicer, click the Multi-Select button . Then, click the pools
you do not want leaving Beach, Haven, and Tropics.

Repeat the process in the Item slicer, leaving only Dive and Swim.

A B C D E |~ . .

1 Month (All) - PivotTable Fields ~ X
2 -
3 | Sum of Income Column Labels | T Choose fields to add to report: @ =
4 |Row Labels T Dive Swim  Grand Total Search 0
5 |Beach $2.555 $9.147 $11,702 :
6 |Haven $2.799 $9.438 $12 237
7_|Tropics $2,213 87,735 $9,048 Drag fields between areas below:
8 |Grand Total $7,567 $26,320 $33,887
9 | Pool Y= N2 | tem v=| N2 Filters Columns
o
b1 Beach Ball Maonth - Item A
12| Cape Dive
3
H4 Coral Food
H5 Haven Polo Rows Values
16 Poo g Sum of Income ¥
L7 Sands Spa
8 | | Tropics Swim -

4 » ..| Pools | Filtered ... P » -

m7. Set up to print as usual.

PivotTable - Individual Reports - Solutions

n. On the Filtered worksheet, double-click D5, Grand Total for Beach. A new
worksheet appears. Double-click the worksheet tab and type Beach.
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PivotTable - Stacked Column Chart - Solutions

ol. Click inside the table on the Filtered worksheet. On the PivotTable
Analyze tab, in the Tools group, click PivotChart, select Stacked

Column, and click OK

il

Mac: Clicking PivotChart inserts a column chart. To change it, on the PivotChart
Design tab, in the Type, group, click Change Chart Type, select Column,

and then Stacked Column.

02. Onthe PivotChart Design tab, in the Location group, click Move Chart.
Click the New sheet button, type Stacked, and click OK.

03. Windows users can use the Filter Buttons on the chart (they do not exist
on the Mac). Alternatively, Windows and Mac users can use the cells in the
PivotTable on the Filtered tab and/or the slicers

Filter Button on Chart | Cell in PivotTable Slicer
B1

A3

A4 (Row Labels) Pool
B3 (Column Labels) | Item

Here are the steps using the cells in the PivotTable:

* Click the arrow in cell B1, check Select Multiple Items, check April and

May, and click OK.

* Click the arrow in cell B3 (Column Labels), check Dive and Swim, and
click OK. Or, use the Item slicer.

* Click the arrow in cell A4 (Row Labels) and check Coral, Haven,
Sands, and Tropics, and click OK. Or, use the Pool slicer.
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04. Right-click cell A3 (Sum of Income) and select Value Field Settings.
Click Average and then OK.

(Multiple Iltems) ¥ PivotTable Fields

Average of Income Column Labels -7 Choose fields to add to report:
-2 Row Labels -7 Dive Swim Grand Total
4 Coral $1,111 $3,522 $2,316
8 Haven $910 $3,350 $2,130
YA Sands $906 $2,694 $1,800
=0 Tropics $734 $2 660 $1,697
8 Grand Total $915 $3,056 $1,986

Item
Income

%= %

o
=
=]
@
&
=1

|C-:||--J|-.’JJ

©

(=]
o

Y Filters Il Columns

Month e

3%

M
[A*]

(=]

w

Month ¥

]
i

=]
[%)]

Average of Income

[n*]
7]

1] |c-:| |"-J |

$5,000

=]

=]

$4,000 2 Values

Average of Income ¥

=]

$3,000
$2,000
$1,000
S0

()

ol =]

%]
g

5]

R+ ]

w
3

5]

e

Coral Haven Sands Tropics

sl
n

C
o

[=7]

e

Filtered BN @ : Defer Layout Update

05. On the Stacked chartsheet, click the green cross and select Chart Title,
Above Chart.

» ... Pools | Beach

-

Mac: On the PivotChart Design tab, in the Chart Layouts group, click Add Chart
Element, Chart Title, Above Chart.

Select the Chart Title and type the title.

06. Click the title to select it. On the Home tab, in the Fonts group, select 12 pt
and Arial Black. Repeat for the legend, and axes.

07. Onthe PivotChart Analyze tab, in the Show/Hide group, click Field
Buttons, and select Hide All.

Mac: Skip this. There are no Field Buttons on Mac.

08. Set up to print as usual.
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PivotTable - Change Data and Update PivotTable - Solutions

pl. Click the Data worksheet, right-click its tab, select Move or Copy, check
Create a copy, and click OK. Double-click the worksheet tab, type
Updated Data, and tap Enter.
p2. Click inside the data table and, on the Insert tab, in the Table group, click
PivotTable. Drag the fields to the appropriate boxes. Double-click the new
worksheet tab, type Updated Pivot, and tap Enter.
p3. Click the Updated Data worksheet and change the value in cell D2 from
$2,009 to $40,000.
p4. Starting at cell A110, type the new data.
p5. Click the Updated Pivot worksheet. In still shows the original data.
A B C D E F G H
1
2
3 Sum of Income Column Labels ~
4 Row Labels - Ball Dive Food Polo Spa Swim Grand Total
5 Beach 2341 2555 6684 1386 6792 9147 28905
6 Cape 2043 2813 6612 1155 5721 8432 26776
7 Coral 2216 2943 6470 1349 6928 9610 29516
8 Haven 2804 2799 5264 1270 6699 9438 28274
9 Sands 2872 2713 5502 1473 6985 7630 27175
10 Tropics 2559 2213 5397 1311 6436 7735 25651
11 Grand Total 14835 16036 35929 7944 39561 51992 166297
Right-click any number and select Refresh.
A B C D E F G H
1
2
3 |Sum of Income Column Labels -
4 'Row Labels - Ball Dive Food Polo Spa Swim Souvenirs Grand Total
5 Beach 2341 2555 6684 1386 6792 9147 28905
6 Cape 2043 2813 6612 1155 5721 8432 27376
7 Coral 2216 2943 6470 1349 6928 9610 29516
8 Haven 2804 2799|43255|1270 6699 9438 66265
9 Sands 2872 2713 5502 1473 6985 7630 27175
10 Tropics 2559 2213 5397 1311 6436 7735 25651
11 Grand Total 14835 16036 73920 7944 39561 51992 600 204888

p6.

The data are updated and appear in the PivotTable. Cell H6 shows a value
of 600 for the Cape pool in the new column for Souvenirs. Cell D8, Haven
Food, has changed from 5264 to 43255.

Click a tab and drag it into the correct position.







Information on the Excel Exam

The first exam will cover only Excel. You may not submit any Excel homework on
or after the day the exam is sent to you.

Date and Time: Check your syllabus for the date and time.
Location: On your own Windows or Macintosh computer.

Time Allowed: | will email the exam to you in the morning and you will have to
upload your zipped solution folder to Canvas by the afternoon of the next day.

Materials: | will email you a pdf copy of the exam questions and the original files you
are to modify.

Submission: You will submit your exam in the same way as you did for the
homework except you will NOT send pdf files. Instead, you will submit your
modified Excel files so that | can see your formulas as well as the displayed
results. Do the exam as soon as you get it. Do not wait until the last minute. If
you miss the submission deadline you will receive a score of 0.

Preparation: Before exam day, be sure you have gone over HW06-1 Sample Exam
Questions for Excel a few times before exam day. Be sure you have a reliable
internet connection and computer. You may use either a Windows computer or
a Mac. The exam will work on both platforms.

Questions: If you have questions during the exam, email me. Of course, | will not
give you any help or hints, but if you think something is wrong with your copy of
the exam let me know immediately.

Honesty: The exam is open book and notes, but you may NOT discuss the exam or
get any help from anyone else or do the exam with anyone else. Doing so may
result in your receiving a 0 for the exam and an F for the course.

— SG187 —






Project 7
Word Chapter 1: Creating Documents

Step 1 Read Read the introductory material on page 103 of the textbook.

Step 2 Activities Turn on the computer and do the following:
Project 1A: Start at the top of page 105.

Instead of Activity 1.01 step 1 do the following:

1. Open a blank Word document and save it to your Word Files folder using
the name Lastname_Firstname_1A_ Flyer

You are not going to use sub folders (e.g., Word Chapter 1).
Instead, so you can see them all at once, save all your Word files
in the Word Files folder you downloaded on page SG11.

2. Complete the rest of the Activities through step 6 on page 123. Do NOT do
steps 7 and 8 in Activity 1.16 on page 123.

3. Return here when you have completed Project 1A on page 123.

Do NOT do GO! With Google Docs

Project 1B: When you have completed Project 1A, start at the top of page 127.

Instead of Activity 1.17 step 1 do the following:

1. Navigate to your Word Files folder and open wO1B_Programs, which is
one of the files you downloaded at the start of the term.

2. Save the file in your Word Files folder using the name
Lastname_Firstname_1B_Programs

3. Complete the rest of the Activities through step 4 on page 146. Do NOT do
steps 5 and 6 in Activity 1.29 on page 146.

4. Return here when you have completed Project 1B on page 146.

|‘ Do NOT do GO! With Google Docs or GO! To Work

Step 3 Homework After you have completed Projects A and B return here, do
the following additional activities, and turn them in for grading.

— SG189 —
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HWO07-1 Flyer (Based on Project 1A)

Problem: How can you create a flyer to advertise an upcoming event?

a. Open the document Lastname_Firstname_1A_Flyer, which you created while
following the directions in the textbook and saved on page 123.

b. Save the document in the Word Files folder using the name
HWO07-1 HWID 1A Flyer Done

c. The orange textbox is too large and will get in the way of text you soon will add.
1. Make the text in the orange textbox 12 pt.
2. Make the textbox 0.75 inch high and 3.5 inches wide.

3. Move the textbox so it is in the lower right corner of the page, just inside
the orange border.

d. In this project you learned how to insert a field code that displayed the name of
the file in the footer. This is a bit different from Excel but the result is the same.
Insert a few more field codes by doing the following:

1. Move the insertion point to the bottom of the document, just to the right of
the word website.

2. Tap Enter twice, type Today's Date: and then a space.

3. Onthe Insert tab, in the Text group, click the Quick Parts arrow and
select Field.

Mac:Insert tab, Text group, Field. Under Field names, click Date. Click Options,
select this format: ddd,MMMM d, yyyy. Click Add to Field. Click OK twice.
Skip to Step 6 below.

4. In the Field names group, scroll down and click Date.

5. In the Date formats group, select the format that has day, month, date, and year.

Please choose a field Field properties
Categories: Date formats:
(Al v dddd, MMMM d, yyyy
Field names: 7/4/2023
Datab Tuesday, July 4, 2023
T [iya. 2023
oot 714723

Click OK.

6. The current date will be shown. If the code is shown (rather than the actual
date) tap Alt + F9. If that does not work, try Fn + Alt + F9. If that does not
work, point to the field, right-click, and select Toggle Field Codes. Alt + F9
is called a toggle because it toggles (switches) between two things.
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7. To make it easy to identify text that is the result of a field code, tell Word to
highlight all fields in the document by doing this:

Click the File tab, click Options, click Advanced, scroll down to the Show
document content group, click the Field shading arrow, and select Always.

General Show document content

Display [] show background colors and in|
Proofing [] Show text wrapped within the d
Save [] show picture placeholders
Language Show drawings and text boxes ¢

Show bookmarks
|:| Show text boundaries

Ease of Access

Advanced

|:| Show crop marks

Customize Ribbon
[T] Show field codes instead of the|

Quick Access Toolbar

Field shading: | Always =

Mac: To have the field codes always shaded, from the Word menu, select
Preferences, View and, next to Field shading, select Always.

8. Click OK. The date now appears with a shaded background.

Today’s Date: Tuesday, July 4, 2D23|

The shading will not appear on the printed copy.

9. Tap Alt + F9 to view the field code.

| Today’s Date: { DATE \@ "dddd, MMMM d, yyyy" \* MERGEFORMAT }

10. Use the same technique to insert, under Today’s Date, enter the following
text and fields, one per line.

Date Last Saved: SAVEDATE
Last Saved By: LASTSAVEDBY

File name full location: FILENAME For this one, when you insert the
FILENAME field, click the box Add path to filename (the path is the
location):

Please choose a field Field properties

Categories: Format:

(All v none) |
Uppercase
Lowercase

A First capital

Field names:

Mac: Insert tab, Text group, Field. Under Field names, click FileName. Click
Options, click Field Specific Switches, click Add to Field, click OK twice.
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This shows the complete location just like you did in Excel. Tap Alt + F9 to
show the field name results, if necessary.

Today’s Date: Tuesday, July 4, 2023
Date Last Saved: Tuesday, July 4, 2023

Last Saved By: Douglas Robertson

File name full location: C:\Users\droberts\Desktop\HW07-1 HWID 1A Flyer Done.docx

Here, C: stands for my hard drive, Users means my computer is set up to
have multiple users, droberts is my login ID, Desktop is where | have this
file stored, and then the file name, and .docx means it is a Word file.

Mac: Skip parts e, f, and g below and resume at part h. | could not get the
described Quick Access Toolbar techniques to work properly on my Mac. It
is possible to modify the Quick Access Toolbar but it is difficult to work with.
If you want to give it a try, from the Word menu, select Preferences, click
Ribbon & Toolbar, click Quick Access Toolbar tab.

e. You are going to add a footer that contains the file name for every Word
document you save. Here is a quick way of doing that using Word’'s AutoText
feature. First, you will add AutoText to the Quick Access Toolbar, which is
the top line in the Word window. Here is what mine looks like:

T e T

Outdent202s~| BB [F H - 9 Q - [/ DocumentMap =~ =

Click the File tab, click Options, and click Quick Access Toolbar.
In the list under Choose commands from, click All Commands.

Scroll through the list of commands until you see AutoText.

A

Click AutoText. E.E Customize the Quick Access Toolbar,

Choose commands from: G

All Commands EI
OGS TR "
i AutoText

5. Click| add>> |.

6. Click OK. The AutoText button |~ appears in the Quick Access Toolbar.

f. To add an entry to the AutoText gallery, do the following:

1. Select the text that you want to add to the Footer |
AutoText gallery. In this case, double-click the [Foote]
footer area where the file name appears and
select the file name field code. HWO07-1 HWID 1A Flyer Done

2. Inthe Quick Access Toolbar, click AutoText, and
then click Save Selection to AutoText Gallery.
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3. Type FileName in the Name box of the | c"eate New Building Block

Create New Building Block dialog box.
Leave the other boxes as they are.

Mame: FileMame

4. Click OK.
General
5. Click the AutoText button and you will see the | micname
FileName entry you just created. [ L s Fyeroore

Even though the actual file name shows the AutoText entry it is really the
field code that will change if you change the file name. Any time you want
the field name inserted, simply select it from the AutoText button.

g. You can have Word insert the file name field code directly into the footer
without having to open the footer first.

1. Onthe Quick Access Toolbar, click the the AutoText button, point to
FileName, right-click, and select Insert at Page Footer.

General

FileMame

HWO7-1 HWID Flyer Don

Insert at Current Docu

Insert at Page Header

Insert at Page Footer

The file name field code is inserted directly into the footer (now the file
name is there twice). If necessary, adjust the orange textbox so the file
names in the footer are visible.

www.SturgeonPointProductions.com

HW07-1 HWID 1A Flyer DoneHW07-1 HWID 1A Flyer Done

2. Save the document.

h. Depending on how your system is set up, the fields may not have automatically
updated their values. To do that select the four lines in the body of the
document that contain field codes, and then tap F9. Remember, on a laptop
you may need to use the fn key also.

Mac: Right-click and select Update Field.

This will update the fields. You may have to do the same for the field names in
the footer.

i. Tap Ctrl + p and compare the preview with the key. Make needed corrections,
save the document, and close it.
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HWO07-2 Programs (Based on Project 1B)
Problem: How can you create a flyer that advertises available internships?

a. Open the document Lastname_Firstname_1B_Programs, which you created
while following the directions in the textbook and saved on page 146.

b. Save the document in the Word Files folder using the name
HWO07-2 HWID 1B Programs Done

c. Do the following to adjust the title so that it is on two lines.

1. Onthe Home tab, in the Paragraph group, click the Show/Hide button | 4
SO you can see the paragraph codes.

4 | shows where the Enter key has been tapped. It indicates a new paragraph.

a dot shows where the Spacebar has been tapped.
—» a right-pointing arrow shows where the Tab key has been tapped.
------------------------------- Page Break------ indicates a manual page break.
- SECHON Break (Next Page)--- indicates a section break.
2. Inthe title, click just to the left of the word Productions.

3. Tap the Backspace key to remove the blank space.

4. Tap Shift + Enter to insert a manual line break.
It is indicated by a left-pointing arrow (_l

Sturgeon-Point<

Productionsy]

This means the two lines are still considered a single paragraph. If you had
tapped Enter the two lines would be considered separate paragraphs.

d. Scroll down so you can see the break between pages 1 and 2. Notice how the
second list is split between the two pages.

Here-is-a-partial-list-of-internship-positions-currently-available:q

v" = Production-Assistanty]

HWO7-2-HWID-1B_Programs_Donel

If possible, it is a good idea to keep all items of a list on a single page so the
reader can see all lines in the list at once.
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Fix this by doing the following:
1. Select the text from Here is a partial list... through the end of the list.

Right-click and select Paragraph.

Indents and Spacing : Line and Page Breaks :

2
3. Click the Line and Page Breaks tab.
4

Check the first three boxes.

Pagination

Widow is the last line of a paragraph that
appears by itself at the top of a page. It
is considered good form to force a
second line to accompany a widow.

Widow/Orphan control
Keep with next

Keep lines together
|:| Page break before

Orphan is the first line of a paragraph
that appears at the bottom of a page by itself. It is considered good form
to send an orphan to the next page to rejoin its paragraph.

Keep with next forces the current paragraph to appear on the same page
as the next paragraph. This is good for lists and for rows of tables (so
the table will not split across a page break) and subheads (so the
subhead will stay with its following text).

Keep lines together forces a paragraph to have all of its text on the same
page, rather than split between the bottom of one page and the top of
the next. This is good to do for short paragraphs.

Page break before. This puts the text on the next page no matter what.

— v i— - i

I
I

5. Click OK; selected items now are together on page 2.

Bullet Library

e. Change the bullet type on the first page: Nere || @ || O

1. Select the first bulleted list and, on the Home tab, in the » | v
Paragraph group, click the Bullet icon arrow, and
select Define new Bullet.

Click Picture.

Click Browse next to From File. égefne New Bullet..

Navigate to the Word Files folder, select HW07-2 Goldy Original, click

Document Bullets

e VvV | m

Insert and OK. If the image of Goldy cannot be added
to the gallery, drag the file HW07-2 Goldy Original to 28 Short feature films
the desktop and try again. If that fails, use any image. M2 Documentaries

f. Tap Ctrl + p and print only page 1. Your print dialog should look like this:
Printer ,

[P © Page Range
Mac 0
. Adobe PDF

I - T mmm——m— Enter page numbers andfor
Ready page ranges separated by

: : [ - commas (e.g. 2, 5-8)
Printer Properties

Settings =) tefr e i)

Show Quick Preview

o -j Custom Print

-

Type specific pages, secti...

Pages: |1 | ° |

Make needed corrections, print, save the document, and close it.
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HWO07-3 Agenda
Problem: How can you create a draft agenda for a club meeting?

a. Open the document HWO07-3 Agenda Original, which is one of the files you
downloaded at the start of the term.

b. Save the document in the Word Files folder using the name
HWO07-3 HWID Agenda Done

c. Insert a footer that contains the name of the file.
d. Change all four margins to 1.25 inches.

e. Put a border on the page. The border should have a purple thick and thin 3 pt
line (Design, Page Background, Page Borders).

Page Border | Shading

Setting: Style: Preview

diagram below or

Mone eflittons to apply borders

. BDE

m

K
I:l Shadow —————— ‘ g
D 3D Color i i
= I - |
Width:
g—.u Custom 3pt _B
=" Apply to:
Whole document E|
e ]
[ OK ] l Cancel ]

f. Insert a Watermark that says Draft slanted across the page (Design, Page
Background, Watermark)

g. Make the font of the first two lines of the Agenda Arial Black, 18 pt, and red.

h. Set up the agenda as an outline.

1. Select the lines starting with New Business and continuing all the way
through Continue discussion of fundraising projects.

2. Onthe Home tab, in the Paragraph group, click the m

=" and then click this format: | a)

Multilevel List arrow

The list will appear with numbers going from 1 to 12. )
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i. Do the following to change the outline level of the lines from Treasurer’s report
through Other new business so that they are subordinate to New Business.

1. Select those lines.

2. On the Home tab, in the Paragraph group, click the Increase Indent
button |#=| . Notice how the numbers of the selected lines are automatically
changed to letters.

1) New Business

a) Treasurer's report

b) Big brother and big sister project
c) Election of officers

d) President

e) Vice President

f) Treasurer

g) Secretary

h) Other new business

j. Change the outline level of the list of officers.
1. Select the lines from President through Secretary.

2. Click the Increase indent button. The list of officers will be indented and
listed with Roman Numerals.

k. Follow a similar procedure to change the outline level of the last two lines
(Reading of minutes and Continue discussion of fundraising projects) so
that they are subordinate to Old Business.

|. To see how Word will automatically adjust the lettering of the items, add the
following two lines just under Big brother and big sister project:

Food Shelf donations
Tax program

Notice how the items are automatically given letters and the letters of following
items are changed.

a) Treasurer's report

b) Big brother and big sister project
c) Food Shelf donations

d) Tax program

e) Election of officers

m. Delete the line with Vice President. Again, notice how the numbers for
Treasurer and Secretary are automatically updated.



SG198

PRrRoOJECT 7 WORD CHAPTER 1: CREATING DOCUMENTS

n. Insert a SmartArt object.

1. Tap Ctrl + Home to move to the top of the document.

2. Onthe Insert tab, in the Illustrations group, click the SmartArt button.

3. From the Relationship category, choose the Basic Venn shape.

Choose a SmartArt Graphic &u
— =1 U5 EE[E
Al == EI@@
EE List 00— 00— O ®
% Process E e+0=0 é'::)@
f:j? Cycle - .
&b Hierarchy EL@E : C%)iz @E|®
: : @ =l =l =
BEd Relationship —
_ © G @
Matrix &
< @0+® L
P id
é yram © © é Basic Venn
Picture —~ - HH;H Q - =l uUseto show overlapping or -
@ Office.com ( - ﬁ? I»Sfi\ interconnected relationships. The first
= o= MRS seven lines of Level 1 text correspond
A with a circle, If there are four or fewer
- ﬁ = Basic Vi lines of Level 1 text, the text is inside
.r'_}:_}:_}:_‘\, ﬁ q.a@ —a;c\}:;n L_I|| the circles. If there are more than four
St @ = . | lines of Level 1 text, the text is outside ~
[ ok || canca |
Click OK.

4. In the top circle, type Service; in the left circle, type Respect; in the right

circle, type Dignity.

5. Apply a Colorful theme.

SMARTART TOOLS
MathType DESIGH FORMAT
L
L ° L
- -
Change " "
Colors =
|| Primary Theme Colors
Colorful
L 4 ' 4
> 'y .‘
Accen Colorful - Accent Colors

6. Make the font purple 12 pt Comic Sans MS.

7. Make the height and width of the object 2 inches.
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8. Setthe Wrap Text to In Front of Text.

Respect

Service

H s H

Age

Campus Service Cli

LAYOUT OPTIONS X

In Line with Text

I

With Text Wrapping

o FRE o TR = B

n:E

bdmare waiith tevt

In Front of Text

9. Move the object to the upper right corner just inside the page border.

0. Tap Ctrl + p and compare the preview with the key. Make needed corrections,

save the document, and close it.

HWO07-4 Brochures

Problem: How can you create a memo outlining features of a brochure that will be

published?

a. Open the document HWO07-4 Brochures Original, which is one of the files you
downloaded at the start of the term.

b. Save the document in the Word Files folder using the name

HWO07-4 HWID Brochures Done

c. Insert a footer that contains the name of the file.

d. Set up the company logo and memo header by doing the following:

1. Insert the JPG file, HWO07-4 Brochures Logo Original.

2. With the image selected, on the Drawing Format tab, in the Arrange
group, click the Wrap Text arrow and select In Front of Text. You can also

do this by clicking the Layout Options icon |-A:

of Text icon

Fas

and selecting the In Front

Drag the logo so it is in the upper left corner of the page, about a quarter

inch from the top and side.

3. Insert a textbox (Insert, Text, Text Box, Draw Text Box) and enter this

text:

PO Box 75732

Colorado Springs, CO 80970

719-638-9511
JohnWells@ad-excellence.net
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4. Change the font to 10 pt Comic Sans MS.

5. Move the textbox to the upper right corner of the page about a quarter inch
from the top and side. It should have no border or fill (Drawing Format,
Shape Styles, Shape Outline, No Outline).

6. Select the word MEMO and, on the Insert tab, in the Text group, click the
Word Art arrow, and select the pink A

7. Move the Word Art so everything is aligned like this:

PO Box 75732
Colorado Springs, CO 80970

‘ y M @ 719-638-9511
AD JohnWells@ad-excellence.net

e. Change the tab settings on the first 7 lines of the memo. Keep this in mind:

Page Margins are the amounts of blank white space at each side of the page
(left and right, top and bottom).

Paragraph Indents are the little triangles that show where the first line, the left
edge, and the right edge of a paragraph are located.

Tab Stops are locations where you want text to line up. When you tap the Tab
key the text moves to line up with a tab stop.

Type of Tab Stop Left
Click to Change  First Line (Hanging) Tab Stops Right
l Margin  Indent Indent Right Left Center Decimal Indent Margin
f—Aﬁ
S Y e AT L e e e e 2 e T 3 g & e B e A 7
Dr. + Terry - Ann » Lamb -+ Blacksmith -+ 0.3212q Backward P
Ms. - Adeline -+ Sylvia - Robertson -+ Student - 15.234Y| ——— shows where
Mr. - John - Paul + Ozols -  Lecturer - 365.2 Enter Key
Arrows show where Tab Key was}apped was tapped

In the above, notice how the

middle names (Ann, Sylvia, Paul) are lined up on the right

last names (Lamb, Robertson, Ozols) are lined up on the left
occupations (Blacksmith, Student, Lecturer) are lined up in their middles
numbers are lined up on their decimal points

Mac: Tab stops look a bit different on a Mac.

r Tt 4 r
Left Tab Center Tab Right Tab Decimal Tab
Left Tab Cenﬁer Tab Right Tab Decimal Tab
Left Tab Center Tab Right Tab Decimal Tab

1. Select the 7 lines starting with the line that contains TO and ending with the
line that contains DATE. Set a right tab stop 2/ at 1 inch and a left tab
stop ['= at 1.25 inches.
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2.

5.

Click the Show/Hide button to show the codes. Click just to the left of P
in Patricia (between the O in TO and the P) and then tap the Tab key. It
looks like nothing happened! Now, click just to the left of the T in TO: and
tap Tab. Notice how the colon in TO: lines up with the right tab stop and
the P in Patricia lines up with the left tab stop.

2 SRR T RN S KRR

LIl

-+ TDE -+ :Patricia-Smith: -‘Marketing -Director¥

Remember, the Tab stops are the markers on the ruler ['2 and '] that
show where the text will be aligned, while the Tabs are the little arrows -+
that show where the Tab key was tapped to move the text.

Repeat this procedure for the FROM, SUBJECT, and DATE lines.

Click to the right of the tab arrow in the DATE line. Insert the PrintDate
field, which will display the date the memo was printed (Insert, Text, Quick
Parts, Field). Set the date format to show the day, month, date, and year.

Please choose a field Field properties
Categories: Date formats:
(Al v dddd, MMMM d, yyyy
Field names: 7/27/2020
PrintDat Monday, July 27, 2020
p = ~ July 27, 2020
rivate 7127420

Click OK. The field will display XXX, XXX 0, 0000 because you have not
yet printed the document.

| -

DATE: - XXX XXX00, 00007

6.

When you print, the proper date will appear.

Tap Alt + F9 to see the field code.

| -

DATE: + {PRINTDATE-\@"dddd. MMMMdd. yyyy"-\*-MERGEFORMAT}* |

Mac: Right-click and select Toggle Field Codes.

7.

Tap Alt + F9 again to see the result.

f. Click in the paragraph that begins with The concept for the new... and set the

first
and

line indentation to 0.25 inch. You can do this by right-clicking the paragraph
then selecting Paragraph from the shortcut menu or by sliding the upside

down triangle = on the left side of the ruler to 0.25.

g. Click in the paragraph that begins | need to schedule.... Tap Ctrl +y. This is
the shortcut for the Repeat command. It repeats your last action or text entry.
The first line indent is set to 0.25 inch.
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h. Move the insertion point to the left of the first word of the paragraph that begins
Be prepared to discuss. You are to insert a bullet here without using the
automatic bulleted list feature. Like many of Word’s automated features, the
automatic bulleted list feature can save time, but it also can be annoying and do
things behind your back that you do not want.

1. Onthe Insert tab, in the Symbols group, click Symbol and then More Symbols.
2. Inthe dialog box, if necessary, click the Symbols tab.

3. From the Font box drop-down menu, select (normal text)

Mac: Instead of steps 4 and 5, select any symbol you wish.

4. From the Subset box drop-down menu, select Miscellaneous Symbols.

5. Scroll down until you see the symbol for beamed eighth notes
If you have trouble finding it, type 266B in the Character code box near
the bottom of the window. You may \ use a different symbol if you wish.

Symbols Special Characters

Font: |(normal text) o Subseg: | Miscellaneous Symbols b
v o )P EHE|P|R alt|H| KKK
Z|z | AM|V|D v [Wiw|¢ Flole|l|o|a
j V S Z r r r 1 g a TN T § § L o N
2 A A 2 el # ] 52 ]
Recently used symbols:
"l |V | F|EEF|O® T L] >+
|:mddEg:th =] Character code: [2668 | from: |Unicode hey |
AutoCorrect... Shortcut Key..  Shortcut key:

The lower left corner says you have selected Beamed Eighth Notes and it
gives you the option of creating a Shortcut Key for this symbol. Let’s do that so
that if you want to insert this symbol again all you have to do is tap the shortcut.

6. Click Shortcut key.

7. Click in the box under Press new shortcut key and then tap Alt + n (n for note) or
any other key combination you wish.

8. Click Assign and then click Close (or tap Esc key).
9. Click Insert and then click Close. The symbol is inserted.
10. Inthe Symbol dialog box, click Close.

11. Tap Tab to move the text Be prepared to discuss... to the next tab stop.
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12. Follow the same procedure, or use the new shortcut key, Alt + n, to insert
the Beamed Eighth Notes just to the left of Have ready in...

J - Beprepared-to-discuss-in-great-detail-your-ideas-concerning-the-layout-of‘the-
brochure. It-is-a-nice-piece that-we-can-be proud-of.q

T

# - Havereadyin'report-form-your-analysis-of-the marketability-of‘the -new-product.-
Include-the-target-population-as-well -as-revenue-projections.q|

13. Select the two paragraphs you just worked on and use your mouse to slide
the indent markers on the ruler as follows:

First line indent = to 0.25 inch
Left indent (handing indent) & to 0.5 inch.
Right indent « to 5.5 inches.

Y L e e 2 e e 3 e A 0B e
J4->Be prepared-to-discuss-in-great-detail-your-ideas-concerning the-layout-of*
the'brochure. It'1s‘anice piece-that-we-can-be-proud-of.q

14. For the two paragraphs you just worked on, set a right tab stop with a dot
leader at 5.5 inches by doing the following:

First, select the two paragraphs. Then:
Right-click and select Paragraph.
Click the Tabs... button.

Type 5.5 in the Tab stop position box.
Click Right in the Alignment group.
Click 2.... in the Leader group.

Click the Set button.

Tabs ? X
Tab stop position: Default tab stops:
5.5" 0.5" =

-

5 5
Tab stops to be cleared:

Alignment
O Left O Center @ Right
O pecimal () Bar
Leader
O 1 None @:z... O3
Os__
Set Clear Clear All
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15. Click OK. The new right tab stop appears in the ruler.

A SR SRR SR AR B S SR SRR B SR SRR SRR SUR

J4->Be prepared-to-discuss-in-great-detail your-ideas-concerning the-layout-of-
the-brochure. It‘is-a‘nice-piece-that-we-can-be proud-of.q

16. In the first of the two paragraphs, click to the right of the words proud of,
delete the period, tap the Tab key, and then type IMPORTANT!

SRRV SERNEEES SRR SRR SRR SRR SN SRR SRR B R RRIE- SRR SCREE

Ji->Beprepared to-discuss-in-great-detail -your-ideas-concerning the-layout-of*
the-brochure. It-is-a-nice piece-that-we-can-be proud-of .. .\IMPORTAN T

Dot leader

Depending on how your computer is set up, you might have noticed that
the word Be in the first bulleted paragraph has a blue squiggly underline.
Word does this to alert you that the grammar might incorrect. It is like Word
asking you “Are you sure this is the word you want?” In this case, it is.

i. Use tabs to align the items in the list near the bottom of the document.

1. The items are separated by a comma and a space. Replace the comma
and space by a TAB. You can do that in one of two ways:

e Use your mouse and the TAB key and make the changes one by one.
This is easy but soooo unsophisticated and takes time.

e OR, use Word’s Find and Replace feature as you did in Excel on page
SG134. To use that, select the four lines and tap Ctrl + h to open the
Find and Replace dialog box. Note that you can use wildcards in
Word’s Find and Replace, but that is not necessary here.

Mac: From the menu bar, click Edit, Find, Advanced Find and Replace, Replace.

Type a comma and a space in the Find what box, type the TAB code, "t,
in the Replace with box, and click Replace All. Twelve replacemets will
be made. When asked if you want to continue from the top of the
document, click No.

g e
Style— Colors+Price + Thicknessq
Regular —+ onewcolor - 4 -%0000087
Foldeditwo-color -+ 5.25 - 11.67
Multi-stapled+fourcolor - 13.3 + 8.17
a

—— _Little arrow shows TAB key was tapped.

2. Select the four lines and, on the ruler, insert the following tab stops:

-

Right tab stop at 2 inches Mac 0|

Left tab stop at 2.5 inches '~/ Mac r
Decimal tab stops at 4 and 5 inches. /! Mac i

Bar tab stop at 5.5 inches. |
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SG205

3. Click at the left of each line. Tap the TAB key to right align the first word of
each line.
& 'EI"""1"""'3"'L"'3"""'i-'"""i-"'l"'a"""'?'
- -+ Style —+ Colors —+  Price + Thickness
. -+ Regular - one-color -+ 4 - .0000089
- Folded -+ two-color - 525 - 11.69
v - Multi-stapled -+  four-color - 13.3 - 8.1

q

j. Changing the locations of the tab stops is easy. Do the following:

1.
2.
3.

B

Select the four lines you just worked on.
Move the right tab stop to 1 inch (click it and drag to the left).

Move the left tab stop to 2 inches and set a dot leader for this tab
(double-click any tab stop to open the Tabs dialog box).

Change the decimal tab stop at 4 inches to a left tab. To do that, click the
tab stop and drag it down off the ruler. Then, set the tab type to Left and
click at 4 inches. Notice that when you do this the numbers in the column
no longer line up on their decimal points.

5. Drag the bar tab to 3 inches.

ATEEEEELERTE: TR RN TSR R S e TR 'R
=  Style..........: o JUUU Colors - PriceThicknessq
- Regular........... r= JOUO one-color - 4 - .0000089
-  Folded........... = JOTO two-color - 525 - 11.69
->Multi-stapled........... r= SRR four-color - 133 > 819

6. Select only the line with the titles and change the decimal tab at 5 inches to
a left tab at 4.75 inches. This lines up the title Thickness a bit better.

k. Put in some textboxes to highlight parts of the memo.

1. Insert a textbox (Insert, Text, Text Box, Draw Text Box).

2. Type the text Decimals lined up and make it Arial Black 14 point red.
3. Make the textbox border red 3 pt and Format Decimals-lined-up9]
the Shape Fill to No Fill. Thicknessq
_ N _ .000008
4. Adjust the position and size of the textbox so 11.6Y
it's box surrounds the last column of numbers. 8.19

5. Insert an oval and place it around the second column of numbers.
6. Set the oval to have no fill. ]
Price
7. Make the border 3 pt and blue. 4
5.25
8. Adjust the position and size so the oval 13.3

surrounds the second column of numbers.
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10.
11.
12.

Insert a Cloud Thought Bubble (Insert, lllustrations, Shapes, Callouts).
Type Decimals NOT lined up and make the font Arial Black 14 pt white.
Set the Fill to Texture, Purple mesh.

Position the callout as shown below. To move the pointer
part of the callout, click the little yellow box and drag it.

p

I'need-to-schedule-this-with the printer-so-they-can-order-paper.-Myunderstanding-is-

that-we-will -be-printing-copies-as-follows.J
)| Decimals-lined-up¥]
- Style.......... R idiiicisis Colors = Thicknessq
- Regular.........2.......... one-color - .000008Y
Folded....ccc.c iciuiina two-color - 11.69
->Multi-stapled..........2.......... four-color - 8.1
f

Decimals-NOT-
lined-up9|

I. When you fill out a form or write a paper for publication you typically are given a
limit on the number of words or characters you may use. Word has a feature to
help you determine this.

1.

Be sure nothing is selected and, on the Review tab, in the Proofing group,
click Word Count. You should see that this document has about 161
words (plus or minus a few).

Use the Snipping Tool to take a screenshot of the Word Count window
and then close the window.

Paste the screenshot into the document.

Make the image 2 by 2 inches. You may notice that if you change one
dimension to 2 inches, the other dimension automatically changes. Excel,
Word, and PowerPoint do this to keep the same relative dimensions (called
the aspect ratio) on an inserted picture.

To get around this, first select the Word Count image.

On the Picture Format tab in the Size group, click the launch dialog button
to open the Format Picture pane. On the Size tab, uncheck Lock aspect
ratio so you can change each dimension separately. ] LO"‘"'

Mac: Remove the check in the box to the right of the height and width values.

Hos 07
=1 = ~ <€
N i -~

Then, enter 2 in the Height box and 2 in the Width box. Click OK
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5.

10.

11.

12.

Click in a white area to deselect the Word Count image. On the Insert tab,
in the lllustrations group, click the Shapes arrow and, under Basic
Shapes, select the oval || This will display a cross. Drag the cross to
display an oval.

With the oval selected, on the Shape Format tab, in the Size group, make
the height and width 2.85 inches so it is a circle.

On the Shape Format tab, in the Shape Styles group, click the Shape Fill
arrow and select yellow.

Right-click the circle and select Send to Back.
Center the Word Count image in the circle.

With the Word Count image selected, hold down the Ctrl key and click the
circle. This selects them both.

Right-click and select Group. This makes the two images act as one object
S0 you can move both at the same time.

Drag the Word Count/Circle group so it is under the Style/Colors list.

m.Tap Ctrl + p and compare the preview with the key. Make needed corrections,
save the document, and close it.

Step 4 Submit Now, submit the following. Use these names for the pdf files:

HWO7-1 HWID 1A Flyer Done

HWO07-2 HWID 1B Programs Done Page 1 — Do NOT submit pages 2 or 3
HWO07-3 HWID Agenda Done

HWO07-4 HWID Brochures Done

Create a pdf file of the output for each of the above, place them in a folder
called HWO7 HWID LastName, FirstName, zip the folder and, by the due date,
upload it to the Canvas folder HW07 Word Chapter 1: Creating Documents.

Step 5 Backup Now would be a good time to backup your files.






Project 8
Word Chapter 2: Creating Letters and Tables

Step 1 Read Read the introductory material on page 169 of the textbook.

Step 2 Activities Turn on the computer and do the following:

Project 2A: Start at the top of page 171.

Instead of Activity 2.01 step 1 do the following:

1.

Navigate to your Word Files folder and open wO2A_Experience, which is
one of the files you downloaded at the start of the term.

Save the file in your Word Files folder using the name
Lastname_Firstname_2A Resume

To save time, instead of typing the text shown in several places in the
textbook you may copy the text from the file HW08-1 Resume Extra Text
Original and paste it in the locations described in the textbook:

Page 173, Activity 2.02, Step 2
Page 173, Activity 2.02, Step 3
Page 176, Activity 2.03, Step 11
Page 179, Activity 2.06, Step 4

The Resume Assistant is mentioned in Step 4 on page 174. That is NOT
installed on many computers so skip to Step 9 on page 175.

Complete the rest of the Activities through step 16 on page 186. Do NOT
do steps 17 and 18 in Activity 2.10 on page 186.

Do NOT do Activity 2.11 on pages 186-187.

Return here when you have completed Project 2A on page 185.

Do NOT do GO! With Google Docs

Project 2B: When you have completed Project 2A, start at the top of page 191.

Instead of Activity 2.12 step 1 do the following:

1.

Open a blank Word document and save it to your Word Files folder using
the name Lastname_Firstname 2B Cover_Letter

Complete the rest of the Activities through step 8 on page 205. Do NOT do
steps 9 and 10 in Activity 2.20 on page 206.

Do NOT do Activities 2.21 through 2.24 on pages 206-211.

— SG209 —
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4. Return here when you have completed Project 2B on page 206.

Do NOT do GO! With Google Docs or GO! To Work

Step 3 Homework After you have completed Projects A and B return here, do
the following additional activities, and turn them in for grading.

HWO08-1 Resume (Based on Project 2A)

Problem: How can you create a professional looking resume?

a. Open the document Lastname_Firstname_2A_ Resume, which you created
while following the directions in the textbook and saved on page 185.

b. Save the document to your Word Files folder using the name
HWO08-1 HWID 2A Resume Done

c. Make the following modifications.

1. Onthe Table Layout tab, in the Table group, if necessary, click View
Gridlines so you can see the non-printing cell gridlines.

2. In the first column, select from OBJECTIVE through HONORS AND
ACTIVITIES.

3. Onthe Home tab, in the Font group, click the Change Case button
and select Capitalize Each Word.

HOME INSERT DESIGM PAGE LAYOUT REFEREMCES AT

cut Calibri (Body) ~|11 ~|A & |Aa~- | %o | := - i= -
Copy ot
- I Sentence case,
" Format Painter D dmes=s o
lowercase
board I Font
UPPERCASE

Capitalize Each Word

The letters are converted from all UPPERCASE so that each individual word
is capitalized. This is really useful if you mistakenly tap the CAPS LOCK key
and type a bunch of stuff that you did not want to be UPPERCASE.

d. Tap Ctrl + p and compare the preview with the key. Make needed corrections,
save the document, and close it.
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HWO08-2 Cover Letter (Based on Project 2B)

Problem: How can you create a cover letter that will catch the attention of the reader?

a. Open the document Lastname_Firstname_2B_Cover_Letter, which you
created while following the directions in the textbook and saved on page 206.

b. Save the document to your Word Files folder using the name
HWO08-2 HWID 2B Cover Letter Done

c. Modify the table in this document by doing the following:

1.
2.

Select the first row of the table.

Right-click and select Insert, Insert Rows Above.

Inzert

Delete Rows

B Merge Cells

b & Insert Columnsto the Left
= Insert Columns to the Right

[:l Insert Rows Abowve

In the new top row, type Program in the left cell and Duty in the right.

Select the entire table. On the Home tab, in the Paragraph group, click the
arrow next to the border icon and select | O gorders and Shading... |

Click ! Custom

affecting others.

so you can change individual cell borders without

Under Color, select red. Under Width, select 3 pt. In the Preview section,
click on the four borders of the table.

Make the Style dashed, the Color blue, and the Width 1 pt. In the Preview
section, click on the inside horizontal and vertical lines.

Borders

Setting:

Page Border Shading

MNone

Grid

Custom

Style: Preview

A Click on diagram below or use buttons
to apply borders

Apply to:
Table
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8. Click OK.

9. Selectrow 1. On the Home tab, in the Paragraph group, click the arrow
next to the border icon and select Borders and Shading.

10. Click the Shading tab and select gray for the Fill.

d. Tap Ctrl + p and compare the preview with the key. Make needed corrections,
save the document, and close it.

HWO08-3 Bill of Rights *

Problem: How can you reformat text from an email to make it easier to read?

During the debates on the adoption of the U.S. Constitution, its opponents
repeatedly charged that the Constitution as drafted would open the way to tyranny
(cruelty and injustice in exercising authority) by the central government. Fresh in
their minds was the memory of the British violation of civil rights before and during
the American Revolution. They demanded a bill of rights that would spell out the
immunities of individual citizens. Several state conventions in their formal ratification
of the Constitution asked for such amendments; others ratified the Constitution with
the understanding that the amendments would be offered.

On September 25, 1789, the First Congress of the United States therefore proposed
to the state legislatures 12 amendments to the Constitution that met arguments most
frequently advanced against it. The first two proposed amendments, which
concerned the number of constituents for each Representative and the
compensation of Congressmen, were not ratified. However, Articles 3 to 12 were
adopted and ratified by three-fourths of the state legislatures. They constitute the
first 10 amendments of the U.S. Constitution. These amendments are collectively
known as the Bill of Rights.

The amendments are necessarily brief and were designed to be applicable for
centuries to come. It is the duty of the U.S. Supreme Court to interpret those rights in
light of our current society. This is not easy. For example, the second amendment
says “A well-regulated Militia, being necessary to the security of a free State, the
right of the people to keep and bear Arms, shall not be infringed.” In 1789 “Arms”
were knives, swords, and front loading single shot muskets. Today “Arms” include
assault weapons, bazookas, and rocket-propelled grenades. Should every citizen be
allowed to own those, or only front loading muskets, or something in between?

a. Open the file HWO08-3 Bill of Rights Original, which is one of the files you
downloaded at the start of the term.

b. Save the document in the Word Files folder using the name
HWO08-3 HWID Bill of Rights Done

c. Insert a footer that contains the name of the file.

44 Adapted from http://www.archives.gov/exhibits/charters/charters.htmi
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This copy of the Bill of Rights was received as a forwarded email. Instead of
employing word wrap, the email app inserted paragraph marks at the end of each
line. Your task is to reformat the document by removing the paragraph marks,
restoring word wrap, and formatting the document to make it easier to read and
more interesting to look at. This project will provide instruction and practice on
using the Find and Replace feature of Word.

d. Center the first three lines of the document and change the font to Arial Black.

e. If necessary, click the Show/Hide button (Home, Paragraph) to make the
paragraph marks 7 visible. Notice that most of the lines in the body of the text
are separated by double paragraph marks. Replace the double paragraph
marks with a space by doing the following:

1.

Open the Find and Replace dialog box by tapping Ctrl + h (or, on the
Home tab, in the Editing group, click Replace).

Mac: From the menu bar, click Edit, Find, Advanced Find and Replace, Replace.

2.

If the More button is showing, click it to display the advanced
options of the Replace feature. If the Less button is showing the
advanced options are already displayed.

JR—

Mac: The More button is an arrowhead: [l]

3.

7.

In the Find what box, type two paragraph codes: *p”p
To type a circumflex, ~, tap Shift + 6. The paragraph codes may also be

selected from the Special menu | specal~ |

) Find Replace Go To
In the Replace with box, type a space

(tap the Spacebar). Find what:  “p*p

Be sure that none of the boxes are
checked and, unless it is dimmed, click the _
. Replace with:
No Formatting button to be sure character
formatting will be ignored. \

Click Replace All. There should be 56
replacements. This combines all the
paragraphs into a single paragraph.

There is a blank space
here but you cannot see it.

Click OK and then close Find and Replace.

f. Format the paragraphs by doing the following.

1.

Right-click anywhere in the paragraph that begins Amendment | and
choose Paragraph.

Type 12 in the Spacing before box. This will put some blank space before
(above) each paragraph and help to visually separate the paragraphs.
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3. Under the word Special, select First line from the drop-down menu.
Confirm that 0.5" shows in the By box (if not, type it in). This will indent the
first line of each selected paragraph.

In the Spacing group, you can also specify the line spacing. But there is no
need to do that now unless you want to.

4. Click OK.

g. The document will be easier to read if you make each occurrence of the word
Amendment into a heading. To do this, you can use one of Word’s built in
heading styles.

1. Move the insertion point to the top of the document and then tap Ctrl + h to
open the replace dialog box.

Mac: From the menu bar, click Edit, Find, Advanced Find and Replace, Replace.

2. Inthe Find what box, type Amendment

With the insertion point still in the Find what box, click the Match case box to
ensure that words like amendment (lowercase a) will not match the criteria.

Also click the Find whole words only box to ensure that words like
Amendments (it has an s on the end) will not match the criteria.

3. Inthe Replace with box, type *pAmendment. The *p is equivalent to
tapping the Enter key before each occurrence of Amendment so they will
appear on their own lines.

Find and Replace ‘ \ e P S
Replace GoTo

Find what: Amendment E
Options: Match Case, Whole Words
Replace with: | “pAmendment E i

<< Less Replace J l Replace All J [ Find Mext ] l Close J

Search Options

Search: | All E
[] match prefix

Find whole words only [] match suffix
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4. Click Replace All. There should be 10 replacements. Click OK.

A O O O N T R R

Bill-of-RightsT|
First-Ten-Amendments-of-the-Constitution-of-the-United-States-of-America¥|
Ratified-December-15, 17919

all
Amendment-|------Congress-shall-make-no-law-respecting-an-establishment-of-religion, -or-

prohibiting-the-free-exercise-thereof;--or-abridging-the-freedom-of-speech, -or-of-the-press;-or-the-right-
of-the-people-peaceably-to-assemble,-and-to-petition-the-Government-for-a-redress-of-grievances.--q

Amendment-1l------A-well-regulated-Militia,-being-necessary-to-the-security -of-a-free-State, -the-
right-of-the-people-to-keep-and-bear-Arms, -shall-not-be-infringed.-q

5. Inthe Find what box, type six spaces (tap the Spacebar 6 times). If
necessary, uncheck the Match case and Find whole words only boxes.

6. Inthe Replace with box, type a single paragraph code: "p

7. Click Replace All. There should be 10 replacements. Click OK.

L T T R S R I SN DI SRR BRI TSI NCER SRR - BRI BETNCIY ROy

bad

Bill-of-RightsT]
First-Ten-Amendments-of-the-Constitution-of-the-United-States-of-America¥]

Ratified-December-15,-17919]

1
Amendment-I]

Congress-shall-make-no-law-respecting-an-establishment-of-religion, -or-prohibiting-the-free-
exercise-thereof;--or-abridging-the-freedom-of-speech,-or-ofthe-press; --or-the-right-of-the-people-
peaceably-to-assemble,-and-to-petition-the-Government-for-a-redress-of-grievances.- |

Amendment-II]

A-well-regulated-Militia,-being-necessary-to-the-security-of-a-free-State, -the-right-of-the-people-
to-keep-and-bear-Arms,-shall-not-be-infringed.- |
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h. Apply a heading style to each line that contains the word [ Find and Replace

Amendment by doing the following: Reglace
1. Inthe Find what box, type Amendment Findwhat:  |Amendment
Options: Match Case, Whole Words

2. With the insertion point still in the Find what box,
make sure the Match case and Find whole words Replace with:
only boxes are checked.

3. Inthe Replace with box, clear any text or spaces so l << Less
that the box is blank. Be sure the insertion point is in Search Options
that box. Search: |All |z|

V| Match case

4. At the bottom of the Find and Replace window,
click the Format button and then select Style. Uee wildcards
This will display a list of the styles available to Sounds like (English)
this document. Find all word forms (English)

| Find whole words only

5. Scroll down and click Heading 1.

6. Click OK. Replace
r Format ] [ Special » l
Find and Replace | Font..
Paragraph... —
Find what: Amendment Language...
Options: Match Case, Whole Words Frame..
Format: Style... %
. . . Highlight
Replace with: bNothlng in here
Farmat: Style: Heading l@— Style shown here

7. Click Replace All. There should be 10 replacements. Click OK.
All the amendment headings are changed to the Heading 1 style.

bad

L T S B S S I BRI BEC DI SRR EECICRNI. TR RRCERIRR TN - BRI BRI RNy

Bill-of-Rights1]
First-Ten-Amendments-of-the-Constitution-of-the-United-States-of-America¥
Ratified-December-15,17919]
1
"Amendment-19]
Congress-shall-make-no-law-respecting-an-establishment-of-religion, -or-prohibiting-the-free-

exercise-thereof;--or-abridging-the-freedom-of-speech,-or-ofthe-press; --or-the-right-of-the-people-
peaceably-to-assemble,-and-to-petition-the-Government-for-a-redress-of-grievances.- |

"Amendment-119]

A-well-regulated-Militia,-being-necessary-to-the-security-of-a-free-State, -the-right-of-the-people-
to-keep-and-bear-Arms,-shall-not-be-infringed.--q|




PROJECT 8 WORD CHAPTER 2: CREATING TABLES AND LETTERS SG217

I. To see how replace works within paragraphs, tell Word to find and modify only
words that exactly match The by doing the following:

1. Tap Ctrl + Home to move to the top of the document.

2. Inthe Find what box, type The Confirm that the Match case and Find
whole words only boxes are checked. This will ignore words like the,
which is not capitalized, and these and thereof, which have the embedded
within them.

3. Click inside the Replace with box and delete any text. Click No
Formatting to remove the reference to the Heading 1 style.

4. In the lower left corner of the Find and Replace window, click Format and
select Font.

5. Change the font to red Arial Black. Click OK.

Find and Replace

Find Replace Go To
Find what: The
Options: Match Case, Whole Words
Format:
Replace with:

Font: arial Black, Font color: Red

Format:

6. Click Replace All. There should be 3 changes. Click OK and then close
Find and Replace. Under Amendment IV you should see a red The.

7. Save the document but do not close it.

j. If your document will be read online it may be useful to include hyperlinks to
web sites so that the user can go directly there with a single mouse click. The
process in Word is similar to the one you used in Excel.

1. Atthe top of the document, for the text of Amendment I, use the ruler to
change the right indent to 5 inches. You will see why in a moment.

A T - T B R T

"Amendment-19]

Congress-shall-make-no-law-respecting-an-establishment-of-
religion,-or-prohibiting-the-free-exercise-thereof;--or-abridging-the-
freedom-of-speech,-or-of-the-press;--or-the right-of-the-people-
peaceably-to-assemble,-and-to-petition-the-Government-for-a-
redress-of-grievances. -

2. Inthe blank line under Ratified December 15, 1791, type the following all
on one line:

The Constitution may be viewed at hitp://www.archives.gov/exhibits/charters/constitution.htm|



http://www.archives.gov/exhibits/charters/constitution.html

SG218

PRoOJECT 8 WORD CHAPTER 2: CREATING TABLES AND LETTERS

3. Remove the first line indent, if necessary.

4. Select the web address and tap Ctrl + k. This is the shortcut for Insert
Hyperlink. You can also click Hyperlink on the Insert tab.

Insert Hyperlink
Link to: Text to display: http://www.archives.gov/exhibits/charters/constitution.html
. .
Existing File or Look in: Word Files - Keys
SELEEE {, HWO1-4 HWID ZIPPED Done
8 Current Folder |B1Z) HWO01-1 HWID Practice Save Done
Place in This ﬂ: HWO01-2 HWID Google Drive Done
Document B HWO01-3 HWID Lynda Done
\ Browsed Pages ﬂ" HWO1-4 HWID Email Done
i = HWO01-4 HWID Pdf Daone
Create New % HWO7-1 HWID 1A_Flyer Done
Document -
Regent Files ﬂL HWO07-2 HWID 1B_Programs_Done
0 B HWO07-3 HWID Agenda Done
L e PIERTERIT = ' —~
B Address: http://www.archives.gov/exhibits/charters/constitution.html

The top box shows the text that will be displayed. Leave that as is so if
someone is reading a printed copy, they will be able to see what to type to
get to the web page. The bottom box has the actual web address. That is
where you want to send the user when they click the link in the online
document.

5. Click OK. The hyperlink is created and the style for the web address is
automatically set to Hyperlink (underlined blue text). Point to the hyperlink
and a screen tip will appear.

Bill-of-Rights T

First-Ten-Amendments-of-the-Constitution-of-the-|http://www.archives.gov/exhibits/charters/
constitution.html

Ratified-December-15,-17 ¢ Ctri+Click to follow link

‘The-Constitution-may-be-viewed-at-http://www.archives.gov/exhibits/charters/constitution.htmif]

6. Hold down the Ctrl key and click the hyperlink. Your web browser will open
and take you to the web site. If that does not work, copy the web address
and paste it into your web browser.

America's Founding Documents
Home > America's Founding Documents

America's Founding
Documents . . .
These three documents, known collectively as the Charters of Freedom, have secured the rights of the

Hain Page American people for more than two and a quarter centuries and are considered instrumental to the founding

Explore the Documents

Dec

Cor
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Bill

he United

Special Features

High Re

of Independence

and philosophy of the United States.

Declaration of Independence Constitution Bill of Rights
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7. Right-click the image of the Bill of Rights and select Copy Image.
8. Close the web browser.

9. Paste the image to the right of the Amendment | text. Place a black border
around the image. Change the height to 2 inches and set the Wrap Text to
In Front of Text. Move it so it looks like this:

-The-Constitution-may-be-viewed-at-http://www.archives.gov/exhibits/charters/constitution.him{f

"Amendment-19] RS Nl

{ CH7COS Cfo: 081 il
Congress-shall-make no-law-respecting-an-establishment-of- o

religion, -or-prohibiting-the-free-exercise thereof;--or-abridging-the-

freedom-of-speech,-or-of-the-press;--or-the-right-of-the-people-

peaceably-to-assemble,-and-to-petition-the-Government-for-a-

redress-of-grievances.--{|

"Amendment-11q]

. Use Replace to change all occurrences of two spaces to one space. To do

that, put two spaces in the Find what box, one space in the Replace with box,
and click Replace all. There should be 16 replacements. Click OK.

Tap Ctrl + p and compare the preview with the key (page 1 only). Make needed
corrections, save the document, and close it. When you are ready to submit the
pdf file, you will print only page 1.

HWO08-4 Park

Problem: How can you create an eye-catching memo that includes tables?

a.

Open the document HW08-4 Park Original, which is one of the files you
downloaded at the start of the term.

. Save the document in the Word Files folder using the name

HWO08-4 HWID Park Done

. Insert a footer that contains the name of the file.

. To the right of DATE in line 3, enter the Date field code. Use the format Day,

Month Date, Year.

. Format the five lines that start with Days through Sunday by doing the following.

1. The sections of each line are separated by commas. Change the commas to

tabs. A quick way to do this is to use the Replace feature. To do this, select the

five lines, tap Ctrl + h, type a comma in the Find what box and the tab code,
At, in the Replace with box. Click Replace All. There are 10 replacements.

The little arrows show where the tabs have replaced the commas. You cannot
see some of them because you have not yet set up the Tab Stops.

Days->OpensClosesq|
Monday-Thursday- 1-pm->10-pmq]
Friday 1-pm->11-pmfq]
Saturday-and-Holidays - 11-am11-pmfq[
Sunday - Noon->11-pmq
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2. Click anywhere in the first line. Set a right tab stop at 4 inches and a left tab
stop at 4.5 inches. Make the tab stops have dot leaders.

3. Set the left and first line indents to 1.5 inches.

Days................ SO Opens ...z2....Closesq

4. Change the format of the next four lines to match this first line. You could
do this as you just did for the first line but, like Excel, Word has a Format
Painter that allows you to copy the format of one line or group of
characters and apply it to others. To see how this works, select the line you
just formatted and, on the Home tab, in the Clipboard group, click the

Format Painter paintbrush.

Now, select the next four lines (Monday through Sunday). The result is
that all five lines now have identical formats.

Days................ xR Opens ...2....Closesq
Monday-Thursday ......: = S 1-pm .. =....10-pmq
Friday ................ tr ST 1-pm..=2...11-pmf
Saturday-and-Holidays ..»...11-am ...=2....11-pmq
Sunday.............. = S Noon ...>....11-pmf

f. Select the 5 lines starting with the line that has Ave, One Day, Season Pass.
Convert the text to a table (Insert, Tables, Table, Convert Text to Table). If
necessary, change the font to 12 pt Arial.

g. Shade some of the cells by doing the following:

1. Select the three column headings and, on the Home tab, in the Paragraph
group, click the Borders arrow, and select Borders and Shading.

2. Click the Shading tab and set the fill to gray. Confirm that the Apply to box
shows Cell.

3. Click OK.

4. Do the same to shade the cells that have Toddler, Junior, Adult, and Senior.

h. Remove the top and left border of the upper left cell by doing the following:

1. Click in the upper left cell and on the Home tab, in the Paragraph group,
click the Borders arrow, and select Borders and Shading.

2. Inthe Apply to box, select Cell so your changes will only affect the one cell.
3. Under Settings, click Custom Cell.

4. To remove the top border, click the border itself
or the box next to the top border. \

: > |-
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5. Use the same process to delete the left cell border.

6. Click OK. If the table gridlines are not showing, on the Table Layout tab, in
the Table group, click View Gridlines to show them. It may appear that
there still is a border on the upper left cell.

Ave
3&1

A #~

Toddler

himinAr

The lines are not borders but cell gridlines. They will not print. To hide the
gridlines, on the Table Layout tab, in the Table group, deselect View
Gridlines.

i. Adjust the position and size of the columns by doing the following:
1. Select the whole table by clicking the icon at the upper left of the table e

An alternative way of selecting the entire table is to go to the Table Layout
tab, in the Table group, click the Select arrow, and click Select Table.

With the whole table selected, right-click and select Table Properties.

2. On the Cell tab, in the Preferred width box, enter 1.2”.

Table Row Column Cgll Alt Text
Size
Preferred width: 1.2" Measure in: | Inches

Click OK.

3. With the entire table still selected, on the Home tab, in the Paragraph
group, click the Center icon. This will center the table between the page
margins.

4. To center the characters inside the cells, select the cells, but not the whole
table, and click the Center icon.

Admission charges are significantly different, with the price of season passes reduced
by $20 for Adults, and increased by $20 for Juniors. Let's hope the 15% increase in
revenue is realistic!

Ave One Day Season Pass
Toddler 3 & under Free Free
Junior 4 to 11 $19 $89
Adult 12 to 59 $39 $129
Senior 60+ $29 $99

j. Tap Ctrl + p and compare the preview with the key. Make needed corrections,
save the document, and close it.
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HWO08-5 Bank Product Report Table

Problem

: How can you convert raw data into a table, sort the data, and format the
table?

a. Open the document HWO08-5 Bank Product Report Original, which is one of
the files you downloaded at the start of the term.

b. Save the document in the Word Files folder using the name
HWO08-5 HWID Bank Product Report Done

c. Insert a footer that contains the name of the file.

d. Select the lines starting at Date and down to the last line of data. Convert the
data to a table (Insert, Table, Convert Text to Table).

e. Format the table so numbers and dates are right aligned and headings are
centered and bold.

f. Like Excel, Word allows you to sort rows of data by Text, Number, and Date.
To see how this works, do the following:

1.
2.
3.

Select all the rows below the header row.

On the Home tab, in the Paragraph group, click the Sort button | 2|

Click the Sort by arrow and select Column 1.

Word will recognize the first cell, 16 Jan, as a date and so it will put Date in
the Type box. If it does not, click the Type arrow and select Date.

Because entire rows are selected, Word will put Paragraphs in the Using box.
Confirm that Ascending is checked.
Click OK. The rows of data are sorted by the dates in Column 1.

Repeat the process except this time, in the Type box, select Text.

Sort by

Column 1

V| Type: |Text v '@:'&scending

O Descending

Using: |Paragraphs v

6.

Click OK. Now, the values in Column 1 are sorted as if they were text
instead of dates. Thus, cells starting with 1 come first, followed by cells
starting with 2, then 3, then 6, then 8, and finally 9.

g. Do another sort using more than one sort level.

1.

Click in any cell of the table. On the Home tab, in the Paragraph group,
click the Sort button. Word automatically selects the entire table, including
the column headings.

Be sure Header row is selected in the My list has area. In the Sort by box,
select Sales Rep. Notice that the Type is automatically changed to Text.
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2. Inthe Then by box, select Amount. If the Type is not automatically
changed to Number, make this change.
3. Choose Descending order for the Amount column.
Sort by
Sales Rep v | Type: | Text v | @ ascending
Using: |Paragraphs v|  Rescending
Then by
Amount v | Type: | Number v O Ascending
Using: | Paragraphs ® Descending

4. Click OK. The data are sorted by Sales Rep, in alphabetical order and, for
each Sales Rep, the data are listed by amount, largest to smallest.

Date Product Amount | Sales Rep Points
5 Feb | Savings 6,300 | Betsey 44
12 Feb | Savings 6,000 | Betsey 42
16 Jan | Certificate 5,000 | Betsey 400
26 Jan | Certificate 150 | Betsey 120
13 Jan | Certificate 5,000 | Carolyn 200
22 Jan | Credit 2,000 | Carolyn 16

h. If necessary, select the entire table and, on the Table Layout tab, in the Cell
Size group, click the AutoFit arrow, and select AutoFit Contents.

I. Calculate the sum of the Amounts column and the average of the Points

column by doing the following:

1. Click the lower right cell and tap the Tab key. This inserts a new row.

2. In the cell at the bottom of the Amount column, type Sum = and a space.

3. Onthe Table Layout tab, in the Data group, click the Formula button.
Notice that =SUM(ABOVE) automatically appears in the Formula box. This
means that the sum of the numbers above the cell will be calculated.

4. Click OK. The sum will be 59,500.

5. In the cell at the bottom of the Points column, type Ave = and a space.

6. Onthe Table Layout tab, in the Data group, click the Formula

button. Notice there is a Paste function arrow. Clicking that will
show you all the functions you may use here. In the Formula -
box, delete SUM(ABOVE) but leave the equal sign. Click the
Paste function arrow and select AVERAGE.

Word will show =AVERAGE(). Since you want the average of
the numbers above this formula, type above inside the

parentheses.

Formula:

Number format:

Paste function:

Eormula:

=AVERAGE(above)

ABS
AND
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Within these Word formulas, you can use positional arguments to indicate
which numbers you would like summed. These include LEFT, RIGHT,
ABOVE, and BELOW.

7. Click OK. The average should be 315.17.

8. If you change any numbers in the column, you will have to update the
formulas manually. It is not automatic as it is in Excel. To see how this
works, in the last cell of the Amounts column, change 300 to 900. Notice
that the sum just below this cell has not changed. Select the cell with the
Sum in it and tap the F9 key. This updates the selected fields. The cell will
now show Sum = 60,100.

6 Jan | Certificate 900 | Pam 240
Sum = 60,100 Ave =315.17

j. Format the table borders by doing the following:
1. Center the title and the table on the page.
2. Bold the last row (with Sum and Ave).

3. Put a heavy (3 pt width) red border around the outside of the entire table
and a light (1 pt width) red dashed border on each cell on the inside.

4. Put ared 3 pt width double line border between the column headings and
the data. To do this, select the row with the column headings, open
Borders and Shading, and fill in the parameters.

Borders Page Border Shading
Setting: Style: Preview
~ Click on diagram below or use buttons
None to apply borders
Box B N (O R P
Al ‘ ‘
I E
Color:
Grid
I
it ]
2 Custom 3 pt ——
i o I ﬁpp_')f tO:
Cell

It should look like this:

First National Bank January/February Sales Report

Date Product Amount Sales Rep Points

5 Feb | Savings 6,300 | Betsey 44
12 Feb | Savings 6,000 | Betsey 42
16 Jan | Certificate 5,000 | Betsey 400
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5. Remove part of the border on the two cells in the last row, as shown below.
You will have to select the cells whose borders you want modified and then
open Borders and Shading and change the borders individually.

8 Feb | Auto Loan 3,000 { Pam 300
6 Jan | Certificate 900 | Pam 240
Sum = 60,100 Ave = 31517

k. Tap Ctrl + p and compare the preview with the key. Make needed corrections,
save the document, and close it.

HWO08-6 Infections Memo

Problem: How can you create a memo that includes a table of data and a graph of
those data?

Excel tables and charts can be inserted into Word documents. Follow these
directions to copy a data table and chart from an Excel workbook.

a. Open the document HWO08-6a Infections Memo Original, which is one of the
files you downloaded at the start of the term.

b. Save the document in the Word Files folder as
HWO08-6¢c HWID Infections Memo Done

c. Insert a footer that contains the name of the file.

d. Replace <name> with the field code for UserName (Insert, Text, Quick Parts,
Field, UserName). This will insert the name of the owner of the computer you
are using (this may not be you if you are using a friend’s computer or a
computer in a lab).

e. Replace <creation date> with the field code for the present date. Use the
format that shows the day, month, date, and year.

Mac: Insert tab, Text group, Field. Under Field names, click CreateDate. Click
Options, select this format: ddd,MMMM d, yyyy. Click Add to Field. Click
OK twice.

If you want to see the field codes, tap Alt + F9.

Mac: Right-click and select Toggle Field Codes.

To: Infectious Diseases Foundation

From: { USERNAME \* MERGEFORMAT }

Date: { CREATEDATE \@ "dddd, MMMM d, yyyy" \* MERGEFORMAT }
Re: Data you requested

To hide the field codes, tap Alt + F9 again.
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f. Copy information from Excel and paste it into the memo by doing the following:

1. Open the Excel file HW08-6b Infections Data Original, which is one of the
files you downloaded at the start of the term and is in the Word Files
folder. You cannot open the file while you are in Word. Either start Excel
and then open the file, or open your Word Files folder in Windows Explorer
and double-click the file name.

Click the Infections Data tab and select A1:C22.

Tap Ctrl + ¢ to copy the data table.

Switch to Word and move the insertion point to the bottom of the document.
Paste the data as a table into the memo.

o o bk~ Wb

Switch to Excel and click the Infections Chart tab.

The shape of the graph is called a logistic curve. It shows how infections
spread in a community or, in the case of a pandemic, the world. At the start, the
virus spreads slowly, and then infections rapidly rise as more and more people
come in contact with those infected. Finally, when almost everyone has
become infected, the rate flattens out. This is called Herd Immunity, meaning
that so many people have become infected and developed antibodies that the
spread to new people becomes negligible.

The blue dots represent the actual number of 05x
infections while the red curve represents the f(x)= S00e™ ™
predicted spread from this mathematical model: 49 +e*%

7. Click anywhere inside the chart and select the Chart Area (Chart Format,
Current Selection, Chart Area).

Tap Ctrl + ¢ to copy the chart.
Close Excel.

10. Switch to Word and, on the Home tab, in the Clipboard group, click the
Paste arrow, select Paste Special, and select Picture (JPEG) or TIFF.

Paste Special

Source: Microsoft Excel Chart
Infections Chart

As:

@ Paste: Microsoft Excel Chart Object
. Bitmap
Paste link: ) )
O e Picture (Enhanced Metafile)
Picture (GIF)
Picture (PNG)

Picture (JPEG!
Microsoft Office Graphic Object

Click OK. This inserts the chart as a picture that cannot be altered. If you
had wanted the user to be able to edit the chart, you would have chosen
Microsoft Excel Chart Object. That is NOT what you want.
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g. Adjust the chart as follows:

1. Change the Width to 5 inches. The height should automatically change to
about 3.62 inches.

2. Click the Layout Options button [:/:

Mac: If you do not see the button, right-click the chart and select Wrap Text.

Select In Front of Text.

3. Click the edge of the chart and drag it so that it is just to the right of the table.

h. Insert a link to a video by doing the following:

1. Just under the table, type What you should know about COVID-19 can
be found at: and tap Enter.

2. Open your browser, type youtube.com in the address bar, and tap Enter.

3. Type What you should know about COVID-19 in the YouTube search
box and tap Enter.

4. Click on any video you wish. Copy the URL - ? 0 Loop
by right-clicking the video and selecting
Copy video URL.

GO Copy video URL

Switch to Word, paste the link, and tap the spacebar, Word will change the
style to Hyperlink (underlined blue text). The one | picked is
https://www.youtube.com/watch?v=POloTTb3ock

To open the video, point to the link, hold down the Ctrl key, and left-click.

https://youtu.be/polottb3ock (3989 |

Ctrl+Click to follow link about C

https://youtu.be/POloT Th3ock

Mac: Point to the URL and a little finger will appear. Click and the video will open.

5. Close your browser.

I. Tap Ctrl + p and compare the preview with the key. Make needed corrections,
save the document, and close it.

Step 4 Submit Now, submit the following. Use these names for the pdf files:

HWO08-1 HWID 2A Resume Done

HWO08-2 HWID 2B Cover Letter Done

HWO08-3 HWID Bill of Rights Done Page 1 — Do not submit page 2
HWO08-4 HWID Park Done

HWO08-5 HWID Bank Product Report Done

HWO08-6¢c HWID Infections Memo Done


https://www.youtube.com/watch?v=POloTTb3ock
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Create a pdf file of the output for each of the above, place them in a folder
called HWO08 HWID LastName, FirstName, zip the folder and, by the due date,
upload it to the Canvas folder HW08 Word Chapter 2: Creating Letters and
Tables.

Step 5 Backup Now would be a good time to backup your files.



Project 9
Word Chapter 3: Research Papers, Newsletters,
and Mail Merge

Step 1 Read Read the introductory material on page 235 of the textbook.

Step 2 Activities Turn on the computer and do the following:
Project 3A: Start at the top of page 237.

Do not do Activity 3.01 (all_ steps). Instead, do the following:

1. Navigate to your Word Files folder and open
wO03A_ Quantative_Technology, which is one of the files
you downloaded at the start of the term.

2. Save the file in your Word Files folder using the name
Lastname_Firstname_3A_Quantative_Technology

3. Start on Activity 3.02 on page 238 and complete the Activities through step
8 of Activity 3.11 on page 251. Save your file after completing step 8 of
Activity 3.11. Do NOT do Activity 3.12 or 3.13 or 3.14 on pages 251-258.

4. Return here when you have completed Project 3A on page 251.

|‘ Do NOT do GO! With Google Docs

Project 3B: When you have completed Project 3A, start at the top of page 262.

Instead of Activity 3.15 step 1 do the following:

1. Navigate to your Word Files folder and open wO3B_Environment_Newsletter,
which is one of the files you downloaded at the start of the term.

2. Save the file in your Word Files folder using the name
Lastname_Firstname_3B_Environment_Newsletter

3. Complete the rest of the Activities through step 12 on page 279. Do NOT
do steps 13 and 14 in Activity 3.26 on page 279. Do NOT do Activities
3.27 or 3.28 or 3.29 on pages 280-284.

4. Return here when you have completed Project 3B on page 279.

Do NOT do GO! With Google Docs or GO! To Work

Step 3 Homework After you have completed Projects A and B return here, do
the following additional activities, and turn them in for grading.

— SG229 —
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HWO09-1 Research Paper (Based on Project 3A)

Problem: How can you create a short research paper?

a. Open the document Lastname_Firstname_3A_Quantitative_Technology,
which you created while following the directions in the textbook and saved on
page 251.

b. Save the document to your Word Files folder using the name
HWO09-1 HWID 3A Quantitative Technology Done

c. Tap Ctrl + p and compare the preview with the key (page 4 only). Make needed
corrections, save the document and close it. When you are ready to submit the
pdf file, you will print only page 4.

HWO09-2 Newsletter (Based on Project 3B)

Problem: How can you create a newsletter?

a. Open the document Lastname_Firstname_3B_Environment_Newsletter,
which you created while following the directions in the textbook and saved on
page 279.

b. Save the document to your Word Files folder using the name
HWO09-2 HWID 3B Environment Newsletter Done

c. Tap Ctrl + p and compare the preview with the key. Make needed corrections,
save the document, and close it.

HWO09-3 Home Address Label

Problem: How can you create address labels?

In this project you will create labels that have your campus address. You can put
these on your books, USB drive, etc. to identify them as yours. These are not mail
merge labels because there is no data file involved.

a. Create the labels by doing the following:
1. Start Word and open a blank document.
2. Onthe Mailings tab, in the Create group, click Labels.

3. Click the Labels tab and then Options. Under Label vendors, select
Avery US Letter.
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4. Under Product number, select 5160 Address Labels.

Envelopes Labels

Label Options

Printer information
O Continuous-feed printers
@ Page printers Tray:
Label information

Label vendors: | Avery US Letter

Find updates on Office.com

Product number:

5160 Address Labels

Bypass Tray R

Label information

Type: Address Labels
5161 Address Labels .
Height: 1
5162 Address Labels e_lg . .
5163 Shipping Labels W'dth'_ 2.63
5164 Shipping Labels Page size: 85" = 11"

Under Printer information, Page printers may be checked and Bypass
Tray shown. That assumes you will insert blank label sheets one at a time
in the Bypass Tray. If you want to print several sheets you can select
Continuous-feed printers to have the labels come from the usual tray.

5. Click OK. In the Address box, type the following using your own data:

Envelopes Labels

Address: |:_ + [ ] Use return address
FirstName LastName HWID )
Room 203 Bailey Hall, St. Paul

Campus

Campus mail code: 6017
651-555-1234
namel234@umn.edu

Print Label
® Full page of the same label

O Single label

Avery US Letter, 5160 Address Labels
Address Labels

6. Click New Document. A new document with the mailing labels is produced.
The gridlines will show, but they will not be printed, which is what you want.

FirstName LastName HWID

Room 203 Bailey Hall, St. Paul Campus
Campus mail code: 6017
651-555-1234

name1234@umn.edu

FirstName LastName HWID

Room 203 Bailey Hall, St. Paul Campus
Campus mail code: 6017
651-555-1234

namel234@umn.edu

FirstName LastName HWID

Room 203 Bailey Hall, St. Paul Campus
Campus mail code: 6017
651-555-1234

namel234@umn.edu

FirstName LastName HWID
Room 203 Bailey Hall, St. Paul Campus

FirstName LastName HWID
Room 203 Bailey Hall, St. Paul Campus

FirstName LastName HWID
Room 203 Bailey Hall, St. Paul Campus
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When you want to print actual labels you should print on regular paper first and
then check to see if the printed labels line up properly with the labels on the
sheet. Often, you will have to make minor adjustments due to differences in
printer characteristics. Printing on paper first will save you the cost of label
sheets you might have to throw away.

7. Save the document in the Word Files folder using the name HW09-3
HWID Address Labels Done

b. Tap Ctrl + p and compare the preview with the key. Make needed corrections,
save the document, and close it.

HWO09-4 Name Tag Labels
Problem: How can you create individual name tags?

In this project you will create labels to be used as name tags at an orientation session.

[

a. Create the blank labels.

1. Start Word and open a blank document. Start Mail ~ Select
L . . . Merge = Recipients -
2. Onthe Mailings tab, in the Start Mail Merge group, click B Letters

Start Mail Merge and select Labels.
fZ1  E-mail Meszages
Notice you are not selecting Labels from the Create
group, which makes all the labels the same. For this

project, you want each label to have different information.

E1 Envelopes..
TR Labels...

3. Be sure the Label vendor is Avery US Letter. Select the 5095 Adhesive
Name Badges. These are described in detail on the Avery.com web site.

4. Click OK. If the table gridlines do not show, on the Table Layout tab, in the
Table group, click View Gridlines.

5. Select the table and change the font to 10 pt Arial.

b. Save the document to your Word Files folder using the name
HWO09-4 HWID Name Tag MAIN Done. It is good practice to use the word
MAIN or SOURCE in the name of a mail merge file to indicate that this is the
main document into which the data from the DATA document will be inserted.

c. The data for this merge file will come from an Excel file called HW09-4 Name
Tag Labels DATA Original, The first row contains the names of the merge
fields. You could copy the data and paste it into a new Word document but that
IS not necessary.

A B C D E F G
1 |First Last Major Interest1 Interest2 Interest3 Dorm
2 il Barnum English Flute Walking Gardening Bailey
3 |Sue Vanage Biology Band Jogging Territorial
4 Bill Gates Computer Science Money Money Money
5 |Barak Obama Political Science Community Service Sports
6 |Albert Einstein Physics Special Relativity  General Relativity Photons  Territorial
7 Will Shakespare English Poetry Plays Bailey
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Select the data file by doing the following:

1. Onthe Mailings tab, in the Start Mail Merge group, click Select Recipients,
and then Use Existing List.

2. Navigate to your Word Files folder and select the Excel file HW09-4 Name
Tag Labels DATA Original. Notice that there is only one Worksheet,

called Data.
Select Table
Mame Description Modified Created Type
7/12/2023 2:02:04 PM 7/12/2023 2:02:04 PM TABLE
3. Click OK.

4. On the File tab, click Options, click Advanced, scroll down to the Show
document content group and verify that the Field shading box is set to
Always.

Mac: To have the field codes always shaded, from the Word menu, select
Preferences, View and, next to Field shading, select Always.

This allows you to easily distinguish between normal text and text that is
displayed by a field.

Click OK.
d. Insert the field codes.

1. Click the upper left corner of the first cell in the table. Type Hello, my
name is and then tap the Spacebar. N

2. On the Mailings tab, in the Write & Insert Fields group, click |insert Merge
Insert Merge Field and select First. Field -
First

The code for the person’s first name is inserted.

KN

Hello, my name is «First» «Next Record»

3. Click Preview Results to see what the merge will look like.

+

' Hello, my name is Jill

Click Preview Results again to show the codes.
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4. Tap Alt + F9 to see the field codes. If that does not work, point to a field,
right-click, and select Toggle Field Codes.

KX

Hello, my name is { MERGEFIELD First } { NEXT }

5. Click the Show/Hide button E S0 you can see the paragraph marks. Type
the text and insert the fields as shown below. Remember that to insert a tab
within a table cell you tap Ctrl + Tab rather than Tab because tapping Tab
will send you to the next cell or add a row to the bottom of a table.

KX

Hello,-my-name-is-{{MERGEFIELD-First-}{
My-major-is-f MERGEFIELD-Major}9]
My-interests-areq

> {MERGEFIELD-Interest1-}
{-MERGEFIELD-Interest2 Jq
{MERGEFIELD-Interest3-}

NEXT

o

e. In the data file, some of the Dorm information is missing and the campus of the
dorm not included. Word can use an IF/THEN/ELSE structure similar to the one
in Excel to help with a situation like that.

1. To the right of Interest3, tape Enter to go to the next line. On the Mailings tab,
in the Write & Insert Fields group, click Rules and select If...Then...Else.

2. Set the dialog box as follows. Leave the Otherwise insert this text box
blank.

Insert Word Field: IF

IF
Field name: Comparison: Compare to:

Dorm ~ | | Equal to ~ | |Bailey

Insert this text:

I live in Bailey Hall on the 5t. Paul Campus

This says that if the Dorm field is Bailey then | live in Bailey Hall on the
St. Paul Campus will be displayed. Otherwise, nothing will be displayed.
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3. Click OK.

&
Hello,-my-name-is-{fMERGEFIELD-First-}1
My-major-is-{:MERGEFIELD-Major-}1
My-interests-areq]
-~ {MERGEFIELD-Interest1-}Y
{-MERGEFIELD Interest2-3
{MERGEFIELD-Interest3-}q]

-{MERGEFIELD-Dorm = 'Bailey":"I-live:in-Bailey-

Hall-on-the-St.-Pasul-Cam bus“-""-aﬁ]
o

Notice that the code for the IF/THEN/ELSE rule has a form that is similar to
an Excel IF function. Where Excel uses a comma to separate the three
parts Word uses spaces.

Excel: =IF(A1="Bailey","I live in Bailey Hall on the St. Paul Campus","")

Word: { IF { MERGEFIELD Dorm } = "Bailey" "I live in Bailey Hall on the St. Paul Campus" "" }

4. Enter a similar rule for Territorial Hall. You could go through a similar
process as you did for Bailey Hall or you could simply copy the rule for
Bailey Hall, paste it, and then change Bailey to Territorial and St. Paul to
Minneapolis.

Territorial-Hall-on-the-Minnea polis-Campus"-""-J

i

f. Add an image to the labels.
1. Click to the left of H in Hello.

2. Onthe Insert tab, in the Illustrations group, click Pictures and select This
Device.

3. Navigate to the Word Files folder and select the picture of Goldy
(HWO07-2 Goldy Original). Or, choose any other picture you wish.

4. Click Insert.

5. Double-click the image and change its height to 0.5 inch.

6. Click the Layout Options button 22| and select In Front of Text.

Mac: If you do not see the button, right-click the image and select Wrap Text.

7. Move the image to the upper right corner of the first cell.
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8. On the Mailings tab, in the Write & Insert Fields group, click Update
Labels to copy this cell to all the other cells.

Hello,-my-name-is- MERGEFIELDFirst¥
My-major-is-{-MERGEFIELD-Major-}
My-interests-areq]

-~ §{MERGEFIELD:Interest13q
> {MERGEFIELD-Interest2-§{
> §{MERGEFIELD:Interest39

] {-MERGEFIELD- Dorm} “Ballev" -live-in-Bailey-
HaII ‘on-the-St.-Pasul- Campus“ "I
MERGEFIELD-Dorm-}-=-"Territorial"-"I-live-in-
Territorial-Hall-on- the -Minneapolis-Campus"-"" 3

r

=1

{-NEXTJHello, my-name-is-{: MERGEFIEI
My-major-is-f-MERGEFIELD-Major-}

{NEXT4Hello,-my-name-is-{‘MERGEFIEI
My -major-is-{- MERGEFIELD-Major-}q
My-interests-areq

> §{MERGEFIELD:Interest1}q]
- {MERGEFIELD:Interest2 39
+ {MERGEFIELD:-Interest3-}]

{IF-{-MERGEFIELD-Dorm}-= “"Bailey"-"|live-in-Bailey-
Hall-on-the-St.-Pasul-Campus"-"" HIFf
MERGEFIELD-Dorm-}-=-"Territorial"-"|-live-in-
Territorial-Hall-on-the-Minneapolis:Campus™""- 3

o]
=] o

{NEXT4Hello,-my-name-is-{-MERGEFIEI
My -major-is-{- MERGEFIELD-Major-}q

Hello,-my-name-is-Jillq
My-major-is-Englishy]
My-interests-aref

-+ Flutey]

-+ Walking{

- Gardeningf

I-live-in-Bailey-Hall-on-the-St.-Pasul-Campusf|
o

=]
Hello,-my-name-is-Billf]
My-major-is-Computer-Sciencef

Hello,-my-name-is-Suef

My-major-is-Biology{
My-interests-aref]
- Bandf

- Joggingf
E

I-live-in-Territorial-Hall-on-the:-Minneapolis-Campusf
=

=1

Hello,-my-name-is-Barakf]
My-maijor-is-Political-Sciencef]

g. Create a file that has the labels by doing the following:

1. Onthe Mailings tab, in the Finish group, click Finish & Merge, and select
Edit Individual Documents. This will send the output to a new Word file
that you can edit if you need to. Click OK.

2. Save the file using the name HW09-4 HWID Name Tag PRN Done

Next time you open HW09-4 HWID Name Tag MAIN Done, Word will ask if
you want to insert the data from the file that contains the data. Click Yes.

h. With HW09-4 HWID Name Tag PRN Done still open, tap Ctrl + p and compare
the preview with the key. Make needed corrections, save the document, and
close it. Also save and close HW09-4 HWID Name Tag MAIN Done.
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HWO09-5 IF Merge

Problem: How can you create customized letters or emails that will send different
information to different people depending on given conditions?

In this activity you will set up a mailmerge email that offers a deal on magazine
subscriptions to Sports Illustrated if the person is male or Ms. Magazine if the
person is female. Also, you will display a different shipping and handling charge
depending on the zip code of the person. The data file contains information like this:

Title - LastName - FirstName - Address - City - State - Zipq
Mr. - Anderson - Eric - 619-4th-St.-NE-apt.-1 - Robbinsdale » AZ - 853737
Ms. » Arias - Jennifer » 1522-Colleen-Ave - Syosset > NY - 117919

a. In order to offer the correct magazine, you have to know the sex of the person.
The title Mr. clearly indicates a man while Ms., Miss, or Mrs. clearly indicates a
woman. But what if the title is missing, or if it is listed as Dr. or Professor? You
can use Excel to try to figure out the sex. Do the following:

1. Open the document HW09-5 IF Merge DATA Original, which is one of the
files you downloaded at the start of the term.

2. Save the document to the Word Files folder using the name
HWO09-5 HWID IF Merge DATA Done.

3. Copy the data, start Excel, and paste the data as text starting in A1. The
tabs in the Word file will indicate how the data should be placed into cells.

4. In H1 type Sex.

5. In H2 enter an Excel formula that will display:
Male if the title in A2 is Mr.
Female if the title in A2 is Ms., Miss, or Mrs.

Unknown if neither of the above is true (that is, the sex is not obvious).

=IF(A2="Mr.","Male" IF(OR(A2="Ms." A2="Miss" ,A2="Mrs."),"Female","Unknown"))
6. Fill the formula in H2 down to H39.

H2 = Fo | =IFA2="Mr.","Male" IF{OR(A2="Ms." A2="Miss" A2="Mrs."),"Female","Unknown"))
A B C D E E G H | J

1 |Title LastName FirstName Address City State Zip Sex

2 |Mr. Anderson  Eric 619 4th St. Robbinsda AZ 85375|Male

3 Ms. Arias Jennifer 1522 Colle Syosset  NY 11791 Female

4 |Miss Aure Sue 601 West *Renton WA 98059 Female
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9.
10.

If it is important, you could eyeball the data and manually enter the sex of
the Unknown people, if possible. For example, Dr. Alexander Ayu most
likely is a man so you could type Male in H5. However, in row 6 Terry
Bagha could be either male or female so you are out of luck there. With 38
names cleaning the data would take 2 minutes; with 50,000 names it might
not be worth the time and money. That is why it sometimes is difficult to
have data about yourself corrected (say your social security number or
date of birth) — it is difficult and costs too much if the database is large.

Copy A1:H39, switch to Word, tap Ctrl + A to select everything, tap Delete,
and finally tap Ctrl + v to paste the new data. It will paste as a table but
that is fine.

Select the table and, on the Table Layout tab, in the Cell Size group, click
AutoFit and select AutoFit Contents.

TABLE TOOLS

VIEW MathType DESIGM LAYOUT

& [| Height: = || B Distribute A
AutoFit oz Width: > || B Distribute g
== AutoFit Contents ze

B AutoFit Window
Lol
oo

Fixed Column Width

Save and close HW09-5 HWID IF Merge DATA Done.

Save the Excel file using the name HW09-5 HWID IF Sex Added Done
and then close it.

b. Set up the mail merge main file by doing the following:

1.

Open the document HW09-5 IF Merge MAIN Original, which is one of the
files you downloaded at the start of the term.

Save the document to the Word Files folder using the name
HWO09-5 HWID IF Merge MAIN Done

Insert a footer that contains the name of the file.

On the Mailings tab, in the Start Mail Merge group, click Start Mail Merge
and select Letters.

On the Mailings tab, in the Start Mail Merge group, click Select
Recipients and select Use an Existing List. Navigate to your Word Files
folder and double-click HW09-5 HWID IF Merge DATA Done.

Replace the red text Title, FirstName, LastName, Address, City, State, ZIP
with their merge field codes (Mailings, Write & Insert Fields, Insert
Merge Field).
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c. Create the mail merge by doing the following:

1.

8.

You want to skip records where the Sex is Unknown. Be sure the insertion
point is at the top of the document and then, on the Mailings tab, in the
Write & Insert Fields group, click Rules and select Skip Record IF...

Select Sex for the Field name, select Equal to for the Comparison, and
type Unknown for the Compare to boxes.

Insert Word Field: Skip Record If ? x
Field name:

Sex ot
Comparison:

Equal to b
Compare to:

Unknown

Click OK.
Select the red text MagazineChoice.

On the Mailings tab, in the Write & Insert Fields group, click Rules and
select If...then...Else.

Choose Sex from the Field name menu and Equal to from the
Comparison menu. Type Male in the Compare to box. Type Sports
lllustrated in the Insert this text box. Leave the Otherwise box empty
and click OK.

Repeat the process but type Female in the Compare to box. Type
Ms. Magazine in the Insert this text box. Leave the Otherwise box
empty and click OK.

Tap Alt + F9 to view the codes.

Thank you for your interest in our magazines. As a new customer | would like to
offer you a special deal on { IF { MERGEFIELD Sex } = "Male"” "Sports
lllustrated" "™ { IF { MERGEFIELD Sex } = "Female" "Ms. Magazine" "™ }. Your
special yearly rate is Price. The shipping and handling charge would be Shipping.

Take a moment to look at the field codes. For example:

{ IF { MERGEFIELD Sex } = “Male” "Sports lllustrated™" "" }

You can edit the field parameters as if they were text. For example, if you
wanted to change Sports lllustrated to Newsweek, you would delete Sports
lllustrated and type Newsweek in its place.

9.

Tap Alt + F9 again to hide the codes.
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10. The prices of the two magazines are different. Sports Illustrated costs
$15.99 while Ms. Magazine costs $13.99. Follow the same procedure as
above to replace the red word Price with the following:

Field name: Comparison: Compare to:

Sex ~ | | Equal to | |Male
Insert this text:

$15.99

Otherwise insert this text:

$13.99

11. Inthe same way, replace the red word Shipping with the following:

Field name: Comparison: Compare to:

Zip hod Greater than ~ || 50000
Insert this text:

$6.95

Otherwise insert this text:

$4.95

d. On the Mailings tab, in the Preview Results group, click the Preview Results
button. This will show the results for the first person in the data file, Eric
Anderson. If you click the Next Record arrow you will see the results for
Jennifer Arias.

e. On the Mailings tab, in the Finish group, click Finish & Merge and select
Edit Individual Documents. When the Merge to New Document dialog box
appears, click OK. This will produce a nhew document that contains the
individual letters, one per page.

Scroll down a bit and notice that Ayu, Bagha, Baker, Baltz, and others were
skipped because their sex is unknown.

f. Close the newly merged document without printing or saving it.

g. Do the following to print the main document with the field codes displayed:

1. Click the File tab, select Options, click Advanced, scroll down to the Print
group and click the box next to Print field codes instead of their values.

Mac: Click Word menu, Preferences. Under Output and Sharing, click Print.
Under Include in Print Version, check Field codes.

2. Click OK.
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3. Tap Ctrl + p and compare the preview with the key. Notice that the field
codes will be printed rather than their values. This is what you want. Make
needed corrections and save the document but do not close it. This is
what you will do when you create the pdf version of the file for submission.

4. Now, turn off the field codes printing by doing this: Click the
File tab, select Options, click Advanced, scroll down to the Print group
and clear the check in the box next to Print field codes instead of their
values. Click OK.

Mac: Click Word menu, Preferences. Under Output and Sharing, click Print.
Under Include in Print Version, uncheck Field codes.

h. Save the document and exit Word.

Step 4 Submit Now, submit the following. Use these names for the pdf files:

HWO09-1 HWID 3A Quantitative Technology Done Page 4 — Do not submit
pages 1, 2, 0or 3
HWO09-2 HWID 3B Environment Newsletter Done
HWO09-3 HWID Home Address Labels Done
HWO09-4 HWID Name Tag PRN Done
HWO09-5 HWID IF Merge MAIN Done (Codes Showing) — Codes must be showing

Create a pdf file of the output for each of the above, place them in a folder
called HW09 HWID LastName, FirstName, zip the folder and, by the due date,
upload it to the Canvas folder HW09 Word Chapter 3: Research Papers,
Newsletters, and Mail Merge.

Step 5 Backup Now would be a good time to backup your files.






Project 10
Word: Styles, Cross-References, TOC, Indexes

Step 1 Read For this project, there are no pages to read in your textbook.
Step 2 Activities For this project, there are no textbook activities.

Step 3 Homework Do the problems listed below, and turn them in for grading.

In Word, a style is defined as a collection of text and paragraph formats. The
formats are saved as a collection, given a name, and applied to text just like any
other format. As you will see below, styles are extremely useful.

Word has five style types:

Character styles contain formatting characteristics that can be applied to text, such
as font name, size, color, bold, italic, underline, borders, and shading. In a list of
styles, character styles are indicated using this icon &

Paragraph styles include everything that a character style contains, but it also
controls all aspects of a paragraph's appearance, such as text alignment, tab
stops, line spacing, and borders. In a list of styles, paragraph styles are indicated
using this icon

Linked styles behave as either character styles or paragraph styles, depending on
what you select. If you click in a paragraph or select a paragraph and then apply a
linked style, the style is applied as a paragraph style. However, if you select a
word or phrase in the paragraph and then apply a linked style, the style is applied
as a character style, with no effect on the paragraph as a whole. In a list of styles,
linked styles are indicated using this icon 14

List styles determine the look of lists, including characteristics such as bullet style
or number scheme, indentation, and any label text.

Table styles determine the look of tables, including characteristics such as the text
formatting of the header row, gridlines, and accent colors for rows and columns.

HW10-1 Character Styles and the Declaration of Independence

Problem: How can you create character formats that can be changed throughout a
document by changing one occurrence?

There may be times when you want a particular word or phrase to have special font
characteristics throughout a document. For example, in this Study Guide, the default
paragraph font is black 12 point Arial, without bold or italic or other enhancements.
However, all computer file names appear in 12 point Arial, dark blue, bold. This
makes them stand out from the rest of the text and helps the reader quickly identify
them as file names.

— SG243 —
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Individually applying 12 point Arial dark blue bold to each of the 226 occurrences of
file names that appear in this Study Guide would be very time consuming. To get
around problems like this, you can use character styles. When you want a
particular word or phrase to have those characteristics, you simply select the text
and tell Word to apply the character style you have defined.

If you want to change any characteristic (color, size, etc.) of a character style, that is
easily done. When the definition is changed all text with that character style changes
immediately everywhere in the document.

To see how this works, you will carry out some
character style modifications on an excerpt from the
Declaration of Independence.*® The Declaration was
drafted by Thomas Jefferson (who later became the
third president of the United States) between June 11
and June 28, 1776. In it, Jefferson expressed the
convictions in the minds and hearts of the American
people. The political philosophy of the Declaration was
not new; its ideals of individual liberty had already
been expressed by people such as John Locke i
(seventeenth century English philosopher and physician). What Jefferson did was to
summarize this philosophy in self-evident truths (ideas so obvious that they need
no proof), such as “all men are created equal” 6. The Declaration is considered to
be a powerful and important statement on human rights. It also set forth a detailed
list of grievances against King George Il of England in order to justify before the
world the breaking of ties between the American colonies and Great Britain.
Benjamin Franklin and John Adams (who later became our second president) had a
hand in editing Jefferson’s draft.

The original Declaration, hand printed on parchment most likely by a clerk named
Timothy Matlack, currently is on display in the National Archives in Washington, DC.
The Continental Congress voted to declare independence from Great Britain on July
2, 1776 and approved the wording of the Declaration on July 4, which we celebrate
as Independence Day. Many copies were printed on paper and read aloud from
town squares throughout the colonies so that those who could not read would
receive the news about the intended separation from England.

In declaring their independence, the thirteen British colonies referred to themselves
as States and that they were uniting to form a new and independent country in
America; hence, the United States of America.

45 Text is adapted from http://www.archives.gov/national-archives-
experience/charters/declaration.html

46 While he espoused equality, Jefferson himself owned slaves, as did 11 other presidents at one
time. He was always deeply in debt and slave labor made his lifestyle and many accomplishments
possible. In an 1820 letter he wrote about slavery, "We have the wolf by the ears; and we can
neither hold him, nor safely let him go. Justice is in one scale, and self-preservation in the other.”
To his shame, he chose “self-preservation.” Although he was born into one of the wealthiest
families in North America, Jefferson was deeply in debt when he died.
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a. Start the process of formatting the document by doing the following:

1. Open the document HW10-1 Character Styles and Declaration Original,
which is one of the files you downloaded at the start of the term.

2. Save the document in the Word Files folder using the name
HW10-1 HWID Character Styles Done

3. Insert a footer that contains the name of the file. Note that the background
graphic of the flag takes up the entire header/footer area so you

cannot exit the footer by simply double-clicking in the body of
the document. To exit, on the Header & Footer tab, in the Close Header
Close group, click Close Header and Footer. and Footer

b. On page SG192, in HWO07-1 Flyer, you learned how to modify the Quick Access
Toolbar by placing the AutoText icon on it. In this project you will be working a
lot with styles so it will be helpful to add the Styles icon. Do the following:

Mac: | don’t think you can do this on a Mac. Instead, on the Home tab, in the
Styles group, click the arrow, and select Styles Pane to show the styles.
Skip to part C below.

1. Click the File tab, click Options, and then click Quick Access Toolbar.
2. Inthe list under Choose commands from, click All Commands.

3. Scroll through the list of commands until you see Style. A quick way to
get to Style is to click any command, and then tap the t key. This will
take you to the start of the t's in the list. Then scroll up a little until you
see Style. There are a bunch of Style commands, but Word does not tell
you what each one does. | found out the one | wanted by trial and error.
It has this icon on its right Tw

E-Eﬂ Customize the Quick Adxess Toolbar.

Choose commands from:"d

All Commands

Style
4. Click Add and then OK. The Style menu 0 MNormal - B8 @ M [

now appears in the Quick Access =

Toolbar. It shows you the style of the -_n_ h1 T

paragraph that contains the insertion point. [

If you click the arrow, you will get a listof | p. | N2 T

the styles in your document and you can -

select what you want from the list. Or, you Header T

can simply type the style name in the box. |*- -

Here is what it looks like on my computer: | - Heading 1 -
MNormal T
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c. Word allows you to assign keyboard shortcuts to most commands. Using the
keyboard often is quicker than selecting with the mouse. Do the following:

1. Click the File tab, click Options, click Customize Ribbon, and finally click
Customize just to the right of Keyboard shortcuts. Here, you can select a
command and then assign a shortcut key. Let’s do this for Paragraph.

Mac: Click the Format menu. Here, you will see |Paragraph... M
This says the name is Paragraph... and it already has a shortcut, Option +
Command + m. To change it to F7, from the Apple menu, select System
Preferences, click Keyboard, then click Shortcuts. Select App Shortcuts
on the left, click the Add button[ + ] Click the Application menu and choose
Microsoft Word. In the Menu Title box type Paragraph... (you need the ...)
In the Keyboard Shortcut box tap the fn + F7 keys. Click Add. Quit System
Preferences. In Word, if you click the Format menu, next to Paragraph...
you now will see F7. Skip to step 8 below.

2. Under Categories, scroll down and click Home Tab. This will display the
commands that appear on the Home tab.

3. Under Commands, scroll down and click FormatParagraph.

Categories: Commands:

Wl -ormatParagraph
Insert Tab FormatPhoneticGuide
Draw Tab FormattingPane
Design Tab FormatTwolinesinCne
Layout Tab GrowFont

References Tab HeadingSort
Mailings Tab HighlightColorPicker
Review Tab R Increaselndent

Specify keyboard sequence

Current keys: Press new shortcut key:

The box under Current keys is blank, which means currently there are no
shortcut keys to open the Paragraph dialog box.
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4. Click inside the box under Press new shortcut key and tap the F7 key.
You may need to use the fn key on a laptop.

Customize Keyboard

Specify a command
Categories: Commands:
NIl fo:matParaaraph
Insert Tab FormatPhoneticGuide
Draw Tab FormattingPane
Design Tab FormatTwolinesinOne
Layout Tab GrowFont
References Tab HeadingSort
Mailings Tab HighlightColorPicker
Review Tab v Increaselndent
Specify keyboard sequence

Current keys:

Currently assigned to:  ToolsProofing (

Press new shortcut key:

F7

Word indicates the F7 key currently is assigned to ToolsProofing.

5. Click the Assign button to reassign the F7 key.
6. Click Close.
7. Click OK.
8. To test the new assignment, tap F7. The Paragraph dialog box will open.
Paragraph
Indents and Spacing Line and Page Breaks
General
Alignment: Left b
Outline level: | Body Text b
9. Click Cancel.

FYI, below are the keyboard assignments that | have made on my computer.

Remember, on a laptop, you may need to use the fn key when you tap a
function key.

F1
F2
F3
F4
F5

Help — This one cannot be changed.

Cut (Home Tab, EditCut)
Copy (Home Tab, EditCopy)
Paste (Home Tab, EditPaste)

Keep with next — ensures that the current paragraph is on the same
page as the next paragraph (All Commands, ParaKeepWithNext)
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F6

F7

F8
F9
F10

F11

F12
Ctrl + Num O
Alt +a

Alt +d
End
Home

Paste Special — makes it easy to paste things from the clipboard in
different formats. | use this to paste text without any formatting (Home
Tab, EditPasteSpecial)

Paragraph — Opens the paragraph dialog box (Home Tab,
FormatParagraph)

Bold (Home Tab, Bold)
Update Field — This is the default value.

Repeat last Find — | use this so | do not have to keep going back to
the Find and Replace dialog box when | want to move to the next
item in a search (All Commands, RepeatFind)

Revert to style — Removes any “extra” formatting from the style of the
current paragraph (All Commands, ResetPara)

Save As — This is the default value.
Go back to the previous location (All Commands, GoBack)

Repeat the last action — Ctrl + y does this but it is too difficult to do
with one hand (All Commands, EditRedoOrRepeat)

Insert date (Insert, InsertDateTime)
Moves to end of document (All Commands, EndOfDocument)
Moves to top of document (All Commands, StartOfDocument)

d. Now, you will change all occurrences of the word Government to blue 18 point
bold Arial Black by creating a character style called gov and then applying it to
every occurrence of the word Government in the file. Do the following:

1. At the top of the document, click just to the left of the first letter in the
sentence that begins The unanimous Declaration.

2. On the Home tab, in the lower right corner of the Styles group, click the Styles
dialog box launcher

= | This will open the Styles and Formatting pane.

Mac: There are no dialog box launchers on the Mac. On the Home tab, in the
Styles group, click the Styles Pane button.

Styles €
Styles | pPc |¥ X Mac
Current style:
h2 T | Normal q |
Header T [ MNewsStyle.. | | SelectAl |
Heading 1 1a Apply a style:
Mormal T | Clear Formatting

Show Preview

| h2

Disable Linked Styles
Al kA

|
| h |
|
|

| Header

Options...

List: [Styunsln use :l
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3.

Click the New Style button at the bottom left of the pane. | A,

This will open the Create New Style from Formatting dialog box.

In the Name box, replace Stylel with gov. This defines the name of the
style for future reference.

In the Style type box, select Character from the drop-down menu. This
defines the style as a character style and so only selected characters will
be affected by this style, rather than entire paragraphs.

Change the font to Arial Black, 18 pt, bold, blue.

Create Mew Style from Formatting
Properties
Mame: gov
Style type: Character
Style based on: 4 pefault Paragraph Font
Style for following paragraph:
Formatting
Arial Black vll1ie [~|/|/B | T U |GGG

Click OK. The new style, gov, will appear in the list of styles.

The little letter, &, to the right of gov indicates that this is a character style.
The other styles, like Normal, have a little paragraph mark I showing
that these are paragraph styles (discussed later).

e. Apply the new character style to all occurrences of the word Government
throughout the document. You could do this manually by looking for and then
selecting each occurrence of Government and making the changes
individually, but that would be time consuming. Here is a faster way:

1.
2.
3.

Tap Ctrl + Home to move the insertion point to the top of the document.

Tap Ctrl + h to open the Find and Replace dialog box.

If the More button is showing, click it to display the advanced

options of the Replace feature. If the Less button is showing the
advanced options are already displayed.

Click inside the Find what box and type the word Government.

With the insertion point still in the Find what box, click the Match case
box. This will ensure that words like government (it starts with a lowercase
g rather than an uppercase G) will not match the criteria.

Click the Find whole words only box. This will ensure that words like
Governments (it has an s on the end) will not match the criteria.
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Click inside the Replace with box and clear any text so that the box is blank.
At the bottom of the dialog box, choose Format, Style. P

This will display a list of all the styles available to this Font..
document. Scroll down and click gov (if you type the Paragraph..
letter g Word will automatically scroll to the first word that o
begins with the letter g; that saves scrolling time).

Replace With Style

Tabs...

Language...

@ pefault Paragraph Font Frame...

.................................................................................... Style..
8. Click OK.

Find Replace Go To

Find what: Government

Options: Match Case, Whole Words
Format:

Replace with: |
Format: Style: gov
<< Less
Search Options
Search;  All ~

Match case
Find whole words only

Notice it says All next to Search. If you want to just search from here to the
end of the document, select Down. If you want to search from here to the
top of the document, select Up.

9. Click Replace All. There should be 5 replacements.
10. Click OK.

11. Close the Find and Replace dialog box. Notice the effect on all occurrences
of the word Government.

f. Suppose you want to make the word Government red instead of blue and you
want the font to be underline italic. There is no need to do this manually. All you
have to do is redefine the gov style. Do the following:

1. Onthe Home tab, in the Styles group,
right-click the gov style and select Modify. | AaBbcc AaBl

T Mormal gov =
2. Click the Italic button and the Underline N Update gov
button and change the font color to red. T2 A Modify..

I S SN S B

3. Click OK. Notice that all occurrences of the word Government now are
red, italic, and underlined.

g. Tap Ctrl + p and compare the preview with the key (page 1 only). Make
needed corrections, save the document, and close it. When you are ready to
submit the pdf file, you will print only page 1.
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HW10-2 Paragraph Styles

Problem: How can you create paragraph formats that can be changed throughout a

document by changing one occurrence?

Paragraph styles are like character styles but they affect an entire paragraph rather
than only a word or phrase.

a. Do the following to get some practice in creating paragraph styles.

1.

Open the document HW10-2a Paragraph Styles Original, which is one of
the files you downloaded at the start of the term.

Save the document in the Word Files folder using the name
HW10-2c HWID Paragraph Styles Done

On the Home tab, in the Styles group, click the launch dialog button to
show the Styles pane. Click the arrow next to Normal and select Modify
from the drop-down menu.

Set the font to 12 point Times New Roman and click OK. This changes all
the text because every paragraph is in Normal style.

Select the paragraph with the title, center align it, and change the font to
Arial Black 16 point.

Click anywhere in the paragraph which begins In 1988 the mathematics.

On the Home tab, in the Paragraph group, click the dialog box launcher | '«

Mac: From the Format menu, select Paragraph.

Set the Left Indentation to 0.5 inch, the Right Indentation to 0.5 inch, the
First line Indentation to 0.5 inch, the Spacing before to 12 pt, and the
Line spacing to single.

Indents and Spacing Line and Page Breaks
General
Alignment: Left b

Outline level: | Body Text b Collapsed by default

Indentation

Special: By:

LLIRIE I 3

First line bhed 0.5"

Spacing

Before: 12 pt Line spacing: At:

LRLIRIE B

After: 0pt Single bhd

Click OK.
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10.

Click the New Style button at the bottom left of the Styles pane to open
the Create New Style from Formatting dialog box.

In the Name box type Paral. This new style is automatically set to match
the formatting of the paragraph you just modified.

Be sure the Style type is set to Paragraph.

Click OK. A new paragraph style called Paral appears in the Styles pane
and in the Quick Styles Gallery.

Select the text from just after the first paragraph (starting
with the line that contains the single word Courses) to the AaBbCcl
end of the document and apply the Paral style by clicking 1 Parai

its name in the Styles group.

b. Set up a style for the sideheads (the subtitles that separate parts of the text).
These should stand out from the regular text.

1.

2.

Select the paragraph that contains the single word Courses and change
the style of that paragraph to Normal.

Change the font to 14 point Arial bold.

The way text breaks across pages can affect the readability of a document. For
example, it is best that a sidehead does not appear at the bottom of a page
when the following text appears at the top of the next page. Word has several
ways of addressing line and page breaks as you will see below.

3.

10.

11.

Right-click the single word Courses and choose Paragraph.

4. Change the Spacing Before to 12 points.
5.
6

Click the Line and Page Breaks tab.

Put a check in the box next to Keep with next. This forces the current
paragraph to appear on the same page as the next paragraph. This is good
for rows of tables (so the table will not split across a page break) and
sideheads (so the sidehead will stay with its following text).

Put a check in the box next to Keep lines together. This forces a
paragraph to have all of its text on the same page, rather than split
between the bottom of one page and the top of the next. This is good for
short paragraphs, but it is not practical for long paragraphs.

Click OK.

With the insertion point still in the word Courses, open the Styles dialog
box. Create a new style called Sidehead that has the characteristics you
just set for this paragraph.

Scroll down and apply the Sidehead style to the line with the single word
Implementation and to the line with the two words Typical Class.

Scroll up to the second paragraph under the sidehead Courses (the
paragraph begins Educational research findings...) and click anywhere in
that paragraph. This is a quotation and so it needs to be formatted
differently from other paragraphs.
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12.

13.
14.

Apply the normal style. Right-click anywhere in the paragraph and select
Paragraph. If necessary, click the Indents and Spacing tab. Set the left

indent to 1.5 inches, the right indent to 1.5 inches, the first line indentation
to none, the space before to 0, and the line spacing to single.

Click OK.

With the insertion point still in the paragraph, open the Styles dialog box.
Create a new style called Quotel that has the characteristics you just set
for this paragraph.

c. Add text at the bottom of this file by inserting the text from another file.

1.
2.

7.

Tap Ctrl + End to move the insertion point to the end of the document.
On the Insert tab, in the Text group, click the arrow to the right of the
Object button and select Text from File. Navigate to the document
HW10-2b Paragraph Styles Add Text Original, which is one of the files
you downloaded at the start of the term. Then, click the Insert button.

Click anywhere in the paragraph under Typical Class sidehead and select
all the text below it. Apply the Paral style to this text.

Apply the Sidehead style to the blue headings Discussion, Problem Types,
New Courses, Effects, and Conclusion.

Apply the Quotel style to the two new paragraphs in red (The idea is to
help students... and | think the three mathematics professors...).

Modify the Quotel style so that the paragraphs have 12 pt spacing before
and so the text is purple.

Modify the Normal style so that is has Widow/orphan control.

d. Be sure you understand the difference between character styles, which only
affect individual words or phrases, and paragraph styles, which affect entire
paragraphs.

1.

Create a character style called Math that makes the font Arial Black,
10 point, red.
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2. Use the Replace feature to change all occurrences of the word
mathematics to style Math. Do NOT change the word Mathematics to
that style. There should be 9 replacements.

Character style Math

Courses
Paragraph _
specifically tr
style i
idehead mathematics problems than s
Sidehea that students who construct their §wn knowledg@ rather than acquire 1t from the
teacher. will exhibit a better underftanding of mathematics and. hence, will
P perform better. These notions are 11\ concert with Professional Standards for
aragraph . .
Teaching Mathematics statement thit
style
Paral Paragraph Educational researchg§adings from cognitive
psvchology and mathematies education indicate
style
Quotel

e. Word comes with a built-in language translator that you can use to translate a
section of a document, or the entire document, into more than 70 languages.
To see how this works, do the following:

1. On the first page, select the purple text that begins Educational research
findings ...

2. Onthe Review tab, in the Language group, click the Translate arrow and
select Translate Selection. This opens the Translator pane.

Above the top box it says From English (detected). This means Word was
able to determine the language of the selected text.

Above the bottom box it says To English (or possibly some other language
depending how your computer is set up).

3. Click the arrow above the bottom box to see a list of available languages.
Select any other language you wish. | selected Spanish.

4. Just below the bottom box, click Insert. You may have to click Insert twice.
The purple text is now displayed in Spanish.

Of course, no two languages will translate exactly word for word but this
translation looks pretty good.

f. Word can also read your text aloud. With the purple text still selected, on the
Review tab, in the Speech group, click Read Aloud. Word will “say” the
selected text. However, the pronunciation is not very good since Word is
expecting English and not Spanish.

Select the paragraph just above the purple text and click Read Aloud again.
This sounds pretty good. To stop the reading, click Read Aloud again.

g. Insert a footer that contains the name of the file.
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h. Tap Ctrl + p and compare the preview with the key (page 1 only). Make
needed corrections, save the document, and close it. When you are ready to
submit the pdf file, you will print only page 1.

HW10-3 Census
Problem: How can you break up a document into different sections that can be

formatted independently?

a. Open the document HW10-3a Census Original, which is one of the files you
downloaded at the start of the term.

b. Save the document in the Word Files folder using the name
HW10-3¢c HWID Census Done

c. Insert a HEADER that contains the following:

1. Onthe left, insert a field with the file name (Insert, Text, Quick Parts, Field).

2. Onthe Home tab, in the Styles group, click the dialog box launcher | =
to open the Styles pane.

Mac: On the Home tab, in the Styles group, click the Styles Pane icon.

Modify the Header style so that it is bold and the paragraph has a 3 pt width
border on the bottom. Remove the center tab stop located at 3.25 inches.

3. On the right, type the word Sec and a space, insert the automatic section
number. Then type a space the word Page, a space, and insert the
automatic page number.

PX 12 e 3 s 8 e 6

HW10-3¢c HWID Census Done Sec 1 Page 1|

d. In the numbered list at the bottom of the first page, convert the spaces after the
numbers into periods followed by tabs. You could do this by hand for each of
the ten paragraphs but using the Replace feature is more illustrative.

You cannot simply replace the space with a tab (using the "t code) because
some lines have more than one space and you only want to change the space
next to the number. So, you will apply bold to the space to the right of each
number and then change the bold spaces into *t codes. Do the following:

1. Select the numbered paragraphs.
2. Tap Ctrl + h to open the Replace dialog box.

Mac: From the menu bar, click Edit, Find, Advanced Find and Replace, Replace.

Clear any text or options that may be in the Find what and Replace with
boxes.
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3. Ifthe button is showing, click it to reveal more options.

Mac: Click the arrow [z] in the lower left corner of the Find and Replace dialog.

In the Find what box, type *# and tap the Spacebar. The *# represents
any single digit so Word will "find" a digit followed by a space. You can see
a list of special symbols by clicking Special at the bottom of the dialog box.

Click inside the Replace with box and tap Ctrl + b.

Mac: Click the Format down arrow, then Font, Font style, Bold, OK.

This says to replace the *# space with the same characters but bolded.

Find Replace Go
Find what: r+ = There is a space after the #
Options: Search Down
Format:
Replace with:
Format: Font: Bold <= Found item will be bolded

4. Click Replace All. There will be 10 replacements. Click No when asked if
you want to search the rest of the document.

1-Citizen-Al Microsoft Word %
who-are-no

We made 10 replacements in your selection.
2-Federal E o
information Do you want to search the rest of the document?
3-Genealog Yes No

5. Now, change the bold spaces to *t by doing the following:

With the ten numbered paragraphs still selected, in the Find what box,
enter a single space and tap Ctrl + b.

Mac: Click the Format down arrow, then Font, Font style, Bold, OK.

In the Replace with box, enter .~ t. Be sure to type the period to the left of Mt

6. Click Replace All. There will be 10 replacements. 1. = Citiz
Click No when asked if you want to search the rest of the but-who-ara
document. Notice the spaces have been replaced with the
tab arrows. 2. > Fed;s

information

7. Remove the bold from all the numbered paragraphs
(select the paragraphs and tap Ctrl + b).
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8. Apply the style Outdent 1 to all the lines and add Outdent 1 to the Quick
Style Gallery.

Styles

Qutdent 1,01

Update Outdent 1 to M4
Ar Modify..

Select All: (No Data)

Remove All: (No Data)

Delete Outdent 1...

Add to Style Gallery

e. Word has a large number of predefined styles that you can apply to words or
paragraphs. For example, do the following to apply the predefined paragraph
style Heading 3 to the three headings:

1. Tap Ctrl + Home to move to the top of the document.

2. If necessary, click the Styles dialog box launcher to open the Styles pane.

Mac: Home tab, Styles, Styles Pane.

At the bottom of the Styles pane, click the Options button.

Mac: Click the arrow next to List.

3. Inthe Style Pane Options dialog box, under Select styles to show,
select All styles. This will display all the styles available to this document.

4. Click OK.
5. Close the Styles pane.

6. Apply the Heading 3 style to the following 3 headings: Introduction,
The Document, and Census Schedules Available to the Public.

f. Modify the style Heading 3 so that it has the following characteristics:
» The font is 12 pt Arial Black, italic, and red.
* There is a 3 pt wide red border around the paragraph.
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g. Tap Ctrl + Home to move to the top of the document. Create a new paragraph

style called T1 that has these characteristics:

» The font is 16 pt Arial Black, italic, and green.
» Center the paragraph

* No space before

» Style based on Normal

Mame: T
Style type: Paragraph
Style based on: T Normal

Style for following paragraph: | T T1
Formatting

Arial Black 16 ¥ B | I

=
L4

Apply the new T1 style to the first paragraph, if necessary.

. In the first paragraph of the document, insert a line break just before the word

Economics and another line break just before the word BUREAU. To do this,
place the cursor just before each word and tap Shift + Enter (that is, hold down
the Shift key and, with the Shift key held down, tap the Enter key). The little
arrows «' indicate where the line breaks are.

U.S.-Department-of-Commerce-Economics~:
and-Statistics-Administration~ r
BUREAU-OF-THE-CENSUSY R Line breaks

Infroduction|

Click the left side of the heading Census Schedules Available... and tap

Ctrl + Enter. This will insert a page break so that the heading Census
Schedules Available... will begin at the top of page 2. The Page Break code is
inserted just below item 10.

10.-Work-at-the-Archives-]

You can also insert a page break by choosing Insert, Pages, Page Break.
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There are times when it is appropriate to break up a document into several
sections that have different characteristics, such as page layout (portrait or
landscape), margins, headers and footers, and numbers of columns.

For example, | wanted a different header for each project in this Study Guide so
the reader could quickly see which project was being discussed. | did this by
separating the projects into different sections and then putting the name of the
project in the header of each section.

For this Census document, you will display some of the text in a 3 column format
and also insert a graphic that is better viewed in landscape orientation. Do the
following:

J-

The Status Bar is located at the bottom of the document window.

PAGE:2 Section:1 Page2of2 620 words %  Track Changes: Off

This one shows the location of the insertion point (PAGE 2), the section number (1),
that you are on page 2 of a total of 2, that the document has 620 words, a button for
page proofing, and that Track Changes are off. Your Status Bar may be different.

Right-click the Status Bar to see its options:

Customize Status Bar

¥ Formatted Page Number 2

¥ Section 1

¥ Page Number Page 2 of 3
Vertical Page Position 24"

A check means the item is shown on the Status Bar. You can set your Status
Bar as you wish but for this project be sure the first three items are checked.

The difference between Formatted Page Number and Page Number will be
explained in HW10-5 on page SG275.

Move the insertion point to the bottom of the document. On the Layout tab, in
the Page Setup group, click |*=iBreaks - | and in the Section Breaks section
select Next Page. This is like a page break but it also creates a hew section to
which you can apply different characteristics.

Notice that the Status Bar now shows the insertion point is on PAGE 3 and in

Section 2. The header also shows this information.

PAGE:3 Section:2 Page3of3 620words [[p  Track Changes:Off @ % Accessibility: Investigate [# Display Settings [ Focus — ————f——— + 100%

HW10-3c-HWID-Census-Done > Sec-2-Page-3

" -
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I. Insert a new header for this section by doing the following:

1. Double-click in the header area.

=P\ oo Seciont|
1
\HW1 0-3c-HWID-Census-Done - Sec-2-Page-3
-_m -------------------------------------------------------------------------------------------------------------------------------------------------------- _Same as Previous -

'LNotice the header for the current page is labeled Header-Section 2 while
—the footer of the previous page is labeled Footer-Section 1.

You can tell Word wants to use the same header for section 2 as for

section 1 because in the Navigation group Link to Previous [|=] Link to Previous

is highlighted and | Same as Previous | appears in the header section.

2. To be able to insert a different header for this section, on the Header &
Footer tab, in the Navigation group, click the Link to Previous button to
turn it off. Same as Previous disappears.

3. To the right of the file name, type a blank space and Actual Census.

HW10-3c-HWID-Census-Done-Actual-Census - Sec-2-Page-3Y

Header -Section 2-

4. Close the Header.

m. Since you are about to insert a picture that should be displayed sideways you
must set this new section to landscape orientation. Be sure the insertion point is
in the new section (this is section 2).

1. Onthe Layout tab, in the Page Setup group, click Orientation and select
Landscape.

Scroll up a few lines to see that the previous section remains in portrait
(vertical) while the new section is changed to landscape (sideways).
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2. Open the Header and move the right tab stop to the right indent marker at
9 inches so Sec 3 Page 4 is all the way over on the right.

e ol [ BRI SRR SR U | O IR SRR SEARIN SRR TR SR TR IR SO O R ey,

Sec 1 is in Portrait >
€ Sec 2 is in Landscape >
HW10-3c-HWID-Census-Done-Actual-Census - Sec-2-Page-31

Header -Section 2 |
T

3. Close the Header.

4. With the insertion point still at the bottom of the document, on the Insert
tab in the lllustrations group, click the Picture button and This Device.
Navigate to your Word Files folder and insert the file HW10-3b Census
Picture Original, which is one of the files you downloaded at the start of
the term. This is a photo of a census record from 1910.

5. Place a black border around the image. If necessary, change the style of
the paragraph that contains the graphic to Normal.

n. Place a border around section 2 only by doing the following:

1. Make sure the picture of the 1910 Census is not selected10n the Design
tab, in the Page Background group, click Page Borders.

2. Select This section from the drop-down menu under Apply to. This will
ensure that the border is placed around the pages in this section only and
not every page in the document. There is only one page in this section.

3. Click the arrow next to Art and choose a border you like. | chose cherries.
4. Change the number in the Width box to 10.

5. Confirm that under Setting, the Box icon is selected.

Borders Page Border Shading

Setting: Style: Preview

~ Click on diagram below or use
None buttons to apply borders

B

width (5

Custom 10 pt
Apply to:

Art: This section v

6. Click OK.
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0. Different sections of a document can have different page number sequences.
You will see how this is useful when you work on a large document that has a
Table of Contents in HW10-5. To see how this works now, change the
automatic page number in the last section to 100 by doing the following:

1. Be sure the insertion point is on the page with the Census and that the
Census is NOT selected. Then, on the Insert tab, in the Header & Footer
group, click Page Number and select Format Page Numbers.

This allows you to have the page numbers displayed in different formats,
such as letters or Roman Numerals. It also allows you to change where the
page numbering begins for this section.

2. To the right of Start at type 100.

Page Number Format ?

Mumber format: |1, 2, 3, ..

|:| Include chapter number
Chapter starts with style: | Headi
Use separator: - fhy

Examples: 1-1, 1-A4

Page numbering
O Continue from previous section

(@ startat: 100 =

3. Click OK. The page numbering is set to start at 100 for section 2.

HW10-3c HWID Census Done Actual Census Sec 2 Page 100

p. Displaying text in multiple columns can make a document easier to read because
the reader’s eyes do not have to track so far from the end of a line to the start of
the next line. Do the following to make part of this document display in 3 columns:

1. On page 2, click just to the left of the first word in the second paragraph
(Microfilm copies of the original...).

2. Onthe Layout tab, in the Page Setup group, click Breaks and select
Continuous under Section Breaks.

Microfilm-copies-of-the-original-population-schedules,-from-1790-through-1920-(virtually-
all-of-the-1890-records-were-destroyed-in-a-1921fire),-are-available-at-the- Nafionar

3. Insert another continuous section break at the start of the paragraph that
begins A number of State and territorial...

4. Click anywhere between the two continuous section breaks. The status bar
should show | paGE: 2 Section: 2

On the Layout tab, in the Page Setup group, click Columns and select 3.
Click to the left of the first word in the paragraph that begins There are sound...
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7.

Section1

Section 2

Section 3 {

r. Tap Ctrl + p and compare the preview with the key (pages 1, 2, and 100 only).

On the Layout tab, in the Page Setup group, click Breaks and select
Column. This will ensure the second column starts at that point.

Click to the left of the first word in the paragraph that begins Researchers
may find... and insert another column break.

HW10-3c-HWID-Census-Done - Sec-1-Page-2

Census-Schedules-Available-to-the-Public 9

Individual -records-from-the-national-population-censuses-are-confidential-for-72-years,-
by-law-(Title-44,-U.S.-Code).-Thus, -April-2002-is-the-scheduled-date-forthe- Nafionaf
Archives-to-open-the-1930-records-to-public-use.{[-...wSection Break (CONtINUOUS )«

Microfilm-copies-of-the-
original-population-
schedules,-from-1790-
through-1920-(virtually-
all-of-the-1890-records-
were-destroyed-in-a-
1921 ire),-are-available-
at-the-National
Archives-in-Washington-
(http://www.archives.gov
findex.html)-and-its-13-
regional-archives,-and-
many-libraries-in-various-
parts-of-the-United-
States.-Most-have-
facilities-for-making-
paper-copies-from-the-
microfilm.-q

There-are-sound-of-the-
surname-rather-than-its-
spelling-indexes-on-
microfilm-for-the-1880,-
1900,-and-1920-
censuses-for-each-
State,-and-for-1910-for-
21-States, -principally-in-
the-South.-Alphabetic-
indexes-to-the-1790-
1860-and-most-of-the-
1870-censuses-are-

available-in-genealogical-

libraries.q
TR Column Break ..o

Researchers-may-find-
two-Bureau-of-the-
Census-publications-
useful;-most-major-
libraries-have-copies:-
Heads-of-Families-at-the-
First-Census-of-the-
United-States-Taken-in-
the-Year-1790-(12-vols.,-
Washington,-DC,-1907-
08,-reprinted-1965-75),-
contains-specific-names.-
A-Century-of-Population-
Growth—1790-1900-
(Washington,-DC,-1909,-
reprinted-1967-1970),-
includes-the-incidence-of-
surnames-in-1790,-and-
a-variety-of-summary-
tables-from-colonial-
censuses-and-from-1790-
01900 qcoecmmmmsnes

A-number-of-State-and-territorial-censuses-were-Nationalized-in-the-intra-decennial-

years, -particularly-in-the-19th-century.-See-Henry-J -

Dubester,-An-Annotated-

Make needed corrections, save the document, and close it. When you are
ready to submit the pdf file, you will print only pages 1, 2, and 100.
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HW10-4 Track Changes

Problem: How can several people collaborate on and edit a document and allow
everyone to see the changes made by each individual?

If you are working on a group project you may need to make changes to documents
that were written by other group members. The person who writes the original draft
is referred to as the author. The others who read the document and suggest
changes are referred to as the reviewers.

You can use Word’s Comment feature to insert comments into a document,
perhaps expanding on something or clarifying something, or suggesting some
change that needs to be made. To see how this works, you will edit a paper
concerning mathematical modeling and global poverty 4’

a. Set up the document by doing the following:
1. Open the document HW10-4a Track Changes Original.

2. Save the document to your Word Files folder using the name
HW10-4b HWID Track Changes Done

3. On the Review tab, in the Tracking group, click the launch dialog button.
Make the settings match the following:

Mac: Review tab, in the Tracking group, Markup Options.

Track Changes Options ? K
Show

Comments Highlight Updates

Ink Other Authors

Insertions and Deletions || Pictures By Comments!

Formatting

Balloons in All Markup view show: |Revisions w
Reviewing Pane: Off bt
Advanced Options... Change User Name...
4. Click OK.

b. Set the options and insert some comments by doing the following:

1. Inthe Track Changes Options dialog box, click Advanced Options.

Mac: Review tab, Tracking group, Markup Options, Preferences.

Here is where you can set the way changes are indicated and the colors
that will be used. If necessary, make the settings as close as you can to
match the following:

47 Material adapted from Staats, S. K., Robertson, D. F. (2009). International Inequalities: Algebraic
Investigations into Health and Economic Development. MathAMATYC Educator, 1(1) 6-11.
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Insertions: ~ | Color: . Red &
Deletions: Strikethrough v | Color . By author A
Changed lines: Qutside border ~

1
Comments; . By author e
Track moves
Maved from: Double strikethrough |~ | Color: . Green ™
Moved to: Double underline ~ | Color: . Green ™
Inserted cells: |:| Light Blue ~ | Merged cells: D Light Yellow | ™
Deleted cells: D Pink ~ | Split cells: I:l Light Orange | ™
Track formatting
Formatting: (none) v | Color: . By author >
Preferred width: | 3.7" 2 Measure in: Inches b
Margin: Right bed
Show lines connecting to text
Paper orientation in printing: Preserve e

2. Click OK and click OK again.

3. Onthe Review tab, in the Tracking group, be sure All Markup
is showing. If not, select it from the drop-down menu.

[:rf" All Markup

4. Select the author's names (Douglas Robertson and Susan Staats)

5. On the Review tab, in the Comments group, click New Comment. The
screen is redrawn with the selected text highlighted and a balloon on the

right.

6. Type the following in the balloon: The names of the authors should be
reversed since Sue did the original draft. In the following screenshots, |
set the author to HWID. Your computer probably will show your name.

Algebraic Investigations into International Health
and Economic Development

HWID 2 minutes ago

the original draft

‘Douglas Robertson and Susan Staats| The names of the authors should be reversed since Sue did
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7. Point to the selected text and a screen tip appears showing the date and
time the comment was made and the name of the person who made it.

HWID, Friday, July 31, 2020 11:20:00 AM
commented:

The names of the authors should be reversed
since Sue did the original draft.

Douglas Robertson and Susan Staal

8. In the first paragraph, click just to the right of Sub-Saharan Africa (it is
bold lavender) and insert a comment with the text Should we list
countries here?

9. Near the end of the first paragraph, click just to the right of the word
complex and insert the comment Should we use the word
"complicated" instead?

On the Review tab, in the Comments group, four buttons now are available.
You can insert a New Comment, Delete a selected comment, move to the
Previous comment, or move to the Next comment.

10. Click anywhere in the second comment.

11. Inthe Review tab in the Comments group click the Delete arrow and
select Delete. You can also delete a comment by clicking in it, right-
clicking, and selecting Delete Comment from the menu.

c. If you want to make changes to a document and have Word keep a record of
those changes you can use the Track Changes feature. This is helpful to the
author and other reviewers because it allows them to see specifically what you
think should be added, deleted, or modified, and how. For example, a comment
like This paragraph is confusing would be useful but it would be much more
helpful if you made specific suggestions as to how the paragraph could be
changed to make it better. Once you save the document and send it to others
they can accept, reject, or modify the changes.

Note that even if you set the Track Changes options as directed above, your
computer may be set up so things look a bit differently. Don’t worry about it.

1. If Track Changes: Off shows in the Status Bar, click it to turn it on. Or, on
the Review tab, in the Tracking group, click Track Changes.

2. Right after the last sentence in the first paragraph, type a space and then
insert the following text: Unfortunately, many people try to avoid using
mathematics because they perceive it to be beyond their capabilities.
Because you set insertions to be red and underlined that is how the text
appears.

3. At the start of the next paragraph, make the second word (relatively) italic.
The change in formatting is noted on the right side.
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4. In the same sentence, select the words to become and type in becoming.
Notice how easy it is to see what was deleted and what was inserted.

2006, p. 4). Globalization is responsible for desperate working conditions in many parts Wb
of the world, but it also allows people who will never meet in person to communicate | Should we use the word "compiicated” instead?

frequently, they are conveyed through mathematical data. Unfortunately, many people

try to avoid using mathematics because they perceive it to be beyond their capabilities. HWID
,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,, ----] Formatted: Font: Itali
Yet relatively few math educators—nor their colleagues in other disciplines—receive the " e

training in global issues to let them guide students in becoming critical users of 1 WD o become
ernational data. Michael Vern, a multicultural education scholar, writes that “(t)he near

The lines that have changes (added text, deleted text, and formatting) are
indicated on the left side by a vertical line.

5. On page 2, select the following text, including the paragraph mark:

Insert-Figure-1-About-Hereq|
1

Figure-1:-Millennium-Development-Goals.-The-assessment-targets-are-available-at-
http://www.un.org/millenniumgoals/-

Cut the text. Track Changes notes the deleted text on the right side.

ﬂ I ' (1]
il g y

T E-R -0f - | i - E . Ml i N i . . . . Fi -1z Developl Is.-The
There-is-a-wealth-of-data-being-collected-for-the-Millennium-Project-that-can-help f "Js“'f niu 1$I:|;Mww”n i T

students-gain-a-sense-of-the-dramatic-differences-in-standard-of-living—particularly-in-

6. Go back to page 1, click just to the left of the start of the third paragraph,
In this paper, we..., and paste the deleted text.

significant-social-issues-like-problems-in-international-development.q| HWID

Insert-Figure-1-About-Heref Moved (insertion) [1]
1

Figure-1:-Millennium-Development-Goals.-The-assessment-targets-are-available-at-
http://www.un.org/millenniumgoals/-.g
In-this-paper,-we-describe-international-issues-that-can-be-taught-alongside-standard-

d. You can choose to view your document in four different ways. Do the following:

1. Onthe Review tab, in the Tracking group, notice that All Markup is
displayed. This tells you that the current view of the document details
all the comments and proposed changes.

2. Click the arrow and select Simple Markup. This shows a simplified version
of the markup.

3. Click the arrow and select No Markup. This shows how the document will
look if all the changes are accepted.

4. Click the arrow and select Original. This shows how the document looked
before you started making changes.

5. Click the arrow and select All Markup again.
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e. With HW10-4b HWID Track Changes Done open, tap Ctrl + p and compare
the preview with the key (page 1 only). Make needed corrections, save the
document, and close it. When you are ready to submit the pdf file, you will print
only page 1.

f. Now, let’s process the suggested changes.

1. Open the document and save a new copy of the document using the name
HW10-4c HWID Track Changes Done

2. Move to the top of the document. On the Review tab, in the Changes group,
click the Next button. This will select the first comment.

3. Click the Next button again to select the second comment.

4. On the Review tab, in the Changes group, click the Reject button arrow ' ~

select Reject and Move to Next. The comment is deleted and the next
change is selected, which is the inserted text Unfortunately, many people...

5. On the Review tab, in the Changes group, click the Accept button arrow
and select Accept and Move to Next. This will retain this change and move
to the next change, which is the format change of the word relatively.

You can move through the document rejecting and accepting changes one
at a time. You can accept all the remaining changes by clicking the arrow
on the Accept button and selecting Accept All Changes. Using a similar
procedure, you can reject all the rest of the changes.

6. Turn off Track Changes.

7. Save the document and close it. No need to print this one.
HW10-5 Large Document

Problem: How can a large document, such as this Study Guide, be organized and
include graphs, equations, a table of contents, an index, and cross
references?

The following book chapter on computer-mediated mathematics courses serves as
the basis for this assignment:

Kinney, D. P., Kinney, L. S., Robertson, D. F. (2005). Learning Mathematics
Through Computer-mediated Instruction. In J. L. Higbee, D. B. Lundell, & D. R.
Arendale (Eds.), The General College vision: Integrating intellectual growth,
multicultural perspectives, and student development (299-318). Minneapolis:
University of Minnesota, General College, Center for Research on Developmental
Education and Urban Literacy.

a. Open the document HW10-5a Large Document Original, which is one of the
files you downloaded at the start of the term.

b. Save the document to the Word Files folder using the name
HW10-5f HWID Large Document Done

described here due to different computer and printer setups.

‘ The page numbers in your document might not exactly match those
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c. One way to move quickly through a document is to use the Navigation Pane,
which displays a list of headings and subheadings in the document. When you
click a heading in the Navigation Pane, Word jumps to that heading in the
document, displays it at the top of the window, and highlights the heading in the
Navigation Pane. To see how this works, do the following:

1. On the View tab, in the Show group, click the checkbox to the left of
Navigation Pane. This displays an outline of the document in a pane
on the left side of the window.

Navigation v X
Search document P~

Headings Pages Results

Learning Mathematics through Compute...
Abstract
Insert Photo Here

- Heading 5

Insert Table of Contents Here -
Computer-mediated Instruction =

Overview of Computer-mediated Software o Heading 2

4 Structure of Computer-mediated Courses

—

Daily Schedule of Class Activities }- Heading 3

The outline entries are automatically generated using built-in styles called
Heading 1, Heading 2, Heading 3, etc. For example, | applied the
following styles to various parts of this book chapter:

Heading 1: This heading normally would be used for the title but later on you
will create a Table of Contents from the first three levels of headings and you
do not want the title in the Table of Contents. So, Heading 1 is not used.
However, you do want the title to appear in the Navigation Pane so | applied
Heading 5 to it.

Heading 2: Section headings such as Computer-mediated Instruction,
Overview of Computer-mediated Software, and Structure of Computer-
mediated Courses.

Heading 3: Some sections have sub-parts. For example, Structure of
Computer-mediated Courses has sub-parts such as Daily Schedule of
Class Activities, Homework Assignments, and Exams and Quizzes.

4 Structure of Computer-mediated Courses
Daily Schedule of Class Activities
Hormework Assignments

Exams and Quizzes
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With this, you can see how a good outline of a paper can be helpful later on as
the paper grows and details are filled in.

2. If you think the width of the Navigation Pane is too narrow or too wide, you
can change it. Point to the vertical bar that separates the .
Navigation Pane from the document screen and the pointer Pt
will change to a double pointed arrow. Drag left or right to '
change the width.

3. Inthe Navigation Pane, click Structure of Computer-mediated Courses.
The insertion point will jump to that section of the document.

4. Click the arrow E on the left of Structure of Computer-mediated Courses.
The down-pointing arrow turns into a right-pointing arrow, and the
subheadings of Structure of Computer-mediated Courses are hidden.

» | Structure of Computer-mediated Courses

4 Student Performance in Computer-media...

The Mathermatics Placement Exarm

You can use the arrows to collapse or expand any section that you wish.
In a large document, collapsing and expanding selected levels can make it
easier to see the parts of the document you are working on.

5. Click the arrow on the left of Structure of Computer-mediated Courses
to once again display its subheadings.

6. Point to any heading, right-click, and select Collapse all to show only the
major headings. Then, click Expand all so you can see all the headings
and subheadings again.

7. This document contains many hidden codes that will be explained
later. If the codes are visible, hide them by clicking the Show/Hide | T |
button on the Home tab.

d. Insert a photo of the room where the classes are taught by doing the following:

1. Use the Navigation Pane to move the insertion point to Insert Photo Here
(third line from the top in the Navigation Pane).

2. Select the entire line.

TR B R T S B SRR B E- SPEREN SRR SRR SRR B
Navigation V&N

- Insert Photo Here
Search document Felng

HEADINGS PAGES RESULTS

Learning Mathematics through C.. Computer-mediated Instruction

=l The structure of the computer-mediated courses at the General College 15

Insert Photo Here

3. Onthe Insert tab, in the Illustrations group, click the Pictures button.

4. Navigate to your Word Files folder and double-click the file
HW10-5b Photo Original.jpg.

5. Center the picture, make the height of the picture 5 inches, and place a
black border around it.
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e. Insert two tables and a graph by doing the following:

1.
2.
3.

Move the insertion point to Insert Table 1 Here (around page 16).
Select the entire line. EI:| -
On the Insert tab, in the Text group, click the arrow on EI:| Object...

the right of Object and choose Text from File.

Navigate to your Word Files folder and then El Text from File...

double-click the file HW10-5c¢ Table 1 Original, which
is one of the files you downloaded at the start of the term.

Change the style of the caption, Table 1: Course Satisfaction, to
Heading 5 (Home, Styles, scroll down and click Heading 5).

Lecture 216 333 0.48 0.03

Table 1: Course Satisfaction

Use the Navigation Pane to move the insertion point to Insert Table 2 Here
(about page 17). Follow the same procedure as you did for Table 1 to insert
the file HW10-5d Table 2 Original, which is one of the files you downloaded
at the start of the term. Change the style of the caption to Heading 5.

Use the Navigation Pane to move the insertion point to Insert Figure 1
Here (about page 22). Follow the same procedure as you did for Table 1 to
insert the file HW10-5e Graph Word Original, which is one of the files you
downloaded at the start of the term. Change the style of the caption to
Heading 5. Center the figure on the page. If the caption is on the next
page, set them to be on the same page (select the line with the figure, then
right-click, Paragraph, Line and Page Breaks, and Keep with next).

f. Word offers two ways to enter equations.

Use an equation editor such as MathType. This is an app you must
purchase and install in Word. If you are a STEM major and will be typing a
lot of equations this is a good investment because it is fast and efficient.

Use a pallet from which you can choose mathematical symbols and
structures. This is slower but it is easier to use and free. You will use this
method since most of you are not STEM majors and probably will not do this
very often. Do the following:

Use the Find feature to locate the red text EquationHere.

Delete the red text EquationHere. You will insert this formula at this
location: 5x2 —3x+1=0

On the Insert tab, in the Symbols group, click the big pi symbol. Tt
This opens up the Equation tab. Equation

-
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4. It will be easier if you change the magnification to 200% by repeatedly clicking
the plus symbol on the Status Bar in the lower right corner of the window.

— — 7 200% e Ix

Seript |Radica

w w

5. Type the numeral 5.

6. Click the Script arrow and select Superscript. Subscripts 3

This inserts a template where you can enter the values.

Superscript

7. In the larger box, type x and in the smaller box type 2 to get 5x2

8. Tap the Right Arrow key to move out of the subscript box and type-3x +1 =0

5x2—3x+1=0

v

9. Click outside the editor box to return to normal Word editing mode. The line
should look like this: |“Use the Quadratic Formula to solve 5x% —3x +1 = 0.”

10. Change the magnification back to 100% by repeatedly clicking the minus
symbol on the Status Bar in the lower right corner of the window.

11. After the quotation mark, insert a footnote that says Here, quad refers to
the number of sides of a square, which has 2 dimensions. If
necessary, change the font of this footnote to Times New Roman.

g. Create cross references to specific pages in the document so the reader can
be directed to other places for more information. Here is an example of a cross-
reference in this Study Guide:

For information on opening a Navigation Pane see page SG269.

You cannot simply type the page numbers because as parts of the document
are added or deleted the page numbers will change. Word has a way of
creating page references that will automatically update each time the document
is saved or printed.

Do the following:

1. Locate the caption Figure 1: Gender and Type of Class Chosen.
Select the text Figure 1.

2. Onthe Insert tab, in the Links group, click Bookmark. E
This will display the bookmark dialog box. Bookmark

3. Type Figurel in the Bookmark name: box. A bookmark name must begin
with a letter and may contain numbers or the underscore but no spaces.
So, Figurel and Figure_1 are fine but Figure 1 is not.
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4. Click Add. The dialog box closes automatically. This creates a hidden
bookmark at this location. If you want to see where bookmarks are, click
the File tab, click Options, click Advanced, scroll down to Show
document content, and put a check next to Show bookmarks.

If they enclose text, bookmarks will show as gray brackets: |[Figure 1

If no text was selected when you created the bookmark, a gray I beamI
will show.

To go to a specific bookmark, open the Bookmark dialog box, click the
bookmark you want, and click Go To.

Bookmark ? X

Bookmark name:

Figurel Add

Delete

To delete a bookmark, open the Bookmark dialog box, click the bookmark
you want, and click Delete.

5. Set up a bookmark for Table 1: Course Satisfaction.

6. Be sure the Show/Hide feature is off. Use the Find feature to locate the
blue text page xx near the top of the document (about page 3). You want
to replace xx with the page number where the reference can be found.

7. Delete xx. Then, on the Insert tab, in the Links group, click
Cross-reference.

8. Set the choices in the Cross-reference dialog box as follows:

¢ Reference type: Bookmark
e Insert as hyperlink

e Insert reference to: Page number

e For which bookmark: Figurel

Cross-reference

Reference type:

Bookmark

Insert as hyperlink
Separate numbers with

For which bookmark:

?

Insert reference to:

W Page number

Délﬂclude above,ﬁbelowé

et

9. Click Insert and close the dialog box. The page number, 23, is inserted.

N T N S TR SR R S S R R RN S T BRI S SRR BRI SRR T SRR

difference in course choice (see the graph on page 23). Course satisfaction slightly favors
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10.

11.

If you add or delete text from the document this page number will
automatically be updated when you save or print.

Since you checked the box next to Insert as Figurel

hyperlink, if you hold down the Ctrl key and click the oo Ctrl+Click to follow link
page number cross-reference you just set up, the
insertion point will jump to that part of the document.

page 23b. Course satisfactio

Two lines down locate the blue text page yy. Replace yy with a cross-
reference that contains the page number where Table 1 can be found.

Close the Cross-reference dialog box.

h. Breakup the document into different sections and insert headers for each
section by doing the following:

1.

Right-click the Status Bar to open the Customize Status Bar dialog box.
If they are not already there, click to place check marks to the left of
Formatted Page Number (explained later) and Section.

Customize Status Bar

v Formatted Page Number 3
v Section 1
v/ Page Number Page 3 of 32

Use the Navigation Pane to move the insertion point to the left of the
heading Abstract near the top of the document. On the Layout tab, in the
Page Setup group, click the Breaks button and select Section Breaks,
Next page.

Now, the Abstract section starts at the top of page 2. The Status Bar will
show PAGE: 2 Section: 2.

Use the Navigation Pane to move the insertion point to the left of the
heading Insert Table of Contents Here and insert a next page section
break. Now, the Table of Contents section starts at the top of page 3. The
Status Bar will show PAGE: 3 Section: 3.

Use the Navigation Pane to move the insertion point to the left of the
heading Computer-mediated Instruction and insert a next page section
break. The Status Bar will show PAGE: 4 Section: 4.

Use the Navigation Pane to move the insertion point to the left of the
heading Works Cited near the end of the document and insert a next page
section break. The Status Bar will show PAGE: 32 Section: 5.

Use the Navigation Pane to move the insertion point to the left of the
heading Insert Index Here and insert a next page section break. The
Status Bar will show PAGE: 35 Section: 6.
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I. Adjust the page numbers of the body of the paper by doing the following:

1. Use the Navigation Pane to move the insertion point to the left of the
heading Computer-mediated Instruction near the top of the document.

Look at the Status Bar in the lower left corner of the window. The page
number is 4, which is not what you want. This is because the title page,
abstract, and Table of Contents are all counted as pages. The Computer-
Mediated Instruction section should begin on page 1.

2. Onthe Insert tab, in the Header & Footer group, click Page Number, and
click Format Page Numbers. In the Page Number Format dialog box,
click Start at and be sure a 1 is in the Start at box.

Page Number Format ? X

Mumber format: | 1, 2, 3, ... b
|:| Include chapter number
Chapter starts with style: | Heading 1 g
Use separator: - (hyphen) b

Examples: 1-1, 1-A

Page numbering

O Continue from previous section

(@ startat: |1 ﬁ

3. Click OK. Look at the Status Bar:| PAGE: 1 Section: 4 Page 4 of 35

PAGE: 1 is called the Formatted Page Number. That is the page number
that will appear in the document header or footer. This is the page
number you just set to 1 in the Page Number Format dialog box.

SECTION: 4 means the insertion point is in the fourth section of the document.

Page 4 of 35 means the insertion point is in the "real" 4" page of the
document and the document has a total of 35 "real" pages. Your
document may have 34 or 36 "real" pages due to differences in printer
setups. That is no big deal.

4. Save the document.

j. Putin headers by doing the following:

1. Use the Navigation Pane to move the insertion point to just to the left of the
Computer-mediated Instruction heading near the top of the document.

2. Onthe Layout tab, in the Page Setup group, click the dialog box Iauncher
to open the Page Setup dialog box.

Mac: From the Format menu, select Document.
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Click the Layout tab, click the check boxes next to Different odd
and even and Different first page. In the drop-down menu next to
Apply to, be sure This section is selected.

Margins Paper Layout
Section
Section start: MNew page

Suppress endnotes
Headers and footers

Different odd and even

Header: |0.5"

From edge:

Footer:  |0.53"
Page

Vertical alignment: | Top

Preview

Apply ta: | This section <

3. Click OK. In the Status Bar it says Page 5 of 36, which means there now
are 36 “real” pages in the document and the insertion point is on the “real”
page 5. Word has automatically inserted an invisible blank page after page
3 because you just told it to set up different headers for the first page of the
section, the odd pages of this section, and the even pages of this section.

4. Double-click in the Header area. On the Header & Footer tab, in the
Navigation group, click Link to Previous to deselect it. This will enable
you to change the header for this section without affecting the header in the
previous section. The header area is now called First Page Header -
Section 4. This is the first page of section 4 and you do not want a header
on this page.

| First Page Header -Section 4- | Computer-mediated Instruction
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5. Scroll down and click in the Even Page Header -Section 4 in the header
area, deselect the Link to Previous button and remove the center tab stop.

Insert field codes so that the automatic page number is displayed on the
left and the file name is displayed on the right.

2 HW10-5f HWID Large Document Done

6. Scroll down and click in the next header area. It has the label Odd Page
Header -Section 4. Deselect the Link to Previous button and remove the
center tab stop.

Type a header that contains your HWID on the left and the automatic
page number on the right.

HWID 3

7. Close the Header and Footer area.

k. Add a Table of Contents by doing the following:

1. Use the Navigation Pane to move the insertion point to the left of the
heading Insert Table of Contents Here.

2. Replace the text with the words Table of Contents and tap Enter.
3. Change the style of the line that contains Table of Contents to normal.

4. Format the line that contains Table of Contents as 18 point, bold, Arial,
and center the line between the margins.

5. Right-click anywhere in the Table of Contents line and | Indents and Spacing  Line
select Paragraph. Set the Outline Level to Level 5. General
Click OK. Alignment: Centered
This will make the Table of Contents heading at the Outline level:  Body Text
same level as paragraphs that have style Heading 5 Body Text
and it will appear in the Navigation Pane. Do not use entation |l
Heading 1 or Heading 2 or Heading 3 style because Level 3
you do not want the Table of Contents heading to be Left Level 4

in the actual Table of Contents.

6. Click in the blank line just under Table of Contents.
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7. Onthe References tab, in the Table of Contents group, click Table of
Contents and select Custom Table of Contents near the bottom of the
menu. The Table of Contents dialog box opens. Set it to look like the
following (show the page numbers, right align the page numbers, apply a
dotted tab leader to the page numbers, choose the format from a template,
and show the top 3 levels only):

. Table of Figures Table of Authorities

Print Preview Web Preview

Heading 1.....ccooveeeeveeienns 1|~ | Heading 1
Heading 2.......ccooevverceevennne 3 Heading 2
Heading 3......cccoevvveevnnee 5 Heading 3

W

Show page numbers Use hyperlinks instead of page numbers

Right align page numbers

Tab leader: | ... b

General

Formats: From template b

-

Show levels: 3 =

8. Click OK. The Table of Contents is inserted.

You can use the Table of Contents to quickly go to any item listed. To do
this, point to the item, hold down the Ctrl key, and click.

Table of Contents

Computer-mediated Instruction
Overview Current Document d Software
Structure |CtrI+C|ick to follow Iink;] Courses

Daily Schedule of Class Activities

v R —

Try it. Hold down the Ctrl key, point to Homework Assignments and click.
The insertion point is moved to the Homework Assignments section.

[. An index is helpful in a large document because it can help the reader quickly find
particular words and phrases of interest. Creating an index involves four steps:

Step 1 Mark words and phrases that are to appear in the index. For this
document, | have already marked quite a few index entries in order to save
you time. You are going to mark a few more and then create the index.

Step 2 Edit the index codes so the wording is appropriate and makes sense.
Step 3 Have Word create the index from the index codes.

Step 4 Check the index and edit the index codes as needed.
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Do the following:

1.

Use the Navigation Pane to move the insertion point to the left of the
heading Computer-mediated Instruction.

If the hidden codes are not showing, on the Home tab, in the Paragraph
group, click the Show/Hide button | 4 |

This will display the paragraph marks, 7, tabs —+ , spaces, -, and other
document marks such as index codes.

The first index code look like this: { XE "computer-mediated” }

The prefix XE stands for indeX Entry. The word or phrase that will appear
in the index is shown inside quotation marks.

Computer-mediated-instructiony]

' Bc oursesi XE-

i
LU H

consistent-with the-definition -of-computer-mediated -instruction -stated -by-Gifford-(1996). -

2.
3.

Select learner-centered in the first paragraph. It is in red to help you find it.

Tap Alt + Shift + x (or choose References, Index, Mark Entry).

Mark Index Entry ? x

Index

Mmain entry: | leamner-centered |

Subentry: ‘ |

Options

O Cross-reference: |_5‘ee |

@ Current page
O Page range
Bookmark: by

Page number format

[ ] Bold
|:| Italic

This dialog box stays open so that you can mark multiple index
entries.

The selected word appears in the Main entry box.
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If you want to change it for some reason you can type what you want.

If you click Mark the index entry will be marked for this occurrence only.
If you click Mark All the entry will be marked for every occurrence of

4.

6.

learner-centered in the document.

Click Mark. The phrase learner-centered is marked as an index entry.

learner-centered {-XE "learner-centered" -}

.........................................................

The Mark Index Entry dialog box stays open so you can mark more
entries.

Move four lines down and select graphics (it is in red). Click anywhere in
the Mark Index Entry dialog box and then click Mark All. This will mark
every occurrence of graphics in the document. Note that this will NOT
mark graphic or graphical. That is one of the drawbacks of the Mark All
button — variations on the word or phrase will not be marked even though
they may be important. Hence, you will have to carefully read the document
and tweak the index to make it accurate. This takes time!

Close the Mark Index Entry dialog box.

m. Create the index by doing the following.

1.

Move the insertion point to the heading Insert Index Here at the bottom of
the document.

Replace the text Insert Index Here with the single word Index and apply
the Heading 2 style.

Click in the blank line below Index.

Turn off Show/Hide by clicking the Show/Hide button | 9|
If you do not turn off Show/Hide the page numbers will be incorrect because
the text of the marked index entries will add to the length of the document.

On the References tab, in the Index group, click Insert Index.
In the Columns box, change the number of columns to 3.

In the Formats box, click the arrow, scroll down, and select Bulleted.

Index able of Contents able of Figures able of Authorities

Print Preview

A Type: @ Indented O Run-in
A Columns: 3 =
Language: | English (United States) v
Aristotle, 2
Asteroid belt. See Jupiter
Atmosphere

Earth

O] Right align page numbers

Tab leader v

Formats: Bulleted v
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6. Click OK to create the index. Note that the page numbers in your index may
be slightly different from those shown due to the setup for different printers.

Index
exams, 5, 6, 7, 11, 14, 22, 23
A Explain, 3, 4, 16, 17 N

Explore, 3

Academic Systems, 2, 20, 25, 26, nonlinear, 22, 24
29, 30 E

Academic.com, 26, 27, 29 0
administrative tasks, 9 focus groups, 6, 8, 13, 16
Algebra, 10, 11, 12, 13 Focus groups, 10 Overview, 2
anywhere, anytime, 20
Apply, 3, 4, 16, 17 G P
asynchronous, 24
attfandance, 4,8,13 General College, 1, 2, 4 pass rates, 11
att!tude, 16 graphics, 1, 3,7, 9, 10, 16 performance, 4, 10
attitudes, 10, 16, 25 personalized system of

n. It is often the case that after you create the index you will have to modify it. For
example, the index you just created lists attitude and attitudes as separate
entries even though they are the same topic. The same is true for Evaluate
and Evaluates. So, after you create the index it is a good idea to print it, go
through the entries, and make changes as appropriate. But, do NOT edit the
index directly — only edit the marked entry codes in the body of the document.
Once you make the entries consistent you can create a new index with a single
keystroke.

Change the Evaluates index entries to Evaluate by doing the following:
1. Tap Ctrl + Home to move to the top of the document.
2. Turn on the Show/Hide feature by clicking the Show/Hide button | 1T |
3. Tap Ctrl + h to open the Find and Replace dialog box.

In the Find what box type: XE "Evaluates

In the Replace with box type: XE "Evaluate

4. Click Replace All. Word replaces all the index entries that contain
Evaluates with Evaluate (there should be 3 replacements). Word does
not change the text of the document, only the index entry codes.

5. Click OK.

6. Repeat the process changing the index entries for attitudes to attitude
(there should be 3 replacements). Close the Find and Replace dialog box.

7. Turn off the Show/Hide feature by clicking the Show/Hide button |9 |.
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8. Now, you need to update the index. To do that, click anywhere in the index,
right-click, and select Update Field. You could also choose References,
Index, Update Index. or tap F9. Now, only attitude appears in the index.

A

Academic Systems, 2, 20, 25, 26,
29, 30

Academic.com, 26, 27, 29

administrative tasks, 9

Algebra, 10, 11, 12, 13

anywhere, anytime, 20

Apply, 3, 4, 16, 17

asynchronous, 24

attendance, 4, 8, 13

attitude, 10, 16, 25

There are several other similar situations (e.g., focus groups & Focus
groups, and math placement & mathematics placement) but, to save time,
you can leave those alone.

0. Do NOT submit the entire document for grading. Instead, create pdf files for 4
specific pages by doing the following:

Mac: To make a pdf of any page, click anywhere in the page, tap Command + p,
and click the Current Page button. In the lower left corner, click the arrow
next to PDF and select Save as PDF. In the Save As box, type HW10-5¢g
HWID Large Document TOC Done and click Save. Go to step 7 below.

1. Tap Ctrl + p to open the Print dialog box.
2. Under Printer, select Adobe PDF.

3. Inthe Settings section, point to the Pages box and the Screen Tip will
show you how to print selected pages or sections.

Settings
|_ Print All Pages
The whole thing
Pages:

Pages

Type page numbers and/or page
ranges separated by commas
counting from the start of the
document or the section. For
example, type 1, 3, 5-12 or p1s1,
p1s2, p1s3—p8s3
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4. To make a pdf of section 3 only, which has the Table of Contents, type s3
in the Pages box.

5. Click Print. If get the following message, click the Update entire table button.

Word is updating the table of contents. Select one of the following
options:

(O Update page numbers only

6. Click OK. Save the pdf file as HW10-5g HWID Large Document TOC Done
Compare the preview with the key. Make needed corrections to the Word file
and try again.

7. Move the insertion point to the page that contains the quadratic formula.
This probably is formatted page 7 (real page 11) but, depending on your
printer, it could be page 6 or page 8. Tapping Ctrl + g, typing 7, and
clicking Go to will send you to page 7.

8. Tap Ctrl + p to open the Print dialog box.

9. Inthe Settings section, click the arrow and select Print Current Page.
This will print the page that currently contains the insertion point.

Printer
< Adobe PDF .
- Ready
Printer Properties
Settings
Print Current Page
Just this page

10. Be sure Adobe PDF is still showing under Printer and then click Print.
Save the pdf file as HW10-5h HWID Large Document Equations Done

If the field codes are printing, see page SG241 for information on how to
turn them off.

11. Follow the same procedure to print the page that contains Table 1.
Save the pdf file as HW10-5i HWID Large Document Table 1 Done

12. Follow the same procedure to print the page that contains the Index.
Save the pdf file as HW10-5] HWID Large Document Index Done

p. Save the document and close it.
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Step 4 Submit Now, submit the following. Use these names for the pdf files:

HW10-1 HWID Character Styles Done Page 1

HW10-2c HWID Paragraph Styles Done Page 1

HW10-3c HWID Census Done Page 1

HW10-3c HWID Census Done Page 2

HW10-3c HWID Census Done Page 100

HW10-4b HWID Track Changes Done Page 1

HW10-5f HWID Large Document Done TOC in section 3
HW10-5f HWID Large Document Done Equations on Page 7
HW10-5f HWID Large Document Done Table 1 on Page 14
HW10-5f HWID Large Document Done Index on Page 32

Create a pdf file of the output for each of the above, place them in a folder
called HW10 HWID LastName, FirstName, zip the folder and, by the due date,
upload it to the Canvas folder HW10 Word: Styles, Cross-References, TOC,
Indexes.

Step 5 Backup Now would be a good time to backup your files.



Sample Exam Questions for Word

These sample questions will help you prepare for the Word exam. You will NOT
submit these activities for grading. The solutions start on page SG294. The output
keys are in this Study Guide, starting on page SG406.

General Word Operations

a. Open the Word document Sample-a Exam Questions Original, which is one
of the files you downloaded at the start of the term.

b. Save the file to your Word Exam folder using the name
Sample-b Exam Questions Done

c. Heading style

1. Apply the h1 style to the headings labeled Part 1, Part 2, Part 3, Part 3a,
Part 3b, Part 3c, Part 4, Part 5, and Part 6 and also, at the end of the
document, to the paragraph containing the word Index.

2. Modify the h1 style so that the font color is purple, the font size is 16, the
paragraph is center aligned and there is a 3 pt. purple border around the
paragraph. Set the layout so that the heading will always be on the same
page as the following paragraph.

d. Part 1

1. For the two paragraphs under Part 1, set the spacing before to 24 pt. and
the spacing after to 12 pt.

2. Insert the picture of Goldy (HWO07-2 Goldy Original) anywhere in the first
paragraph. Change the height to 0.5 inch and the width to 1 inch.
Position the picture as shown below:

I Part 1

This study analyzes the citation patterns in an algebra writing assignment completed by
students in two sections of college algebra, one that used iPads throughout the
semester and one that did not. = '&g':a Students in the iPad section did not
prefer to use apps as an 3 information source more than
students in the non-iPad section, ==\ even though available apps were
closely linked to course content. Open-ended assignments are a useful tool in iPad
initiatives to gauge student interest in new learning technologies.

e. Part 2

For the 3 lettered items under Part 2, use the ruler to do the following:
+ Set the left indent to 1.5 inches.

+ Set the first line indent to 1 inch.

» Set the right indent to 6 inches.

— SG285 —
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f. Part3

1. Double space the paragraph that begins with DOUBLE SPACE THIS
PARAGRAPH.

2. Set the Part 3 heading and the next (double spaced) paragraph so that
they always appear on the same page.

3. Under Part 3a, click anywhere in the phrase SIDE HEAD ONE. Create a
new paragraph style called s1 that makes the font Arial Black, 14 point,
blue, and the paragraph centered.

Apply this style to SIDE HEAD ONE.
4. Find the phrase SIDE HEAD TWO and apply the s1 paragraph style.

5. Create a new character style called el that makes font Arial, 12 pt., bold,
italic, underlined, and red.

6. Apply style el to all occurrences of the word Disk. Words like disk and
Diskette should not have the style applied.

There should be 3 replacements.

I Part 2

a. This is the first lettered item. It contains the word Diskette,
which should NOT have the style e1 applied to it.
b. This is the second lettered item. It contains the word disk,

which should NOT have the style e1 applied to it.

C. This is the third lettered item. It contains the word Disk,
which should have the style e1 applied to it.

A few universities have introduced iPads, which do not have a Disk, within a wide range
of undergraduate classes. Pepperdine University, for example, conducted a three term
experimental Disk comparison of iPad- and non-iPad-using classes use across
discipline including calculus, business, nutrition, and religion.

7. Under Part 3c, at the end of the phrase Vertex form of the quadratic
function: construct this formula f(x) = a(x — hy)? + k,

Note that the default font of the equation is Cambria Math and not Arial like
the rest of the document. To change the font, Word Help says to select the
text, right-click, choose font, and select the one you want. That does not
work! Leave the font as it is. You can change the font if you use the app
MathType. However, changing the font size and applying bold do work in
the usual ways.

g. Part4
1. Select the phrase Part 4 and insert a bookmark called Part4.

2. Break up the paragraph which begins BREAKUP THIS PARAGRAPH.
Make the breaks just before (a), just before (b), and just before (c).

3. Set the line and page breaks so that the side head Part 4 and the four lines
below it always appear on the same page.
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4. For each lettered paragraph (a), (b), and (c), set a left tab stop at 1 inch, a
center tab stop at 3 inches, and a decimal tab stop at 5 inches. Make the
decimal tab have a leader that is a dotted line.

Use the Tab key to make these paragraphs look as follows:

[Part 4
BREAK UP THIS PARAGRAPH
(a) SKINNY ..o 0.0025
(b) REALLY PORTLY ..o 82.1
(c) SOMEWHERE IN BETWEEN............. 177

5. Insert a footnote mark to the right of the word SKINNY. The text of the
footnote should be By skinny, we mean really thin.

h. Part 5
1. Convert the four paragraphs under Part 5 to a table. Format the table as follows:
e The outside border should be solid red 6 pt.
¢ The inside lines should be dotted blue 3 pt.
Make the fill color pink of the cell that contains the word Ms.
Insert a new row between the rows for Doug and Melissa.
Delete the row for Noah.
Make the height of all the rows 0.3 inch and the width of all the columns 1 inch.

Center the table on the page.

N o o A~ WD

Adjust the borders so that they look like the following:

I Part 5

Name = Title * Phone

L]
EEEEEEEE N NS R EEEEEEEEE N EEEEEEEEEER

Melissa " Ms. = 555-0000

Doug : Boss = 555-9999

i. Part6

1. Use the Multilevel List feature on the 16 lines under Part 6 to make them
look like the following. Make the Spacing Before 0 pt.
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Part 6

1) Colors
a) Black
b) Red
i) Light
ii) Dark
c) Green
d) Blue
2) Sizes
a) Six
b) Eight
c) Ten
d) Twelve
i) Medium width
i) Wide width
iii) Extra wide width
e) Fifteen

2. Insert a textbox next to the heading Part 6 and type the following in the
textbox: More colors are available on our Web site.

Make the text orange Arial Black. Remove the textbox outline.

3. Insert an arrow pointing from the textbox to the word Colors in the outline.
Make the weight of the arrow 3 pt. and the color blue. Make the arrowhead

this shape:
4. Insert an orange four-pointed star with a blue outline under the textbox.

5. Arrange the items as shown below:

Part 6

1) Colors
a) BlacN
b) Red More colors are available
i) Light on our Web site
i) Dark
c) Green
d) Blue
2) Sizes
a) Six
b) Eight
c) Ten

j. Table of Contents

At the top of the document, under the phrase Table of Contents, insert a
Table of Contents by doing the following:

1. Setto 2 the outline level of the paragraph BREAKUP THIS PARAGRAPH
so it will appear in the Table of Contents.
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2. Go to the top of the document, click in the blank line below Table of
Contents, and insert a Table of Contents. Construct the table using the
first two heading levels only in the Distinctive format, show page
numbers, right align the page numbers, and make them have a dot
leader.

3. Click to the left of the heading Part 1 and insert a next page section break
so the heading Part 1 appears on the next page and in the new section 2.

You might want to click the Status Bar (very Customize Status Bar
bottom of window) and put a check next to Section |v  rormatted Page Number
so you can easily tell which section you are in.

v Section

k. Cross Reference

Just after the second paragraph of the document, find the phrase Part 4 is on
page XX of this document. Replace the XX with the automatic page number
cross-reference to the Part4 bookmark. Make the page number red bold.

|. Headers

Set up the headers for section 2 (it starts at Part 1) as follows:

1. Set the layout for section 2 so that it has a different First Page Header,
and different Even and Odd page headers.

2. First Page Header should contain the filename on the left, the word Page,
a space, and the automatic page number in the middle, and the date the
file was last saved on the right in the format Day, Month Date, Year.

Sample-b-Exam-Questions-Done - Page-1 - Wednesday,-July-19, -2023{11

First Page Header -Section 2- |

3. Even Page Header contains the word Page, a space, and the automatic
page number on the left and the word Sec, a space, and the automatic
section number on the right.

4. Odd Page Header contains your HWID on the left and the word Page,
a space, and the automatic page number on the right.

m. Index

Set up and insert an Index by doing the following:

1. Mark the following as index entries: disk, quadratic function, and
REALLY PORTLY.

2. Move to almost the end of the document. Insert a next page section
break so the word Index is on the next page.
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3. Move to the end of the document and tap Enter. Be sure to turn off the
Show/Hide codes so the page numbers will be correct.

Insert an index. Use the Modern format, two columns, right align page
numbers, and a dot leader.

4. Change the automatic page number for the Index page to start at 101.

Sample-b Exam Questions Done Page 101 Saturday, July 15, 2023
Index

D R

disk. .1 REALLY PORTLY 2

Q

guadratic function ..... 2

5. For the page that contains the word Index and the index itself, make the
orientation Landscape. All other pages should remain in Portrait mode.

6. Place a 3 pt. red border around the page that contains the Index.
No other pages should have that border.

<€————— Page 3 is in Portrait orientation 3

€ Page 101 is in Landscape orientation >

Sample-b Exam Questions Done Page 101 Sunday, July 16, 2023

| Index I

n. Select the entire document and tap F9 to update all the fields. Then, tap Ctrl + p
and compare the preview with the key. Make needed corrections. Save Sample-b
Exam Questions Done and close it. Note that Word automatically put a blank
page right after the Table of Contents and just before the Index so while there are
5 pages with text on them there are 7 “real” pages.

Graphics and Other Stuff

a. Start Word, open a new blank document, and save the file in your Word
Exam folder as Sample-c Graphics and Other Stuff Done
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b. Type the following. Tap Enter where you see the paragraph marks 1:

Practice-Questions-for-Word-Exam.|
This-file-provides-practice-with¥

graphics-and-columns.q|

c. Change the Normal style so the font is 12 pt. Arial Bold and the paragraph
has 8 pt. spacing after.

d. Sections and Columns:

1. Move to the end of the document, tap Enter, and insert the text from the
file wO2B_Cover_Letter_Text, which is one of the files you downloaded at
the start of the term.

2. Correct the spelling and grammar.

3. Putthe text from | can be accessible... through In addition, | have... in
three column format so it looks like the following:

With a permanent position as my ultimate goal, | hope to use the Florida Port
Community College Career Center to secure a temporary job.

I can be accessible for As my resume In addition, | have part-
a flexible number of illustrates | have time work experience
days or hours and am exceptional computer as a software tester,
willing towork in a skills. | am a honor where | perform the
diversity of student at FPCC and following computer
businesses or have outstanding activities.
organizations. references.

| am available for the purpose of an interview at your convenience. You can
contact me by email at jgarcia@alcona.net or by telephone at (727) 555-0347.

1. Move to the top of the document and insert a SmartArt object Process,

Continuous Block Process.
\

Choose a SmartArt Graphic

2 A

=T
0= st
—1
oo Process Bl B EreElE
5y |
1S Cycle — s =T

SEIE ) BT
é% Hierarchy -

Continuous Block Process
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o 0 kW

Enter the following phrases, one in each textbox: Sleep, Alert, Good Grades,
Happy Student, Good Life.

Make the object 4 inches wide and 2 inches high.
Change the colors to Colorful.
Change the font to 8 pt. Arial Black and make the color black.

Move the object to the upper right corner of the page so it just touches the
top and right side.

T T T T T S T S B S S S (S R ST S S BRI S S S BTSRRI -SSR SRR SR R A T

Good Happy Good

SHCop AISRC Grades Student Life

Practice-Questions-for-Word-Exam.f|
Thisfile-provides-practice-with{

graphics-and-columns.q

With-a-permanent-position-as-my-ultimate-goal,-I-hope-to-use-the-Florida-Port-

f. Move to the end of the document, to the line just below the phone number.
Insert as a table the data in B2:F10 from the Data tab of the Excel file Sample-
d Education and Earnings Original.

g. Picture

1.

o ~ 0D

Move to the top of the document and insert the picture wO1A_ Bird, which
is one of the files you downloaded at the start of the term.

Change both the height AND width to 2 inches so the picture is square.

Apply the Soft Edge Oval style. S— | -

Rotate the picture 45 degrees clockwise.

Soft Edge Ova

Move the picture to the lower right corner of =
the document.

h. Screenshot

4.
5.

Do a Word Count of the document.

Take a screenshot of the Word Count window and paste the screenshot
under the table.

Make both the height and width 1.5 inches.
Place a 3 pt red border around it
Move the screenshot to the bottom left of the document.

i. Tap Ctrl + p and compare the preview with the key. Make needed corrections.
Save Sample-c Graphics and Other Stuff Done and close it.
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Sorting

a.

o o

. AutoFit the columns.

Open the file Sample-e Table Sort DATA Original, which is one of the files
you downloaded at the start of the term. You will use this file in this section on
sorting and on the next two sections on Mail Merge and Mailing Labels
(hence the word DATA in the file name).

. Save the document to your Word Exam folder using the name

Sample-f Table Sort DATA Done

Convert the text into a table.

. Make the table style Grid Table 5 Dark — Accent 6. =

Sort the data in the table by State in Descending —1) Grid Table 5 Dark - Accent 6

order (Z to A) and, within State, by LastName in
Ascending order (A to Z).

. Center the table horizontally on the page.

. Tap Ctrl + p and compare the preview with the key. Make needed corrections.

Save Sample-f Table Sort DATA Done and close it.

Mail Merge

a.

b.

Create a Mail Merge MAIN document by doing the following:

1. Open the file Sample-g Merge MAIN Original, which is one of the files you
downloaded at the start of the term. Save the file in your Word Exam folder
as Sample-h Merge MAIN Done

Convert the document to a mail merge letters document.

Select Sample-f Table Sort DATA Done as the data source.

Set the mail merge to skip data if the Height field is empty.

In place of the word LastName insert the merge field code LastName.
In place of the word HEIGHT insert the merge field code Height.

In place of the word WEIGHT insert the merge field code Weight.

© N o 0o bk w0 D

In place of the word IF insert fields so that if Weight is over 200 Word will
display You need to LOSE a few pounds. If the Weight is 110 or less,
Word should display You need to GAIN a few pounds.

Tap Ctrl + p and compare the preview with the key. Make needed corrections.
Save Sample-h Merge MAIN Done and close it.
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Mailing Labels

a. Create a set of mailing labels by doing the following:

1. Start Word, open a new blank document, and save the file in your Word
Exam folder as Sample-i Merge Labels MAIN Done

2. Create mailing labels using the Avery US Letter 5160 Address Labels
product number.

3. Use the file Sample-f Table Sort DATA Done as the data source.

4. Include on each label on separate lines the fields for FirstName,
LastName, and BirthDate of each person.

5. Insert the picture HWO07-2 Goldy Original, which is one of the files you
downloaded at the start of the term.

6. Make the picture height and width 0.5 inch and move it to the lower right
corner of each label.

7. Update all the labels. The document should look like the following:

wFirstName» «MNext Record»«FirstName» «Mext Record»«FirstName»

«LastName» «LastName» «LastName»

«BirthDate» «BirthDate» «BirthDate»

«Next Record»«FirstName» «MNext Record»«FirstName» «Mext Record»«FirstName»

«LastName» «LastName» «LastName»

«BirthDate» «BirthDate» «BirthDatex»

b. Save Sample-i Merge Labels MAIN Done. Tap Ctrl + p and compare the
preview with the key. Make needed corrections. Save the document and close it.

How to Solve the Sample Exam Questions for Word

General Word Operations - Solutions

c. Heading Style Solution

cl. Click in the heading Part 1. On the Home tab, in the Styles group, click the
launch dialog button (lower right corner of the group).

Mac: Click Styles. A

Styles

Click the style labeled h1. Repeat for Part 2 through Part 6 headings and
the Index.
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c2. Onthe Home tab, in the Styles group, click the launch dialog button.
Right-click the style labeled h1 and select Modify.

Mac: Click Styles, point to the h1 style, right-click, and select Modify Style.

Change the font color to purple, the font size to 16, and click the Align
Center icon. Click Format arrow, select Border, and make the border 3 pt
purple. Click Box. Click OK.

Formatting

Arial Black v 16 ~[ B I U | IINIING -

I
Il
il
ll
[1l
]
=
It

Part 1

Click the Format arrow, select Paragraph, select Line and Page Breaks,
and put a check next to Keep with next.

Paragraph

Indents and Spacing Line and Page Breaks

Pagination

D Widow/Orphan control

Click OK twice.

d. Part 1 Solution

d1l. Selectthe two paragraphs, right-click, and select Paragraph. Under
Spacing Before (above), set the size to 24 pt. Under Spacing After
(below), set the size to 12 pt. Click OK.

d2. Onthe Insert tab, in the lllustrations group, click Pictures. Navigate to
HWO07-2 Goldy Original and click Insert.

Click the picture to select it. On the Picture Format tab, in the Size group,
click the launch dialog button.

In the Scale group uncheck Lock aspect ratio. In the Height group enter
0.5”. In the Width group enter 1”. Click OK.

Mac: Remove the check to the right of the height and width values.
I o5 -
de w

=1 =
- -~

]

q




SG296 SAMPLE EXAM QUESTIONS FOR WORD

On the Picture Format tab, in the Arrange group, click With Text Wrapping

Wrap Text and select Tight. B

Mac: Right-click the picture, point to Wrap Text, select Tight. _—
~ =lohtE

Use your mouse to position the picture as shown.

e. Part 2 Solution
Select the three paragraphs.
On the ruler, drag the left indent marker ™ to 1.5 inches.

On the ruler, drag the first line indent marker - to 1 inch.

On the ruler, drag the right paragraph indent marker ™y to 6 inches.

T A L - T R IR SR BRI BTSN

which should NOT have the style e1 applied to it.

which should NOT have the style e1 applied to it.

a. This is the first lettered item. It contains the word Diskette,

b. This is the second lettered item. It contains the word disk,

e B

f. Part 3 Solution

f1. Select the paragraph, right-click, and select Paragraph. In the Line

spacing area, click the arrow and select Double.

f2. Select the double spaced paragraph, right-click, select Paragraph, click
the Line and Page Breaks tab, and check Keep lines together. Tap OK.
The Part 3 heading is already set to Keep with next so it will be on the

same page as the double spaced paragraph.

f3. On the Home tab, in the Styles group, click the launch dialog button.

Mac: Click Styles Pane. Q

Styles
Pane

Ay
New Style

At the bottom, click the New Style button.

Set the parameters as shown below:
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Create New Style from Formatting ? *
Properties
Mame: s1
Style type: Paragraph &= Affects entire paragraph -
Style based on: T Normal ~

f4.
f5.

Style for following paragraph: T s1

Formatting

Arial Black v 14 ~| B 1 U | I

R

SIDE HEAD ONE

Notice how this Paragraph style affects the entire paragraph and not just some
of the characters. To change only selected characters, use a Character style.

Click anywhere in the phrase SIDE HEAD TWO and then click the s1 style.

On the Home tab, in the Styles group, click the launch dialog button if
necessary. At the bottom, click the New Style button.

Set the parameters as shown below:

Create New Style from Formatting

Properties
Mame: el
Style type: Character
Style based on: 4 Default Paragraph Font

Style for following paragraph:

Formatting

pria Sz M| (8] 7|[u] | E——

Click OK.
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SAMPLE EXAM QUESTIONS FOR WORD

f6. Click at the top of the document. Tap Ctrl + h to open Find/Replace.

Mac: In top menu, click Edit, point to Find, click Advanced Find and Replace,

Replace. In lower left, click the arrow to show more options.

In the Find what box type Disk.

If the More > > button is showing, click it to

show more options

Mac: The More button is an arrowhead: [ w ]

f7.

Check the Match case and Find whole

words only boxes.

Click inside the Replace with box, delete
any text, click the Format arrow, and
select Style. Scroll down to el, select i,

and tap OK.

Click Replace All. There should be 3
replacements. Click OK and close the
Find and Replace dialog box.

Find and Replace

Find Replace Go To
Find what: Disk
Options: Match Case, Whole Words
Format:
Replace with:

Format: Style: e1
<< Liess

Search Options

Search: | all b

Match case
Find whole words only

Click at the end of the phrase and, on the Insert tab, in the Symbols
group, click Equation. This opens the Equation tab and inserts a box
where you can type the equation.

Vertex form of the quadratic functior:: Type equation here. |~

Type f(x) =a

On the Equation tab, in the Structures group, click the Script arrow and

select superscript to show

fG) = abi

Click inside the large box. On the Equation Tools tab, in the Structures

group, click the Bracket arrow and select parentheses to show

Click inside the large box and type x - to show

£G) = aGEE

f(x)=alx-)"

On the Equation tab, in the Structures group, click the Script arrow and

select subscript to show

f&) = alx = £5)°

Click inside the large box and type h.

Click inside the small box and type 1 to show

Click inside the exponent box and type 2 to show

f(x) =alx — hy)~

f(x) = alx — hy)?

Tap the Right Arrow key to move out of the exponent box and type + to

show

flx) = alx — hy)?

_l_
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On the Equation tab, in the Structures group, click the Script

arrow and select subscript to show |[f(x) = a(x — hy)? + i

In the large box type k; in the small box type 1 to show |f(x) = a(x — hy)? + k&

g. Part 4 Solution

gl. Selectthe phrase Part 4 and, on the Insert tab, in the Links group, click
Bookmark.

In the Bookmark name box type Part4.

Bookmark

Bookmark name:

Part4 Add

Click Add.

You cannot see the bookmark code unless you click the File tab, click
Options, click Advanced, scroll down to Show Document Content, and
check Show bookmarks. The brackets indicate the bookmark.

art

Mac: In top menu, click Word, select Preferences, click View, check Bookmarks.

g2. Click to the left of the parenthesis in (a) and tap Enter. Do the same for (b),
and (c).

g3. Select the lines from BREAK UP THIS PARAGRAPH through (b), right-
click, select Paragraph, click the Line and Page Breaks tab, and check
Keep with next. You do not need to click the line with (c) because that
does not have to be on the same page at the line with Part 5. You do not
have to do this to Part 4 because the h1l style already has that.

g4. Select the three paragraphs. / -

On the left side of the ruler, point to the Tab Type box. Toft Tab
A screen tip will tell you what kind of tab stop is active. =2 =" 2

Mac: Tab stops look a bit different on a Mac.

r il | ' t
Left Tab Center Tab Right Tab Decimal Tab
Left Tab Cer\ier Tab Right Tab Decimal Tab
Left Tab Center Tab Right Tab Decimal Tab

Be sure the tab type is Left | L [and click the ruler at the 1-inch mark.

Click the Tab Type box once to make the type a center tab stop | L
and then click the ruler at the 3-inch mark.
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Click the Tab Type box twice to make the type a decimal tab stop | ;.
and then click the ruler at the 5-inch mark.

Double-click the decimal tab stop to open the Tab dialog box.

Click the 5” stop. Under Leader, click the bullet to the left of 2...

Tabs

=

ab stop position:

-
-
3
Alignment
O Left O Center

@ Decimal O Bar
Leader

O 1 None e
Click Set and then OK.

Now, set the tab stops by doing the following:

e Click to the left of (a) and tap the Tab key.

e Click to the left of SKINNY and tap the Tab key.
e Click to the left of 0.0025 and tap the Tab key.

Repeat this for (b) and (c).

To see where the Tab key was tapped, click the Show/Hide button | [

21._2145_5)\
" BREAK-UP-THIS-PARAGRAPH|
- > (@) > SKINNY ..o S 0.0025
- > (b) > REALLY-PORTLY ........... B 82.19
> (c) - SOMEWHERE-IN-BETWEEN....>.... 177

g5. Click to the right of the Y in SKINNY and, on the References tab, in the
Footnotes group, click Insert Footnote. Then, type the text.

h. Part 5 Solution

hl. Select the four paragraphs. On the Insert tab, in the Tables group, click
the Table arrow, and select Convert Text to Table. Click OK.

Select the table and, on the Home tab, in the Paragraph group, click the
Borders arrow and select Borders and Shading.

Select red for the color.
Select 6 pt. for the Width.
Click Box. That will apply the border to the outside of the table.
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Click Custom so you can change each border individually.
Select dotted for the Style, blue for the Color, and 3 for the Weight.

Click the inside borders to make them blue and dotted.

Borders and Shading ? x

Borders Page Border Shading

Setting: Style: Preview

~ Click on diagram below or use buttons
None to apply borders

Grid
N I

% Custom 3pt EEEEEEEEEN| | W |
llll| Appyto:

Table bhed

Click OK.
h2. Select the cell that contains the word Ms.

On the Home tab, in the Paragraph group, click the Borders arrow and
select Borders and Shading.

Click the Shading tab. Be sure the Apply to box shows Cell so only the
selected cell will be changed.

From the Fill menu, select pink and then click OK.
Or, you could select the cell, click the paint bucket, and select the color.
h3. Select the bottom row, right-click, click Insert, and select Insert Rows Above.

h4. Select the row that contains Noah, right-click, and click Delete Rows.
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h5. Select the table, right-click, and select Table Properties.

Click the Row tab, click the check box next to Specify height, type 0.3” in
the box, and select Exactly from the Row height is drop-down menu.

Table Properties ? x
Table Row Column Cell Alt Text
Rows 1-4:
Size
Specify height: 03" = Row height js: | Exactly b

Follow a similar procedure to set the width of all the columns to 1 inch.

h6. Select the table and, on the Home tab, in the Paragraph group, click the
Center Align button.

h7. Adjusting the borders will take several steps.

Select the blank cell under Melissa and, on the Home tab, in the Paragraph
group, click the Borders arrow, and select Borders and Shading.

Be sure the Apply to box says Cell.
Make the Style a solid line, the color red, and the width 6 pt.

Click the Custom box so you can independently change each border and
click the edge of the box, so it looks as indicated.

Borders and Shading ? X

Borders Page Border Shading

Setting: Style: Preview
~ Click on diagram below or use buttons
Nane to apply borders
Box U ——
Shadow L
oo —
[
Width: -
% Custom 6Pt I
Emmm Apply to:

Cell w

Repeat the procedure for the blank box under 555-0000.
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i. Part 6 Solution

i1. Select the 16 lines (Colors through Fifteen) and, on the Home
tab, in the Paragraph group, click the Multilevel List arrow,
and select the list with Arabic numerals, letters Roman R
numerals, and parentheses. a)

This puts all the lines at the same level.

Select the lines Black through Blue and, on the Home tab,
in the Paragraph group, click the Increase Indent button.

i

This will make those lines subordinate to the word Colors.

Select the lines that contain Light and Dark and click the Increase Indent
button again. This will make those lines subordinate to the word Red.

Repeat the process for the Sizes.

i2. Onthe Insert tab, in the Text group, click the Text Box arrow and select
Draw Text box. Drag the cross to form the box. Inside the box, type More
colors are available on our Web site. Select the text and change the
color and font type.

Click the edge of the textbox and on the Shape Format tab, in the Shape
Styles group, select Shape Outline and click No Outline.

i3. Onthe Insert tab, in the lllustrations group, click the Shapes arrow and
select Arrow. Drag from the textbox to the word Colors.

With the arrow still selected, on the Design Format tab, in the Shape
Styles group, select Shape Outline and click the blue color box and
make the Weight 3 pt. Click Arrows and select the shape: ==

i4. Onthe Insert tab, in the Illustrations group, click the Shapes arrow and,
under Stars and Banners, click the four-pointed star. Drag to form the
star. With the star still selected, on the Shape Format tab, in the Shape
Styles group, select Shape Fill and click orange.

i5. Use your mouse to position the textbox and star.

j- Table of Contents Solution

j1. Click anywhere in the phrase BREAKUP THIS PARAGRAPH, right-click,
select Paragraph and, on the Indents and Spacing tab under General,
select Level 2 from the Outline level drop-down menu.
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j2. Onthe References tab, in the Table of Contents group, click the Table of
Contents arrow, and select Custom Table of Contents. Set the

j3.

parameters as follows:

Table of Contents

Index Table of Contents  Table of Figures

Print Preview

Heading 1...........ccvvveeuen.... 1
Heading 2.......ccececeevrrenennnnnnee 3

Show page numbers
Right align page numbers

Tabl

Tab leader: | ... A
General
Formats: Distinctive Lo
Show levels: 2 =
Click OK.

Click just to the left of the heading Part 1 and, on the Layout tab, in the
Page Setup group, click the Breaks arrow and, under Section Breaks,

click Next Page.

k. Cross Reference Solution

Select XX and, on the Insert tab, in the Links group, click Cross-reference.

Set the parameters as follows.

Reference type:
Bookmark
Insert as hyperlink
Separate numbers with

For which bookmark:

Click Insert and then Close.

l. Headers Solution

b

Insert reference to:

Page number

|:| Include above/below

1. Be sure the insertion point is in section 2. Double-click in the Header area
(top of the page). This opens the Header & Footer tab.

In the Navigation group, if necessary click Link to Previous to deselect it.
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In the Options group, put a check next to Different First Page and
Different Odd & Even Pages.

yout References Mailings Review View Developer Help Acrobat Header & Footer

|E|:.| E@| E |_E|(_ Previous | Different First Page g Header from Top:

) - ) E)NEXT Different Odd & Even Pages EFooter from Botto
Quick Pictures Online Go t
barts v Pictures Foote {5 Link to Previous I Show Document Text 2] Insert Alignment T
hsert Navigation Options Positio
L7
-9----‘-1---|---2------3‘J-_-|---4-‘----5------6---&5‘
1

| First Page Header -Section 2- |

2. On the Insert tab, in the Text group, click the Quick Parts arrow and
select Field.

Mac: From the menu, click Insert and then select Field.

Under Field names, select FileName, and click OK.

Tap the Tab key to move to the center tab stop and type Page and a space.
Click the Quick Parts arrow and select Field.

Under Field names, select Page, and click OK.

Tap the Tab key to move to the right tab stop.

Click the Quick Parts arrow and select Field.

Under Field names, select SaveDate and, under Field properties, select
the format dddd, MMMM d, yyyy.

Please choose a field Field properties
Categories: Date formats:
(Al v dddd, MMMM d, yyyy
Field names: §/2/2020
Py e
e— 9 August 2, 2020

Mac: Click Options, select the format, and click Add to Field.

Click OK.

Sample-b-Exam-Questions-Done - Page-1 - Wednesday,-July-19, -2023i1T

First Page Header -Section 2- |
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Follow a similar procedure for the Even Page Header. Be sure Link to
Previous is turned off.

Follow a similar procedure for the Odd Page Header. Be sure Link to
Previous is turned off.

m. Index Solution

ml.

m2.

m3.

m4.

m>5.

Find and select the word disk. It is under Part 2, subpart b.
On the References tab, in the Index group, click Mark entry.

At the bottom of the Mark Index Entry dialog box, click Mark. This will
insert an index entry.

b. - This-is-the-second-lettered-item.-It-contains-the-word-disk{-
XE-"disk"-},-which-should-NOT -have-the-style-e1-applied-to-

Repeat the procedure for quadratic function, and REALLY PORTLY.

Move to the end of the document and click to the left of the word Index.
On the Layout tab, in the Page Setup group, click the Breaks arrow and
select Section Breaks, Next Page.

Move to the end of the document. On the References tab, in the Index
group, click Insert index. Make the dialog box look like the following:

Index Table of Contents Table of Figures Table of Authorities

Print Preview

~ Type:

-

Columns: 2

-

A Language: | English (United S
Aristotle ool 2
Asteroid belt......ccceereenriens See Jupiter

S L

Right align page numbers

Tab leader: | ... b
Formats: Modern e
Click OK.

While still at the end of the document, on the Insert tab, in the
Header & Footer group, click the Page Number arrow and select
Format Page Numbers.

At the bottom of the dialog box, click Start at and type 101. Click OK.

Select the line with the word Index and the Index. On the Layout tab, in
the Page Setup group, click Orientation arrow and select Landscape.
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m6. With the word Index and the Index still selected, on the Design tab, in the
Page Background group, click Page Borders, and click Page Border. Set
it up to look like the following (be sure Apply to shows This section).

Borders and Shading

Borders Page Border Shading

Setting: Style: Preview

~ Click on diagram below or gEe buttons
None

Shadow JE

QDDD
B

Custom 3 pt

Apply to:
Art: This section ™

(none)

Options...

Click OK.
Graphics and Other Stuff - Solutions
c. Change Style Solution

On the Home tab, in the Styles group, click the launch dialog button. Right-
click Normal in the list and click Modify. Change the font to 12 pt. Arial Bold.

Mac: Select the paragraphs and change the font. Then, choose Format Paragraph
and set the Spacing After to 8 pt. Finally, click Styles, right-click on Normal,
and click Update Normal to Match Selection.

d. Sections and Columns Solution

d1l. Onthe Insert tab, in the Text group, click the Object arrow and select
Text from File. Navigate to your Word Exam folder and double-click
w02B_Cover_Letter_Text.

d2. Right-click those words that are underlined in red and select the correct
spelling. Ignore FPCC. Fix the grammar of phrases underlined in blue.

d3. Select the text. On the Layout tab, in the Page Setup group, click the
Columns arrow and select Three. This will put a continuous section break
before and after the selected text and display the text in three columns. If
the columns do not break as shown, place the insertion point where you
want a new column to start and, on the Layout tab, in the Page Setup
group, click the Breaks arrow, and choose Column.
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I-can-be-accessible-for- As-my-resume- In-addition,-I-have-part-
a-flexible-number-of- illustrates,-lI-have- time-work-experience-
days-or-hours-and-am- exceptional-computer- as-a-software-tester,-
willing-to-work-in-a- skills.-I-am-a-honor- where-l-perform-the-
diversity-of- student-at-FPCC-and- following-computer-
businesses-or- have-outstanding- activities:
organizations.q references.-.. Column Break. -

veeveeee. Column Break.......oooooooel

e. SmartArt Solution # Process
i Cyde
el. Onthe Insert tab, in the Illustrations group, click & Hierarchy
SmartArt. Click Process and then Continuous B Relation..
Block Process. Click OK. .
&  Matrix
e2. Click the left-pointing arrow. A Pyramid

Type the phrase in each box.
To add a box, tap Enter.

e3. Click an edge of the object. In the SmartArt Format tab, in the Size group,
enter 4 inches and 2 inches.

e4. Onthe SmartArt Design tab, click the Change Colors arrow and select a
colorful icon.

e5. Click an edge of the object and, on the Home tab, change the font, color,
and size.

e6. Click the edge of the object, right-click, click Warp Text, and then click
In front of Text. Then, drag the object into position.

f. Open the Excel file, select B2:F10 on the Data tab, and copy.

Switch back to your Word document, move to the line just after the phone
number, and paste.

g. Picture Solution

gl. Move to the top and, on the Insert tab, in the Illlustrations group, click
Pictures. Navigate to your Word Exam folder and double-click the picture
of the bird.

g2. With the picture selected, on the Picture Format tab, in the Size group,
click the launch dialog button. Remove the check next to Lock Aspect
Ratio.

Mac: Remove the check in the box to the right of the height and width values.

Then, enter 2 in the Height box and 2 in the Width box. Click OK
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g3. With the picture selected, on the Picture Format tab, in the Picture Styles
group, click the More arrow and select Soft Edge Oval.

g4. With the picture selected, on the Picture Format tab, in the Arrange
group, click the Rotate arrow and select More Rotation Options. In the
Rotate group, enter 45.

g5. With the picture selected, click the Layout Options button and select In
Front of Text. Then, drag the object into position.

h. Screenshot Solution
h1l. On the Review tab, in the Proofing group, click Word Count.

h2. Tap the Windows key and type Snip. Click New. Drag the cross across the
Word Count window. Close the Snipping tool and Word Count windows.

Mac: Tap Shift + Ctrl + Command + 4, drag across the Word Count window, and
then close the window.

Paste the screenshot.

h3. With the screenshot selected, on the Picture Format tab, in the Size
group, in the lower right corner, click the dialog box launcher [ ]

Uncheck Lock aspect ratio and type 1.5 in the Height and Width boxes.
Click OK.

h4. With the screenshot selected, on the Picture Format tab, in the Picture
Styles group, click the Picture Border arrow and select red. Click Picture
Border arrow again and select Weight and then 3 pt.

h5. With the screenshot selected, click the Layout Options button and select
In Front of Text.

Mac: Right-click, select Wrap Text, and select In Front of Text.

Then, drag the object into position.

Sorting - Solutions

c. Select the paragraphs and, on the Insert tab, in the Tables group, click the
Table arrow and select Convert Text to Table. Click OK.

d. Select the table and, on the Table Layout tab, in the Cell Size group, click the
AutoFit arrow and select AutoFit Contents.

e. On the Table Design tab, in the Table Styles group, click the More arrow and
select Grid Table 5 Dark — Accent 6.
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f. Select the table. On the Home tab, in the Paragraph group, click sort %l

Be sure My list has Header row is checked and then set the
parameters as follows:

Sort by
tate > Tpe: | Text | (O Ascending
Using: | Paragraphs - ® Descending
Then by
LastName ~ | Type: | Text | (@ Ascending
Using: |Paragraphs > (O Descending
Click OK.

g. Select the table. On the Home tab, in the Paragraph group, click the Center
Align button. Since the entire table is selected, Center Align centers the table
rather than the text in the individual cells.

Mail Merge - Solutions

a2. On the Mailings tab, in the Start Mail Merge group, click the Start Mail
Merge arrow and select Letters.

a3. On the Mailings tab, in the Start Mail Merge group, click the Select
Recipients arrow and select Use an Existing List. Navigate to your Word
Exam folder and double-click Sample-f Table Sort DATA Done.

a4. Go to the top of the document. On the Mailings tab, in the Write & Insert
Fields group, click the Rules arrow and select Skip Record If. In the Field
name box, select Height. In the Comparison box, select Equal to. Leave
the Compare to box empty.

Insert Word Field: Skip Record If ? X
Field name:

Height b
Comparison:

Equal to W
Compare to:

Click OK.

ab. Select the word LastName. On the Mailings tab, in the Write & Insert Fields
group, click the Insert Merge Field arrow and select LastName.

a6. Repeat the process for HEIGHT.
a7. Repeat the process for WEIGHT.
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a8. Select the word IF. On the Mailings tab, in the Write & Insert Fields group,
click the Rules arrow and select If...Then...Else, and fill in the boxes:

Insert Word Field: IF

IF
Eield name: Comparison: Compare to:

Weight ~ || Greater than ~ | 200

Insert this text:
You need to LOSE a few pounds.

Otherwise insert this text:

Click OK.

Because you have two choices, you need to have two IF fields. So, repeat
the process again with Less than or equal to in the Comparison box, 110
in the Compare to box, and You need to GAIN a few pounds. in the
Insert this text box. Click OK.

Tap Alt + F9 to see the field codes. If that does not work, point to a field,
right-click, and select Toggle Field Codes.

{ SKIPIF { MERGEFIELD Height} ="" }Dear President {
MERGEFIELD LastName }:

We have analyzed your height ({ MERGEFIELD Height })
and weight ({ MERGEFIELD Weight }) data. { IF {
MERGEFIELD Weight } > 200 "You need to LOSE a fiew
pounds.” " }{ IF { MERGEFIELD Weight } <= 110 "You
need to GAIN a few pounds.” " }

Sincerely,

Mailing Labels - Solutions

Label information

a2. On the Mailings tab, in the Start Mail Merge Label vendors: | Avery US Letter
group, click the Start Mail Merge arrow and
select Labels. In the Label vendors box,
select Avery US Letter. In the Product

Find updates on Office.com
Product number:

5152 Flexible Name Badge Labels

number box, select 5160 Address Labels. 5153 Flexible Mini Name Badge Labels
5154 Flexible Mini Name Badge Labels
Tap OK. 5155 Easy Peel Return Address Labels

5159 Address Labels

a3. On the Mailings tab, in the Start Mail Merge [ =MEEEEhEE
group, click the Select Recipients arrow, click Use an Existing List, and
select Sample-f Table Sort DATA Done
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a4. On the Mailings tab, in the Write & Insert Fields group, click the Insert
Merge Field arrow, select FirstName, and tap Enter. Do the same for
LastName, and BirthDate.

a5. Onthe Insert tab, in the Illustrations group, click Pictures. Navigate to
your Word Files folder and double-click the picture of Goldy.

a6. With Goldy selected, on the Picture Format tab, in the Size group, click
the launch dialog button. Uncheck the box to the left of Lock aspect ratio.

Mac: Remove the check to the right of the height and width values.

Mos 07—

1w
¥ -

3

q

In the Height group enter 0.5”. In the Width group enter 0.5”.

On the Picture Format tab, in the Arrange group, click Wrap Text and
select In Front of Text and drag into position.

Mac: Right-click the picture, point to Wrap Text, select In Front of Text.

a7. Onthe Mailings tab, in the Write & Insert Fields group, click Update Labels.

Do NOT submit for grading the Sample Exam Questions for Word




Information on the Word Exam

The second exam will cover only Word. You may not submit any Word homework
on or after the day the exam is sent to you.

Date and Time: Check your syllabus for the date and time.
Location: On your own Windows or Macintosh computer.

Time Allowed: | will email the exam to you in the morning, and you will have to
upload your zipped solution folder to Canvas by the afternoon of the next day.

Materials: | will email you a pdf copy of the exam questions and the original files you
are to modify.

Submission: You will submit your exam in the same way as you did for the
homework except you will NOT send in pdf files. Instead, you will submit your
modified Word files so that | can see your field codes as well as the regular text.
Do the exam as soon as you get it. Do not wait until the last minute. If you
miss the submission deadline you will receive a score of 0.

Preparation: Be sure you have gone over the Sample Exam Questions for Word
a few times before exam day. Be sure you have a reliable internet connection
and computer. You may use either a Windows computer or a Mac. The exam
will work on both platforms.

Questions: If you have questions during the exam, email me. Of course, | will not
give you any help or hints, but if you think something is wrong with your copy of
the exam let me know immediately.

Honesty: The exam is open book and notes, but you may NOT discuss the exam or

get any help from anyone else or do the exam with anyone else. Doing so will
result in your receiving a 0 for the exam and an F for the course.

— SG313 —






Project 11
PowerPoint Chapter 1: Getting Started

Step 1 Read Read the introductory material on pages 743-745 of the textbook.

Step 2 Activities Turn on the computer and do the following:
Project 1A: Start at the top of page 747.

Instead of Activity 1.01 step 5 (page 749) do the following:

1. In the upper right corner of your screen, click the X to close PowerPoint.
Do NOT save your file.

You are not going to use sub folders (e.g., PowerPoint Chapter 1). Instead, so
you can see them all at once, save all your PowerPoint files in the PowerPoint
Files folder you downloaded on page SG11.

2. Navigate to your PowerPoint Files folder and open 01A_KWT_Overview,
which is one of the files you downloaded at the start of the term.

3. Save the file in your PowerPoint Files folder using the name
LastName_FirstName_1A_ KWT_Overview

4. Starting with Activity 1.02 (page 747), complete the Activities through step
7 of Activity 1.14 on page 766. Do NOT do steps 8 and 9 in Activity 1.14
on page 766. Do NOT do Activities 1.15 through 1.16 on pages 767-769.

5. Return here when you have completed Project 1A on page 766.

Do NOT do GO! With Google Slides

Project 1B: When you have completed Project 1A, start at the top of page 773.

Instead of Activity 1.17 step 1 do the following:

1. Navigate to your PowerPoint Files folder and open p01B_Seattle, which
is one of the files you downloaded at the start of the term.

2. Save the file in your PowerPoint Files folder using the name
Lastname_Firstname_1B_Seattle

3. Complete the rest of the Activities through step 7 on page 790. Do NOT do
steps 8 and 9 in Activity 1.33 on page 790.

4. Return here when you have completed Project 1B on page 790.

Do NOT do GO! With Google Slides or GO! To Work

— SG315 —
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HW11-1 Overview (Based on Project 1A)

Problem: How can you create an electronic presentation suitable for large
audiences?

a. Open the presentation Lastname_Firstname_ 1A KWT_Overview, which you
created while following the directions in the textbook and saved on page 766.

b. Save the document to your PowerPoint Files folder using the name
HW11-1 HWID 1A KWT Overview Done

c. On the Design tab, in the Customize group, click Slide Size.

0 &

Slide Format
Size - Background

||-_||I

-
o
]

[ ] standard (4:3)

|:| Widescreen (16:9)

Notice that this slide is set to Widescreen format, that is, a 16 to 9 ratio of
width to height. Standard dimensions have a 4 to 3 ratio of width to height.
Most of the presentations are in Widescreen but feel free to change the ratio to
Standard if you wish.

d. To make the text easier to read, in Slide 5 change the paragraph to three
columns by doing the following:

1. On Slide 5, About Our Company, click anywhere in the bottom textbox.

2. Onthe Home tab, in the Paragraph group, click the Align Text [%]-
arrow and select More Options.

3. Inthe Format Shape pane, click ) .
Text Options and then click Do Format Shape
not AutoFit. This will a_lllow the PR AETTEE e T T
text to stay the same size when
you insert the columns. A A A
— A —
4. Click Columns and set the Number
to 3 and the Spacing to 0.5. 4 TEXT BOX
Columns 2 ¢ Vertical alignment Top v
Text direction Harizontal -
Number: |3 =
Spacing: |0.5" = * Do not Autofit
5. Click OK.

6. Onthe Home tab, in the Paragraph group, click the left align button.
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e. Set up a HANDOUT for printing by doing the following:
1. Tap Ctrl +p. Printer

Under Printer, click the arrow and select Adobe PDF. [ Rt

Ready

Mac: Don'’t try to make the PDF until you are ready to submit the file. See page
SG322.

In the box next to Slides, type 1,3,4,5 (you do not want slide 2 printed).

Click the Full Page Slides arrow and, under Handouts, select 4 Slides
Horizontal. This will print a handout rather than slides.

From the Orientation drop-down menu, select Landscape Orientation.

From the Grayscale drop-down menu, select Color.

Sett| N gs PC —Mac—[ PowerPoint j—
Slides: O All (5 slides)
== Custom Range - OFrom: 1 Jte: [
Enter specific slides to print O Selected slides
Slides: | 1,3,4,5 i © custom Range: E
Custom Shows £
SS 4 Slides Horizontal - Layout: [ Handouts (4 slides per page)
Handouts (4 slides per page)
Collated Qrientation: T - TFI
- 123 123 123 i Output:  Color
Scale: {100 %
G Landscape Orientation - .
Scale to fit paper
Print hidden slides
. Color - Frame slides
Print slide numbers on handouts
Edit Header & Footer

2. At the bottom of the Settings screen, click Edit Header & Footer and then
click the Notes and Handouts tab. Set up the handout as follows:

* Include the Date and time, updated automatically. From the drop-down
menu, choose the format that shows Day, Month Date, Year.

* Include the Page number.
¢ Do not include a Header.

* Check the Footer box and type the name of the file in the footer.
HW11-1 HWID 1A KWT Overview Done Unlike Excel and Word,
PowerPoint does not have an automatic way of inserting the file name
SO you must insert it manually.
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Include on page

Date and time

=

(@ Update automatically

Sunday, July 24, 2022 v

Language:

English (United States) b
'C:l Fixed

sunday, July 24, 2022
Page number
|:| Header

Footer

HW11-1 HWID 1A KWT Overview Done

Calendar type:

Gregorian

Preview

——————

Apply to All Cancel

HAAM A1 AN 1A KFWAIT Murannase MNoana

If that happens, you can do the following to fix it:

* Tap the Esc key to cancel printing.

number. This selects them both.

* Drag up a bit.

Click Apply to All and compare the preview with the key. Depending on
your printer, the bottom edge of the footer may be partially cut off, like this:

* On the View tab, in the Master Views group, click Handout Master.

* Click an edge of the textbox that contains the file name, hold down the
Shift key, and click on an edge of the textbox that contains the page

HW11-1 HWID 1A_KWT_Overview_Done

[§:5

4. Tap Ctrl + p and compare the preview with the key. Make needed
corrections, save the presentation, and close it.

* On the Handout Master tab, in the Close group, click Close Master View.

HW11-2 Seattle Itinerary (Based on Project 1B)

Problem: How can you edit and format a presentation and include custom

a. Open the presentation Lastname_Firstname_1B_Seattle, which you created
while following the directions in the textbook and saved on page 790.

transitions between slides?

b. Save the document to your PowerPoint Files folder using the name
HW11-2 HWID 1B Seattle Done
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c. Tap Ctrl + p and set up to print a handout as follows:

e Has slides 1, 3, 4, 5, 6, and 7 (do not print slide 2).

e Six slides horizontal per page.

e Portrait orientation.

e Color.

e Date, updated automatically, in the format Day, Month Date, Year.
e Page number but no header.

e Name of the file in the footer.

Compare the preview with the key. Make needed corrections, save the
presentation, and close it.

HW11-3 Bird

Problem: How can you add graphics to a PowerPoint presentation and then edit
the images?

a. Open the presentation HW11-3 Bird Original, which is one of the files you
downloaded at the start of the term.

b. Save the presentation in the PowerPoint Files folder using the name
HW11-3 HWID Bird Done

c. Paste a picture of a bird into the slide by doing the following:

1. Look in the PowerPoint Files folder and double-click on the Word file
HW11-3 Bird Graphic WORD Original, which is one of the files you
downloaded at the start of the term. This is a Word file so you cannot
open it from within PowerPoint.

2. Select the picture of the bird, copy it, and then close Word.

3. Switch to PowerPoint and paste the picture. If the Design Ideas pane
opens, close it.

If your slide shows gridlines and you want to get rid of them, on the View
tab, in the Show group, click the box to the left of Gridlines to remove the
check. I left mine in.

d. Adjust the image so that it is a "washout" (a grayscale picture, sometimes called
a "watermark"). Place it behind the text on the slide by doing the following:

1. Right-click the bird and select Format Picture to open its pane.
2. Click the Picture icon ‘{; and then click the arrow next to Picture Color.

3. To the right of Recolor, click the arrow and select Washout.

.
&84

Washoutl

Recolor

TN T

The picture now is much lighter, washed out like faded jeans.
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—
4. Click the Size and Properties button [EJ If necessary, click the Size
arrow to open its menu.

5. Put acheckinthe Lock aspect ratio box so that when you change one of
the dimensions the other dimension will change to keep the height to width
ratio the same.

Mac: Put the check to tWhe height and width values.
] os ~
W+ w

— g -
N ' -~

6. Change the height to 6 inches and tap Enter. Center the image below the title.

7. Notice that the bird is blocking some of the text. To fix this, right-click the
bird, choose Send to back, and then Send to Back. Now the bird is
behind the text.

- Saturday, October 30 f : :
a0 AN e NSO [
-« Hidden Lakes Marsh, Narth Territorial Road

- = Wear boots|and warmm clothes :

e. Duplicate the slide and adjust the image on the new slide by doing the following:

1. Inthe Slides/Outline pane (on the left), right-click the slide and select
Duplicate Slide. This makes an exact copy of the slide and makes the new
copy active.

2. For this new slide, you want the text to go only halfway across the screen.
Click anywhere on the bulleted text to display the textbox, click the right
center resize handle (the little circle on the middle of the right side of the
rectangle), and drag to the left until the textbox is half its original size.

f. Crop, resize, and move the picture so that only the head of the bird appears in
the lower right corner of the slide by doing the following:

1. Click the picture. In the Format Picture pane, click the picture icon, and
then click Reset. This restores the picture to its original form.

2. Onthe Picture Format tab, in the Size group, click the Crop arrow and
select Crop.
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3. Move the cursor to the bottom left cropping handle, L. press and hold the
mouse button, and drag up and right until you just reach the shoulder of the
bird. Then, let up on the mouse button

~........Bird Sanctuary Field Trip.

T= -

» Saturday, October 30]
* 6:30 AM till dawn :

» Hidden Lakes Marsh,L :
- Territorial Rbad" - W .

4. Once again, click the Crop button to turn off the cropping feature.

5. Make the height 4 inches and drag the picture to lower right corner.

g. Apply a light blue blended background to the slide by doing the following:

1. Move the pointer to a blank area of the slide, right-click, and choose
Format Background to open its pane.

2. If necessary, click the arrow next to Fill to display its options and then click
the button next to Gradient fill to apply a colorful background.

h. On the Review tab, in the Proofing group, click Spelling and fix the errors.

i. If necessary, remove the slide numbers from the slides by doing the following:

1. Be sure nothing is selected and, on the Insert tab, in the Text group, click

Insert Slide Number.

2. On the Slide tab, uncheck Slide number.
3. Click Apply to All.

In my version of Office 365 | cannot remove the slide numbers from the
handouts!

j. Tap Ctrl + p and set up to print a HANDOUT as follows:

e Has both slides.

e Two slides per page.

e Portrait orientation.

e Color.

¢ Date, updated automatically, in the format Day, Month Date, Year.
e Page number but no Header.

e Name of the file in the footer.

Compare the preview with the key. Make needed corrections, save the
presentation, and close it.
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Step 4 Submit Now, submit the following handouts (not slides).

Mac: When you tap Command + P to open the Print dialog, at the bottom left
corner of the Settings screen, you should see If it is not there, click
the arrows to the right of PowerPoint and select Print Mode. At the bottom
of the window, click the PDF arrow, select Save as PDF and then click Save.

Use these names for the pdf files:
HW11-1 HWID 1A KWT Overview Done — This is a Handout of slides 1,3,4,5
HW11-2 HWID 1B Seattle Done — This is a Handout of slides 1,3,4,5,6,7
HW11-3 HWID Bird Done — This is a Handout of all slides

Create a pdf file of the output for each of the above, place them in a folder
called HW11 HWID LastName, FirstName, zip the folder and, by the due date,
upload it to the Canvas folder HW11 PowerPoint Chapter 1: Getting Started.

Step 5 Backup Now would be a good time to backup your files.



Project 12
PowerPoint Chapter 2: Formatting Presentations

Step 1 Read Read the introductory material on page 813 of the textbook.

Step 2 Activities Turn on the computer and do the following:

Project 2A: Start at the top of page 815.

Instead of Activity 2.01 step 1 do the following:

1.

Navigate to your PowerPoint Files folder and open p02A_Safety, which is
one of the files you downloaded at the start of the term.

Save the file in your PowerPoint Files folder using the name
LastName_FirstName_2A_Safety

Complete the rest of the Activities through step 7 on page 838. Do NOT do
steps 8 and 9 in Activity 2.21 on page 838.

Return here when you have completed Project 2A on page 838.

|‘ Do NOT do GO! With Google

Project 2B: When you have completed Project 2A, start at the top of page 843.

Instead of Activity 2.22 step 1 do the following:

1.

Navigate to your PowerPoint Files folder and open p02B_Celebrations,
which is one of the files you downloaded at the start of the term.

Save the file in your PowerPoint Files folder using the name
Lastname_Firstname_2B_Celebrations

Complete the rest of the Activities through step 5 on page 854. Do NOT do
steps 6 and 7 in Activity 2.34 on page 854.

Do NOT do Activity 2.35 on pages 854-855.

Return here when you have completed Project 2B on page 854.

|‘ Do NOT do GO! With Google Slides or GO! To Work

Step 3 Homework After you have completed Projects A and B for this Chapter,
return here, do the problems listed below, and turn them in for grading.

— SG323 —
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HW12-1 Safety (Based on Project 2A)

Problem: How can lists, pictures, textboxes, and shapes be added to a PowerPoint
presentation?

a. Open the presentation Lastname_Firstname_2A_Safety, which you created
while following the directions in the textbook and saved on page 838.

b. Save the document to your PowerPoint Files folder using the name
HW12-1 HWID 2A Safety Done

c. For the first slide, change the font color to red and the background color to
white. This will save a lot of ink if you ever have to print it.

d. Tap Ctrl + p and set up to print a handout as follows:

e Has all six slides.

e Six slides horizontal per page.

e Portrait orientation.

e Color.

e Date, updated automatically, in the format Day, Month Date, Year.
e Page number but no header.

e Name of the file in the footer.

Compare the preview with the key. Make needed corrections, save the
presentation, and close it.

HW12-2 Celebrations (Based on Project 2B)

Problem: How can specially formatted artwork be created and added to a
PowerPoint presentation?

a. Open the presentation Lastname_Firstname 2B _Celebrations, which you
created while following the directions in the textbook and saved on page 854.

b. Save the document to your PowerPoint Files folder using the name
HW12-2 HWID 2B Celebrations Done

c. Tap Ctrl + p and set up to print a handout as follows:

e Has slides 3, 4, 5 only.

e Three slides per page.

e Portrait orientation.

e Color.

¢ Date, updated automatically, in the format Day, Month Date, Year.
e Page number but no header.

e Name of the file in the footer.

Compare the preview with the key. Make needed corrections, save the
presentation, and close it.
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HW12-3 Graphics and Sound

Problem: How can graphics sound be added to a PowerPoint presentation?

a. Start PowerPoint and open a blank presentation. Change the slide layout to
Blank (Home, Slides, Layout, Blank).

b. Set the background for the slide to the canvas texture fill (right-click, Format
Background, Fill, Picture or texture fill, click the second texture in the first row).

c. Save the document to your PowerPoint Files folder as

HW12-3a HWID Graphics and Sound Done

d. Add some drawing objects by doing the following:

1.

If the ruler or gridlines are not showing, turn
them on (View, Show, Ruler, Gridlines).

On the Insert tab, in the lllustrations
group, click the Shapes arrow and choose
Rectangle: Rounded Corners.

The mouse pointer will turn into a cross -

Move the mouse pointer onto the slide, and
then click and drag to produce a small square.

On the Drawing Format tab, in the Size group,
change the Height and Width to 2 inches.

Click inside the square and type Access.

09 O B

Shapes Icons 3D SrnartAr]
@ Models ~

Recently Used Shapes
EINNOOCOATLTTL
AR AN B I %

Lines

NNNLTLL22 3

Rectangles

O0LOoQQO0OOano

e Rectangle: Rounded Corners

Make the font Arial Black, 24 pt, and yellow. If necessary, center align the

text within the box.

Insert a diamond that is 2 inches high and 3 inches wide. You can start
from scratch, as you did for the rectangle, or you can use the Format
Painter as you did in Word and Excel to copy the text formatting quickly.

Inside, type Hard, tap Enter, and type Work.

Insert an oval that is 1.5 inches high and 3.5 inches wide. Inside, type the

word Excellence.

e. Add some lines to connect the three shapes by doing the following:

1. Onthe Insert tab, in the Illustrations group, click Shapes, and then

Connector: Elbow.

Lines

NNNLLTL 23

Rectangles Connector: Elbow
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2.

Move the mouse pointer, which is now a cross, to the middle of the right
side of the square and then click and drag to the right and down to connect
to the top center of the diamond and release the mouse button.

Access

The green dots show the objects are “connected” by the line. When you
move an object, the line will stay connected and move with the object.

With the new line still selected, on the Drawing Format tab, in the Shape
Styles group, click the Shape Outline arrow and select Weight and then 3
pt. Change the line color to red.

Use the same technique to add a connector between the oval and the
diamond. A quick way to do this is to select the line you just created and
tap Ctrl + d. This duplicates the line. Then, drag the ends to the proper
locations. The ends will be green dots when the connections are correct.

f. Add some textboxes by doing the following:

It will be easiest if you create the textbox at an arbitrary location on the slide
and then use the mouse or arrow keys to position it after you have entered the
text and formatted it.

1.
2.

On the Insert tab, in the Text group, click Text Box.

Draw a textbox. Make the height 0.5 inch and the width 2. Type Plus in the
box. Make the font Arial, red, 24 pt, and bold. Use Ctrl + d to duplicate the
Plus box and then change the text to Equals.

Adjust the locations of the textboxes and shapes as shown.

- Plus
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g. Insert a couple of photos by doing the following:

1.

o k~ 0D

o

On the Insert tab, in the Images group, click Pictures. Navigate to your
PowerPoint Files folder and select HW12-3b Photo Original.jpg, which is
one of the files you downloaded at the start of the term.

Click Insert.
Make the photo height 3.5 inches.
Move the photo to the lower left corner of the slide.

Insert the picture HW12-3c Goldy Original, which is one of the files you
downloaded at the start of the term.

Make the picture height 2.5 inches.
Move the picture to the upper right corner of the slide.

The background of the image covers up the slide background. You can
remove the background, if you wish, by doing the following (this is a bit
tricky so it is optional):

¢ With the image still selected, on the Picture Format tab, in the Adjust
group, click Remove Background. This makes the part of the image
look magenta. That is the part which will be removed. Notice that it cuts
off part of the large A& and part of Goldie.

e On the Picture Background Removal tab, in the Refine group, click
Mark Areas to Keep. This will produce a little white pencil. Now the
tricky part. Click those areas of Goldy and the M that you want to keep. It
takes some trial and error. Clicking at various points removes the
magenta in blocks, which are not obvious!

e Onthe Background Removal tab, click Keep Changes and the texture
background will show through.



SG328 PROJECT 12 POWERPOINT CHAPTER 2: FORMATTING PRESENTATIONS

h. Add a sound clip from an audio file that is already on your computer.

1. Onthe Insert tab, in the Media group, click the Audio arrow and select
Audio on My PC. Navigate to your PowerPoint Files folder and double-
click HW12-3d Audio Kottke Original, which is one of the files you
downloaded at the start of the term. The file will be inserted. This is a clip of
guitarist Leo Kottke.

2. Drag the speaker icon to the center bottom of the slide.

3. Click the play arrow Eto hear a preview.

i. Add sound clips from a large U of M audio database. Since you are a U of M
student you have access to a huge number of free video and audio files that
can be downloaded and used as you wish.

If you have trouble with the following you can skip it and move on to part j.

If you are working from off campus, you will have to connect to the U through a
VPN (Virtual Private Network). The directions for installing a VPN client are at
https://it.umn.edu/services-technologies/virtual-private-network-vpn

m Cisco AnyConnect
VPN: Disconnected

1. To open the VPN client, on the Taskbar, click the Show
hidden icons arrow and click Cisco AnyConnect
VPN: Disconnected.

2. From the down-arrow, select AnyConnect-UofMvpnFull
A i )

& Cisco AnyConnect Secure Mobility Client

ﬂ’—io VPN:

| i Ready to connect.

AnyConnect-UofMvpnFull

Il IE Cisco AnyConnec
0 @ ‘|:|'s':|:||' i /PN: Connected
-

3. Click Connect and enter your internet ID and email password.
Click OK and join the full-tunnel network.

4. Open your web browser, and type the following in the address box:
https://it.umn.edu/stock-content-0

5. Scroll down a bit and you will see:

Getting Started

VideoBlocks: 100,000+ clips of stock video, Adobe After Effects templates, motion
backgrounds and more.

AudioBlocks: Royalty-free production music, sound effects, and loops.
GraphicStock: Royalty-free photos, vectors, illustrations & other design elements.



https://it.umn.edu/services-technologies/virtual-private-network-vpn
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6. Click AudioBlocks.
7. Select Sound Effects from the drop down menu in the top center of the window.

8. Type Applause in the search box.

Sound
s Effects

Applause
applause
applause group

applause strong concert

’ applause short 1

9. Click Applause at the top of the list.

§ Storyblocks  video Audio Images Maker NEW [S
ssssssssss
il E;zgi applause Q Royalty Free Music Sound Effects Collections
< " " .
applause” x Sound Effects X (100 results found)
Clear Filters
Q
Media Type ~
o Al cheering clapping cheer aughter crowd yay clap applause group hee aplause Sort By Most Relevant
O Music
(® Sound Effects
Applause, Group
. 0:08
Duration v People B

To play a clip, click its Play arrow.

10. Choose one of the clips. On the right, find its download icon. E]
11. Click the download icon and select MP3 48, A EY
MP3

12. A dialog box will appear allowing you to Open or Save the wav
file. Click the button next to Save File and then click OK.

The file will be downloaded to your Downloads folder as an MP3 file.

13. Rename the file HW12-3e Audio Applause U Database. Drag the file to
your PowerPoint Files folder.

14. Close your browser. Open the VPN client on the Taskbar, click the Show
hidden icons arrow, click Cisco AnyConnect, and then click Disconnect.
Close the Cisco dialog box.

15. Insert the new audio clip and drag its icon so it is just above the
other audio icon.

16. Click the top icon (applause). On the Audio Playback tab, in the Audio

Options group, from the Start box select Automatically and then put a
check next to Hide During Show.

Repeat this for the bottom icon.

48 MP3 (also known as MPEG-3) is the designation for a group of audio and video coding standards
agreed upon by the Moving Picture Experts Group (MPEG). It was released in 1993.
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17. Tap F5 to start the slide show. Remember, on a laptop you may need to
use the fn key also. The clapping will start as soon as the show starts and
then the music will play.

18. Tap the Esc key to end the slide show.

j. Tap Ctrl + p and set up to print a handout as follows:

* Has the one slide. If one slide handout is not an option, use 2 slide handout.
* One slide per page.

* Landscape orientation.

* Color.

* Date, updated automatically, in the format Day, Month Date, Year.

* Page number but no header.

* Name of the file in the footer.

Look at the bottom of the Print Preview. Depending on your printer, you may
see that the footer is partially cut off at the bottom.

You can fix that as you did on page SG318.

If necessary, tap Ctrl + p again and compare the preview with the key. Make
needed corrections, save the presentation, and close it.

HW12-4 Poster

Problem: How can a PowerPoint presentation be transformed into a very large
poster suitable for display at a research conference?

PowerPoint is useful when one person
wants to present information to an
audience and there is a computer and
projector available. PowerPoint can also
be used to create large posters that can
be displayed in a room or hall where
people are walking by. In such a setting,
people can read the posters that have
topics which interest them. Typically, the
person who made the poster is available
to have one-on-one discussions of their
work with passers-by.

In this project, you will create a large poster by modifying one of your previous
PowerPoint presentations. More information, useful tips, and some nice templates
can be found at http://www.craftofscientificposters.com/

One of their templates is included in your PowerPoint Files folder under the name
HW12-4 PowerPoint Poster Template Original

a. Open the presentation HW12-3a HWID Graphics and Sound Done, which you
created for HW12-3.


http://www.craftofscientificposters.com/
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b. Save the presentation to your PowerPoint Files folder using the name
HW12-4 HWID Poster Done

c. Modify the slide by doing the following:

1.

2
3
4.
5

10.

11.

12.

Delete the two sound icons.
On the Design tab, in the Customize group, click Slide Size.
Select Custom Slide Size.

In the Slides sized for box click the arrow and select Custom.

Set the width to 40 inches and the height to 32 inches. Be sure the
Orientation is Landscape.

Slide Size ? X
Slides sized for: Orientation
Custom o Slides
Width:
40 in =
Height: )

: = Motes, Handouts & Qutline
321n -
Mumber slides from: D Portrait

- @ Landscape

1 b

Click OK and then click Maximize.

Move the Access square so its top is at about
12 inches on the vertical ruler. Notice how the
connector line stays attached to the shape.

=
o
e

Move the Excellence oval so its bottom is at about 10 inches.

Resize Goldy to be 3 inches high and 4 inches wide (remember to uncheck
Lock aspect ratio). Move the image to the upper right corner of the slide.

Make the height of the photo 8 inches and the width 12 inches. Move the
image to the lower left corner.

Right-click one of the red connectors and select Format Shape to open
that pane. Click the paint bucket and Line and change the Width to 20 pt.
Click the other connector and change its Width to 20 pt.

Change the font of Plus and Equals to Arial Black. Readjust the positions
so they are centered just below their connectors.

Insert a textbox at the top of the slide with the text General College
University of MN. Make the text Arial Black and 128 pt. Adjust the textbox
size so the text is all on one line and in the upper left of the slide.
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13. Insert a textbox at the top of the slide under the word College and type
Presented by HWID (use your HWID). Make the text purple Arial Black
and 88 pt. Adjust the textbox as shown below:

FTI8L TG 11141 11201 1O I8 I TI4 1121011011121 1141016101181 1110011120 11141 1116111181 11

14. Insert another textbox above the photo and enter the following text in bold
66 pt Arial. You can either type the text or copy it from the file HW12-4
PowerPoint Poster Text Original, which is one of the files you
downloaded at the start of the term, and then paste it.

Mission: To develop, through teaching, research, and service, the
potential for baccalaureate education in students who are serious
about fulfilling their previously undeveloped or unrecognized
academic promise.

Make the textbox 8 inches high and 15 inches wide.
15. Just below Goldy, enter this text in bold 66 pt Arial.

Purpose: GC provides entry to the University for students from a wide
range of ethnic, social, and economic backgrounds who would like to
pursue a four-year degree, but who lack the academic skills or
records to realistically compete in a regular degree-granting college.

Make the textbox 9 inches high and 17 inches wide.
16. Just below Excellence, enter this text in bold 66 pt Arial.

Students: The GC student cohort is comprised of approximately equal
numbers of late-teen men and women, 33% of whom are students of
color, and 68% of whom are on some form of financial aid.

Make the textbox 5 inches high and 23 inches wide.
17. Make the titles Mission, Purpose, and Students red.

18. Adjust the textboxes so the slide looks like the following:
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. 'pursue a four-year degree, but who
~lack the academic skills or records to
. realistically compete inaregular .

_ degree-granting college. =

 the potential for baccalaureate <
_‘education in students whoare :

d. The poster is ready to print. Because you will make a pdf of it to fit an 8.5 by 11
inch piece of paper, do the following:

1. Tap Ctrl + p to open Print Preview.

2. Inthe Settings group, click the Full Page Slides arrow and be sure there
is a check next to Scale to fit paper.

3. Choose Color.

4. Compare the preview with the key. Make needed corrections, save the
presentation, and close it.

If you want to print a poster on a large format printer you can use the lab in
B0O60 Coffman Union. The cost is $4.50 per square foot so the poster you
created for this homework would run you about $36. For details on printing, see

http://it.umn.edu/services/all/academic-technology-spaces/computer-labs/large-format/

If you are a CEHD student, you may be able to have your poster printed for
free. For more information call the CEHD Dean'’s office at 612-626-9252 or
drop by 104 Burton Hall.

Step 4 Submit Now, submit the following. The first three are HANDOUTS but the
fourth is a SLIDE. Use these names for the pdf files:

HW12-1 HWID 2A Safety Done — This is a Handout

HW12-2 HWID 2B Celebrations Done — This is a Handout of slides 3, 4, 5
HW12-3a HWID Graphics and Sound Done — This is a Handout

HW12-4 HWID Poster Done — This is a SLIDE, not a Handout


http://it.umn.edu/services/all/academic-technology-spaces/computer-labs/large-format/
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Create a pdf file of the output for each of the above, place them in a folder
called HW12 HWID LastName, FirstName, zip the folder and, by the due date,

upload it to the Canvas folder HW12 PowerPoint Chapter 2: Formatting
Presentations.

Step 5 Backup Now would be a good time to backup your files.



Project 13
PowerPoint Chapter 3: Animation, Tables & Charts

Step 1 Read the introductory material on page 877 of the textbook.

Step 2 Activities Turn on the computer and do the following:
Project 3A: Start at the top of page 879.

Instead of Activity 3.01 step 1 do the following:

1. Navigate to your PowerPoint Files folder and open pO3A_Trails, which is
one of the files you downloaded at the start of the term.

2. Save the file in your PowerPoint Files folder using the name
LastName_FirstName 3A Trails

2. Complete the rest of the Activities through step 9 on page 900. Do NOT do
steps 10 and 11 in Activity 3.17 on page 900.

4. Return here when you have completed Project 3A on page 900.

Do NOT do GO! With Google

Do NOT do Project 3B

Step 3 Homework After you have completed Project A ONLY for this Chapter,
return here, do the problems listed below, and turn them in for grading.

HW13-1 Trails (Based on Project 3A)

Problem: How can customizable backgrounds, themes, and animations be added
to a PowerPoint presentation?

a. Open the presentation Lastname_Firstname_3A_Trails, which you created
while following the directions in the textbook and saved on page 900.

b. Save the presentation to your PowerPoint Files folder using the name
HW13-1 HWID 3A Trails Done

c. To help your audience focus on what you currently are saying, it sometimes
helps to dim previous bullets when a new one enters the screen. To see how
this works, do the following:

1. Click Slide 3 and select the three bullets.

2. Onthe Animations tab, in the Advanced Animation group, click
Animation Pane.

3. Inthe Animation Pane, click the Rectangle arrow and select Effect
Options.

— SG335 —
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4. Click the After animation arrow and select the color brown.

Enhancements

Sound: [Mo Sound] L o

atter amimation: | | -

Animate text: | HB ] |i|

Animate text: By letter

5. Click the Animate text arrow and select By letter. gjl;l itofr’gfe

. By lett
6. Click OK. y emel

7. Click the Slide Show button on the Status Bar
and click through the animations on this slide.

Repeat the process for Slide 4.

Click the photo. In the Animation Pane, Content Place |2 ¥ Content Place.. []

is highlighted. The 5 means the photo will enter after the four bullets.

To make the photo appear before the bullets, click the upward pointing triangle | =

in the upper right corner of the pane. Content Place moves above Rectangle
and the 5 changes to a 0.

o =k O ; e 10 & Rectangle 4: OD:

Challenge Yourself on a Wildefiess Hike 0 ¥ contentpiacer

a Bn‘ng adéquate s:un protéction arid
hydration - -

d. Tap F5 to play the slideshow and note how the animations work.
e. Tap Ctrl + p and set up to print a handout as follows:

e Has all six slides.

e Six slides horizontal per page.

e Portrait orientation.

e Color.

e Date, updated automatically, in the format Day, Month Date, Year.
e Page number but no header.

e Name of the file in the footer.

Compare the preview with the key. Make needed corrections, save the
presentation, and close it.
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HW13-2 Import from Word and Excel Documents

Problem: How can tables and charts created in Word or Excel be inserted into a
PowerPoint presentation?

| asked you to skip Project 3B in the textbook because it shows you how to create
tables and charts from within PowerPoint. You already know how to do that in Word
and Excel so all you really need to learn is how to import them into PowerPoint. In
this exercise, you will copy a table from a Word document and a range of cells from
an Excel workbook and paste them into a PowerPoint presentation. In HW13-3 you
will import a chart from Excel.

a. Open the Word document HW13-2a Word School Attendance Table
Original, which is one of the files you downloaded at the start of the term. It is
in your PowerPoint Files folder. Note that you cannot open it from within
PowerPoint — you must double-click its icon in the PowerPoint Files folder to
have Word open it.

b. Copy the information by doing the following:

1. Onthe Home tab, in the Clipboard group (on the far left), click the
Clipboard dialog box launcher 4 | to open the Clipboard pane.

2. If necessary, click Clear All to delete any items stored on the clipboard.
3. Copy the title, School Attendance.

4. Select the table. Be careful to not include the School Attendance title or
the paragraph mark at the bottom when you make your selection.

5. Copy the table.

Clipboard MR

Paste All Clear All

Click an Item to Paste:

Attended Didn't Attend %
& Attended 1860 6 35 15 1870 101
= 103 50 1880 444 452 50 1900
1000 1019 50

@7 School Attendance

6. Minimize Word but do NOT exit Word.

c. Do the following to paste the Word items you just copied into PowerPoint.

1. Start PowerPoint, open a Blank presentation, and change the layout of the
first slide to Blank.

2. Save the presentation to your PowerPoint Files folder using the name
HW13-2d HWID Import from Word and Excel Done
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3. Onthe Home tab, in the Clipboard group, click the Clipboard dialog
box launcher to open the Clipboard pane.

4. Inthe Clipboard pane, click the title School Attendance to insert it.

5. Change the font to 36 pt Arial Black. Move the title so it is near the top
center of the slide.

6. Click a blank area of the slide to deselect the title.

7. Inthe Clipboard pane, click Attended Didn’t Attend... to insert the table.
If the Design Ideas pane opens, close it.

8. Onthe Table Layout tab, in the Table Size group, change the width of the
table to 9 inches and the height to 3 inches.

9. Make the font bold 24 pt Arial.

10. Move the table to the center of the slide. An exact way to do this is to, on
the Table Layout tab, in the Arrange group, click the Align arrow and click
Align Center to center the table horizontally. Do it again but this time click
Align Middle to center the table vertically.

11. Center the text in each cell both vertically and horizontally.

Center the table on the slide (Table Layout tab, Alignment, | .
. . sign  Layout
Center Horizontally, Center Vertically). —_—
“A
A

12. Apply a table style of your choice. | checked Header Row,

First Column, and Banded Rows and Medium Style 2 — EEQ ™
Accent 1, which is blue. Direction
File Home Insert Design Transitions Animations Slide Sho}

Header Row First Column
[ ] Total Row [ ] Last Column -
Banded Rows [ | Banded Columns E____ E____ === ——

Table Style Options

Medium Style 2 - Accent 1

13. With the table still selected, on the Animations tab, in the Animation
group, click the Add Animation arrow, and select More Entrance Effects.

14. Click Bounce (under Exciting) and then click OK.

15. Onthe Animations tab, in the Timing group, click the Start arrow and
select With Previous. This will automatically start the animation when the
slide show begins.

d. Insert an Excel table by doing the following:

1. Open the Excel workbook HW13-2b Excel Education Rates Table
Original, which is one of the files you downloaded at the start of the term.
It is in your PowerPoint Files folder.

2. In Excel, if the Clipboard pane is not open, on the Home tab, in the
Clipboard group, click the Clipboard dialog box launcher.



PRoOJECT 13 POWERPOINT CHAPTER 3: ANIMATION, TABLES & CHARTS SG339

If necessary, click Clear All to get rid of the old items that were copied.

3
4. Click cell A1 and copy the title, Education Rates by State.
5. Copy cells B2:H12.

6

Minimize Excel but do NOT exit Excel.

e. Do the following to paste the Excel items you just copied into PowerPoint.
Insert a new slide using the Blank layout.

2. Open the Clipboard pane and click the title Education Rates by State to
insert it.

3. Change the font to 36 pt Arial Black and move it so it is near the top center
of the slide.

4. Animate the entrance of the title with the Fly In animation (under Basic)
and set it to start With Previous so it will enter when this slide opens.

5. Click a blank area of the slide to deselect the title.
6. Inthe Clipboard pane, click the table State High School... to insert it.

7. Make the width of the table 9 inches and the height 3 inches (Table
Layout, Table Size). Be sure to choose Table Size and not Cell Size.

8. Make the font 20 pt Arial Black.
9. Center the table on the slide.

10. Animate the entrance of the table using Fade (under Subtle) and set it to
start After Previous with a 1 second delay.

11. Close the Clipboard pane.

12. Make the transition to this slide Fall Over (under Exciting).

f. When importing information from Word or Excel, it is sometimes better to take
screenshots, especially if complex formatting is involved and you will not need
to make changes to the data while in PowerPoint. Do the following:

1. Insert a new slide. Use the Blank layout.

2. Open the Excel workbook HW13-2c Excel Current Literacy Rates
Original, which is one of the files you downloaded at the start of the term.
It is in your PowerPoint Files folder.

3. Open the Clipboard pane and use the Snipping Tool to take a screenshot
of cells B2:F11.

4. Copy the map. FYI, to create the map | selected B4:C10 and, on the Insert
tab, in the Charts group, | clicked the Maps arrow and selected the map icon.

5. Copy the image of the girl reading and then copy the image of the books.
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10.

11.

Switch to PowerPoint and paste the screenshot of the Excel table into the
blank slide. Make the height 4 inches and the width 6 inches. Drag it to the
upper left corner of the slide.

Paste the map. Make the size 4 high inches by 7 inches wide. Drag it to the
lower right corner of the slide.

Paste the image of the girl reading. Make the size 3 inches by 3 inches.
Drag it to the lower left of the slide.

Paste the image of the books. Make the size 3 inches high by 4 inches
wide. Drag it to the upper right of the slide.

Animate the Table, Map, Girl, and Books, so that they enter automatically,
one after the other, using the Fade animation, with a one second delay
between each. 4°

0 Current Literacy Rate for Adults L
Country All__Male Female Rank All
Afghanistan 38.2% 52% 24% 4

Bolivia 95.7% 98% 94%
China 96.4% 98% 95%
Guatemala 79.3% 85% 74%
Pakistan  56.4% 70% 43%
USA 99.0% 99% 99%
Venezuela 95.4% 95% 96%
World 86.3% 90% 83% |

o T L
BN

Tap F5 to play your presentation.

g. Tap Ctrl + p and set up to print a handout as follows:

e Has all three slides.

e Three slides per page.

e Portrait orientation.

e Color.

e Date, updated automatically, in the format Day, Month Date, Year.
e Page number but no header.

e Name of the file in the footer.

Compare the preview with the key. Make needed corrections, save the
presentation, and close it. Exit Word and Excel.

49 Click the chart, set it to Start With Previous; click the map and set it to Start After Previous and
Delay 1.00; do the same for the girl and the books.
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HW13-3 Integration

Problem: How can a PowerPoint presentation be created from a Word document

and objects from other files?

a. You will use the Table of Contents of the large word document you edited in
HW10-5 as the starting point for PowerPoint slides. Do the following:

1.

5.

Open HW10-5f HWID Large Document Done, which is in your
Word Files folder. You saved this file on page SG268.

Copy the Table of Contents.
Open a new blank Word document.

On the Home tab, in the Clipboard group, click the Paste arrow, and
select Paste Special. Click Unformatted Text (Mac-Keep text only).

As:

@ Paste: Microsoft Word Document
_— Formatted Text (RTF)
O Paste link: Unformatted Text

Click OK.
Tap Ctrl + h to open the Replace dialog box.

Mac: From the menu bar, click Edit, Find, Advanced Find and Replace, Replace.

10.
11.

12.

In the Find what box type ~t Click Replace All. This will remove the tab codes.

In the Find what box, delete *t and type "#
Click Replace All. This will remove all page numbers.

Tap Ctrl + a to select all the text. On the Home tab, in the Styles group,
click Heading 1.

Select from Daily Schedule of Class Activities through Role of the
Instructor and click Heading 2.

Select from The Mathematics Placement Exam through Focus Groups
and click Heading 2.

Select all the text. Change the font to Arial and the color to black.

To save the file under a new name and format, select File, Save as,
navigate to your PowerPoint Files folder, and type HW13-3a TOC Done in
the File name box. Click the Save as type (File Format on Mac) arrow
and select Rich Text Format.

File name: | HW13-3a TOC Done

Save as type: Rich Text Format__

Click Save.

Close all Word files.
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b. Use the document you just created as the starting point for your PowerPoint
presentation by doing the following:

Mac: Instead of steps 1 and 2 below, navigate to your PowerPoint Files folder,
right-click the name HW13-3a TOC Done, select Open With, and select
Other. From the Enable menu, select All Applications. Scroll down and
double-click Microsoft PowerPoint.

1. Start PowerPoint and choose Blank Presentation.

2. Tap Ctrl + O, click Browse, and navigate to your PowerPoint Files folder.
At the bottom right of the dialog box, click the All PowerPoint Presentations
arrow and select All Files.

All PowerPoint Presentations -

All PowerPoint Presentations

Double-click the Word file HW13-3a TOC Done.

3. The lines of HW13-3a TOC Done that were formatted with style Heading 1
are transformed into new PowerPoint slides while the lines that were
formatted with style Heading 2 appear as subheadings within the slides.

Save the presentation to your PowerPoint Files folder using the name
HW13-3b HWID Integration Done

click the More button B and apply the Wisp theme.

4. On the Design tab, in the Themes group lower right, LAC
Wisp

If the Design Ideas pane opens, close it.
5. Click on any thumbnail (on the left) and tap Ctrl + a. This selects all the slides.

6. On the Home tab, in the Slides group, click the Layout arrow and select
Title only.

c. Do the following to set up Slide 1 (Computer-mediated Instruction).

1. Click Slide 1 (be sure the other thumbnails are not selected) and make the
title 60 pt bold with center alignment so it looks like this:

Computer-mediated
Instruction

2. Click in a blank area of Slide 1. On the Insert tab, in the Images group,
click Pictures. Navigate to your Word Files folder and double-click
HW10-5b Photo Original. If the Design Ideas pane opens, close it.
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3. Right-click the photo and click Size and Position. On the Format Picture
pane, confirm there is a check next to Lock aspect ratio, and change the
height of the photo to 4.5”. With the aspect ratio locked, when you change
the height the width automatically changes to keep the height and width in
the same proportion as the original (hence, no distortion).

4. On the Picture Format tab, in the Picture Styles group,

click the Picture Effects arrow and click Soft Edges, 50 Point. 20 Point

Mac: On the Format Picture pane and click Effects (the pentagon).

5. Position the title and picture as shown below:

Computer-mediated
Instruction

d. Do the following to insert a graphic.
1. Click Slide 2 and make the title 60 pt bold with center alignment.

2. Click a blank area of the slide to be sure the title is not selected.
On the Insert tab, in the Images group, click Pictures.

3. Navigate to your PowerPoint Files folder and double-click the file
HW13-3c Math Sample Original.jpg, which is one of the files you
downloaded at the start of the term. The graphic will be inserted.

4. Make the height of the picture 4.4 inches.

5. Put a black border around the picture (Picture Format, Picture Styles,
Picture Border).
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6. Adjust the location of the picture so that Slide 2 looks like this:

Overview of Computer-
mediated Software

Fle EGU Options Toos Resources Help

T
atan

e. Adjust and animate the bullets on Slide 3 by doing the following:
1. Click Slide 3 and make the title 60 pt bold with center alignment.
2. Click the textbox that contains the bullets and make the font 24 pt bold.

3. Make the four bullets Homework Assignments, Exams and Quizzes,
Checkpoint Questions, and Evaluates subordinate to Daily Schedule of
Class Activities. Adjust the textbox so it looks like the following:

- Structure of Computer-
mediated Courses

= Daily Schedule of Class Activities
= Homework Assignments
= Exams and Quizzes
= Checkpoint Questions
= Evaluates

= Role of the Instructor in a Computer-mediated Class

4. On the Animations tab, in the Advanced Animation group, click
Animation Pane to display it on the right side of the screen.

5. Click the border of the textbox that contains all the bullets. Set the bullets to
enter using the Appear animation.
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6. Notice that the four sub-bullets are set to enter when .
Daily Schedule of Class Activities enters (they all , - Dall}’
have the numeral next to them). To make each = Hq
individual bullet enter on its own mouse click, click the - » Fx
edge of the textbox to select all the bullets and then, < = Ch
on the Animations tab, in the Timing group, set the 5
Start box to On Click. Now, all the entrance numbers . = Ev
are different, ranging from 1 through 6. = Role ¢

Mac: You may have to open the Animations pane and click the Timing arrow.

7. Inthe Animation Pane, click the arrow and select Effect Options.

8. Inthe After animation box, choose the color orange and, in the Animate
text box, select All at once. This will cause the color of a bulleted line to
change to orange when the next bullet enters. This keeps the information on
the screen and helps to focus the audience on the bullet that just entered.

9. Click OK.

10. Click the Slide Show button = to start the presentation from this slide
and watch the animations as you click the mouse. Click Esc to stop the
slide show.

f. Delete Slide 4 (Student Performance in Computer-mediated ...).

g. Add a video by doing the following:

1. Make the new Slide 4 (Trends in Computer-mediated Mathematics
Instruction) active, change the title to Quadratic Transformations, and
make the title 60 pt bold with center alignment.

2. Animate the title using the Bounce entrance (on the Animations tab, in
the Animation group, click the More button, click More Entrance Effects,
scroll down to Exciting, click Bounce, and click OK). Set the animation to
enter by letter (use Effect Options) and set the Start box to After
Previous. Then, deselect the title.
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3. Onthe Insert tab, in the Media group, click Video and select Video on my
PC. Navigate to your PowerPoint Files folder and double-click HW13-3d
Transformations Original, which is one of the files you copied at the start
of the semester. This video was made on an iPad by students in Cl 1806
College Algebra through Modeling after a visit to the Weisman Art
Museum on campus. They were looking for mathematical themes in visual
art. The two faces look like parabolas (quadratic functions). It appears that
the face on the right is a shift of the face on the left through a quadratic
transformation. °°

Mac: You can skip steps 4 and 5 below. | could not get it to work on my Mac.
Microsoft says “On macOS, this feature is only available to Microsoft 365
subscribers.” | am not. https://support.microsoft.com/en-us/office/trim-a-video-
music-clip-or-sound-clip-in-powerpoint-1fc386f2-8404-43e8-9dbd-
fee3allald8f#Platform=Mac

4. On the Video Playback tab, in the Editing group, click Trim Video and
use the green slider to set the video to start at about 4 seconds and the red
slider so that the video ends at about 27 seconds.

ﬂ B

-

00:04.026 : ql h IF 00:27.027 -
Start Time End Time
Click OK.

|:[[| > Start: Automatically

5. On t_he Video Playback tab, in the quleo ol Play Full Screen
Options group, select Start Automatically olume Olwi _ _
and check Play Full Screen so the video . e e LTl LR P
fills the screen when played. Video Options

6. Make the height of the image 4 inches, center it under the title, and move it
to just below the title.

7. Click the Slide Show button to start the presentation from this slide
and watch the video. Tap Esc to exit the presentation.

h. Do the following to insert a graph from Excel.

1. Display Slide 5 (Instructional Models) and change the title to
Preferences by Gender and Type, and make the title 60 pt bold with
center alignment. Then, deselect the title.

2. Minimize PowerPoint and open the PowerPoint Files folder. Double-click
the Excel file, HW13-3e Gender Graph Original, which is one of the files
you downloaded at the start of the term. Even though it is an Excel file it is
in the PowerPoint Files folder.

50 If you are interested in the project, see Staats, S., Ernst, D., Berken, S. & Robertson, D., 2015.
Investigating the mathematics of inaccessible objects: Algebra videos with iPads. Chapter for M.
Meletiou-Mavrotheris, K. Mavrou & E. Paparistodemou (Eds). Integrating touch-enabled and
mobile devices into contemporary mathematics education. IGI Global.


https://support.microsoft.com/en-us/office/trim-a-video-music-clip-or-sound-clip-in-powerpoint-1fc386f2-8404-43e8-9dbd-fee3a11a1d8f#Platform=Mac
https://support.microsoft.com/en-us/office/trim-a-video-music-clip-or-sound-clip-in-powerpoint-1fc386f2-8404-43e8-9dbd-fee3a11a1d8f#Platform=Mac
https://support.microsoft.com/en-us/office/trim-a-video-music-clip-or-sound-clip-in-powerpoint-1fc386f2-8404-43e8-9dbd-fee3a11a1d8f#Platform=Mac
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3. Select the graph by clicking near the upper left corner of the white area
surrounding the graph.

Chart Area

<IN [+

200

Tap Ctrl + ¢ to copy the graph and then close Excel.
4. Switch back to PowerPoint and tap Ctrl + v. The graph is inserted.
5. Change the font of the three axis labels to 18 pt purple.

6. Change the color of the two columns for Women to pink and the two
columns for Men to blue. You will have to do the columns one at a time. To
select a single column, click it, wait a second, and then click it again. Then,
on the Chart Format tab, in the Shape Styles group, click the Shape Fill
arrow and select the color.

Mac: On the Home tab, click the Drawing arrow, and select the color.

7. Make the height of the chart 5 inches (Chart Format, on the left select
Chart Area, and then, over on the right, change the Height to 5).

8. Position the title and graph so that the slide looks like the following:

Preferences by Gender
Type

Number

Lecture
Type of
Computer-

“ #of Women Mediated Class

#of Men

Gender
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I. There are times when you may want to set up all the slides with particular
objects, like a company logo or page numbers or specific text. Doing that
individually to each slide is time consuming for a large presentation. To help
with that task, you can use a Master Slide, similar to what you did when fixing
printing on page SG318. This is like a style in Word. When you edit the Master
Slide (or a style in Word) every slide in the presentation is affected (just like
every paragraph with that style is affected in Word). To see how this works, do
the following:

1. Click the thumbnail for Slide 1.
2. Onthe View tab, in the Master Views group, click Slide Master. This

displays a new tab called Slide Master and displays the Master Slide and
many different slide layouts.

File Slide Master Home Insert Transitions Animations Review View Help Acrobat O Tell me what you want to
1 Colors - &7 Background Styles - =
3 ® o fcolos B Boctarou s =
EE Rename Fonts' [] Hide Background Graphics
Insert Slide Insert Insert Footers Themes @ Slide Close
Master Layout Placeholder ~ = Eifeeise Size - Master View

Edit Master Master Layout Edit Theme Background r Size Close

a | 6 | 5 4 i 3 | 2 ! 1 !

Click to edit M

Click the Insert tab and look in the Text group. A D ,q @
Click Slide Number and put a check in Text Header WordArt
. Box & Footer = El::l
the box to the left of Slide Number.
Text

Click Apply to All to insert the slide number on the Master Slide. The
current position is inside the red arrow. It can be dragged to any location
but, leave it where it is.

On the Insert tab, in the Images group, click Pictures, navigate to your
PowerPoint Files folder, and insert HW12-3c Goldy Original.

The background of the image covers up the Wisp theme. You can remove

. the background, if you wish, as you did on page SG327 (this is optional).

Make the image height 1 inch and move it to the lower right corner of the
slide.

Insert a textbox, type American Mathematical Association, which is the
organization that sponsored the conference where | made this
presentation.

Make the font bold red and move the textbox to the upper
left of the slide, just under the large red arrow. Adjust it to

Americun
i 4 Mathematical
look like this: Association

|
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| used modified versions of the full 60 slide presentation at two conferences,
one for the American Mathematical Association and the other for the
National Council of Teachers of Mathematics. Using the Master Slide
feature, | was able to quickly change the organization name on all the slides
when | went from one conference to the other.

10. On the Slide Master tab, in the Close group, click Close Master View.
11. Delete slides 6 through 10.

j. Tap F5 to run the slide show and marvel at your work. Notice that each slide
has the slide number and the image of Goldy.

k. Tap Ctrl + p and set up to print a handout as follows:

e Has all five slides.
e Six slides horizontal per page, even though you only have 5 slides.

e Portrait orientation.

e Color.
e Date, updated automatically, in the format Day, Month Date, Year.

e Page number but no header.
e Name of the file in the footer.

Compare the preview with the key. Make needed corrections, save the
presentation, and close it. Exit Word and Excel.

HW13-4 (Mis)-communication

Problem: How can images from the web be copied, modified, and inserted into a
PowerPoint presentation and then have animations applied?

In my precalculus class, | talk about the importance of clear communication when
solving problems and communicating the solutions to others. | created a slide as a
humorous way of illustrating how one person can explain an obvious solution that is

completely misinterpreted by his colleague.

‘/I FEEL Lla

|
4 SOME KINDOF
A FCL’L!‘J

| started with the following BC comic, by Johnny Hart.
[ STLLAYTHE

; DT | SIMPLY ADDTHREE MERE TO
WHEeL CiNTBE | | IMPROE T | |7 fien You GOT SVETHING,
by T

| WPOED PN |

e
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| used the Snipping Tool to copy the characters and pasted them in the slide. |
wanted the text to be more readable, so | typed it into textboxes and made the font
Arial Black. Finally, | added animations and sounds. To get some experience with
animations and sound, do the following:

a. Open the presentation HW13-4a Communication Original, which is one of the
files you downloaded at the start of the term.

b. Save the presentation in the PowerPoint Files folder using the name
HW13-4b HWID Communication Done

c. Insert animations by doing the following:
1. Select the box with the text The wheel cannot be improved!

2. Onthe Animations tab, in the Advanced Animation group, click
Animation Pane.

3. Onthe Animations tab, in the Animation group, click Fade.

Mac: Animations, Entrance Effects, Fade.

Set the textbox to Start: On Click.
Select the image below The wheel cannot be improved!
On the Animations tab, in the Animation group, click Fade.

Set the image to Start: With Previous.

© N o o b

Do the same for the three other pairs of textboxes and images.

IR - R EREY FERNERNT: SRR SERNREET RN RN TR ERES RN SRR RREE: SRR RN SRR SRR RN L
Animation Pane

Dlﬂ'erent People Thlnk leferehtly' 3

o : S S VI Play From
' The wheel > Dowt 3| Add 3 more to it,*| Hmmm...

cannot be - improve - - then you have 10 % TextBox 4: The. ]

o improved! it! : : something! % Picture 8 0
1 3 2 @ % TextBox 5: Do... D

- 2 c .{R -{, = 3 /Cg :ﬁGroupQ D
L <) 3 3 (0 3% TextBox 6: Ad... []

o \) - D Tﬂ ( é“ ) % Group 13 D
H\\/ \ b% 40) 3% TextBox 7: Hm...[]

1 [ / _, 3% Picture 17 1

GE:‘-'_ \‘

To be sure your animations are correct, tap F5 to play the presentation (or
Slide Show, Start Slide Show, From Beginning).



PRoOJECT 13 POWERPOINT CHAPTER 3: ANIMATION, TABLES & CHARTS SG351

9. | wanted to have the last image appear on the left and travel across the
screen until it is under Hmmm... To do this, drag the image under
Hmmm... way over to the left and out of the slide. PowerPoint may resist
you doing that so you may have to drag the image to the left, let up on the
mouse button, and then drag the image left again. Repeat as needed.

R R R N T T s R T TR R R SR T TR Ry C R T TR T

Different People Think Differently!

' The wheel 2 Don’t *' Add 3 more to it, * Hmmm...
€ cannot be improve then you have
£ - 4 improved! it! something!
4 PR .
/C; e -
f b = iy G
j il 17\ X g? CF 73
2 é/‘“ %§ }-’ ( 74 (/ \
At‘_\,\ ﬂ\/k/ \ﬁ / Lb% [ |
: o~ v . || a2 l\\
P _ <1 =

10. With the image that has the four wheels still selected, on the Animations
tab, in the Advanced Animation group, click the Add Animation arrow
and select More Motion Paths...

Mac: There is no Add Animation button. Animations, Animation, Path Animation,
Draw Curve. Drag to the right and then double-click. Skip step 11.

11. Under Lines and Curves, select S Curve 2 |VY* S Curve 2| and click OK.

12. The animation will start at the green triangle, follow the S curve, and end
at the red triangle.

@)

Set the animation to Start With Previous.
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13. The following may be a bit tricky so don’t spend too much time on it: Click
the animation and then point to the middle right circle and you will get a
double headed arrow.

Drag to the right until the red triangle is under the Hmmm... textbox.

Different People Think Differently!

/02 m\%

Start here
Follow this path

1| The wheel 2| Don’t 3| Add 3 more to it, *  Hmmm...
cannot be improve then you have
improved! it! something!
fé 2 .j Y 3 ) 7
A (7 AN p. o e
/ )I &\ (1‘.\] ; {’z r}) /Tw‘ 1 ;
P S Z AN A

If you right-click the red triangle and select Edit Points, you will see
several black squares that you can drag to alter the path.

SN\

T A w,r% — IS
y= { - j‘&\( P AL T )
l;—/’{K 4‘,{ = / = g

Tap Esc and then tap F5 to see how the animation works.

f. Add sound effects by doing the following:

1. Click in a blank part of the slide. On the Insert tab, in the Media group,
click the Audio arrow, and select Audio on my PC. Navigate to your
PowerPoint Files folder and double-click HW13-4c Indy Car Pass Sound
Original, which is one of the files you downloaded at the start of the
semester.

2. Drag the speaker icon down so it is below the images.




PRoOJECT 13 POWERPOINT CHAPTER 3: ANIMATION, TABLES & CHARTS

SG353

3. Onthe Audio Playback tab, in the Audio Options group select Start:
Automatically and put a check in the Hide During Show box.

Slide Show Record Review View Help Acrobat Audio Format Playback
> Start: Automaticall v
1> Start: Automatically Hide During Show é\’<| |<|J
L [] Play Across Slides [ Rewind afte playi No EEn
[] Loop until Stopped ewind after Playing Style Background
Audio Options Audio Styles
A 13 2 g Tl 23 g 50000106

ple Think Differently!

. Don’t °> Add 3 more to it, *' Hmmm...
improve then you have
it! something!
2 C‘ fR
=~
<
Y )
1N =
™~ o [
=

4. On the Animation tab, in the Timing group, select Start With Previous.

5. Click in a blank area of the slide to deselect the speaker icon.

6. Onthe Insert tab, in the Media group, click the Audio arrow, select Audio
on my PC. Navigate to your PowerPoint Files folder and double-click
HW13-4d Hmmm Sound Original, which is one of the files you

downloaded at the start of the semester.

7. Onthe Animation tab, in the Timing group, select Start After

Previous.

8. Drag the speaker icon down so it just below the Indy Car Pass speaker

icon.

9. With the speaker icon still selected, on the Audio Playback tab, select
Start: Automatically and put a check in the Hide During Show box.

g. Tap F5 to run the slide show and check that everything is working properly.

h. So that | can see your animations do the following:

1. Open a new Word document and save it using the name
HW13-4e HWID Communication Word Done

2. Insert a footer that contains the name of the file.



SG354 PROJECT 13 POWERPOINT CHAPTER 3: ANIMATION, TABLES & CHARTS

3. Switch to PowerPoint. Be sure the Animations tab is selected and the
Animation Pane is showing. Use the Snipping Tool (Mac: Shift + Ctrl +
Cmd + 4) to copy to the clipboard the entire slide, including the rulers and
Animation Pane.

4. Switch to Word and paste the image. Put a black border around the image.

5. Tap Ctrl + p and compare the preview with the key (they should be close,
but not necessarily exact). Make needed corrections, save the document
and close Word.

6. Close PowerPoint and save the presentation.

OK, so now you know some ways to make your PowerPoint presentations
flashy and, hopefully, more interesting. But, your message is the most
important part so be sure to first figure out the message or facts you want your
audience to leave with, then map out a talk that accomplishes your goal.
Finally, consider adding animations, transitions, audio, video, and so on to liven
up things. You want your audience to pay attention, to be surprised, to smile
and nod and laugh at the right places and the extras can help with that.

HW13-5 Course Evaluation

Problem: How can you help to improve this course for future students?

During the last two weeks of the semester, you will be sent an email telling you that
the web-based evaluation for this course is available. To access the evaluation,
follow the directions in the email, or go to https://srt.umn.edu/blue/

The evaluation is only available until the last day of the
semester (BEFORE finals) so you must complete it by then.

a. If you do not want to fill out the evaluation, log into the site anyway so the
system knows you were there and then exit without answering any of the
guestions.

b. After you have exited from the course evaluation site, open Word and on
separate lines type your four-character HWID, the date, the name of this
homework problem HW13-5 Course Evaluation, and the words | accessed
the course evaluation web site.

c. Save the document using the name HW13-5 HWID Course Evaluation Done
and close it.

Step 4 Submit Now, submit the following. The first three are pdfs of handouts
and the last two are pdfs of Word files. Use these names for the pdf files:

HW13-1 HWID 3A Trails Done — This is a Handout

HW13-2d HWID Import from Word and Excel Done — This is a Handout
HW13-3b HWID Integration Done — This is a Handout

HW13-4e HWID Communication Done — This is a pdf from a Word file
HW13-5 HWID Course Evaluation Done — This is a pdf from a Word file


https://srt.umn.edu/blue/
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Create a pdf file of the output for each of the above, place them in a folder
called HW13 HWID LastName, FirstName, zip the folder and, by the due date,
upload it to the Canvas folder HW13 PowerPoint Chapter 3: Animation,

Tables & Charts.

Step 5 Backup Now would be a good time to backup your files.






Sample Exam Questions for PowerPoint

These sample questions will help you prepare for the PowerPoint exam. You will
NOT submit these activities for grading. The solutions start on page SG361. The
output keys are in this Study Guide, starting on page SG414.

a. Start PowerPoint and open a new blank presentation.

b. Save the file to your PowerPoint Exam folder using the name Sample-a
PowerPoint Questions Done.

Slide 1

c. Make the following changes to Slide 1.

1. Change the layout to Blank.

2. Insert a WordArt object. | used the orange Ainthe top row, but you can

use any color you wish. Type the following text: PowerPoint Sample
Exam Questions.

Mac: When you insert a WordArt object, the WordArt options will appear in the

ribbon.
@0 Aatcsave @7 BHEHSSYT = #lh Sample-aPowerPoint Questions Done
Home Insert Draw Design Transitions Animations Slide Show Review View Q Tell me
A . A2 O L R T
e (e [me| AV B- Ay B The W o
Shapes Text L Shape i, WordArt Alt Arrange = 462" - 1

Box Fil Styles Text -

msert Shapes Shape Styles Accessibllity Slize
When you click outside the WordArt object to deselect it those options
disappear. | cannot figure out how to get those options back without inserting
a new WordArt object. Let me know if you figure it out!

3. Modify the text effect of the WordArt object so that it has the

bcda
Deflate Bottom transform. ab<de

08

Make the text fill purple.
Make the font of the WordArt object Arial Black and the size 48 pt.
Move the WordArt object to the top center of the slide.

A A

Have the WordArt object enter automatically when the slide show begins.
Use the Fly In animation. Have the object enter from the lower right corner.

8. Insert a textbox and, on separate lines, type your FirstName, LastName,
and HWID.

9. Make the font 36 pt. Arial Black.
10. Make the space before each line 12 pt.

11. Animate the six lines of text you just typed so that they enter one at a
time, in order, each time the mouse is clicked. Use the Fly In animation.

— SG357 —
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12. Set the animation so that each of the 6 lines of text is dimmed to purple
when the next bulleted line of text appears.

13. Insert the photo Sample-b PowerPoint Balloons Original, which is one
of the files you downloaded at the start of the term.

14. Crop the bottom of the photo so that the trees are not visible.

15. Change the height of the photo to 3 inches and the width to 5 inches.
16. Place ared border around the photo and make the border weight 6 pt.
17. Insert an oval. Make the height 4.6 inches and the width 7 inches.

18. Make the fill texture of the oval Bouquet texture and the border 6 pt. red.

19. Send the oval behind the photo. Center the picture inside the oval.

20. Group the photo and the oval so they act as one object when moved.
21. Move the Photo/Oval to the lower right corner of the slide.
22. Set the background for this slide only to Bouquet texture fill.

23. In the PowerPoint Files folder, double-click the Word file Sample-c
PowerPoint Table Original to open it. Copy the table. Do NOT copy the
title or the text below the table.

Paste the table into the PowerPoint slide, keeping the source formatting
of the table.

24. Make the width of the table 6 inches and the height 2 inches.
25. Change the font to 14 pt. and right-align the three columns on the right.
26. Move the table to the lower left corner of the slide.

27. Have the table enter with the Swivel animation automatically when the
slide show begins. Swivel is under the Subtle category. Set the Duration
(speed) to Medium (2.0).

28. Insert a curved connector that connects the bottom of the SmartArt
textbox to the top of the oval. If you drag the oval the connector should stay
connected.
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St 4 3 2 0 2 3 A 56
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A [Tl
Slide 2

d. Create a new Slide 2 and set it up by doing the following.

1.
2.
3.

10.

11.
12.

Insert a new slide and make the Layout blank.
Make the background of this slide Texture fill Papyrus.

Insert a textbox, type Natural Gas Safety. Make the font Bold 40 pt. Arial.
Move the title to the upper left corner of the slide.

Insert a textbox. Type the following on separate lines: As a Fuel, Light,
Narrow Range, High Temperature, Low Toxicity.

Change the text to 36 pt. Arial.
Convert these five lines of text to a bulleted list.

Make Light, Narrow Range, and High Temperature subordinate to the
first bullet, As a Fuel.

Move the line High Temperature so that it is between As a Fuel and
Light.

Move the list so that it is under the title.

Animate all the bullets so they enter one at a time when the mouse is
clicked. Use the Fly In animation.

Make each bulleted line dim to purple when the next bullet appears.

In the PowerPoint Files folder, double-click the Word file Sample-c
PowerPoint Table Original to open it. Copy the text that is below the
table. Do NOT copy the title or the table.

Paste the text into the PowerPoint slide, keeping the source formatting.
Make the font 24 pt. Arial. Feel free to move the textbox so you can see it better.
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13. Make the text in the box display in three columns. Make the spacing
between the columns 0.4 inch.
14. Adjust the columns so they look like the following and then drag the textbox
to the lower left corner of the slide.
. Whenused Buming  Butitis still
: correctly, naturalgas = agreener -
naturalgas  does ~ solution
“ Edeie i plofucs o idEahe
2 efficient some . fossil fuels. :
~ ..sourceof . greenhouse - ...
E pQwer. gases.§ :
15. Have the text enter using the Fly In animation from the lower left corner
and one letter at a time.
16. Open the Excel workbook Sample-d PowerPoint Chart Original, which is
one of the files you downloaded at the start of the term.
17. Copy the chart and paste it into this slide.
18. Make the height of the chart 5 inches and the width 8 inches.
19. Move the chart to the upper right corner of the slide.
20. Insert a straight line and an arrow as shown below. Make their weight 6
pt. and color red.
21. Arrange the line and arrow as shown below and group them.
22. Animate the grouped line and arrow so that it enters after the last bullet
enters. Use the Spiral In animation (under Exciting).
23. Animate the grouped line and arrow so that it blinks 3 times after it spirals

n.

4

Natural Gas Safety

* Asa Fuel
+ Light
» High Temperature
* Narrow Range

~+ Low Toxicitv

Animation Pane 1

10 & AsaFuel

1

i
[
a1
e [
0

Value

6() # Rectangle 5: .. [I

© 4 N © & O o N ®

6

When used Burning But it is still
correctly, natural gas a greener

natural gas does solution
is a safe, produce than other
efficient some fossil fuels.
source of greenhouse

power. gases.
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Slide 3

e. Create a new Slide 3 and set it up by doing the following.
1.
2.
3.

Insert a new blank slide.

Make the Theme of this slide only Berlin.

Berlin

Insert a SmartArt object that uses the List category

and Basic Block List subcategory.

Add the text shown below.

Make the fill of each box blue and the font bold Arial.

Animate the six textboxes so they enter, one by one, when the mouse is
clicked. Use the Fly In animation.

f. Use the Push transition when moving from slide 2 to slide 3.

g. Click Slide 1 and then view the slide show.

How to Solve the Sample Exam Questions for
PowerPoint

Slide 1 - Solutions

cl.

c2.

c3.

c4.

Co5.

On the Home tab, in the Slides group, click the Layout arrow and select

Blank.

On the Insert tab, in the Text group, click the WordArt arrow and the

orange A in the top row, or a different one. Type the text.

On the Drawing Format tab, in the WordArt Styles group,

click the Text Effects arrow
select Deflate Bottom.

A -

click Transform, and

abcdg

Deflate: Bottom

Select the text and, on the Home tab, in the Font group, select purple from
the Font Color drop down menu.

On the Home tab, in the Font group, in the lower right corner, click the

dialog box launcher Eand change to size to 48.

Mac: Click the Format menu, select Font, and change to size to 48.

c6. Drag the object to the top center of the slide.
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c’.

c8.

c9.

c10.

On the Animations tab, in the Animation group, click Fly In.

On the Animations tab, in the Advanced Animation group, click
Animation Pane. The Animation pane will open on the right.

On the Animations tab, in the Timing group, click the Start arrow and
select With Previous. That will make it start when the show starts.

On the Animations tab, in the Advanced Animation group, click the
Effect Options arrow and select From Bottom-Right.

On the Insert tab, in the Text group, click Text Box, move the cursor to
anywhere on the slide, and drag the mouse to draw a Text Box. Then, type
the 3 lines of text, one per line.

Select the text you just typed and, on the Home tab, in the Font group,
select 36 pt. and Arial Black.

With the text still selected, right-click, select Paragraph.

Mac: Click the Format menu and select Paragraph.

c11.

cl2.

In the Spacing group set Before to 12 pt. Click OK.

With the text still selected, on the Animations tab, in the Animation group,
click Fly In. Notice that the little numbers just to the left of each word are all
set to 1. This means they will all enter all at the same time, so you need to
change this.

On the Animations tab, in the Timing group, click the Start arrow and
select On Click. Now the little numbers show 1, 2, 3, which means they will
come in one at a time each time you click the mouse.

With the text still selected, in the Animation Pane, click the arfow to the

right of 3 HWID. /

Mac: There is no arrow. Just click the 3 /

Animation Pane v X
Play Selected -

0 W Rectangle 4: P... D
1 O * FirstName

[

2() ¥ LastName 0

30 #Hwip 0
Start On Click

Start With Previous
(O  Start After Previous

Effect Options... «—t—

On the Effect tab, in the Enhancements group, click the After animation
arrow and select purple. Click OK.

Mac: Click More Colors, which is just above Don’t Dim.
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c13. Onthe Insert tab, in the Images group, click Pictures. Navigate to your
PowerPoint Files folder, Double-click Sample-b PowerPoint Balloons
Original.
cl4. With the picture selected, on the Picture Format tab, in the Size group,
click the Crop arrow and select Crop.
Drag the bottom middle size handle mms@ up until the trees are no
longer visible. Click outside the photo.
c15. Onthe Picture Format tab, in the Size group, click the launch dialog
button to show the Format Picture pane.
Uncheck Lock aspect ratio so you can change the height and width
independently.
Type 3 in the height box and 5 in the width box.
Mac: To change the Height and Width independently 1 s ~ =
you must first remove the check mark to the - | —
right of the Height and Width boxes. — 5 "
c16. With the picture selected, on the Picture Format tab, in the Picture Styles

cl7.

c18.

c19.

c20.

c21.

group, click the Picture border arrow and select red. Then, click the
Picture border arrow, click Weight, and select 6 pt.

On the Insert tab, in the lllustrations group, click the Shapes arrow and
select oval. Move the cursor to a blank spot on the slide and drag the
mouse.

On the Drawing Format tab, in the Size group, change the height to 4.6
inches and the width to 7 inches.

On the Drawing Format tab, in the Shape Styles group, click the Shape
Fill arrow, click Texture, and select Bouquet. Then, click the Shape
Outline arrow and select red. Finally, click the Shape Outline arrow, click
weight, and select 6 pt.

Right-click the oval, click Send to Back and select Send to Back.

Click the picture, hold down the Shift key, and click the oval. This selects
both of them. On the Drawing Format tab, in the Arrange group, click the
Align arrow, and select Align Center. Repeat but this time select Align
Middle.

With the picture and oval still selected, right-click, click Group and select
Group.

Drag the Photo/Oval group to the lower right corner of the slide.
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c22. In a blank part of the slide, right-click, and select Format Background.

In the Format Background pane, click Picture or texture fill.

To the right of Texture, click the arrow and select Bouquet.

c23. Inthe PowerPoint Files folder, double-click the Word file

Sample-c PowerPoint Table Original to open it.

Select the table, tap Ctrl + ¢ to copy it, switch to PowerPoint, and click a

blank spot anywhere on the slide.

On the Home tab, in the Clipboard group, click the
Paste arrow and select Keep Source Formatting (K).

c24. With the table selected, on the Table Layout tab, in
the Table Size group, type 6 in the width box and 2 in
the height box.

Mac: Grab the upper left size handle and drag until the height
and width are correct. Get as close as you can — it need
not be perfect.

‘X, _+_ Layo
=

9
Paste New 5 il
v Slide v [ Secti

Paste Options: =

aBim o

Keep Source Formatting (K)

c25. With the table selected, on the Home tab, in the Font group change the

font type and size.

Select the three columns on the right. In the Paragraph group, click the

Right Align button.

c26. With the table still selected, drag it to the lower left corner of the slide.

c27. With the table still selected, on the Animations tab, in the Animation
group, click the More buttonE to open the Animation menu.

Click More Entrance Effects.

In the Subtle group, click Swivel and then OK. [> Start: With Previous - | Reo
@Duration: 02.00

On the Animations tab, in the Advanced

Animation group, click Animation Pane to open it. O pelay: -

Select the Start box arrow and select With

Previous. This automatically starts the animation Animation Pane

when the slide show starts.
Type 2 in the Duration box.

In the Timing group, under Reorder Animation

click Move Earlier until the Table is first. 1[0 & firstName  []

Play From

0

0000 v

Timing

® Table 9 ]

o} Rectangle 1: ... D
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c28. On the Insert tab, in the lllustrations group, click the Shapes arrow and
click Curved Connector.

Lines

NNNTLLRZZE NG
Rectangles Connector: Curved p I e

W N

A small cross will appear. Move the cross until it is on
top of the gray dot just below the | in Sample.

ﬁ

Click, drag to the top of the circle, and click to draw the connector. The two
ends should be green dots.

/‘H
With the connector selected, on the Drawing Format tab, in the Shape

Styles group, click the Shape Outline arrow and select red. Then, click
the Shape Outline arrow again, click Weight, and select 6 pt.

Tap F5 to start the slide show. The WordArt and the Table should
automatically appear. As you click the mouse, the bulleted items should
appear, and then dim to purple when the mouse is clicked again.

Slide 2 - Solutions

d1l. Onthe Home tab, in the Slides group, click the New Slide arrow and
select Blank.

d2. Right-click a blank area of the slide and select Format Background.

In the Format Background pane, click Fill, Picture or texture fill. A little
way down to the right of the word Texture, click the arrow and select
Papyrus.

d3. On the Insert tab, in the Text group, click Text Box, move the cursor to
anywhere on the slide, and drag to draw a Text Box. Then, type Natural
Gas Safety.

Select the text and, on the Home tab, in the Font group, make the font
Bold 40 pt. Arial.

Select the textbox and drag it to the upper left corner of the slide.
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d4.

ds.

deé.

d7.

ds.
do.

d10.

dil.

di2.

di3.

On the Insert tab, in the Text group, click Text Box, move the cursor to
anywhere on the slide, and drag to draw a Text Box. Then, type the
phrases.

Select the text and, on the Home tab, in the Font group, change the text to
36 pt. Arial.

With the text still selected, on the Home tab, in the Paragraph group, click
the Bullets arrow and select Filled Round Bullets.

- 3= 1=. 1T T [IA]

-t AT

- 2

3

. (@]
None . o

Filled Round Bullets

Select the bullets and, on the Home tab, in the Paragraph group, click the

il

Increase List Level button (Indent More on the Mac).

Click the bullet next to High Temperature and drag it up two lines.

Click the textbox outline and drag the list so that it is under the title. Make
the textbox wider if necessary.

Select the lines of text and, on the Animations tab, in the Animation
group, click Fly In. Notice that the little numbers just to the left of each
word are all set to 1. This means they will all enter at the same time, so you
need to change this.

On the Animations tab, in the Timing group, click the Start arrow and
select On Click. Now the little numbers show 1, 2, 3, 4, 5, which means
they will come in one at a time each time you click the mouse.

With the text still selected, in the Animation Pane, click the arrow to the
right of 5 Low Toxicity and select Effect Options.

On the Effect tab, in the Enhancements group, click the After animation
arrow and select purple. Click OK.

Navigate to the PowerPoint Files folder and double-click the Word file
Sample-c PowerPoint Table Original to open it.

Select the text below the table, tap Ctrl + ¢ to copy it, switch to
PowerPoint, and click a blank spot anywhere on the slide.

On the Home tab, in the Clipboard group, click the Paste arrow and select
Keep Source Formatting (K).

On the Home tab, in the Paragraph group, click the Add or Remove

Columns arrow | == +~ | and select More Options. Change the Number to 3

and the Spacing to 0.4. Click OK.
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d14. Thereis no Column Break as in Word so use the Enter key to make the
three columns break as shown. You may have to adjust the size and
location of the textbox to get the desired result.
d15. Select the textbox and, on the Animations tab, in the Animation group,
click Fly In.
Click the Effect Options arrow and select From Bottom-Left.
In the animation pane, click the Effect arrow and click Effect Options...
6() X Rectangle 5: ... |:|
Start On Click
Start With Previous
©  Start After Previous
Effect Options...
Under Enhancements, next to Animate text select By letter. Click OK.
Mac: Do not click Effect Options. Rather, click the Effect Uptions
triangle next to Text Animations. .
Timing
Triggers

¥ Text Animations

Animate text: | By letter

d16.

dl7.

di18.

Navigate to the PowerPoint Files folder and double-click the Excel
workbook Sample-d PowerPoint Chart Original, which is one of the files
you downloaded at the start of the term.

With the chart selected, tap Ctrl + ¢ to copy it. Switch to PowerPoint, click
an empty part of the slide, and tap Ctrl + v.

On the Chart Format tab, in the Size group, change the height of the
chart to 5 inches and the width to 8 inches.

Mac: With the chart selected, double-click the edge to open the Format Chart
Area pane. Click the Size & Properties button and type the height and width.

d19.
d20.

Click the edge of the chart box and drag it.

On the Insert tab, in the lllustrations group, click the Shapes arrow and
select the straight line.

Click an empty part of the slide, click and drag to draw the line.

With the line still selected, on the Drawing Format tab, in the Shape
Styles group, click the Shape Outline arrow, select Weight and then 6 pt.
Select red for the color.

Repeat the process for an arrow.
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d21.

d22.

d23.

Click the line and move it to the proper position. Do the same for the arrow.

Click the line, hold down the Shift key, and click the arrow to select them
both. Right-click, select Group, and select Group again.

With the group selected, on the Animations tab, in the Animation group,

click the More button, B to open its menu. Click More Entrance Effects.
Scroll down to the Exciting group, click Spiral In, and click OK.
In the Timing group, select After Previous from the Start menu.

In the Timing group, click Move Earlier until the group us just below
Low Toxicity.

With the group selected, on the Animations tab, in the Advanced Animation
group, click Add Animation (Mac: There is no Add Animation button).

Click More Emphasis Effects and select Blink.
On the Animations tab, in the Timing group, select Start: After Previous.

Click the triangle and select Timing.

%Group 13 D E

‘15 Start On Click

Start With Previous
Start After Previous

Effect Options...

Timing...

Set Repeat to 3.

Slide 3 - Solutions

el.

e2.

e3.

On the Home tab, in the Slides group, click the New Slide arrow and
select Blank.

On the Design tab, in the Themes group, click the More button, right-click
Berlin, and select Apply to Selected Slides.

_

Apply to All Slides

Apply to Selected Slides

On the Insert tab, in the Illustrations group, click SmartArt.
Click List, and then click Basic Block List subcategory.

Click OK.
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e4. Type the text in the first five boxes. To add a box, right-click in the Toyota
box, click Add Shape, click Add Shape After, and type Honda.

] Add Shape > [ Add Shape After

e5. Select the six textboxes by clicking on the edge of the Ford textbox,
holding down the Shift key, and clicking the edges of the other five
textboxes.

On the SmartArt Format tab, in the Shape Styles group, click the Shape
Fill arrow, and select blue.

Mac: Click the Format menu and select Format Object to open the Format Shape
pane. Click the triangle next to Fill, click Solid fill, and choose the color blue.

With the textboxes still selected, on the Home tab, in the Font group,
change the font to bold Arial.

e6. Select the six textboxes. On the Animations tab, in the Animation group
open the Animation Pane.

Click the Fly In animation. The numeral indicates that all the boxes
will appear as a group.

To make the boxes appear one by one, in the Animation Pane, click the
arrow next to Diagram 1 and select Effect Options. Click the SmartArt
Animation tab and, from the Group graphic box, select One by one.

Effect  Timing SmartArt Animation

Group graphic: |As One Object
As One Object

'One by one

Reverse ord

Click OK. The numerals 1 through 6 indicate that the boxes will appear one
after the next. Be sure that Start is set to On Click.

f. Onthe Transitions tab, in the Transition to This Slide group, click Push.
g. Tap the F5 key to play the slide show.

For your reference, screenshots of the three slides showing the animation codes are
on page SG414.






Information on the PowerPoint Exam

The third exam will cover only PowerPoint. You may not submit any PowerPoint
homework on or after the day the exam is sent to you.

Date and Time: Check your syllabus for the date and time.
Location: On your own Windows or Macintosh computer.

Time Allowed: | will email the exam to you in the morning and you will have to
upload your zipped solution folder to Canvas by the afternoon of the next day.

Materials: | will email you a pdf copy of the exam questions and the original files you
are to modify.

Submission: You will submit your exam in the same way as you did for the
homework except you will NOT send in pdf files. Instead, you will submit your
modified PowerPoint files so that | can see your animations as well as the
regular output. Do the exam as soon as you get it. Do not wait until the last
minute. If you miss the submission deadline you will receive a score of 0.

Preparation: Be sure you have gone over the Sample Exam Questions for
PowerPoint a few times before exam day. Be sure you have a reliable internet
connection and computer. You may use either a Windows computer or a Mac.
The exam will work on both platforms.

Questions: If you have questions during the exam, email me. Of course, | will not
give you any help or hints, but if you think something is wrong with your copy of
the exam let me know immediately.

Honesty: The exam is open book and notes, but you may NOT discuss the exam or
get any help from anyone else or do the exam with anyone else. Doing so will
result in your receiving a 0 for the exam and an F for the course.
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Project 14
Access Chapter 1: Getting Started with Databases

Access Projects are optional. For Project 14 you may earn up to 40 extra
credit points if you submit it for grading by the due date listed in your
syllabus. The points earned will be added to your Homework score when
final grades are calculated. Access is not available for Mac so Mac users
will have to do it in a computer lab on campus or at a library.

If you have submitted HWO06 for extra credit you may NOT get extra credit
for doing HW14 or HW15.

Step 1 Read Read the introductory material on page 519 of the textbook.

Step 2 Activities Turn on the computer and do the following: N
Project 1A: Start at the top of page 521.

Instead of Activity 1.02 step 2 (page 523) do the following:

1. Start Access and click Blank database. Blank

2. Locate the Browse folder icon, which is just to the right of the File Name box.

File Name
Databasel

Wad.umn.edu\CEHD\Home\droberts\Documentsy,

Click the Browse folder icon and navigate to your Access Files folder.

You are not going to use sub folders (e.g., Access Chapter 1). Instead, so you
can see them all at once, save all your Access files in the Access Files folder
you downloaded on page SG11.

3. Inthe File Name box, type LastName_FirstName_1A_ Advising, where
LastName is YOUR last name and FirstName is YOUR first name.

4. Click OK.
5. Click Create.

When you open a database, you might get the following Security Warning:

d

Security Warning Some active content has been disabled. Click for mare details, Enable Content

If that happens, click| Enable content |

6. Complete the rest of the Activities for this Project EXCEPT do NOT do
steps 3 and 4 in Activity 1.17 on page 553.

— SG373 —
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7. Return here when you have completed Project 1A on page 553.

Do NOT do GO! With Google
Do NOT do Project 1B

Step 3 Homework After you have completed Project A ONLY return here, do
the following additional activities.

HW14-1 Advising Database (Based on Project 1A)

Problem: How can a database be designed and populated with data?

a. Open the database Lastname_Firstname_1A_Advising, which you created
while following the directions in the textbook and saved on page 553.

b. Do the following to save the database to your Access Files folder under a new
name:

Click the File tab and click Save As.
Be sure Save Database As is selected.
Click Save As.

Navigate to your Access Files folder.

In the File name box type HW14-1a HWID 1A Advising Done

2 A

Click Save. If you get a security warning, click Enable Content.

c. Do the following to set up for submitting the two tables:

Tables

j Lastname Firstname 1A Faculty Advisors

j Lastname Firstname 1A Students

1. Open the table Lastname Firstname 1A Faculty Advisors.

2. Click the File tab, click Print, and then click Print Preview. Compare the
preview with the key. You will submit only page 1 (of 3) so that is all that is
shown in the key. On the Print Preview tab, in the Close Preview group,
click Close Print Preview. Make needed corrections.
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3. Click the File tab, click Print, and click Print to open the Print dialog box.
In the Name box, select Adobe PDF. In the Page Range group click
Pages and enter 1 in the From box and 1 in the To box.

Printer
Name: Adobe PDF

Status: Ready
Type: Adobe PDF Converter
Where: Documents\*.pdf

Comment:

Print Range

Oall

(@ Pages From: ' 1| To: 1‘\

4. Click OK. The Save PDF File As dialog box will open.

5. Inthe File name box type HW14-1b HWID 1A Faculty Advisors Table
Page 1. Be sure the Save as type box shows PDF files (*.PDF).

6. Click Save.

7. Open the table Lastname Firstname 1A Students and follow the same
procedure to save as a pdf file (there is only 1 page). Name the pdf file
HW14-1c HWID 1A Students Table Page 1.

8. Close both tables.

d. Do the following to set up for submission the query, which you saved on page 547:

1. Right-click LastName FirstName 1A All Students Query, select Rename,
and replace the name with HW14-1 HWID 1A All Students Query.

2. Open the query.

3. Follow the same procedure as you did for the tables to save as a pdf its
first page. Name the pdf file HW14-1d HWID 1A Students Query.

4. Close the query.

e. Do the following to set up for submission the report, which you saved on page 552:

1. Rename Lastname Firstname 1A Faculty Advisors Report as
HW14-1 HWID 1A Faculty Advisors Report.

2. Open the report.
3. Switch to Design View.
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4. Inthe Report Header box, change the text to HW14-1 HWID 1A Faculty
Advisors.

HW14-1 HWID 1A Faculty Advisors Report
| ty po

L T T S T T S R I IR

¥ Report Header

THW14-1 HWID 1A Faculty Advisors

Campus Last Name First Name

5. Follow the same procedure as you did for the tables to save as a pdf its
first page. Name the pdf file HW14-1e HWID 1A Faculty Advisors Report.

6. Close the report.
f. Exit Access.

Step 4 Submit Now, submit the following Extra Credit projects. Remember, you
may not get extra credit for HW14 if you have already submitted HWO6 for extra
credit. Use these names for the pdf files:

HW14-1b HWID 1A Faculty Advisors Table Page 1 — Print page 1 only
HW14-1c HWID 1A Students Table Page 1 — Print page 1 only
HW14-1d HWID 1A Students Query

HW14-1e HWID 1A Faculty Advisors Report

Place the pdf file of each of the above in a folder called HW14 HWID
LastName, FirstName, zip the folder and, by the due date, upload it to the
Canvas folder HW14 Access Chapter 1: Getting Started with Databases.

Step 5 Backup Now would be a good time to backup your files.



Project 15
Access Chapter 2: Sort and Query a Database

Access Projects are optional. For Project 15 you may earn up to 40 extra
credit points if you submit it for grading by the due date listed in your
syllabus. The points earned will be added to your Homework score when
final grades are calculated. Access is not available for Mac so Mac users
will have to do it in a computer lab on campus or at a library.

If you have submitted HWO06 for extra credit you may not get extra credit for
doing HW14 or HW15.

Step 1 Read Read the introductory material on page 595 of the textbook.

Step 2 Activities Turn on the computer and do the following:

Project 2A: Start at the top of page 597.

Instead of Activity 2.01 step 1 do the following:

1.

Navigate to your Access Files folder and open a02A_Instructors_Courses,
which is one of the files you downloaded at the start of the term

Save the file in your Access Files folder using the name
LastName_FirstName_2A_Instructors_Courses

Complete the rest of the Activities for this Project EXCEPT do NOT do
steps 9 and 10 in Activity 2.16 on page 619.

Return here when you have completed Project 2A on page 619.

Do NOT do GO! With Google

Project 2B: When you have completed Project 2A, start at the top of page 623.

Instead of Activity 2.17 step 1 do the following:

1.

Navigate to your Access Files folder and open 02B_Athletes_Scholarships,
which is one of the files you downloaded at the start of the term.

Save the file in your Access Files folder using the name
LastName_FirstName_2B_Athletes_Scholarships

Complete the activities through Activity 2.24 on page 632.

Return here when you have completed Activity 2.24 on page 632.

Do NOT do GO! With Google or GO! To Work
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Step 3 Homework After you have completed Projects A and B, return here, do
the problems listed below, and submit them. Remember, you may not get extra
credit for HW15 if you have already submitted HWO0G6 for extra credit.

HW15-1 Instructors and Courses (Based on Project 2A)

Problem: How can separate databases be linked and information extracted from
each to answer questions concerning the data?

a. Open the database Lastname_Firstname_ 2A_Instructors_Courses, which you
created while following the directions in the textbook and saved on page 618.

b. Save the database to your Access Files folder using the name
HW15-1a HWID 2A Instructors Courses Done

c. Take a screenshot that shows you did all the queries by doing the following:

1. Change the name of the 2A No Credits Query, which you saved on page
618, to HWID 2A No Credits Query.

2. Open HWID 2A No Credits Query and switch to Design View. [\./ Design View

3. While in Design view, use the Snipping Tool to take a screenshot that
includes the Navigation pane and the HWID 2A No Credits Query.

- ] .
) ‘ =3 HWID 2A No Credits Que:
All Tables © « |& i
Search... ,C) 2A Schedule
2A Instructors A . -
EH 24 instructors : Table B Schedule ID
Subject
'=§] 2A Department Sort Query c t-l
atalog#
[ 24 Instructor IDs Query Course Name
'=__rf] 2A Instructors Query Credits
_:j Section
IR= 2A IST Quer
Hery Prerequisite v
=§] 2A Professors Query 4
2A Schedule 2
Bl 2a Schedule : Table Field: |Subject Catalog# Section Course MName | Credits
T Table: [2A Schedule |2A Schedule |2A Schedule |2A Schedule | 2A Schedule
'-_Eﬂ 2A Department Sort Query Sort: | Ascending Ascending Ascending
Show: v v v v v
= HWID 2A No Credits Query Criteria s Nu

4. Open a blank Word document, type HW15-1a 2A No Credits Query,
HWID, and tap Enter.

Paste the screenshot you just made and place a black border around it.

Save the Word document as HW15-1b HWID 2A No Credits Query Done
to your Access Files folder.

7. In the footer, insert a field for the file name, tap the Spacebar, type saved
on, tap the Spacebar, and enter a field for the date it was saved.

8. Tap Ctrl + p and compare the preview with the key. Make needed
corrections, save the document, and close it.

d. Exit Access.
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HW15-2 Athletes Scholarships (Based on Project 2B)

Problem: How can complex queries be designed and applied to linked databases in
order to answer specific questions?

a. Open the database Lastname_Firstname 2B _Athletes_Scholarships, which
you created while following the directions in the textbook and saved on page 632.

b. Save the database to your Access Files folder using the name
HW15-2a HWID 2B Athletes Scholarships Done

c. Take a screenshot that shows you did all the queries by doing the following:

1. Open 2B Tennis OR Swimming Query, which you created while following
the directions in the textbook and saved on page 631.

2. Rename the query HWID 2B Tennis OR Swimming Query.
3. Open HWID 2B Tennis OR Swimming Query and switch to Design View.

4. While in Design view, use the Snipping Tool to take a screenshot that
includes the Navigation pane and the HWID 2B Tennis OR Swimming

T =
All Tables ® <« |73 HWID 2B Tennis OR Swimming Query
search £ 2B Athletes 2B Scholarships Awa..
2B Scholarships Awarded A/ - . -
ER 2B Scholarships Awarded : Table B Student ID = B scholarship ID
.:;'] 2B $300 or More Query First Name Scholarship Nam
c:j B is M Last Name mount
8 Awards ) e
! Gender sport
P 2B Football AND Over $500 Quer Address Team
R 28 volleyball OR Golf AND Over $200 Query ‘
P HWID 28 Tennis OR Swimming Quer ;
Field: |First Name |Last Name | College Email Home Phone |Scholarship Name Sport Amount
2B Athletes A Table: |28 Athletes |2B Athletes |28 Athletes |28 Athletes | 2B Scholarships Awarded |28 Scholarships Awarded |28 Scholarships Awarded
I I P
EE 28 Athletes : Table Sort: Ascending
show:
™ HWID 28 Tennis OR Swimmin g Query Criteria: “tennis” Or "swimming”

5. Open a blank Word document, type HW15-2b 2B Tennis or Swimming
Queries, HWID, and tap Enter.

6. Paste the screenshot you just made and place a black border around it.

7. Save the Word document to your Access Files folder using the name
HW15-2b HWID 2B Tennis or Swimming Queries Done

8. In the footer, insert a field for the file name, tap the Spacebar, type saved
on, tap the Spacebar, and enter a field for the date it was saved.

9. Tap Ctrl + p and compare the preview with the key. Make needed
corrections, save the document, and close it.
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d. The textbook showed you how to import data from an Excel worksheet into an
Access table. Data may also be exported from an Access table or query to an
Excel worksheet using the Export command. To see how this works, export
one of your queries to an Excel worksheet by doing the following:

1. Open 2B $300 or More Query, which you created while following the
directions in the textbook and saved on page 627.

2. On the External Data tab, in the Export group, click Excel.

3. Click the Browse button, navigate to your Access Files folder, and save the
workbook using the name HW15-2c HWID 300 or More Query Excel Done.

4. Click Save.

5. Check the box next to Export data with formatting and layout.

Select the destination for the data you want to export

Specify the destination file name and format.

Eile name: C:\Users\droberts\Desktop\Stuff\28-2020 Fall\b-1871 F20\Before Semester Begins\CI1871F200riginalFi Browse...

File format: | Excel Workbook (*xIsx) v

Specify export options.

We will not import table relationships, calculated columns, validation rules, default values, and columns of certain legacy data types such as OLE
Object.

Search for “Import” in Microsoft Access Help for more information.

Export data with formatting and layout.

Select this option to preserve most formatting and layout information when exporting a table, query, form, or report.

6. Click OK. Click Close without checking the save steps box.

e. Set up for submitting the Excel workbook you just created.
1. Open the Excel workbook HW15-2¢c HWID 300 or More Query Excel Done
2. AutoFit the columns.

3. Set up the workbook to print in Portrait orientation, all on one page,
centered horizontally but not vertically. Include a footer that contains the

file name on the left and the sheet name on the right. Compare the preview

with the key. Make needed corrections, save the workbook, and close it.

f. Set up for submitting the 2B Awards May-June Query:
1. Open the query 2B Awards May-June Query.

2. Click the File tab, click Print, and then click Print Preview. Compare the
preview with the key. On the Print Preview tab, in the Close Preview
group, click Close Print Preview. Make needed corrections.
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3. Click the File tab, click Print, and click Print to open the Print dialog box.
In the Name box, select Adobe PDF.

4. Click OK. The Save PDF File As dialog box will open.

5. Inthe File name box type HW15-2d HWID 2B Awards May-June Query Done
Be sure the Save as type box shows PDF files (*.PDF).

6. Click Save.

g. Exit Access.

Why use Access?®!

Now that you have extensive knowledge of Excel, and a bit of knowledge about
Access, you can see how they can do similar things. So, with Excel being so
powerful and “easy” to use, why do so many businesses and institutions use
Access?

Access helps you manage and manipulate data more effectively and efficiently
than Excel. A spreadsheet app is good for small sets of data, but it is not suited
for handling tens of thousands of records or where data are stored in multiple
locations. For example, Excel is ideal for me to keep track of my students’
scores because | have only about 120 students per semester. However, if |
wanted to look at trends for homework, or performance on the Excel exam, or
whatever, over the 25 years | have been teaching the course | would have to
use Access because it would allow me to connect (form relationships between)
the 50 gradebooks | have used.

As another example, think of the information the University keeps on each of its
50,000 current students and millions of students who have attended the U over
its 170 year history. The data include things like name, address, phone, email,
high school data, courses taken, health care used, employment, salaries,
benefits, etc. Using Access, each of those attributes can be stored in separate
databases and all linked through your U of M ID number as the "primary field."
It would be easy to write queries to look for trends. For example, a simple query
could generate a report that shows graduation trends of female Hispanic
students between the ages of 18 and 22 who went to high school in South
Dakota. Excel could not do that.

While you are in school, you probably will not have to manage or analyze huge
sets of data so Excel will probably be your best bet. Once you enter the
workforce you most likely will find that your knowledge of Access will come in
handy.

Two of the major benefits of using a database are:
Fewer errors and inconsistencies. Maintaining one version of data minimizes

the potential for duplication, errors, and inconsistent values (e.g., equivalent
names such as William, Will, Willy, Bill, Billy).

51 Adapted from http://www.opengatesw.net/ms-access-tutorials/What-Is-Microsoft-Access-Used-For.htm
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Higher productivity. Using Access, you need only change a single record and
all other related data in your database will automatically "see" the change. In
Excel, you would need to change every occurrence of, say, a customer's name.
Find and replace wouldn't necessarily catch that a customer's name is spelled
six different ways. In a database, there is only one customer record to change.
Every other record (orders, contacts, etc.) that relates to that customer record
will never need to change because they are joined to the customer through a
one to many relationship.

Step 4 Submit Now, submit the following Extra Credit projects. Remember, you
may not get extra credit for HW15 if you have already submitted HWO06 for extra
credit. Use these names for the pdf files:

HW15-1b HWID 2A No Credits Query Done — This is a Word Doc

HW15-2b HWID 2B Tennis or Swimming Queries Done — This is a Word Doc
HW15-2c HWID 300 or More Query Excel Done — This is an Excel Doc
HW15-2d HWID 2B Awards May-June Query Done

Place the pdf file of each of the above in a folder called HW15 HWID
LastName, FirstName, zip the folder and, by the due date, upload it to the
Canvas folder HW15 Access Chapter 2: Sort and Query a Database.

Step 5 Backup Now would be a good time to backup your files.



Keys for Homework Projects
HWO01-1 HWID Practice Save Done HWO01-2 HWID Google Drive Done

This file belongs to FirstName LastName HWID HW01-2 HWID
abce1234@umn.edu Share "HWO01-2 HWID Google o 9

Drive Done.docx"

| @am using a Windows computer. Add people and grc

| am using the Electronic textbook.
People with access.

@ Dovos Robertson ou)

1871 Excel exam is due on DATE at or before TIME.

1871 Word exam is due on DATE at or before TIME. General access
© Anvonewiththeiink -

1871 PowerPoint exam is due on DATE at or before TIME.

Screenshot of Word Count.

Statistics:
Pages 1
Words 57
Characters (00 spaces) 252
Characters (with spaces) 301
Paragraphs 8
Lines. n

[] Include textbozes, footnotes and endnotes

Close

HWO01-3 HWID-c Compressed Files Done

HWO01-3 HWID

Screens will vary e
a bit for these Dovges Robrtaen ot s ® 112415
three projectsI Attached is the compressed file

— SG383 —
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HWO02-1 HWID 1A Quarterly Sales Done (Data)

HWO02-1 HWID 1A Quarterly Sales Done (Formulas)

Pro Fit Marietta
Second Quarter Cardio Sales

April May June Tatal
Exercise Bikes $ 6899112 § 8589482 S 99,65058 § 25553652
Elliptical Machines 2883600  22,63423  22,82878 7429301
Treadmills 5951978  82,33798 99,8387 2415816
Rowing Machines 81,267.17  S7,B6750  91,659.98 26080455
Total $238,6107 §27973453 §$313972.21 § 832,321.81

Second Quarter Cardio Sales

a

april

June

®Eeeicis Bibes @ Elliptical Machines @ Tieadmilk @ Rowing Machines

Total Sales for Each Type of Machine

_ﬂ‘
Rowing Machines

$241,682 ‘
. .

. L ]
Bliptical Machines E -

$255,5

HWO2-1 HWID 1A Quarterly Sales Dona m Data

Mac will not have Goldie.

-9 A I B I c | D |

E F
1 Pro Fit Marietta

2 Second Quarter Cardio Sales

3 April May June Total Trend
4 [Exercise Bikes 6839112 86894.82 9965058 —sUM{B&D4] "
5 [Eliiptical Machines ;28836 22634.23 2282878 =SUM|B5:05

€ [Treadmills 5351378 H3337.98 9582387 —SUM[BEDE] | o
7 |Rowing Machines  :81267.17 78615 9168998 <SUM[BT:D7] | -~
8 [Total =B&+B5+B6+87 {=CA+C5+C6+CT (=SUM|D&:DT) =SUM|BS:D8]

Notice Formulas.

Notice Row and Column Headings.

HWO2-1 HWID 1A Quarterly Sales Dona m Formulas

HWO02-2 HWID 1B Plyo Products Done

Pro Fit Marietta

Plyometric Products Inventory Valuation

Total Retail Value for All Products

2.

Adaptive i Cardio
Equipment

Equipment

Group Fitness Nordic Ski

Strength
Equipment

HWO02-2 HWID 1B Plyo Products Done @ Notice File and Sheet Names. é Data

Swimming

As of September 30
Warehouse Quantity in - Total Retail Percent of Total
N Retail Price "
Location Stock Value Retail Value
Power Hurdle Atlnta 125 § 3295 § 4,11875 1.41%
Speed Hurdle Atlnta 995 59.95 59,650.25 20.37%
Stackable Steps Marietta 450 25159 113,215.50 38.65%
Pro Jump Rope Marietta 1,105 4995 55,194.75 18.84%
Plyometric Box Set Marietta 255 158.05 40,302.75 13.76%
Plyometric Mat Atlnta 215 9499 20,422.85 6.97%

University Recreation and Wellness Center is a great place to work out
For more information see https://recwell.umn.edu/

S 292,904.85

== A N
Climbing + Cross Training
Bouldering Equipment

Small Group

Personal Training Training

Track
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HWO02-3 HWID Vehicle Sales Done (Data)

Vehicle Sales
(in thousands of vehicles)

2005 2010 2015 2020

Cars
Sedans 23 3 35 29 T
Coupes 14 12 16 15 — T
Total Cars 3 43 51 44

Vans
Full Sized 12 10 8 12 |Hl - |
Mini 8 12 14 23 ——
Four Wheel Drive 1] 2 3 16 — —Iu
Total Vans 20 24 25 51

SUVs
Regular 0 4 12 18
Towing Package 0 0 2 6
Total SUVs 0 4 14 24

Grand Total 57 i1 a0 119 |Average is 84.25

C:Wsers\droberts\Des ktop\Excel Files\[HW02-3 HWID Vehicle Sales Done.xlsx]Data

Note that in the location shown in cell A19:
™ C: is the hard drive
Users shows the computer has been partitioned for multiple users
droberts is my part of the partition
Desktop is my desktop
Excel Files is the name of the folder that contains the file
The square brackets [ ] enclose the file name
HWO02-3 HWID Vehicle Sales Done is the file name
xIsx shows that this is an Excel file
Data is the worksheet name

HW02-3 HWID Vehicle Sales Done Data

HWO02-3 HWID Vehicle Sales Done (3-D Column Chart)

Selected Vehicle Sales for 2005, 2015, 2020

Thousands of Vehicles

Sedans Coupes Full Sized Mimi Regular

Type of Vehicle

HWO02-3 HWID Vehicle Sales Done 3-D Column Chart
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HWO03-1 HWID 2A Tree Inventory Done

A [ B8 ] c I D [ E [ F I G H

1 Pasadena Tree Nursery
2 As of December 31

=l

4] Total tems in Stock 3,022

5 | 0 s Average Price $ 107 .89

6 | A Median Price $ 10799

7| e £ Lowest Price $ 10299

8 | we Highest Price $ 11798
b

10| OCak Trees 13

11 |Maple Trees 6 (571 total itemsin stock)
12
13 Quantity in $tock ltem # Tree Name Retail Price Light Landscape Use Category | Stock Level
14 78 13129 |Golden Oak. 108.99|Partial Sun__|Erosion Control Oak. oK
15 35 13358 |Columnar English 106.95|Full Shade Border Oak Order
14 40 15688 |Coral Bark 106.25|Partial Shade |Erosion Control Oak. Order
17 20 16555|Crimson King 105.50|Full Shade Border Oak Order
18 75 21683|Japanese Blooming 103.9?|Partial Shade |Erosion Control Cherry OK
19 &0 22182 |Crimson Queen 109.95|Fitered Sun _|Erosion Control Oak Order
20 &8 23677 |Black Japanese 107.99|Partial Sun Border Maple Order
42 350 43153 |Bradford 104.99|Full Shade Border Pear oK

43 6/21/202211:15

HWO3-1 HWID 2ATree Inventory Done Sheetl

HWO03-2 HWID 2B Weekly Sales Don

e (Summary)

HWO03-2 HWID 2B Weekly Sales Done (Bonus)

Sales of Rose Plants and Rose Supplies
Week of May 24

Arce s

ROSE!IF.‘DSE Rose Sales Rose Supply Sales Total Sales Matsio $

supplies Momeon S

Online Sales [ | 3 4346056 § 1334945 § 56,81001 Tndall s
In-Store Sales 32,957.58 11,13812 44,09570
Total S 76,418.14 § 2448757 $  100,905.71

HWO3-2 HWID 2B Weekly SakesDone

Summary HWO3-2 HWID 2B Weekly SaksDone

Salesperson Weekly Sales

4588 S
2575 §
3851 §
5162 §

Weekly Online Sales Bonus

Bonus using IFS Bonus using nested IF

30 § 350
_S -
%0 § 250
500§ 500
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HWO03-3 HWID 2G Inventory Done (Bulbs)

HWO03-3 HWID 2G Inventory Done (Summary)

Pasadena Facility: Inventary Status of Bulbs Pasadena Inventory Details
As of December 31 As of December 31
Total hemsin Stock 2847
Average Price S 899 Bulbs Trees
Median Frice $ 842 Totd ftems in Stock. 2,847 3,503
Lowest P: $ 475 Average Price; § 899 § 3343
Highest P $ 1458 iedian Brice; § 84289550
Tulip Types 5 Tulip Total using SUMIFS Lowestfrice $ 1i%. % 500
Tulip Totel Guonthr > ek HighestPrice. § 16587 § 65700
Tulio Averoge Pice S 1143
Number | Categorie ! Average
Guanfity inStock  [fem #  [em Name Retail Pice  Sze |Category |Stock Level Bulbs Category; in Stock s Price
|| 78 1239 Exofic 1098  18|Deofiodis  |OK Begoniasi 314 3 § 1092
] 86 1285 Bell Song 7.45  18|Doffods  |OK Callas; 101 2 § 191
I:II:I 109 1285 Haley Jone 858 1Z'|Dahlias 851 Daffodils; 755 8 § ih2
) 129 Yellow Hoop 498 18'|Daffodis er i
] i 1325|3plit Crown 475  18'|Doffodis  |OK w Dalias #;3 i : 1;'3?
[ ] 128 1356 | Contessa 787 1Z|Dahlias OK Tufins, 433 % 5 43
(] 55 1365 Jonquilla 487  18'|Dofiodis  |Order P
[ s BT 1368| Butterfly Mix 825 25|Gladiolus  |OK
] 13 1379 | Fringed Mix 1299 15Begonios |OK Number | Categorie © Average
(] 49 1389 | Decorative Glory 695 12|Dahias | Order Trees Category; in Stock s Price
[ —7F] 1425|Men Ameur 755 29|Gladiolss |OK Evergreens; 583 4 $ 1075
] 56 1438 | Topmix Yellow 595 12'|Dahlias Order Flowering Trees: 414 3 $ 2567
M1 165 1452|Campemelia 525  18|Doffodis  |OK Eruit Trees: 438 il §UR A
| — 123 1453 Apeldoom Elite 1125 10"Tulips OK fiut Troes) 618 i (L]
[ ] & 1456 | Stars Lady 85  12|Dahlas OK e Tremer™ 1580 & €
] 124 1456|Pendula Cascade 987 15|Begonies |OK -
(] 52 1458 | Zantedeschia M 1095  Xr|Calles Crder
o] 5 1463(Manley 785 18'|Dafiodis  |OK
3] 25 1465/ Goldstick 9.5 10Tulips Order
(] 42 1465(Topmix Color 752 12'|Dohlas Order
(] 49 1468 Eliotfians White 499 Xr|Callcs Order
(] 52 1489 | Mutfflora 98  15|Begonios  |Order
[} 70 1478| Narcissa Mixed 998 18|Doffodis  |Order
] 123 1482|Nathalie 165 25|Gladiols |OK
[ —T] 1482 | Morning Gold 785  25|Gladiols |OK
(] 75 1482 |Maureen 285  10Tulips OK
[ ] 135 1482 |Pumple Flag 1485 10"(Tulips OK
[ ] 75 1498 | Passionate 859 10°[Tulips oK
Hw03-2 HWD 26 Inventon Dane Elbs HW03-3 HWID 2G Inventory Done Details
HWO03-4 HWID Payroll IF Done
Payren
Date Modified: Fri 18 Jun 2021 Mumber of people who earned overtime pay = 7 people
Time Modified: 2:01 PM Mumber of women who earned overtime pay = 6 women
Current Date: Sun 11 Jul 2021 Sum of Total Pay for people who worked overtime = § 1,597.50
Current Time: 3:52 PM Total hours for men whose pay rate is under 5 = 130 hours
1D Last Name First Name : Sex: Pay Rate: Total Hours Regular Pay | Overtime Pay Total Pay Total Pay Pay Rank
4470881 Anderson Amanda F [ 21 126.00 50.00 126 00 ] 12
4208561  ‘Bastian-Smith  :Christopher: M 4 35 140.00 $0.00 140.00 | | 1
A37EE5 T Bl Gary 1] 3 5 120,00 $45.00 165.00 | | g
4328801 Bergstrom Kenneth M 4 23 $92.00 $0.00 $92.00 L] 15
4719182 Besha Chiyo F 1 65 $40.00 $37.50 $77.50 | 19
4650662 ‘Bohlken Ryan M 7 a2 822400 $0.00 $224.00 ] 5
4450275 iBostrom Taylor F 2 40 80.00 $0.00 $20.00 [ 17
4662548 Comer Jacgueline i F 2 50 80.00 %30.00 110.00 ] 13
4580990 :Dahl Thomas M 8 40 5320.00 $0.00 320.00 _— | 3
4588135 Doublette Amanda F 5 40 5200.00 50.00 200.00 I 1 7
4611455 Fermro, Claire F 4 65 160.00 $150.00 3000 1 ] 4
4558447 " Francis Alissa F 3 40 $50.00 i $80°00 (] 7
4395057 Grahn Darigla F 3 3 105,00 00 105,00 | 14
A5TEIE " Grattan iiegh an F [ 54 240,00 §60.00 330.00 i 3
4235648 Gril Christian T g 32 192.00 50.00 192.00 | | g
4019425__'Huculak Alexis F 7 50 $280.00 $105.00 385.00 I 1
4346294 ‘lsakson Evan 1 4 2 $88.00 $0.00 $38.00 = 16
4580074  iKoch Do-Kyung F 3 23 $69.00 $0.00 $69.00 — 20
4429640 'Kuharske Malyn F 4 50 $160.00 $60.00 $220.00 _-— [
4566665  iLentsch Michael [ 7 21 $147.00 $0.00 $147.00 | | 10

HW03-4 HWID Payroll IF Done

Payroll Data
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HWO04-1 HWID 3A Enterprise Fund Done (Expenditures Chart)

HWO04-1 HWID 3A Enterprise Fund Done

Enterprise Fund Expenditures

Expenditures Chart

HWO04-2 HWID 3B Tourism Done (Expenditures)

HWO04-2 HWID 3B Tourism Done (Advertising)

Pacifica Bay
Tourism Spending 2016 to 2020
Year 2016 2017 2018 2019 2020
Tourism Spending $ 4644325 $ 5605958 § 7,235397 S 8824638 S 11,086,354
Percent Increase 21% 29% 22% 26%

Projected Tourism Spending

Estimated Growth Rate 21%

Year 2020 2021 2022 2023 2024
§ 11086354 S 13,414,488 § 16,231,531 § 19640152 § 23,764,584

Estimated Growth in Tourism Spending 2020 to 2024

Year 2020 2021 2022 2023 2024
25% Growth Rate $ 11086354 S 13,857,943 § 17,322,428 § 21653035 § 27,066,294
21% Growth Rate S 11086354 § 13414488 $ 16231531 $ 19640152 $ 23,764,584

HWO04-2 HWID 3B Tourism Done Expenditures

Tourism Advertising Tourism Advertising by State

By State ' Expenditures
State Expenditures 75,200
Arizona s 48,500 ‘
Ningis. s 62,350
New York s 51,300
Oregon s 75,200 48,500
Washington s 68,500 reaarnany g

/0801, ATt M, o, Wi

Travel Agent Event Promotional Event

Invitation Analysis
vited
Invited 125
Responded Yas 78
Attended 85 Responded¥es
o
HWO4-2 HWID 38 Tourism Dane Advertising
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HWO04-3 HWID HLOOKUP Gradebook Done

Course: Math 1051 65
Instructor: Robertson 6 |
1
Total Points 0 65 82 86 90
Quch! Study lots! Studyl Fair Ok Mot bad Fine Good Prettygood : Very good
F D D+ C- C C+ B- B B+ A
7 0 9 3 10 16 12 22 15 15 1
Using HLOOKUP XLOOKUP
Name Attend HW Di; Exi Ex2 Ex3 Final Ex Total Grade G it | C it
Aanon, Natalie 80 90 99 56 94 74 74 79 C+ Not bad Not bad
Aba, Megan 93 92 91 65 62 52 65 68 D+ Study! Study!
Aguilar, Andrew 83 94 88 7 69 67 67 73 C Ok Ok
Aiuppy, Aliasgher 20 19 89 0 0 0 0 11 F Ouch! Ouch!
Ali, Elijah 97 100 86 il 72 67 67 74 C Ok Ok
Bartlett, Jeffrey 87 9 95 94 83 85 94 91 A Verygood | Verygood
Becker, Stefanie i 53 45 0 23 0 0 10 F Quch! Quch!
Bedore, Laura 73 85 66 66 i3 53 66 68 D+ Studyl
Bello, Lamia 100 100 90 68 60 67 60 69 D+ Studyt
Bennett, Kevin 20 63 93 70 {3 67 62 68 D+ Studyl

HW04-3 HWID HLOOKUP Gradebook Done

This column is blank if you
do not have XLOOKUP.

Gradebook

HWO04-4 HWID VLOOKUP Shipping Done

Shipping Cost Calculations

Calculate Shipping Cost H
Given Item Number _!vleiumand Item Number Blank If you do nOt
Choose Shipping <_Use VLOOKUP |
Item Number Cost <_Use XLOOKUP if you haveit.| é have XLOOKU P.
80680 $33.00
VLOOKUP XLOOKUP XLOOKUP Weight/Cost Table Scratch Area
Item Number Weight (Ibs) Cost Cost Round up Cost Weight Shipping Cost Weight Item Number : Shipping Cost
44537 75 530.60 530,60 53180 0.0 §11.75 75 44537 530,60
80630 99 $33.00 $33.00 Not found 10 $15.75 99 80680 $33.00
43913 87 $31.80 $31.80 $33.00 20 $18.50 87 43913 $31.80
71304 57 $26.75 $26.75 §20.40 30 $21.25 57 71204 $26.75
42 $24.00 $24.00 $26.75 40 §24.00 42 64287 $24.00
60417 31 521,25 521.25 524.00 50 §26.75 31 60417 521.25
54049 42 $24.00 $24.00 $26.75 6.0 $20.40 42 54049 $24.00
48320 1.1 $15.75 $15.75 $1850 7.0 $30.60 11 48320 $15.75
90169 49 $24.00 $24.00 826.75 80 §31.80 490 90169 $24.00
13529 11 $15.75 $15.75 $1850 9.0 $32.00 11 13529 $15.75
45187 82 $21.80 $21.80 $33.00 82 45187 $21.80
94225 3.0 $21.25 $21.25 $2125 30 94225 $21.25
688378 35 521.25 521.25 $24.00 a5 88378 521.25
71532 6.7 $20.40 $20.40 $30.60 6.7 71522 $20.40
22546 53 52675 526.75 $29.40 53 22645 526.75
61276 71 $20.60 $20.60 $31.80 71 61276 $20.60
85052 14 $15.75 $15.75 $1850 14 85052 $15.75
98358 6.1 $29.40 $29.40 $30.60 6.1 98358 $29.40
52011 90 $33.00 $33.00 $33.00 a0 52011 $33.00
36577 47 524.00 $24.00 $26.75 47 36577 $24.00
40590 6.3 $20.40 $29.40 $30.60 6.3 40590 $29.40
64817 87 $21.80 $31.80 $33.00 87 64217 $21.80
2153 33 $21.25 $21.25 32400 33 21530 $21.28
33587 70 $30.60 $30.60 $30.60 70 33587 $30.60
39536 66 529.40 $29.40 $30.60 66 39526 529.40
HNOH4HAID VLOOKLS Stipping Done you do not have XLOOKUP Stiping Costs
L]
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HWO04-5 HWID PivotTables Done (Slicer-1)

HWO04-5 HWID PivotTables Done (Crime)

Precinct 2
Precinct 4

HWO04-5 HWID PivotTables Done

Precinct 5

Precinct 6

3-D Chart

S o e e B e e Fire/Police _|Month _|Location _|Class _[Num __|Num |
2 EFWMM Ciass Police Jan Precinct2  Crime 310]
- Police Jan Precinct 4 Crime 308 ]
= oo [ Police Jan Precinct 5 Crime 286 |
Accidents Palice Jan Precinct 1 Crime 5l |
Crime Police Jan Precinct 6 Crime ZrEAl |
Sent Police Jan Precinct 3  Crime 196 [
Police Feb Precinct 4 Crime 27T ]
Police Feb Precinct 5 Crime 230 ]
Police Feb Precinct 3 Crime 224 ]
Police Feb Precinct 6 Crime 206 ]
Police Feb Precinct 2  Crime 175
Police Feb Precinct 1 Crime 93]
Police Mar Precinct 6 Crime GED]
Police Mar Precinct 4 Crime PG |
Police Mar Precinct 5  Crime 2341
Police Mar Precinct 2 Crime 211
Police Mar Precinct 3 Crime 21|
Police Mar Precinct 1 Crime 121 [
HWO45 HWID PiofTables Done Slicer-1 HWO04-5 HWID PivotTables Done Cnme
HWO04-5 HWID PivotTables Done (3-D Chart)
1st Quarter Crime and Accident Calls for Top Four Precincts
600
500
400
300
H Crime
W Accidents
200
100
1]
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HWO05-1 HWID River Done (River Depth and Temp Chart)

River Depth and Bottom Temperature vs. Distance From West B ank

25

¥ = 2E-09x° - 6E-07x"° + 7E-05x* - 0.0037x° + 0.0778x* + .1473x - 0.0165
R? = 0.9985 where y is Depth and x is Distance from West Bank

(4 Hap) ainjesadwa) wojjog

HWO05-1 HWID River Done

20 30 a0 50 60 70 80
Distance From West Bank (feet)

50 100

River Depth and Temp Chart

HWO05-2 HWID Loans IF Done

Loan Payments

| Today's Date: 13 Jul 2023 |

More than
30 days Number of
Loan Due Date Amount overdue days overdue
Boat 11 Jun 2023 $450.00 OVERDUE 32
Car 30 Jun 2023 $520.00
Home 04 Jul 2023 $980.00
Student 24 May 2023 $300.00 OVERDUE 50

HWO05-2 HWID Loans IF Done

Loan Data
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HWO05-3 HWID Rent IF Done

Rent Payments

| Today's Date 11Jul2023 |
British System Metric System

| Normal Rate,  $9.00 per sq. ft. $96.88 persq. m.
| Introductory Rate,  $5.00 per sq. ft. $53.82 persq. m.
Company Floor Space _Payment Due|
Lisa's Camping Supply 5,000 sq. ft. 10 Oct 2015 $45,000.00
Badtke Burger Barn 1,500 sq. ft. 4 Apr 2023 $7,500.00
Brainiac Books 800 sq. ft. 30 Apr 2016 $7,200.00
Know It All Notions 2,000 sq. ft. 6 Jan 2023 $10,000.00
Panera 2,500 sq. ft. 5 Jul 2023 $12,500.00
Cub 18,000 sq. ft. 25 May 2015:  $162,000.00
Gertins 23,000 sq. ft. 2 Aug 2019 $207,000.00
Menards 25,000 sq. ft. 8 Jan 2017 $225,000.00
Mary's Malts 3,200 sq. ft. 2 Sep 2023|  $16,000.00
Stamp House 4,300 sq. ft. 3 Aug 2018 $38,700.00
Trainworld 4,600 sq. f. 8 Jul 2016 $41,400.00

Total Payment Due: $772,300.00

Number payments less than $8,000 = |2
Sum of payments less than $8,000 = 1$14,700.00
Sum of Payments where Floor space less than 2,200 = {$24,700.00

HWO05-3 HWID Rent IF Done

Data

HWO05-4 HWID Commission IF Done (Sales Data)

MicroMania, Inc., Sales and Eamings Summary

Employee Hardware Sales = Software Sales H"’"".’""’fe Soft\._var_e To?al . Total Earnings
Commission Commission Commission
Sherri 5 23,000.00 $ 800.00:% 2,360.00 % 64005 242400 ' % 14,424.00
Mary $ 13,500.00 . Rdfeﬂlgg\nf} $ 1,350.00  $ 4000 % 1,380.00 % 12,390.00
Lawrence 3 28,200.00 | })ced Goal Seck here. |3 298400 ' % 1600 % 3,00000 $ 15,000.00
Brady 75,192.00 goU.0y 8,623.04 76.80 8,600.84 20,699.84
Monica 9.500.00 253.00 950.00 20.24 970.24 10,970.24
Jezebel 79,944 00 919.00 9,193.28 7352 9,266.80 21,266.80
Abigail 3 31,013.00  $ 11200 : % 3,321.56 | § 896 % 333052 % 15,330.52
Marisa 3 2527100 ' $ 78200: % 263252 ' 6256 % 269508 3 14,695.08
Sean $ 98,630.00 % 810.00 - % 1143560 % 64801 8% 11,500.40 : § 23,500.40
Max $ 62,357.00 % 958.00 : § 7,082.84 § 7664 $ 7,159.48 ' § 19,159.48
Amy 33.883.00 974.00 3,665.96 7792 374388 15,743 88
Jessica 58,418.00 388.00 6,610.16 31.04 6,641.20 18,641.20
Totals 4,050,169.00 44,539.00 456,120.06 3,563.12 459,683.18 1,378,683.18
Averages $ 52,599.60 $ 578.43 : § 5923.64 § 46.27 | § 5969.91 | § 17,904.98
HW05-4 HWID Commission |F Done Sales Data
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HWO05-5 HWID Sorting Values Done (Values Sorted)

Home Values
Tstmated | Property | Lot 3ize | Cable TV { Small Lot ; Small Lot |
Address Value Tax (acre) Hookup : withCable | orCable
24 Fourth Street S 262,990 5 2,430.00 1.10 No No No
73580 Cake Avenue 'S J82860 5 186100 1.8 lio fio iio
3578 Lake Avenue 13 26157815 21 80 Ho No es
3578 Take Avenue 1S 953 3878 3 056100 5 ia fio es
3 Fourth Sireef §TES AT SR 5100 743 g fio iia
25 Fourth Streef $ 50,000 5237300 0.95 li fio Yes
1459 Via Calinas § 301887752 35300 120 Ves fio Ves
1460 Via Colinas 3 $2321.00 0.97 Yes Yes es
"T35E Take Avenue TS H 077 Ves es es
1481 Via Cainas 3 TES A5 SR TN 754 Ves es Ves
22 Fourth Streef § 283578 5 1,969.00 082 Yes Ves Yes
1458 Via Colinas 5 260,890 ! § 2,035.00 0.70 Yes Yes es
1457 Via Caiinas ST ARTE T G YTh0 g es es es
T: = number with cable
3 “over one acre and tax under $2,100
§8,724° = sum of faxes for lofs over one acre
$768,347! = sum of values forlots over 1 acre and no cable

Click here to open Zillow.com to see more home values

HW05-5 HWID Sorting Values Done

Values Sorted

HWO05-6 HWID Gradebook with Macros Done (Sec 1)

A B T 1 o ] E 1 F 1 2 1 i [ K . ] N 20 AE | A
1_| 11871 sec 1, Professor Robertson
2 Total Pts Ave Exams
3 88 average wio0's>| & ] Ed
4 B # who took ecam> | 36 i 3
5 84 Bercent of final grade->| 6% . 20% | 10%
& nia Date | Sun . Sun | Sun | Pctof
7 g tem | 15 19 0 | Final
8| nia D | Oct | Nov  Dec | Grade
| 9 |Printed Sat17 Jun 2023 at 2:42PM Pis>[ 100 100 . 10 | 35%
10 | HWID [Name 1D Year [Major email | First Name | LastName | Comments| Code | Excel | Word | PPT | HW | TotPts| Grade
11 101Q_Berg, Alex 7023072 (CEAD __ Senior Business Ed_ berg7023@umn Alex iBeg B 80 3 £ & B
Bets, 5am 7266721 Design | Senior Retail Mer Sam Bets i ! % 73 (3 B
Biff, Timothy Freshman Retail Mer imothy  <Bift ) ) 8 (AL A
Bing, William omore jam “Hing NOL' ] () F
Cheng, Recca Freshman i Recca Cheng W i ) F
15 | 106A Coen, Tiffany Nondegres  Business Ed |coendsb7@umn Tiftany Coen ] El % £l % A
17 . 107€_Collins Phuong Sophomore 'HumanRsr coll2172@umn<Phuong iCollins £ 7 [ 13 ] F
15 | 108R Costdlo, Faith SophomoreUndeclaired cost7236@urm, Faith Costdio k() % [ 9 & B+
19 109C Dinh, Timothy Senior Undeclaired  dinh5393@umn Timothy  iDinh 8 72 [ ] ) B-
20| 110 Fischer, Kelly 7790259 ‘Design  Junior Refil Mer fisc7790@umn.Kelly Fischer £ [} [} ] 2 F
21; 111B | Friederichs, Otto 7296323 (Design __ Senior Refail Mer__ frief286@umn.e Otto Friederichs 9 73 3 %6 @0 A
2 | 1420 Johnson, Heathcii i Junior Retail Mer  |johna4 36@umn; Heathcif  :Johnson L & i A
23| 443t Johnson, Mellodes | 5328773 {CEHD  LJunior lindeciaired | johnb29@umn; Meilodee - Johnson e ) & (] ) :
24 114D _ Lea, Michael 733663 [CEHD ' Sophomore  Undeciaired | lexmi 2ba@umn Michael iea £ L A
25| 1150 Lee, Christopher 5953197 {CEHD | Junior Business Ed | leex5953@urmn. Christopher :Lee % 57 % % % A
26 | 116A |Mcguire, Jennifer 2105675 :Design _Junior Refail Mer  mcgu2105@umiJennffer  iMcguire ] 3 ) 111 % A
27 | 117U | Miller, Dan 5976256 Design Sophomore ApparelDe . mill5875@umn.¢Dan Miller T 5 [ 52 5 F
25 | 118M |Ndson, Kari 2137277 CEHD _ Senior Undeclaired nels2137@umn. Kari Nelson @ b -4 52 7 [
29 118Q_|Oman, Vaughan 5926707 \CFANS Freshman Env Scienc 59261 Oman s | m  ® ] () A
| 20 120H | Payner, Andrew 5907290 \CEHD Junior Business Ed : peteB307@urm. Payner @ ! = - % A
31 | 121E _Pichner, Sue Undeclaired ! pich5%27@urm. Pichner @ o i om = % A
E3 Purtle m % o o & Bt
B Roland 8 ™ % % & Bt
3 u Rush & %0 % 1 = A
EX Sanmuels, Tyler Sophomore Retail Mer  samw3767@un Tyler Samuels % 57 % % % A
% _ 126A  Staber, Michael Freshman Undeclaired _ sab7360@urmn, Michael Staber ® El 100 | 12 . ® A
37 | 127A  Stanmark, Hamy Senior Undeclaired _ step2127@urmn. Hany Stanmark & [ 100 | 11 = A
35 | 1280 Stenson, Chris Nondegres  BusinessEd stra7000@umn.Chris Stenson E7) 0 [ 5 “ F
39 | 129A Taylor, David Sophomore_ Business Ed tonx7259@umni David Taylor % % - (4 @ A
40| 130A Thompson, Marc Senior Undeclaired |tonx5977@umn; Marc Thompson 50 8 93 = 78 [
41 131E_Tondryk, Marvin tond7202@umn Marvin Tondryk & a0 ] 51 & D
= n, Megan .o 8 - % ) A
43 133V Ungermen, Tyler unge2105@un: Tyler & % - o @ A
44} 134U Vang, Linda 5975256 Design | Freshman vang5975@unmi Linda Vang & 80 8 105 1 @ A
45 | 135R |Yang, Biyan 2137277 CEHD __ Sophomore yang2137@umni Bryan Yang @ 8 % s @ A
4 | 136A |Apple, Ben 1233212 ICEHD ___Freshman Business Ed_ appl1234@urm, Ben Apple ] £ 100 (3 £ A
47} 137U
HWO056 HWID Gradebook with Macros Done Sect
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HWO06-1b HWID Excel Practice Done (Sales Data)

A [ B C D [ E [ F
1 [Names and Total Sales Printed on Fri 24 Jun 2022 at 9:48 AM
2 |Name Department Total Sales Ci ission % of Total Sales | Quality
3
[ 4 |Adams, Kathy " Saies $5437066 81175448 2570 Geeat
5 |Baker, Jeff Marketing 38,568.00 9,828.16 88 al
| 6 |Braasch, Cindy _|Production 33,411.00 9.272.88 3.5 Poor
7 |Clover May Sales 35,584.00 9.470.08 5.7 Poor
8 [Day, Dennis Marketing 36,588 00! 9,590.56 6.8 Good
[ 9 |Good, Sara Production 30,574.00 $9.468.88 5.7 Poor
10 |Guled, Holly Marketing 36,847 00 9 62164 7.0 Good
[ 11 ]Joshi, Steven Sales 3547500 9,457 00 58 Poor
12 |Khan, Rachael  Marketing 38,327 .00 9 799 24 85 Great
[ 13 |Khatoon, Cara | Production 9,658.00 9.958.98 9.9 Great
14 |Mady, Niki Production 33,095.00 9,247.60 2.2 Poor
15 | Schwert, TWatt Sales 8,885.00 £5,958720 10.2: Great
16
17 Total 847 48766
18 Average 38 12558
um of [otal
Sales for
Commissions
19 over $9.800
20 552 581.66
Num of Comm
over $9,600 for
21 Marketing
22 3

Used Goal
Seek to
change C4
so E4is
exactly 25.

HWO06-1b HWID Excel Practice Questions Dene - KEY Sales Data
HWO06-1b HWID Excel Practice Done (Column Chart)
HWID
s2s000.00  $24,371
‘o
[}
$9,658 $9,985
$8,568 $8,327
$6,588 $6,847
$5,584 $5,574 $5,475
D A I I I $3,095
i Adams, Baker, Jeff Braasch Clover, May Day, Dennis Good, Sara  Guled, Holly Joshi, Steven Khan Kh: Mady, Niki.  Schwert,
Kathy Cindh Rachael Matt
People

HWO06-1b HWID Excel Practice Questions Done - KEY

Column Chart
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HWO06-1b HWID Excel Practice Done (Bonus Data)

A [ B [ c [ D [ E F G
1 Bonus Data
2 |Highest Bonus Awarded was $1,000.00
3 |[Name Sales Bonus Average of Total Sales is $8,123.56
4 |Maren $38,200 $1,000
5 |Sue $30,123 $800
6 |Melissa $25,821 $600
7 |Elana $22,054 $400
8 |Kathy $17,866 $200
9
10 Sales. $15,000 $20,000 $25,000 $30,000 $35,000 $40,000
11 Level Low Fair Medium Good Excellent ' Outstanding
12 Bonus 200 400 600 800 1000 1200

HWO06-1b HWID Excel Practice Questions Dene - KEY

HWO06-1b HWID Excel Practice Done (Births Chart)

1200

1000

Live Births Per Thousand Women

200

Live Births Per Thousand Women vs. Age

¥ = -0.0003x5 + 0.0598x4 - 3.9721x% + 117.28)¢ - 14607

R* =10.9973

12

16

20

24

HW06-1b HWID Excel Practice Questions Done - KEY

28 32

36

Age (years)

40
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HWO06-1d HWID Excel Practice Pivot Done (3-D Pie)

Sum of Income

HW06-1d HWID Excel Practice Questions PivotTable Done - KEY

Contribution of Each Pool

Puol
Manth
Item
Staff

= Beach
= Cape
« coral
Haven
= Sands

= Tropics

3-D Pie

HWO06-1d HWID Excel Practice Pivot Done (Filtered)

HWO06-1d HWID Excel Practice Pivot Done (Beach)

Month (Multiple ltems)

Average of Income Column Labels

Row Labels Dive Swim Grand Total
Coral $1,111 $3,522 $2,316
Haven $910 $3,350 $2,130
Sands $906 $2,694 $1,800
Tropics $734 $2,660 $1,697
Grand Total $915 $3,056 $1,986
Pool Item

Beach Ball

Cape Dive
‘ Coral | Food
\ Haven | Polo
[ Sands | Spa
[ Tropics | Swim

HWO06-1d HWID Excel Practice Questions PivotTable Done - KEY  Filtered

A B Cc D F
1 0 Poo te e a
2 |June Beach Dive 791 86 Melby
3 [May Beach  Dive 882 95 Melby
4 |April Beach Dive 882 95 Melby
5 |June Beach iSwim 2876 295iKing
6 (May Beach Swim 3377 345 King
7 |Apri Beach  Swim 2894 296:King
HWO086-1d HWID Excel Practice Questions PivofTable Done - KEY Beach
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HWO06-1d HWID Excel Practice Pivot Done (Stacked)

$5,000

$4,500

$4,000

$3,500

$3,000

$2,500

$2,000

$1,500

$1,000

$500

$0

Apiil and May Income for Dive and Swim for Coral, Haven, Sands, and Tropics

Coral

Haven

HW06-1d HWID Excel Practice Questions PivotTable Done - KEY

Sands

Tropics

A A | B | € | D

1 Month (Multiple Items)

2

?ZAverage ofIncome Column Labels

4 Row Labels @Dive Swim Grand Total

5 Coral $1,111 $3,522 $2,316

6 Haven $910 $3,350 $2,130

7 Sands $906 $2,694 $1,800

8 Tropics $734 $2,660 $1,697

9 Grand Total $915 $3,056 $1,986

10| Pool 9= % | Item = %

:; Beach Ball

13 Cape [ Dive ]

(=] [ Coral l Food

15

16 [ Haven ] Polo

17 [Sands ] Spa

18

19 | [ Tropics l [ Swim l
Notice that the Filtered

=swim | Wworksheet has changed
=pive | hecause you changed
the filters on the chart.
Stacked
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HWO07-1 HWID 1A Flyer Done

HWO07-2 HWID 1B Programs Done Page 1

Internships Available

Interviews will be held:
Friday and Saturday, January 14 and 15

In the Career Services Conference Room

This summer, Sturgeon Point Productions will be
filming a documentary in Costa Rica about its
native birds and has positions available for two
interns. The filming will begin the first week of
July and will Iast approximately two weeks.
Payment will be by Day Rate of $100 per day.
Transportation, food, and lodging will be
provided.

The First Assistant Director will work with the
second film crew, which will be filming
background video. The Assistant Script Supervisor
will work with the Script Supervisor and will be

ible for inatil ication
between the two camera crews.

You must have a valid U. S. passport; no
inoculations are necessary. Details are available
on the company website.

Today's Date: Wednesday, July 5, 2023

Sturgeon Point

Productions

Internship Guide

A

N Trainon

Apply
Online

The Internship Program
Sturgeon Paint Productions produces and markets educational videos. We started our company
in 1968, and now we are a dynamic and creative independent film and commerdial production company.
From our base in Miami, we create both contract and in-house videos and feature films.
As an intern, you might take part in the follawing types of productions:

% Shart feature films
2 D

Date Last Saved: Tuesday, July 4, 2023

Full location (path)

Last Saved By: Douglas Robertson

of file.

File name full location: C:\Users\droberts\Desktop\HW07-1 HWID 1A Flyer Done.doox

File name twice for — . -
Win but once for Mac.

M Commercials
A% Training films
M8 Sales and marketing videos

# Recordings of live concerts, sparting events, or theatrical productions

HWO7-1 HWID 1A Flyer DoneHW07-1 HWID 1A Flyer Done HWO7-2 HWID 1B Programs Done
HWO07-3 HWID Agenda Done HWO07-4 HWID Brochures Done
‘ PO Box 75732
| Coloradoe Springs. CO 80570
Service \ A i T19-638-9511
- (B ‘\MF\M'@ Johnwells@ad-excellence.net

Agenda TO:  Patricia Smith, Marketing Director
Campus Service Club Respect Digrity FROM:  John Wells, Publications
QOur club always follows Roberf’'s Rules of Order. SUBJECT. Production of brochures
1) New Business DATE. XXX, XXX 0, 0000

&) Treasurer's repori
b) Big brother and big sister project
¢} Food Shelf donations
d) Tax program
€) Election of officers
i) President
ii) Treasurer
iii} Secrefary
f) Other new business

2) Old Business

a) Reading of minutes
b) Continue discussion of fundraising projecis

HWO07-3 HWID Agenda Done

The concept for the new product brochures has been reviewed and passed by the
marketing committee. Stan is working on design ideas and plans to have something ready
for us to lock at the next meeting.

4 Be prepared to discuss in great detail your ideas concerning the layout of
the brochure. It is a nice piece that we can be proud of .. IMPORTANT!

4 Have ready in report form your analysis of the marketability of the new
product. Include the target population as well as revenue projections.

I need to schedule this with the printer so they can order paper. My understanding is

that we will be printing copies as follows.
Decimals lined up
Styl Colors Price Thickness
Regular. one color 000008
Folded.. two color 116
Mulii-stapled . four color 3.1

Decimals NOT
lined up

Statstcs
1

Pages
Weedh 18

Charactess (mo spaces m
Chasracters fwith spaces) 0
Paragraphs "

Unes H]

[] menase testones, roonotes s engnenes

HW07-4 HWID Brochures Done
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HWO08-1 HWID 2A Resume Done

HWO08-2 HWID 2B Cover Letter Done

Josh Hayes
1541 Dearborn Lane, 5t. Petersburg, FL 33713

(727) 555-0313
jhayes@alcana.net

Objective Technology writing and editing position in the rabatics industry, using
research and advanced editing skills to communicate with customers_

Summary OF
Qualifications

Two years’ experience in rabotics lab for Aerospace Instruction Team
Excellent interpersonal and communications skills

Proficiency using Microsoft Office and page layout and design saftware
Fluency in spoken and written Spanish

Experience Assistant Executive Editor, Tech Today Newsletter, St. Petersburg, FL
September 2019 ta present
®  Write and edit articles for popular college technology newsletter
*  Rasponsible for phota editing, cropping, and resizing phatos for
newsletter
*  Winner of Top Collage Technalogy Publication Award

Instructional Lab Assistant, University of South Florida, Tampa, FL
July 2018 to June 2020

®  Assisted robotics professors with sophisticated experiments

®  Setup robotics practice sessians for Aerospace Instruction Team

College Assistant, Florida Port Community College, St. Patersburg, FL

July 2016 to June 2018

*  In Aerospace Department, helped students with hamework, explzined
i ganized materials for p

®  Setup robotics lab assignments for students

Education University of South Florida, Tampa FL
Bachelor of Science, Mechanical Engineering, June 2020

Florida Port Community College, 5t. Petersburg, FL
Associate of Arts, Journalism, June 2018

Honars And ®  Elected to Pi Tsu Sigma, hanor saciety for mechanical engineers
Activities ®  Qualified for Dean’s List, six semesters
®  Student Mentor, helped other students in engineering programs

HWOE-1 HWID 2A Resume Done

Jennifer Gareia

1776 Bay Cliff Drive, Tampa, FL 33602
{727) 555-0347 Jgarcia@alcona.net

May 12, 2020

Ms. Mary Walker-Huglsman, Director
Florida Part Community College Career Center
2745 Ozkland Avenue

S5t Petersburg, FL 33713

Dear Ms. Walker-Huelsman:

| am se=king 2 position in which | can use my computer and communication skills. My education and
experience, outlined on the enclosed resume, includes a Business Software Applications Specialist
certificate from Florida Port Community College.

With a permanent position as my goal, | hope to use the Florida Port Community College Career Canter
to sacure 3 temporary job. | can be availzble for 3 flaxible number of hours or days and am willing to
work in 3 variety of businesses or arganizations

As my resume illustrates | have excellent computer skills. | 2m an honor student at Florida Part
Community College and have outstanding referances. In addition, | have part-time work experience as a
software tester, where | perform the follawing computer activities:

Microsoft Word | Create and mail form letters

You can contact me by email at jgarcia@alcona.net or by telephone at (727) 555-0247. | am available for
an interview st your conveniance.

Sincerely,

lennifer Garcia

Enclosure

HWOS-2 HWID 2B Cover Letter Done

HWO08-3 HWID Bill of Rights Done Page 1

HWO08-4 HWID Park Done

Bill of Rights
First Ten Amendments of the Constitution of the United States of America
Ratified December 15, 1791
The Consfitution may be viewed at http-/fwww archives gov/exhibits/chariers/conslitution. html

Amendment | sy, f

Congress shall make no law respecting an establishment of
religion, or prohibiting the free exercise thereof. or abridging the
freedom of speech, or of the press; or the right of the people
peaceably to assemble, and to petition the Government for a
redress of grievances.

Amendment Il

A well regulated Militia, being necessary to the security of a free State, the right of the people
to keep and bear Arms, shall not be infringed.

Amendment Il

No Soldier shall, in time of peace be quartered in any house, without the consent of the Owner,
nor in time of war, but in a manner to be prescribed by law.

Amendment IV

The right of the people to be secure in their persons, houses, papers, and effects, against
unreasonable searches and seizures, shall not be violated, and no Warrants shall issue, but upon
probable cause, supported by Oath or affirmation, and particularly describing the place to be
searched, and the persons or things to be seized.

Amendment V

No person shall be held to answer for a capital, or otherwise infamous crime, unless on a
presentment or indictment of a Grand Jury, except in cases arising in the land or naval forces, or in
the Militia, when in actual service in time of War or public danger; nor shall any person be subject for
the same offence to be twice put in jeopardy of life or limb; nor shall be compelled in any criminal
case to be a witness against himself, nor be deprived of life, liberty, or property, without due process
of law; nor shall private property be taken for public use, without just compensation.

Amendment VI

In all criminal prosecutions, the accused shall enjoy the right to a speedy and public trial, by an
impartial jury of the State and district wherein the crime shall have been committed, which district
shall have been previously ascertained by law, and to be informed of the nature and cause of the

HWO08-3 HWID Bill of Rights Done

MEMO TO: Dana Brothers, Vice President, Marketing

FROM: Valerie Fair

DATE: Sunday, June 13, 2021

SUBJECT: Final Changes in Hours of Operation, Ticket Prices, and Restrictions

The hours of operation are very similar to last year, the Sunday opening time is the only
change:

Days ...
Monday-Thursday
Friday ...
Saturday and Holidays
Sunday .

Admission charges are significantly different, with the price of season passes reduced
by $20 for Adults, and increased by $20 for Juniors. Let's hope the 15% increase in
revenue is realisticl

Ave One Day Season Pass
Toddler 3 & under Free Free
Junior 4to 11 19 $89
Adult 1210 59 39 $129
Senior 60+ 29 $99

Height and age restrictions are unchanged with the following exceptions

92" tall Drive alone

16 years old Drive with a passenger

40" tall Ride as a passenger

44" tall Drive alone

14 years old Drive with a passenger

32" tall Ride as a passenger

10 years old Play without parent/guardian

No age limit Play with parent/guardian

5 years old Play with 12+ year old companion

HWO08-4 HWID Park Done
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HWO08-5 HWID Bank Product Report Done

HWO08-6¢c HWID Infections Memo Done

First National Bank January/February Sales Report

Date Product Amount Sales Rep Points
5 Feb | Savings 6,300 Belsey 44
(12 Feb | Savings 6,000 Betsey 42
16 Jan ; Cerlificate 5,000} Betsey 400
26 Jan ; Cerfificate 1501 Betsey 120
13 Jan | Cerlificate 5,000} Carolyn 200
22 Jan ; Credit 2,000; Carolyn 16
7 Feb | Savings 1,450 Carolyn 10
23 Jan | Mortgage 5,000} Diane 1750
9Feb | Auto Loan 4,500} Diane 145
8 Jan | Cerlificate 1,500 Diane 12
16 Jan | Checking 600} Diane 3
| 12.Jan | Cerificate 5,000} Jonell 360
20 Feb ! Auto Loan 2,500 Jonell 125
30 Jan | Checking 1,200 Jonell _6]
77 Jan | Mortgage 5,0001 Pam 1650
28 Feb | Auto Loan 5,000 Pam 250
3,000 Pam 300
900 Pam 240
Sum = 60,100 Ave = 311517

HW08-5 HWID Bank Product Report Done

To
From:
Date:
Re:

Memo

Infectious Diseases Foundation
Douglas Robertson

Tuesday, July 4, 2023

Data you requested

Below please find the raw data and graphical interpretation of the infectious diseases model you
requested we develop. A link to a short video is also included. Please contact me if you need further

analysis._
Actual | Predicted Numbor of Infections va. Time
Month | Number of | Number of
Infections | Infections

0 10 10.0

1 14 163

2 30 26.3 .
3 44 41.9
4 60 65.5 i
5 100 99.6
6 150 1454 §
7 209 201.6 £
B 250 263.5 :
9 301 323.8

10 367 375.9

1 420 416.6

12 456 445.5

13 470 465.7 ° w o
14 483 478.6

15 492 486.5

16 493 491.9

17 496 495.1

18 488 497.0

19 499 498.2

20 500 498.9

What you should know about COVID-19 can be found at
httpsJ/fyoutu. be/POloTTh3ock

HW08-6c HWID Infections Memo Done
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HWO09-1 HWID 3A Quantitative Technology Done Page 4 HWO09-2 HWID 3B Environment Newsletter Done
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HWO9-1 HWID 2A Quantitative Technology Done

‘] University Medical Center Goes Green

Volume 1, Number 1

January 2021

University Medical Center continues its
. i . )

friendly practices and fostering ecologically
This

fouses on practices being implemented at the
Center in  accordance with government
guidelines.

RECYCLING TRASH

More than 300 recycling bins have been placed
beside trash bins throughout the hospital. That
means that for every two to four trash or
hazardous wasta receptacles, thers is now  bin
to collect and process recyclable materials.
Flastic and sluminum cups, bottles, and cans are
the main articles that will be recyclad in these
bins, which are clearly marked with the recycling
sign to differentiate them from other types of
waste. In addition to these bins, two extra
cardboard balers have been installed to help
with our increase of cardbaard box recycling.

HARVESTING DAYLIGHT

Low-watt energy-efficent light bulbs have
replaced traditional lights throughout the center
and energy-efficient lamps and daylight controls
have been installed. This move will conserve
energy and cut down on the hospital’s use of
electricity.

'GREENER LANDSCAPING

New landscaping incorporates the use aof
regionally-native plants and a reduction in turf,
thus reducing the need for extensive use of
power equipment. Water-saving devices and a
system that uses 100% recycled water have been
instelled outside the center, replacing the
previous wratering system. Flants and fauna stay
green in an environmentally conscious manner.

'GREENER GROCER

The hospital cafeteria has eliminated nan-
compostable materials and is using recyciable
paper goods. In addition, a vegetable and herb
garden outside the southeast comer of the
Falomar FPavilion supplements fruits and
vegetables purchased at local farmers marksts.

'GREENER RECORDS

Electronic medical records and consent forms
have replaced a paper system, consenving not
only paper, but alsa reclaiming valuable warking
and storage space.

“Everything we can do here at University Medical Center to protect our environment and conserve:
resources sets the example for others to do the same.”
Emily Lynn—Facilities Director

e

HWO09-2 HWID 2B Environment Newsletter Done

HWO09-3 HWID Address Labels Done

HWO09-4 HWID Name Tag PRN Done

FirstName LastName HWID

Room 203 Bailey Hall, St. Paul Campus
Campus mail code: 6017
651-555.1234

name1234@umn.edu

FirstName LastName HWID

Room 203 Bailey Hall, St. Paul Campus
Campus mail code: 5017
£51-555.1234

namel1234@umn.adu

FirstName LastName HWID

Room 203 Bailey Hall, St. Paul Campus
Campus mail code: 6017
651-555-1234

namel1234@umn.adu

FirstName LastName HWID

Room 203 Bailey Hall, St. Paul Campus
Campus mail code: 6017
651-555-1234

namel1234@umn.edu

FirstName LzstName HWID
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Hello, my name is Jill
My msjor is English
My interests are
Flute
Walking
Gardening

y.

| live in Bailey Hall on the 5t. Pasul Campus
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Hello, my name is Sl
My major is Computer Szience
My interests are

Hello, my name is Albart

My msjor is Physics

My interests are
Special Relativity
(Genersl Relstivity
Phatons

e

| live in Territorial Hall on the Minneapolis Campus
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Hello, my name is
My maior is
My interests are

Hello, my neme is Sue
My msjor is Biology
My interests are

Band

Jopging

| live in Territorial Hall on the Minneapolis Campus

Hello, my name is Barak
My maior is Political Science
My interests are
Community Service
Sports
Golf

Hello, my name is Will
My msjor is English
My interests are

Foetry

Plays

Art

e

| live in Bailey Hall on the St. Pasul Campus

e

Hello, my name is
My maior is
My interests sre




SG402

PROJECT 9 (5 PAGES)

KEY

HWO09-5 HWID IF Merge MAIN Done (Codes Showing)

{ SKIPIF { MERGEFIELD Sex } = "Unknown" H MERGEFIELD Title } {
MERGEFIELD FirstName } { MERGEFIELD LastName }

{ MERGEFIELD Address }
{ MERGEFIELD Cily }, { MERGEFIELD Stale } { MERGEFIELD Zip }

Dear { MERGEFIELD Title } { MERGEFIELD LastName }

Thank you for your interest in our magazines. As a new customer | would like to
offer you a special deal on { IF { MERGEFIELD Sex } = "Male" "Sporis
llustrated™ ™ H IF { MERGEFIELD Sex } = "Female” "Ms. Magazine™ ™ }. Your
special yearly rate is { IF { MERGEFIELD Sex } = "Male” "§15.99" "13.99" }. The
shipping and handling charge would be { IF { MERGEFIELD Zip } = 50000
"§6.05" "4.95" }.

Sincerely,

Keisha Rollings

{ FILENAME \* MERGEFORMAT }
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Declaration of Independence

IN CONGRESS, July 4, 1776
The unanimous Declaration of the thirteen United States of America,

When in the Course of human events, it becomes necessary for one people to
dissolve the political bands which have connected them with another, and to
assume among the powers of the earth, the separate and equal station to which
the Laws of Nature and of Nature's God entitle them, a decent respect to the
opinions of mankind requires that they should declare the causes which impel
them to the separation.

We hold these truths to be self-evident, that all men are created equal, that they
are endowed by their Creator with certain unalienable Rights, that among these
are Life, Liberty and the pursuit of Happiness.—That to secure these rights,
Govemnments are instituted among Men, deriving their just powers from the

consent of the governed, —-That whenever any Form of GOvVernment
becomes destructive of these ends, it is the Right of the People to alter or to

abolish it, and fo institute new Government \aying its foundation on
such principles and organizing its powers in such form, as to them shall seem
most likely to effect their Safety and Happiness. Prudence, indeed, will dictate
that Governments long established should not be changed for light and transient
causes; and accordingly all experience hath shown, that mankind are more
disposed to suffer, while evils are sufferable, than to right themselves by
abolishing the forms to which they are accustomed. But when a long train of
abuses and usurpations, pursuing invariably the same Object evinces a design to
reduce them under absolute Despotism, it is their right, it is their duty, to throw off

such Government and to provide new Guards for their future
security —Such has been the patient sufferance of these Colonies; and such is
now the necessity which constrains them to alter their former Systems of
Government The history of the present King of Great Britain is a

history of repeated injuries and usurpations, all having in direct object the
establishment of an absolute Tyranny over these States. To prove this, let Facts
be submitted to a candid world.

He has refused his Assent to Laws, the most wholesome and necessary for the
public good.

HW10-1 HWID Character Styles Done

Problem Solving in Developmental Mathematics

In 1988 the mathematies faculty began to experiment with the way in
which we teach our developmental mathematics courses. We were disappointed
with the number of students who could not successfully complete our arithmetic
and algebra courses and with the number of the students who successfully
completed our intermediate algebra course but who could not successfully
complete college algebra offered through the Mathematics Department. We felt
that developing a new sequence of courses, based on the ideas of problem solving,

was needed.

Courses

The courses we developed are based on the notions that students who are
specifically frained in general problem solving will do better at solving
mathematics problems than students who have received no such instruction, and
that students who construct their own kmowledge, rather than acquire it from the
teacher, will exhibit a better understanding of mathematics and, hence, will
perform better. These notions are in concert with Professional Standards for
Teaching Mathematics statement that

Los

4

dela

yla

indican que el aprendizaje ocurre a medida que los
estudiantes asimilan activamente nueva informacion

¥ experiencias y construyen sus propios

significados.

Basically, we believe that the purpose of education is to transform novices

into experts and that

ething that cannot be

from one

individual to another but rather a persnnzllzxﬂ version of it must be constructed
by the individual learer. We believe that we do not teach mathematies to
students but that we stimulate the students to construct mathematical concepts and
ideas by arranging experiences for them where they are actively involved in the
learming process. Under this paradigm, the students are active parficipants m the
teaching process rather than passive recipients of lecture material. Our
philozophical approach to the leamning process can be ﬂauught of as an underlying
principle that gmdes us as we conduct our classes. We can implement the
philosophy using a number of activities that include gnup work, writing, reading,
discussing, skill building, problem solving, and discovery learning.

Implementation

Our implementation of problem solving mvolves students workmg in
groups on various topics with the course instructor taking on the role as a
facilitator and question pozer rather than as a source of new information or as the

HW10-2c HWID Paragraph Styles Done
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U.S. Depariment of Commerce
Economics and Statistics Administration
BUREAU OF THE CENSUS

| tntroduction |

The U.S. population census records contain a wealth of information. They are useful in
leaming about one’s family and local social and economic conditions at various times in
history. For more recent years especially, they are official documents for persons who
need to prove their age (in the absence of a birth certificate), relationship, citizenship,
residence, and other facts in order to qualify for pensions: get jobs, naturalization
papers, passports, or insurance policies; establish an inheritance; or trace ancestry

There was a population census taken in 1790 and every 10th year after that. The
Bureau of the Census publication, 200 Years of U.S. Census Taking: Population and
Housing Questions, 1790-1990 (W , DC, 1989), shows the specific questions
and the way they appear on the records. It also reproduces instructions given to the
enumerators for taking each census.

I The Document I
This document explains what census materials are available and how to obtain them,
and also lists the sources for some other useful information including:

1. Citizen Archivists such as those people who have some background in history but
who are no professional historians.

2. Federal Employees whose job might include gathering, analyzing, or publicizing
information on the history of the United States of America.

. Genealogists

4. Members of Congress many of whom waste their time and the taxpayers money in
slowing the progress of the business of the People.

w

5. Preservation

6. Records Managers
7. The Press

8. Attend an Event

9

. Donate to the Archives so that we can continue our work in making accessible many
of the artifacts of the country.

10.Work at the Archives

HW10-3c HWID Census Done

Sec 1 Page 2

fo the Public

& PP

Individual records from the national population censuses are confidential for 72 years,
by law (Title 44, U.S. Code). Thus, April 2002 is the scheduled date for the National
Archives to open the 1930 records to public use.

Microfilm copies of the
original population
schedules, from 1790
through 1920 (virtually
all of the 1890 records
were destroyed in a
1921 fire), are available
at the National Archives
in Washington
(http:/Awww._archives.gov
findex_html) and its 13
regional archives, and
many libraries in various
parts of the United
States. Most have
facilities for making
paper copies from the
microfilm.

There are sound of the
surname rather than its
spelling indexes on
microfilm for the 1880,
1900, and 1920
censuses for each
State, and for 1910 for
21 States, principally in
the South. Alphabetic
indexes to the 1790-
1860 and most of the
1870 censuses are
available in genealogical
libraries.

Researchers may find
two Bureau of the
Census publications
useful; most major
libraries have copies:
Heads of Families at the
First Census of the
United States Taken in
the Year 1790 (12 vols.,
Washington, DC, 1907-
08, reprinted 1965-75),
contains specific names.
A Century of Population
Growth—1790-1900
(Washington, DC, 1909,
reprinted 1967-1970),
includes the incidence of
sumames in 1790, and
a variety of summary
tables from colonial
censuses and from 1790
to 1900

A number of State and territorial censuses were Nationalized in the intra-decennial
years, particularly in the 19th century. See Henry J. Dubester, An Annotated

Bibliography of Censuses Taken After the Year 1790, by States and Territories of the
United States (Washington, DC, 1948, reprinted 1969 and 1975) and State Census
Records, Ann S. Lainhart, Genealogical Publishing Co., Inc., 1992. An appendix to the
Dubester book tells where the existing records (some including names) were located;
copies of many can be obtained commercially on microfiche.

‘Some 19th century economic, agriculture, and mortality census schedules have
survived, mainly in State archives but generally available on microfilm. These records
frequently can be related to individuals listed in the population censuses.
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Algebraic Investigations into International Health
and Economic Development

Douglas Robertson and Susan Staats| .- { commentea [w
University of Minnesota

We live in a world in which, on average, people's standard of living is increasing slightly,

even for many poor people, yet inequalities between the rich and poor are also

increasing. In the 1990's, poverty rates slightly in Sub. Africa, but the

number of poor people increased by 140 miliion (Millennium Development Goals Report

2006, p. 4). Globalization is responsible for desperate working conditions in many parts

«of the world, but it also allows people who will never meet in person to communicate

and Global dev issues are omplex] interdisc iplinary, and___ .- { commentea paw1na2]
frequently, they are conveyed through mathematical data._Unfortunately. many people NEETpACTET AR
1ry to avoid using mathematics because they perceive it to be beyond their capabilities

Yet relatively few math educalors—nor their colleagues in other discij

- { Pormatiit: Fort Isic

£ The names of the aLfhors should be |

------------------------------------------- | reversed since Sue did the arginal drat J

2 Shoukd we use the word

s—ieceive the

training in global issues 1o let them guide students jn becoming ¢ of
international data. Michael Vern, a multicuftural education scholar, writes that “(tjhe near
absence of a critical global perspective in teacher education programs is unfortunate

we are in the most ially and polifically privileged and influential
nation in the world. (Vem 2002 101-102). Furthermore, leaming fo access and evaluate
international situations through data is in line with the National Council of Teachers of
Math tics connections standard, which recommends that students leam to use math
in interdisciplinary contexts ranging from science to social science and medicine, and to
use mathematics to examine social issues. This means that students must have
opportunities for using mathematics that they have leamed to analyze and assess
significant social issues like problems in international development

- { Deleted: 1o become:

LA

- - { Moved (nsertion) [1]

In this paper, we describe international issues that can be taught alongside standard
algebra topics. We identify sources of data that teachers need to be able to implement
the topics along with the specific leaming outcomes for intemational development that
teachers can convey to their students.

Depending on how your computer is set
- up, your Track Changes may look a bit
different from mine. Don’t worry about it.
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Exams and Quizzes

The exams are given to students on paper rather than on the computer. Students

may use a calculator on the exams and quizzes. Five exams are given per semester plusa

comprehensive final exam_ By giving a fairly large number of exams, students are able to

study smaller chunks of the course for each exam_ This is especially helpful for students

who struggle with math Six quizzes are also given during the semester according to a set

schedule, and students are informed about the contents of the quizzes.

Checkpoint Questions

Checkpoint questions consist of one or two questions, that may include graphics,

over recently covered concepts or skills. They are given to students typically early in the

class period and are due by the end of class. Students are enconraged to work together,

compare strategies, and determine if their solutions make sense. Students may use any

available resource. When students believe that they have answered the question correctly

and have provided a sufficient written explanation of how they arrived at the answer, the

instructor checks their work. If it is correct and complete, the instructor informs the

student of this and collects it so that the score can be recorded. Here is an example of a

checkpoint question:

“Use the Quadratic Formula to solve 5x® —3x +1=0"1

Checkpoint questions also promote student-student interaction, which makes a

computer-mediated course feel more like a regular class rather than an open lab. Ifa

student is having difficulty, the instructor provides feedback to point the student in the

right direction. The checkpoint questions count for a small part of students’ grades, and

" Hre, quad refers to the mumber of sides of a square, which has 2 dimensions
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mediated classes were significantly more satisfied than students in lecture classes, #(334)

=339, p=0.001.
Course N Mean 3D SEM
Introductory Algebra
Computer-mediated 65 352 048 0.06
Lecture 166 323 0.63 0.05
Intermediate Algebra
Computer-mediated 120 351 046 0.04
Lecture 216 333 048 003

Table 1: Course Satisfaction

The end-of-the-semester survey also asked students about their perceptions of the
activities that contributed most to their leaming. Computer-mediated students were asked
the following question: Which of the following activities resulted in your learning the
most mathematics? Students selected from the following cheices: (a) using software, (b)
doing homework, (c) using the math center, and (d) reviewing for exams. For students in
lecture classes, the first choice was changed to “listening to lectures.™

The choices “using software” and “listening to lecture™ are the primary methods

diated and lecture formats, respectively.

of delivering the i ion in the
The results, shown in Table 2, indicated significant differences in the activities that
contributed most to student leaming according to a chi-square test, (3, N=3530)=351.1,p

< _001. Computer-mediated students mdicated that using the software was the primary

32
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Part 1

This study analyzes the citation patterns in an algebra writing assignment completed by
students in two sections of college algebra, one that used iPads throughout the
semester and one that did not. Students in the iPad section did
not prefer to use apps as an information source more than
students in the non-iPad section, even though available apps were
closely linked to course content. Open-ended assignments are a useful tool in iPad
initiatives to gauge student interest in new leamning technologies.

The Apple iPad tablet computer has received equal measures of excitement and
criticism as an educational teol. The format of a mobile application seems well-svited to
educational endeavors because they focus students’ attention on specific sets of
knowledge and experiences. This is just what students do as they develop knowledge in
a class—they reduce disciplinary analysis into smaller skills and bits of knowledge. Like
any new technology, however, students must decide whether it is useful to them to
spend time learning to use it. In a recent algebra class, students had the opportunity to
use iPads as a research tool for a writing assignment on mathematical and social
perspectives on HIV epidemics. This article reports on students’ citation patterns as a
means of judging the extent to which they chose to use iPads as a research tool.

Part 4 is on page 2 of this document.

Part 2

a. This is the first lettered item. It contains the word Diskette,
which should NOT have the style e1 applied to it.

b. This is the second lettered item. It contains the word disk,
which should NOT have the style e1 applied to it.

c. This is the third lettered item_ It contains the word Disk,
which sheould have the style e1 applied to it.
A few universities have introduced iPads, which do not have a Disk, within a wide range
of undergraduate classes. Pepperdine University, for example, conducted a three term
experimental Disk comparison of iPad- and non-iPad-using classes use across
discipline including calculus, business, nutrition, and religion.

Do NOT hand in these pages for grading.

Key for Sample-b Exam Questions Page 2

Key for Sample-b Exam Questions Page 3

Page 2 Sec2

Part 3

DOUBLE SPACE THIS PARAGRAPH. DOUBLE SPACE THIS PARAGRAPH

DOUBLE SPACE THIS PARAGRAPH. DOUBLE SPACE THIS PARAGRAPH

DOUBLE SPACE THIS PARAGRAPH. DOUBLE SPACE THIS PARAGRAFPH

DOUBLE SPACE THIS PARAGRAPH. DOUBLE SPACE THIS PARAGRAPH

| Part 3a |
SIDE HEAD ONE
| Part 3b |
SIDE HEAD TWO
| Part 3¢ |
Vertex form of the quadratic funclion: f(x) = alx — b)) + ky
| Part 4 |
BREAK UP THIS PARAGRAPH
(@) SKINNY' oo D.0025
(b} REALLY PORTLY 821
(c) SOMEWHERE IN BETWEEN ... 177
| Part 5

HWID Page 3

Part 6

1) Colors
a) Black‘——__‘-_‘—————__ More colors are available

b} Red :
‘) Ing on our Web site.

i)y Dark
¢} Green
d) Blue
2) Sizes
a) Six
b) Eight
c) Ten
d) Twelve
i) Medium width
1) Wide width
iii) Extra wide width
e) Fifteen

" By skinny. we mean really thin.

Do NOT hand in these pages for grading.
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a

‘quadratic function
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Key for Sample-c Graphics and Other Stuff

Key for Sample-f Table Sort

Practice Questions for Word Exam.

This file provides practice with

graphics and columns.

| can be accessible for
a flexible number of
days or hours and am
willing to work in a
diversity of
businesses or
organizations.

8 Alert Good
..

With a permanent position as my ultimate goal, | hope to use the Florida Port
Community College Career Center to secure a temporary job.

As my resume

illustrates |

have

exceptional computer
skills. | am an honor
student at FPCC and

have outstanding

references.

In addition, | have part-
time work experience
as a software tester,
where | perform the
following computer
activities:

| am available for the purpose of an interview at your convenience. You can

contact me by email at jg I net or by teleph at (727) 555-0347.
Education Yea.dy Lifet.ime Unemployment
Earnings Earnings rate
Doctoral degree 90,636 4,531,800 1.5%
Professional degree 95,472 4,773,600 1.5%
Master's degree 72,852 3,642,600 2.2%
Bachelor's degree 60,996 3,049,800 2.5%
Associate's degree 43,472 2,173,600 3.4%
Some college 40,248 2,012,400 4.0%
High school diploma 37,024 1,851,200 4.6%
Less than high school 27,040 1,352,000 6.5%

>

Oct 5, 1829
Jul 4, 1872
Feb 8, 1773
Apr 13, 1743
Mar 16, 1751
Apr 28, 1758
Nov 24, 1784
Mar 29, 1790
Feb 22, 1732
Dec 28, 1856
Oct 14, 1890
Jan 4, 1916
Nov 20, 1942
Apr 23, 1791
Nov 19, 1831
Apr 27, 1822
Nov 2, 1865
Aug 20, 1833
Oct 4, 1822
Jan 29, 1843
Sep 15, 1857
Dec5, 1782
Jan 7, 1800
Oct 27, 1858
Jan 30, 1882
Jun 14, 1946
Mar 18, 1837
Mar 18, 1837
Nov 23, 1804
Mar 15, 1767
Dec 29, 1808
Nov 2, 1795
Jun 6, 1923
May 8, 1884
Oct 30, 1735
Jul 11, 1767
Jun 12, 1924
May 9, 1917
Feb 12, 1809
Feb 6, 1911
Aug 10, 1874
Aug 2, 1956
Oct 1, 1924
May 1, 1946
Sep 5, 1932
Aug 19, 1946

Arthur
Coolidge
Harrison
Jefferson
Madison
Monroe
Taylor
Tyler
Washington
Wilson
Eisenhower
Johnson
Biden
Buchanan
Garfield
Grant
Harding
Harrison
Hayes
McKinley
Taft
Buren
Fillmore
Roosevelt
Roosevelt
Trump
Cleveland
Cleveland
Pierce
Jackson
Johnson
Polk

Ford
Truman
Adams
Adams
Bush
Kennedy
Lincoln
Reagan
Hoover
Obama
Carter
Bush
Nixon
Clinton

Chester
Calvin
William
Thomas.
James
James
Zachary
John
George
Woodrow
Dwight
Lyndon
Joe
James
James
Ulysses
Warren
Benjamin
Rutherford
William
William
Martin
Millard
Theodore
Franklin
Donald
Grover
Grover
Franklin
Andrew
Andrew
James
Gerald
Harry
John
John
George
John
Abraham
Ronald
Herbert
Barack
Jimmy
George
Richard
Bill

Do NOT hand in these pages for grading.

OH

23
110
191
240
176
192
212
213
185
205
189
233
215
214
161
205
210
202
160
250
171
201
236
151
247
270
166
166
207
207
160
211
176
152
173
173

191
152
222
165
238
244
240
171
162




SG408

SAMPLE WORD EXAM QUESTIONS — DO NOT HAND IN (9 PAGES)

KEY

Key for Sample-g Merge MAIN Codes Showing

Key for Sample-i Merge Labels Main

«Skip Record If...Dear President
MERGEFIELD LastName «LastNamex:

We have analyzed your height («Heightn)

and weight («Weight») data.

MERGEFIELD Weight 231 > 200 "You need to LOSE a few
pound.” ™ You need to LOSE a few pound.

need to GAIN a few pounds.”™ ™

Sincerely,

Dr. Watson

«FirstName=
«LastName»

«BirthDate»

«Next Record»aFirstNames
«lastName»

«BirthDates

«Next Record»aFirstNames

«LastName»
«BirthDater

«Next Record»aFirstNames

«LastName»

«BirthDate»

«Next Record»aFirstNames

«LastNames

«BirthDate»

«Mext Record»aFirstMames

«LastNames

«BirthDatex

«MNext RecordwaFirstNames

ulastNames

«BirthDatex

«Mext RecordraFirstNames

ulastNames

«BirthDates

«Next RecordrsFirstNamex»

«LastNamen

«BirthDates

«Next RecordrsFirstNamex»

«lastNamen

«BirthDate»

as

% B

as @

@y

«Next Record=«FirstNames=
«lastName»

«BirthDate»

«Next Recordz=«FirstName»
«lastName»

«BirthDatex»

«Next Recordz=«FirstName»

#LastName»
«BirthDatex»

«Next Record=uFirstNames

#LastName»

«BirthDate»

«Next Record=uFirstNames

«LastName»

«BirthDate»

«Next Record=aFirstNames

«LastName»

«BirthDatex»

«Next RecordzuFirstNamexs

#lastName»

«BirthDatex»

«Next RecordeaFirstNames

#lastName»

«BirthDate»

«Next Record»aFirstNamez

«LastMamen

«BirthDate»

«Next Record»aFirstNamez

wlastNamen

«BirthDate»

% B R A2 323 B 538

«MNext Recordw«FirstNames
«lastNamen»

«BirthDate»

«Next Record»«FirstNames
«lastNamen»

«BirthDaten

«Next Record»«FirstNames

«LastName»
«BirthDaten

«MNext Record»FirstNames

«LastName»

«BirthDate»

«MNext Record»FirstNames

uLastNamex»

«BirthDate»

«Mext Record»«FirstNames

uLastNamex»

«BirthDate»

«MNext RecordwwFirstNames

ulastNamex»

«BirthDate»

«Mext RecordrwFirstNamex

ulastNamex»

«BirthDate»

«Next Recordr«FirstNamex»

«LastName»

«BirthDate»

«Next Recordr«FirstNamex»

wlastNamen

«BirthDate»

@

as

as

biis

a8

a

&

an

@

@y

Do NOT hand in these pages for grading.
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PROJECT 11 (3 PAGES)

PAGE 409

HW11-1 HWID 1A KWT Overview Done (Handout of slides 1,3,4,5)

Sunday, July 24,2022

Kodiak West Travel

Yous Tavel

Your Way

Our Expertise

* Over 20 year:
* Certified Ty | Azzocates -
* Specializingin land and sea travel

* Pacific Nosthnvest mciuding US. and Canada

experience in the tavel industey

Your Vacation

About Our Company -
Kodizk West Tavd o Alaska inherent aspectof
was established in residents whose their teavel
Mirof 2001by  sense of adventuce  itinerasis.
Ken Dakona and and commitment
MiiamDosmer,  ecotousismis an

HW11-1 HWID 1A KWT Overview Done

HW11-2 HWID 1B Seattle Done (Handout of slides 1,3,4,5,6,7)

HW11-3 HWID Bird Done (Handout)

Sunday, July 23, 2023

Seattle

Making the Most of Your First Port

Day Two Sample Itinerary

And if you can spare
one more day...

HW11-2 HWID 1B Seattle Done

Visit Mt. Rainier National Park!

Tuesday, August 4, 2020

Bird Sanctuary Field Trip

= Saturday, October 30

= 6:30 AM till dawn

= Hidden Lakes Marsh, Morth Termitorial Road
= Bring binoculars and camera

= Wear boots and warm clothes

Bird Sanctuary Field Trip

= Saturday, October 30
= 6:30 AM till dawn

= Hidden Lakes Marsh, Morth
Territorial Road

= Bring binoculars and camera
* Wear boots and warm =

clothes N

HW11-3 HWID Bird Done
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PROJECT 12 (4 PAGES)

KEY

HW12-1 HWID 2A Safety Done (Handout)

HW12-2 HWID 2B Celebrations Done (Handout of slides 3, 4, 5)

Sunday, July 24, 2022

<

Sensation Park

g

OurTop Priority

At Sersatian Park, guest and emplayeesaf ey aur tap|
priavity Staff matraport allaccidens, na matie baw

¢ traied sof tyand sacritypersernelcan

dacament and of ficiatyraportincidents.

Injury Prevention—Protect Guests

Summer Season

At Sensation Park
P

HW12-1 HWID 2A Safety Done

Schedule of Events

m_. i « July
t%%ﬁ *September

Saturday, Movember 26, 2022

A DIFFERENT EVENT EACH WEEK!

CONTACTINFORMATION

topnia Agkermarn | Josepn Mercodo
uriteastates i Mexico

Michael Lewis
carada

HW12-2 HWID 2B Celebrations Done

HW12-3a HWID Graphics and Sound Done (Handout)

Sunday, July 24, 2022

HW12-3a Graphics and Sound Done

Plus

ffice 1932

Equals

This is a handout, NOT a slide.
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HW12-4 HWID Poster Done (Slide)

General College University of MN ﬁ
Presented by HWID

Purpose: GC provides entry to the
University for students from a wide
range of ethnic, social, and economic
backgrounds who would like to
pursue a four-year degree, but who
lack the academic skills or records to
realistically compete in a regular
degree-granting college.

Plus

Mission: To develop, through
teaching, research, and service,
the potential for baccalaureate
education in students who are
serious about fulfilling their
previously undeveloped or
unrecognized academic promise.

Students: The GC student cohortis comprised of
approximately equal numbers of late-teen men and
women, 33% of whom are students of color, and
68% of whom are on some form of financial aid.

This is a slide, NOT a handout.
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HW13-1 HWID 3A Trails Done (Handout) HW13-2d HWID Import from Word and Excel Done (Handout)

Sunday, July 24, 2022 Sunday, July 24, 2022

School Attendance

Take a Hike!

PARKS, TRAILS, AND SCENIC ROUTES
IN PACIFICA BAY

Education Rates by State

It’s a Great Way To. . . Challenge Yourself on a Wilderness Hike

5 Improve your GidIoWSOUar tRness
© Learn about kocal egetationand
was¥e

o Get outsice and mect your
nexheors

For Information on Maintained Trails,
Contact Parks and Recreation

Set a Pace Based on Your Fitness Level

[+ Cromvosds Pack
|- ccers Besch Tra2

+ Manme Viia Park
Moderate [ttt

|« Pacifica Bay State Puk

HW13-2d HWID Import from Word and Excel
HW13-1 HWID 3A Trails Done 1 Done 1

HW13-3b HWID Integration Done (Handout) HW13-4e HWID Communication Word Done (from a Word File)

Thursday, August 6, 2020

Animation Pa. v X|
Different People Think Differently!
The wheel Don't Add 3 more to it, Hmmm...
. o annot be imy then ha
Computer-mediated Overview of Computer- : improvedt _e ormatningt
Instruction mediated Software “ 7z 2
= o] ’, A 3 R )
= : i1 1Y WA S AN
: ! ok )}
= ©
e )
1 2 =

Quadratic
Transformations

| §

Structure of Computer-
mediated Courses

= Dty Schaduie of Crmm Ackvien

Preferences by Gender
Type

HW13-4e HWID Cor ication Word D
HW13-3b HWID integration Done 1 mmunication Word Done
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HW213-5 HWID Course Evaluation Done (from a Word File)

HWID
Today's date
HW13-5 Course Evaluation

| accessed the course evaluation web site.




SG414 SAMPLE POWERPOINT EXAM QUESTIONS — DO NOT HAND IN (3 PAGES) KEY

Slide 1 Screenshot for PowerPoint Sample Exam Questions — Do NOT hand in for grading

1 o Powerpomt Sample Exam Questlons

D ___________ ___________ ;,T__rFlrstName
~ lLastName
| e |-|wm

~ OlfType: ... Small Medlum ...Large]. .
: Premium Cost $1,000 s1,soo sz,ooe

OEM Incentives $500  $800  $900 ‘
& SRR Rk e TR “ 100 | et
- Clean Grants = $200 . $500 $800

Slide 2 Screenshot for PowerPoint Sample Exam Questions — Do NOT hand in for grading
| 6 | 5 | 4 | 3 | 2 | 1 | 0 | 1 | 2 | 3 | 4 | 5 | 6 |
HNatu raI Gas Safety
. ‘

- As a Fuel
s ight

;3, -  High Temperature s
_4 + Narrow Range

o e Low Toxmrtv

ESE When used Burning .§.,But..|.t.|s..st|II
correctly, naturalgas = a greener g
natural gas does ~ solution : ; j : : :

S eate """produce L e e et el e

5 eff cient some fossrl fuels. -

- ..source of.. greenhouse |

power g gases




KEY SAMPLE POWERPOINT EXAM QUESTIONS — DO NOT HAND IN (3 PAGES) PAGE 415

Slide 3 Screenshot for PowerPoint Sample Exam Questions — Do NOT hand in for grading

I A T Y T | T 20 0 1 T | ) 2113 Y | 5o 6 11

L Ford | Chevy

: Lincoln = Jeep




SG416 PROJECT 14 (4 PAGES) ACCESS IS EXTRA CREDIT. IT 1S NOT REQUIRED. KEY

HW14-1b HWID 1A Faculty Advisors Table Page 1 HW14-1c HWID 1A Students Table Page 1

Lastname Firstname 1A Faculty Advisors 8/11/2020 Lastname Firstname 14 Students 8/11/2020
Faculty ID Rank Campus Last Name First Name Student ID Last Name First Name Address City State
FAC-0393 Professor Northeast Betancourt Charles 1023045 Fresch Jenna 7550 Douglas Ln Austin ™
FAC-0767 Professor Southeast  Soja Binit. 2034834 Telfer Larry 162 Rattiesnake Ln Red Rock ™
FAC-1133 Professor Northwest  Bell Dora 2345677 Ingram Joseph 621 Hilltop Dr Leander ™
FAC-1283 Professor Northwest  Hart-Rodriguez  Melanie 12349535 Vohra Ashwin 316 Lost Cove Dr Spicewood ™
FAC-1772 Professor Southeast Hag Mark 2583607 McElaney Cleta 13273 Copperfield Dr Austin ™
FAC-2234 Associate Professor  Southwest Sweeney Megan 3128456 Wwall WenLi 14380 Ceylon Tea Cir Pflugerville ™
FAC-2245 Professor Northwest  Szulkin Martin 3456689 Snyder Amanda 4786 Bluff St Buda ™
FAC-2289 Assistant Professor  Southeast  Sideris Dana 3458632 Caputo Stephanie 1731 Primrose Trl Round Rock ™
FAC-2322 Professor Southwest  Briggs Luis 13569325 Thomas Carlis 28A 4th Ave Smithville ™
FAC-2375 Associate Professor Northeast  Torres Robert 3572184 Reid Carla 715 Pampas Ricas Dr Leander ™
FAC-2377 Associate Professor Northeast  Kubzansky Amy 13586943 Stavish Joseph 660 Bayou Bend Dr Buda ™
FAC-2877 Professor Southwest Treiman Roger 3593653 Hemnandez Anna 2132 Mesquite Ln Georgetown ™
FAC-2998 Professor Northwest  Holland Timothy-John 3768532 Alexander Rebekah 218 Chapparral Trl Dale ™
FAC-3433 Professor Southeast Hackett Jessica 3852938 Marris Atonye 1172 Buttonwood 5t Bastrop ™
FAC-3567 Assodiate Professor  Southwest  Michaels Payne 3856930 Nguyen Cong 444 E Alamo 5t Elgin ™
FAC-3991 Professor Southeast Capelle Arturo 4352863 Bradley Christine 2708 Kickapoo Cavern Dr  Pflugerville ™
FAC-4801  Professor Northeast  Saguy Vilma 4719238 Difntonio  Avelina 1008 Sunset Canyon Dr  Dripping Springs  TX
FAC-6534 Assistant Professor  Southeast  lang Phillippe 4739502 Alvarez Eliza 3590 Longhorn Trl Round Rock ™
FAC-6543 Professor Southwest Goldani ZsuZsa 4769304 Furfy Jana 2107 Edenwood Dr Austin ™
FAC-6678 Assistant Professor  Southeast  Hasenfeld Larthia 4852384 Parkhill James 105 E Myrtle 5t Liberty Hill ™
FAC-7223 Assistant Professor  Northwest  Ong Joel 5820384 Rose Edward 555 5 Blanco 5t Lockhart ™
FAC-7342 Instructor Northwest  Villareal Jose Luis 5834924 Kakaulian Anastasia 4822 Turtle Mound Bnd  Austin ™
FAC-8223 Assistant Professor  Southeast  Kilbride Thea 5835035 Poon Laurence 263 Caddis Cv Kyle T
FAC-8375 Instructor Southwest Friend Gyula 5849320 Soltan Reza 5498 Wild Foxglove Rd Spicewood ™
FAC-8523 Associate Professor  Northwest  Abromsky Alexandru 5860300 Campbell Daria 162 Rockwood Dr Wimberley T
FAC-8662 Instructor Southwest Suh Kingston
FAC-8727 Assistant Instructor  Southeast  Gilmore Teshome
FAC-9005 Assistant Instructor  Northwest  Wazir Paul
FAC-9119 Assistant Instructor  Northeast  Bowman Muzhut
Pagel Pagel

HW14-1d HWID 1A All Students Query HW14-1e HWID 1A Faculty Advisors Report

HW14-1 HWID 1A Faculty Advisors Tuesday, August 11, 2020
HW14-1 HWID 1A All Students Query 8/11/2020 1:28:00 PM
Campus Last Name Email
Last Name First Name Email Phone Student ID

Fresch Jenna ffresch@ticc.edu (512) 555-7550 1023045 Northwest Abromsky Alexandru aabromsky@tlcc.edu

[Telfer Larry Itelfer@ticc.edu (512) 555-2017 2034834 Northwest Bell Dora dbell@tlcc.edu

Ingram Joseph jingram@tlcc.edu (512) 5550717 2345677

Nohra Ashwin avohra@rice.edu (512) 5550302 2348535 Northeast Betancourt Charles cbetancouret@ticc edu

McElaney Cleta cmcelaney@ticcedu  (512) 555-0305 2583697 Northeast Bowman Muzhut nbowman@tlcc.edu

wall WenlLi wwall@tlcc edu (512) 555-2329 3128456

Snyder Amanda asnyder@ticc.edu (512) 555-9120 3456689 Southwest Briggs Luis Ibriggs@ticc.edu

Caputo Stephanie scaputo@ticc edu (512) 555-2330 3458632 Southeast Capelle N acapelle@ticc.edu

[Thomas Carlis cthomas@tlcc edu (512) 555-0301 3569325

Reid Carla creid@tlccedu (512) 555-2026 3572184 Southwest Friend Gyula giriend@tlcc.edu

Stavish Joseph jstavish@tlcc edu (512) 555-5360 35865943 Southeast Gilmore e tgilmore @tlce_edu

Hernandez Anna ahernandez@tlccedu  (512) 555-0301 3593653

Alexander Rebekah ralexander@tlcc.edu  (512)555-1017 3768532 Southwest Goldani ZsuZsa zgoldani@ticc.edu

Morris Atonye amorris@ticc.edu (512) 555-1018 3852938 Southeast Hackett e jhackett@ticc.zdu

Nguyen Cong cnguyen@ticc.edu (512) 555-1004 3856930

Bradley Christine chradley@tlcc.edu (512) 555-2013 4352863 Southeast Hag Mark mhag@tcc.edu

DiAntonio Avelina adiantonio@tlcc.edu (512) 555-2319 4719238 Northwest Hart-Rodriguez Melanie mrodriguez@ticc.edu

Alvarez Eliza ealvarez@tlcc.edu (512) 555-2025 4739502

Furfy Jana ffurfy@tlccedu (512) 555-2064 4768304 Southeast Hasenfeld Larthia Ihasenfeld@ticc edu

Parkhill James iparihill@ticcedu (512)555-2323 4852384 Northwest Holland Timothy-lohn tjholland@tlcc edu

Rose Edward erose@tlcc edu (512) 555-2019 5820384

Kakaulian Anastasia akakaulian@ticcedu  (512) 555-2031 5834524 Southeast Kilbride Thea tkilbride @tlcc.edu

Poon Laurence Ipoon@ticc.edu (512) 555-0304 5835035 Northeast Kubzansky Amy akubzansky@tice.edu

Soltan Reza rsoltan@tlcc.edu (512) 555-9362 5849320

Campbell Daria deampbell@ticc.edu (512) 555-1016 5860300 Southeast Lang Phillippe plang @ticc edu
Southwest Michaels Payne pmichaels@ticc edu
Northwest Ong Joel jong@tlcc_edu
Northeast Saguy Vilma vsaguy@tlcc.edu
Southeast Sideris Dana dsideris@ticc.edu
Southeast Soja Binit bsoja@tlcc.edu
Southwest Suh Kingston ksuh@tlcc edu
Southwest Sweeney Megan msweeneyl @tlccedu
Northwest Szulkin Martin mszulkin@ticc.edu
Northeast Torres Robert rtorres@tccedu
Southwest Treiman Roger rtreiman@capcc c.edu
Northwest Villareal Jose Luis jhvillareal @tlec edu
Northwest ‘Wazir Paul pwazir@tlcc.edu

Pagel
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PROJECT 15 (4 PAGES) ACCESS IS EXTRA CREDIT. IT 1S NOT REQUIRED.

PAGE 417

HW15-1b HWID 2A No Credits Query Done (Word Doc) HW15-2b HWID 2B Tennis or Swimming Queries Done (Word Doc)

HW15-1b 2A No Credits Query, HWID

All Tak

5] HWID 24 No Credits Query

HW15-1b HWID 2A No Credits Query Done saved on Sunday, July 24, 2022

HW15-2b 2B Tennis or Swimming Queries, HWID

YT p——

HW15-2b HWID 2B Tennis or Swimming Queries Done saved on Sunday, July 24, 2022

HW15-2c HWID 300 or More Query Excel Done (Excel Doc)

HW15-2d HWID 2B Awards May-June Query Done

[ _Sport [Amount

iip Name:

Texas State Baseball Association Baseball
Texas State Baseball Association Basaball

Aczdemic Achi Awsrd
Austin Sports Fellowship Award Baskatball
Hoops National Winner Award Baskettall
Hoops Fellowship Award Basketball
HoopsSports Award Baskatball
Austin Sports Award Basketball
Texas Sporswoman Foundation Award Baskerball
Austin Jump Ball Award Basketball
Austin Sports Fellowship Awsrd Football
Texas Science Achievement Award Foottall
The Touchdawn Alumni Association Award Football
Round Rock Country Club Award Golf
Dalphin Club Award Swimming
Rivers and Parks Foundation Award Swimming
Blusbonnat Country Club Foundstion Award  Swimming
Michasl Fresch Foundstion Award Tennis
Josaph Ingram Memorial Award Tennis

HW15-2c HWID 300 or More Query Excel Done

5500.00
$3200.00
5500.00
5$500.00
5400.00
5500.00
$500.00
5500.00
5300.00
5300.00
5500.00
$750.00
5600.00
$3200.00
$3200.00
5750.00
5400.00
5400.00
5400.00

2B 5300 or More Query

2B Awards May-June Query
Scholarship Name Sport Amount Award Date
Texas Sportswomen Foundation Award Basketball 5300 5/6/2022
Austin Sports Fellowship Award Football 5500 5/1/2022
Austin Country Club Award Golf 5200 6/25/2022
Round Rock Country Club Award Golf 5300 5/23/2022
Bluebonnet Country Club Foundation Award Swimming $400 5/23/2022
Texas Lakes Sportsmanship Award Swimming 5100 5/23/2022
District Tennis Club Leadership Award Tennis $200 5/6/2022
Pflugerville Academic Achievement Award Volleyball 5250 5/21/2022

Page 1

8/12/2020




Index

Index entries are followed by a letter that indicates the section of this Study Guide
in which the entry is located: [I] = Introduction, [GS] = Getting Started, [W] = Word,
[P] = PowerPoint, [E] = Excel, [A] = Access

&

& used in COUNTIFS, 79
& Used to connect formulas,
45

A

absolute references [E], 60

Ampersand & Used to connect
formulas, 45

Audio [P], 328

B

Bookmark [W], 272
Borders for tables [W], 211
Borders, table [W], 211
Button
auto fill options [E], 129
increase indent [W], 197
link to previous in header

[W], 276

mark all button for index
[w], 280

mark entry for index [W],
280

minimize window [GS], 20

new style [W], 249

no formatting in Find and
Replace [W], 213

C

Chart
line [E], 46
Clipboard, multiple images on
[E], 337
Computer access [I], 1
Conditional format [E], 68
Conditional Format [E], 65
connector [P], 325
CONVERT function [E, 132
Copy Worksheet [E], 42
COUNTIF [E], 55
COUNTIF function [E], 133,
134
COUNTIFS
Use cell references in, 79
Crop a picture [P], 320
Cross reference [W], 272
Custom format [E], 70, 132

D

Data Validation, 86
Declaration of Independence
[w], 244
Dialog box
bookmark [W], 272
format picture [P], 319
new style [W], 249
page setup [W], 276
Display formulas [E], 43
Document map [W], 269

E

Even page header [W], 277
Exam
information on Excel exam,
187, 313, 371
Excel
absolute reference [E], 76
conditional format, 68
COUNTIF function [E], 133,
134
custom format [E], 70, 132
display formulas [E], 43
format chart [E], 116
hide rows [E], 52
HLOOKUP function [E], 75
hyperlink, 140
IF function [E], 64, 131, 135
line chart [E], 46
sort data, 143
SUMIFS function, 55, 133,
134
trendline [E], 119
VLOOKUP function [E], 80

F

Field code
in Word [W], 190
Files needed [GS], 11
Files, finding [GS], 16, 17
Find and Replace [E], 134
Find and Replace [W], 204
First page header [W], 276
fn key [E], 15
Format
chart [E], 116
paragraph [W], 213
picture [P], 319
Format Painter [W], 220

— SG418 —

H

Header

even page [W], 277

first page [W], 276

odd page [W], 277
Help

finding files [1], 17
Hide rows [E], 52
HLOOKUP function [E], 75
Hyperlink

Excel, 140

Word, 274

IF feature in mail merge [W],
234, 237
IF function [E], 64, 131, 135
IF, nested, 53, 136, 170
IFS function, 53, 137, 170
Increase indent button [W], 197
Indent markers for paragraphs
[W], 203
Insert
graphic into PowerPoint [P],
343
page number [W], 272
photo [P], 327
section [W], 259
isformula, 139

K

Keep lines together [W], 195,
252

Keep with next [W], 195, 252

Keyboard Shortcuts [GS], 19

L

Line and page breaks [W], 252
Link to previous button in
header [W], 260

M

macro, 150

Mail merge
IF feature [W], 237

Mark button for index entry [W],
280

Modify a style [W], 251



INDEX SG419

N Ruler V

PowerPoint [P], 325

names, 66 Word [W], 201 VLOOKUP function [E], 80
New style, create[W], 249
Note in Excel, 57 S i

@) ScreenTip [E], 76, 117, 133 Widow [W], 195

Shutting Down the Computer Wildcards in Find and Replace

Odd page header [W], 277 [GS], 20 [E], 134
Orphan [W], 195 SmartArt [W], 198 Word
Outline, setting up [W], 196 Sort data borders for tables, 211

P

Page break before [W], 195
Page setup [W], 276
Paragraph
indent markers [W], 203
keep lines together [W],
195, 252
keep with next [W], 195, 252
line and page breaks [W],
252
page break before [W], 195
spacing before [W], 213,
251, 253
style [W], 251
PowerPoint
insert a photo [P], 327
insert graphic [P], 343
insert sound [P], 328
ruler [P], 325

R
Replace feature [W], 213, 216

Excel [E], 143

Sound clip [P], 328

Spacing before in a paragraph
[W], 213, 251, 253

Style
modify [W], 251
paragraph [W], 251

Submit homework to Canvas,
30

SUMIFS function [E], 55, 133,
134

Symbols, inserting [W], 202

T

Tabs, setting [W], 201
Textbook for PSTL 1571 [l], 5
Trendline [E], 119

U

USB drive [GS], 13
USB drive, removing safely
[GS], 20

count number of words, 206
field codes, 190
IF feature in mail merge,
234, 237
page number, inserting [W],
272
picture, insert from file [W],
261
replace feature, 213, 216
section, inserting [W], 259
SmartArt, 198
symbols, inserting, 202
tabs, 201
text from file, inserting [W],
253
Word count [W], 206
WordArt [P], 357
Worksheet, Copy [E], 42

X
XE code in an index [W], 279



